
1,2,3,4 (File Menu)

Use the numbers and names listed near the bottom of the File menu to open one of the 
documents recently worked on. Choose the number or name that corresponds to the 
document you want to open.
You can change the number of files listed in the General Options.



A bars settings file is invalid or corrupt

Cause
CorelXARA creates two files in your Windows directory to save the configuration of the 
control bar and Galleries in normal mode and full screen mode :

CORELXBN.INI Settings for Normal mode.
CORELXBF.INI Settings for Full Screen mode.

This error indicates that one of these files is corrupted or missing.

Recommended action
No action is necessary as clicking on OK recreates the corrupt or missing file using the 
default settings. This loses any customised control bar and gallery settings for that mode.



A problem occurred when installing or de-installing a font

Cause
You have tried to install a font that is already installed, or you have tried to de-install a font 
that is currently being used within a document.    Alternatively, the font file itself is corrupt.

Recommended action
Installing a font - check that it isn't installed already.    
De-installing a font - make sure it isn't being used in any loaded documents.

If these do not apply, then recreate the font from a backup.



ATM (Adobe Type Manager) fonts are PostScript fonts. ATM is a software component 
available from Adobe which allows the PostScript fonts to be rendered on screen and hence 
allows matching of PostScript printer fonts and screen fonts. CorelXARA also supports 
TrueType fonts which are supported as standard by Windows 3.1x, Windows 95 and Windows
NT.



Abort or continue printing

Cause
You have suspended a print job.

Recommended action
Click the Abort button to cancel the suspended print job
Click the Continue button to resume printing.



About CorelXARA (Help Menu)

  CTRL+F1
About CorelXARA on the Help menu opens a dialog box containing the following information :

CorelXARA Version Number.
CorelXARA Licensee.
Licensee Organisation.
CorelXARA Serial Number.
Host Operating System.



About Xara Ltd
Xara was set up by Computer Concepts Ltd (UK) to develop CorelXARA. Computer Concepts 
have been developing mainstream application software since 1981. CC was one of the 
pioneer microcomputer software houses of the early eighties in the UK developing 
applications such as the Wordwise word processor which sold a quarter of a million copies. 

With over fifteen years of development experience, more than six of which have been 
developing 32-bit windowing based applications for RISC based computers, this has given us
an unrivalled experience of developing microcomputer application software. This experience 
predates the arrival of 32-bit Windows based environments by many years. 

The arrival of 32-bit Windows programming environments (Windows 95, NT and Win32s) 
meant we could exploit that experience in the wider PC and Windows market, rather than 
the more niche markets we occupied before. 

Xara Ltd
Gaddesden Place
Hemel Hempstead
Hertfordshire HP2 6EX
United Kingdom

Tel +44 1442 350000
Fax +44 1442 350010
Email info@xara.com
WWW http://www.xara.com/



Add Folder Dialog Box

To add new folders or directories to a gallery, you use the Add Folder dialog box. This is 
opened by clicking the appropriate 'Add' button in one of the disk-based galleries (Font 
Gallery, Fill Gallery or Clipart Gallery) or selecting the Add option from the gallery pop-up 
menu.

Add
Add will add the selected folder to the gallery. If it contains an index and thumbnails a 
section (or sections) will appear in the gallery showing the folder's contents. If the folder 
does not contain an index or thumbnails you will be asked if you would like to create them.

Update
Update updates all the index and thumbnail information for a folder where necessary. This is 
generally most useful where you have added files to a folder and you want them to appear 
in the gallery.

Find CD
FindCD will attempt to find the CorelXARA CD on your machine so you can add the folders of 
fonts, clipart and fills supplied on it.

Network
The Network button allows you to connect networks drives to your machine so you can 
access folders on your network. For more information, see your Windows User Guide.

First you should choose the drive for the folder. Do this by either:

Choose from the Drives drop-down list.
Click Network to add a drive from the network (if your computer is connected to a 

network).
Click FindCD to pick the CD drive containing a CorelXARA CD on your computer.

Next you should choose the required directory in the usual way and click OK.
_______________
See also
Adding a folder to a gallery
Adding files to a gallery



Updating a disc-based gallery



 Add Shapes (Arrange Menu)
Add shapes turns the selected objects into a new, single shape. The new shape is much like 
a shadow of the original as it covers the entire area taken up by the combined objects.

On-line Demonstration
    {button Adding Objects,EF("XaraDemo.exe","AddShape.avi `Adding Objects'",1) }



 Add a folder to a gallery
To add a pre-built folder to a gallery

1. Open the Fill Gallery, Font Gallery or Clipart Gallery.
2. Click Add to open the Add Folder dialog box (or select add from the gallery pop-up 
menu).
3. Select the drive where the folder is located.
4. Browse until you reach the folder.
5. Click Add.

To add a new folder to a gallery
The Clipart Gallery and the Fill Gallery allow you to build your own indexes and automatically
create any required thumbnails for a directory containing graphics files. The Clipart Gallery 
allows both vector and bitmap files to be added to its indexes, whereas the Fill Gallery is 
limited to bitmap files (such as TIFFs and BMPs, but not .XAR files).

1. Copy the files you wish the gallery to contain into a separate directory.
2. Open the Clipart Gallery or the Fill Gallery.
3. Click Add to open the Add Folder dialog box or select Add from the gallery pop-up 
menu)
4. Select the drive where the folder is located.
5. Browse until you reach the folder.
6. Click Add.

Creating an index and thumbnails will use disk space up, so you will be asked if you're sure. 
If you click to go-ahead, but the selected directory is read only (if it was a CD for example), 
you will be asked if you want the index to be placed in your temporary directory instead. 
This enables third-party CD's containing images to be added to the gallery.



 Add files to a gallery
To add files to an existing folder
You can add more files to a folder, and update the index by using the 'Update' button in the 
Add Folder dialog box .

To add a folder of files to the gallery, see Adding a folder to a gallery.

Note
Adding files to a folder which already contains an index and clicking 'Add' will not include the
new files in the gallery, you must use Update.



 Add points into a line or shape
1.Select the line or shape.
2.Choose the Shape Editor Tool.
3.Click on the line to add a new point handle.

Click to add a point handle



 Align the centres of QuickShapes
1. Enable Magnetic Snapping (see Snap to Objects).
2. Drag the QuickShape by the cross in its centre over the point you wish to align it with. 

The centre will lock onto the edges of all objects and the centres of QuickShapes.



Alignment is the horizontal and vertical relationship of several objects to each other. For 
example, objects can be aligned so that their top-most edges all line up and they are 
distributed evenly horizontally. To change the alignment and distribution of objects, use the 
Alignment dialog box.



 Alignment (Arrange Menu)

CTRL+SHIFT+L
This dialog box allows the alignment of objects within the selection.
The objects can be aligned or distributed around either the vertical or horizontal axes. The 
diagram in the centre of the dialog box shows the effect the changes will have.
The centre setting controls whether the alignment will take place within the bounds of the 
selection, the page(s) or the spread.

On-line Demonstration
    {button Aligning and Distributing Objects,EF("XaraDemo.exe","algndist.avi `Aligning and 

Distributing Objects'",1) }



 Alter gallery display format
The way in which information is displayed in some galleries can be altered using the Options
button in the gallery.

To alter gallery display format
1. Open the gallery.
2. Click the Options button.
3. Choose the Properties option.
4. Choose the required display format from the display format drop-down list in the Gallery 

Properties dialog box.

The options available for each of the galleries are shown below.

Colour Gallery Options
Full information (colour swatch, name and 'Not in use')
Name (colour swatch & name only)
Icons only (colour swatch only)

Clipart Gallery Options
Large Icons
Full Information
Small Icons

Bitmap Gallery Options
Full Information

Fill Gallery Options
Large Icons
Full Information
Small Icons

Font Gallery
Large Icons
Full Information
Small Icons
Icons Only

Note
Display options cannot be altered for the Layer Gallery and Line Gallery.
_______________
See also
Reordering gallery items
Reordering gallery sections
Galleries



Always on Top

Always On Top is available from the Document Control Menu.
If Always On Top is selected for a view, it will always remain on top of all other views.
This could be used, for example, to edit one view of a document with a smaller higher 
Quality view set to always be on top. The edits made in the first, larger view would be 
reflected in the smaller view which would always be visible.



Anti-Aliasing improves the quality of on-screen images by inserting extra pixels of 
calculated colours around the edges of objects on screen. This has the effect of smoothing 
the edges and of appearing to improve the resolution of the display. Anti-aliasing only occurs
when the CorelXARA Quality setting is at its highest level.

        



The Application Control Menu is displayed by clicking the application control button at 
the top left of the main CorelXARA window or pressing ALT+SPACEBAR. This menu contains 
application specific controls. e.g. Exit and Maximise.



 Apply a bitmap fill
1. Drag-and-drop a bitmap from the Fill Gallery or Bitmap Gallery onto the object. To apply 

the bitmap fill to an object inside another object, hold down CTRL as the bitmap is 
dropped.

or
1. Select the object(s) to be filled.
2. Double-click the required bitmap in the Fill Gallery or the Bitmap Gallery (CTRL-double-

click to close the gallery afterwards).
or

1. Select the object(s) to be filled.
2. In Fill Gallery or Bitmap Gallery select the bitmap to be used as a fill.
3. Click the Fill button in the gallery.

or
1. Select the object(s) to be filled.
2. Choose the Fill Tool
3. Choose Bitmap from the Fill Type drop-down list on the Infobar.
4. Choose the Tiling for the bitmap from the Bitmap & Fractal Fill Tiling drop-down list on 

the Infobar.
5. Choose the Bitmap for the fill using the Bitmap drop-down list on the Infobar.
6. Choose the Resolution for the bitmap using the Bitmap & Fractal Fill Resolution drop-

down list on the Infobar.

Note
Applying a bitmap fill from the Fill Gallery imports and adds the bitmap to the Bitmap 
Gallery.
_______________
See also
Editing bitmap fills



 Apply a circular fill
1. Select the object(s) to be filled.
2. Choose the Fill Tool
3. Either

SHIFT-drag from where you want the centre of the fill to where you want the fill to end,
or choose Circular from the Fill Type drop-down list on the Fill Tool Infobar.

A    fill arrow shows you the radius of the fill.
_______________
See also
Editing circular fills



 Apply a conical fill
1. Select the object(s) to be filled.
2. Choose the Fill Tool
3. Choose Conical from the Fill Type drop-down list on the Fill Tool Infobar.

A semicircular    fill arrow shows you the angle of the fill.
_______________
See also
Editing conical fills



 Apply a fractal fill
1. Select the object(s) to be filled.
2. Choose the Fill Tool
3. Choose Fractal from the Fill Type drop-down list on the Infobar.

A pair of    fill arrows show you the extent and angle of the fill.
_______________
See also
Editing fractal fills



 Apply a linear fill
1. Select the object(s) to be filled
2. Choose the Fill Tool
3. Drag from where you want the fill to start to where you want the fill to end. During the 

drag a fill arrow shows you the extent and angle of the linear fill.

Note
If the object already has a (non-linear) fill applied, the above will reapply the current fill type.
To explicitly apply a linear fill to the shape you must choose 'Linear' from the Fill Type drop-
down list on the Fill Tool Infobar.
_______________
See also
Editing linear fills



 Apply a mould
To apply a mould

1.    Select the object(s) to be moulded.
2.    Choose the Mould Tool.
3.    Choose the required envelope or perspective mould shape from the Infobar. If a custom

envelope or perspective is required, choose the default envelope or perspective mould 
and edit it after application.

To apply a mould from the clipboard
1. Copy or Cut the shape you wish to use as a mould to the clipboard.
2. Select the object(s) to be moulded.
3. Choose the Mould Tool.
4. Do one of the following :

Click the Paste Envelope Button on the Infobar to use the clipboard contents as an 
envelope mould.

Click the Paste Perspective Button on the Infobar to use the clipboard contents as a 
perspective mould.

Note
You can only apply perspective moulds to bitmaps.
_______________
See also
Editing an envelope mould
Editing a perspective mould



 Apply an elliptical fill
1 Select the object(s) to be filled.
2. Choose the Fill Tool
3. Choose Elliptical from the Fill Type drop-down list on the Fill Tool Infobar.

A pair of    fill arrows show you the extent and angle of the fill.
_______________
See also
Editing an elliptical fill



 Apply attributes to text
Applying Attributes to a Whole Text Object

1. Select the text object (see Selecting and deselecting objects).
2. Apply the required attributes. For example; drag-and-drop a colour from the Colour Line,

or a bitmap from the Fill Gallery or a line width from the Line Gallery.
Attributes can also be applied to an unselected text object using drag-and-drop.

To apply text-specific attributes, the Text Tool must be chosen.

Applying Attributes to a Selected Region of Text
1. Choose the Text Tool
2. Select the text region (see Selecting text).
3. Apply the required attributes. (e.g. font, size, colour, bitmap fill).

Note that attributes can be applied to the selected region by dragging and dropping the 
attribute onto the selected region..

Applying Attributes to Individual Text Characters
1. Select the text character (see Selecting text).
2. Apply the attributes.

It is also possible to apply attributes to a single character by holding CTRL whilst using drag-
and-drop.
For example, dragging a fill from the Fill Gallery and dropping it on a character whilst holding
down CTRL will apply a bitmap fill to that character rather than the whole text object.

Applying Attributes to the Text Cursor
If attributes are applied when the text cursor is present in a text object, the attributes are 
applied to the cursor and used for all text typed subsequently. When the text cursor is 
moved, it takes on the attributes of the character to its left (or right if there is no character 
to the left).

Text Specific Attributes
The following is a list of all attributes which can be applied to text. They are all available 
using controls on the Text Tool Infobar.

Font (typeface)
Font Size
Aspect Ratio
Bold
Italic
Left Justification
Centre Justification
Right Justification
Full Justification
Superscript and Subscript
Line Spacing & Tracking
Baseline Shift & Kerning

_______________
See also
Text Tool
Creating New Text
Editing Text
Placing Text Around a Curve
Text Tool Key Shortcuts



Installing a Font



 Apply bitmap transparency
To apply a bitmap transparency

1. Select the object(s) to be filled.
2. In the Fill Gallery or the Bitmap Gallery select the bitmap.
3. Click the Transp (Transparency) button in the gallery.

or
1. Select the object to be filled.
2. Right-click on the bitmap to open the gallery pop-up menu.
3. Choose Apply As Transparency.

Selecting a bitmap from the Fill Gallery imports the bitmap and also adds it to the Bitmap 
Gallery.

For details of how to edit a bitmap transparency, see Editing Bitmap Transparency.

Note
Only greyscale bitmaps can be used for transparency. If necessary, CorelXARA creates a 
greyscale bitmap from the selected bitmap. This creation can be after a user prompt or 
automatic - see Ask before making greyscale bitmaps. 



 Apply circular transparency
To apply a circular transparency

1. Select the object(s).
2. Choose the Transparency Tool.
3. Place the mouse pointer over the document and SHIFT-drag. During the drag a 
transparency arrow shows you the radius of the circular transparency.

For details of how to edit the circular transparency, see Editing Circular Transparency.



 Apply conical transparency
To apply a conical transparency

1. Select the object(s).
2. Choose the Transparency Tool.
3. Choose 'Conical' from the Transparency Shape drop-down list on the Transparency Tool 
Infobar.
4. Place the mouse pointer over the document and drag. During the drag a semicircular 
transparency arrow shows you the direction of the conical transparency.

For details of how to edit the elliptical transparency, see Editing Conical Transparency.



 Apply elliptical transparency
To apply an elliptical transparency

1. Select the object(s).
2. Choose the Transparency Tool.
3. Choose 'Elliptical' from the    on the Transparency Tool Infobar.
4. Place the mouse pointer over the document and drag. During the drag a pair of 
transparency arrows show you the angle and size of the elliptical transparency.

For details of how to edit the elliptical transparency, see Editing Elliptical Transparency.



 Apply fills
The Fill Tool can be used to apply a linear fill, circular fill, conical fill, conical fill, bitmap fill or 
fractal fill to any text, shape or QuickShape object.

Applying linear fills
Applying circular fills
Applying elliptical fills
Applying conical fills
Applying bitmap fills
Applying fractal fills

On-line Demonstrations
    {button Bitmap Fills,EF("XaraDemo.exe","BmapFill.avi `Bitmap Fills'",1) }
    {button Fractal Fills,EF("XaraDemo.exe","Fractals.avi `Fractal Fills'",1) }
    {button Linear Circular Elliptical and Conical Fills,EF("XaraDemo.exe","GradFill.avi `Linear

Circular Elliptical and Conical Fills'",1) }
_______________
See also
Editing fills



 Apply flat transparency
To apply flat transparency

1. Select the object(s).
2. Choose the Transparency Tool.
3. Choose Flat from the Transparency Shape drop-down list on the Transparency Tool 
Infobar.

For details of how to edit the flat transparency, see Editing Flat Transparency.

Note
Applying flat transparency to an object with an outline (or a line) will also apply the 
transparency to the line. To remove the line transparency, change the object's line colour 
(and back again if necessary).



 Apply fractal transparency
To apply fractal transparency

1. Select the object(s) to be filled.
2. Choose the Fill Tool.
3. Choose Fractal from the Fill Type drop-down list on the Infobar.

For details of how to edit a fractal transparency, see Editing Fractal Transparency.



 Apply linear transparency
To apply a linear transparency

1. Select the object(s).
2. Choose the Transparency Tool.
3. Place the mouse pointer over the document and drag. During the drag a transparency 

arrow shows you the angle and extent of the linear transparency .

For details of how to edit the linear transparency, see Editing Linear Transparency.

Note
If the object already has transparency applied, the above will reapply the current 
transparency type. To explicitly apply a linear fill to the shape you must choose 'Linear' from 
the Transparency Shape drop-down list on the Transparency Tool Infobar.



 Apply transparency
The Transparency Tool can be used to apply a flat transparency, linear transparency, circular 
transparency, elliptical transparency, conical transparency, bitmap transparency or fractal 
transparency to any object.

Applying Flat Transparency
Applying Linear Transparency
Applying Circular Transparency
Applying Elliptical Transparency
Applying Conical Transparency
Applying Bitmap Transparency
Applying Fractal Transparency

On-line Demonstrations
    {button Simple Transparency Effects,EF("XaraDemo.exe","Transpar.avi `Simple 

Transparency Effects' ",1) }
    {button    Transparency Applications,EF("XaraDemo.exe","Transfun.avi    `Transparency 

Applications' ",1) }
_______________
See also
Transparency Tool
Removing transparency



Are you sure you want to install or deinstall this font?

Cause
This message is displayed when you install or de-install a font.

Recommended action
Click the Install button to install the font or de-install to de-install the font.
Click the Cancel button to abort the operation.

Note
De-installing a font removes it from your system. The font cannot be recovered unless you 
have another copy.



Arrange Control Bar

Bring to Front
Put to Back
Move Forwards
Move Backwards
Move to Layer in Front
Move to Layer Behind
Group
Ungroup
Alignment
Convert to Editable Shapes
Join Shapes
Break Shapes
Add Shapes
Subtract Shapes
Intersect Shapes
Slice (cut) Shapes
Fit Text to Curve

_______________
See also
Default Control Bars



Arrange Icons (Window Menu)

Arrange Icons arranges the icons of all minimised documents at the bottom left-hand corner 
of the main CorelXARA window.



Arrange Menu

Move to Layer in Front
Bring to Front
Move Forwards
Move Backwards
Put to Back
Move to Layer Behind

Group
Ungroup
Alignment

Join Shapes
Break Shapes
Combine Shapes
Convert to Editable Shapes
Create Bitmap Copy

Fit Text to Curve

Note
When a text object is selected which has been fitted to a curve, the bottom item on the 
Arrange menu reads Remove Text From Curve.



Arrange Views (Window Menu)

Arrange Views tiles all the open document views to fill the main CorelXARA window.



ArtWorks is a vector drawing software package developed by Computer Concepts Ltd in the
UK. ArtWorks runs on Acorn RISC machines.



Attributes are properties that you can apply to objects to affect the way they look and 
behave. The most familiar attributes are colours. When you click on a colour in the Colour 
Line you are actually applying a fill colour attribute to the selected objects.
In CorelXARA all attributes can be applied to all types of object. However, some objects 
simply don't use some attributes. For instance, you can apply a Font attribute to a line but 
because the line doesn't need to know anything about fonts nothing visible will change. 
Applying a Font attribute to a Group will not change any objects in the group that don't use 
fonts but if there's any text in the group then it will use the new Font attribute.
The transparent fills that you create using the Transparency Tool are attributes in the same 
way as normal fills created by the Fill Tool.
When you make a new object, e.g. by drawing a line or typing some text, CorelXARA has to 
decide what attributes to give that object, otherwise it would be invisible because it would 
have no colour, no font, etc. These attributes are called the Current Attributes. For example, 
if the current line colour attribute is red, all new lines you draw will have a red outline. The 
General Options allow you to control how the current attributes are set.



When the Background Redraw option is selected (see View Options), CorelXARA will 
render documents in background mode. In background mode the drawing is rendered in 
time slices and the results of this made visible in the window about every half second. The 
advantage of using background redraw is that you can continue to edit the drawing whilst it 
is being redrawn, but it is a little slower than normal redraw.



Bars (Window Menu)

The Bars submenu of the Window menu controls the enabling/disabling of the Colour Line, 
Status Line, Scrollbars and Rulers. The submenu offers the following :

Colour Line
Status Line
Scrollbars
Rulers



Bevelled Join is one of the options available for line and shape corners:

Use the Line Gallery to choose a join style.



Bezier curves are referred to In CorelXARA as 'curved lines'. The handles (or control points) 
used to alter the shape of a 'bezier' curve are called curve edit handles. The actual movable 
points on the line are referred to as point handles.



A Bitmap is a picture composed, of small 'dots' called pixels. Bitmaps are exported from 
programs such as Microsoft Paintbrush, CorelPaint and Photoshop or taken from scanners or 
PhotoCD's. CorelXARA can import and export all common bitmap formats.



 Bitmap Effects (Utilities Menu)
The bitmap effects dialog box can be used to manipulate bitmaps in a variety of ways. Each 
section of the dialog box contains a different set of options. The original bitmap is always 
shown in the panel on the left, and the proposed result on the panel on the right

When opened, the dialog box shows, on the left-hand side :
If you opened this dialog box from the Bitmap Gallery, the bitmap you selected in the 

Gallery.
The currently selected bitmap.
The default bitmap if no bitmap is currently selected.

A different original bitmap may be chosen from the drop-down list.

Test
To see the result of applying the bitmap effect, click the test button. When using the 
brightness and contrast tab, the display is interactive and you need not use this button

Insert
This button inserts the altered bitmap (displayed on the right-hand side) into the selected 
document. The altered bitmap also appears in the Bitmap Gallery as a new bitmap. The 
original bitmap is unchanged.

Close
This button closes the Bitmap Effects dialog box.

The operations which can be performed on bitmaps using the different sections in this dialog
box are :



Brightness & Contrast
Colour Depth
Flip & Rotate
Resize
Special Effects

On-line Demonstration
    {button Bitmap Editing,EF("XaraDemo.exe","Bitmaps.avi `Bitmap Editing'",1) }

_______________
See also
Bitmap Tracer



Bitmap Effects - Brightness & Contrast

The Brightness & Contrast section of the Bitmap Effects dialog box provides basic 
brightness, contrast and colour (saturation) controls similar to those on a domestic 
television.

The results of changes using the sliders will be shown instantly in the preview on the right-
hand side of the dialog box. There is no need to use the Test button.



Bitmap Effects - Colour Depth

The Colour Depth section of the Bitmap Effects dialog box allows the number of colours in a 
bitmap to be altered.

Bitmaps can converted to be :
Monochrome (2 colours)
Greyscale (256 shades of grey)
16 colours
256 colours

Increasing the number of colours in a bitmap will not increase its quality and will use more 
memory. Reducing the number of colours will use less memory, but the quality of the bitmap
may be reduced. As a change in the number of colours of a bitmap creates a new bitmap, 
the original (unchanged) image has to be deleted before the memory is freed - see Bitmap 
Gallery.

Monochrome
These convert the bitmap to black-and-white. They can produce moire (interference) 
patterns. Therefore only use these where really necessary. They are not needed for printing 
to monochrome printers as CorelXARA automatically screens images.
The three monochrome operations are simply different conversion methods. Diffusion will 
generally give the best quality output.

Greyscale
This is useful for converting coloured images to shades of grey. Images processed in this way
can have their palette altered to produce bitmaps which pass between any two colours, not 
just from black to white. See Editing Bitmaps.

16 Colour
These produce 16 colour bitmaps. Diffusion will generally give the best quality results.

256 Colour
These produce 256 colour bitmaps. Median will give the best colour balance, but Popularity 
produces higher quality dithering in the resultant image.



Bitmap Effects - Flip & Rotate

The Flip and Rotate section of the Bitmap Effects dialog box can be used to flip and rotate 
bitmaps by multiples of 90 degrees. Although the Selector Tool can rotate and flip objects 
(see Flipping Objects and Rotating Objects), these operations create new bitmaps with a 
rotated or flipped image.
The two flip operations flip the bitmap about its vertical or horizontal axis.



Bitmap Effects - Resize

The Resize section of the Bitmap Effects dialog box provides facilities to alter the size 
(resolution) of a bitmap.

In most cases it is easier to use the Selector Tool to resize objects (see Scaling Objects). 
However in some cases you may need to alter the actual bitmap. (For example, to reduce 
the memory needed.)

Lock Aspect Ratio
If the Lock Aspect Ratio option is set, only one of the values for the new size of the bitmap 
need be entered as the aspect ratio of the original bitmap is retained. De-selecting this 
makes it possible to stretch and squash the bitmap.

Linear Interpolation
It is recommended that Linear Interpolation is left selected as it will result in a much 
smoother end result. If it is de-selected the resulting bitmap is likely to be 'chunky'.



Bitmap Effects - Special Effects

The Special Effects section of the Bitmap Effects dialog box provides various effects that can
be applied to bitmaps.

The effects provided are :
Custom
Isolate Points
Edge Detection
Laplacian
Dilation
Robert's Cross
Sharpen
Blur



Bitmap Export

CorelXARA can create bitmaps from the selected document and export them in a variety of 
different formats :

Exporting JPEG (JPG) files
Exporting CompuServe GIF files
Exporting Windows Bitmap (BMP) files
Exporting TIFF (TIF) files
Exporting Multi-page PCX (DCX) files
Exporting PaintBrush (PCX) files
Exporting Macintosh PICT (PCT) files
Exporting Sun Raster (RAS) files
Exporting TrueVision TARGA (TGA) files
Exporting WordPerfect Group (WPG) files

Exporting Animated GIF files
Tip

Remember CorelXARA includes a pixel unit. If you need to produce a bitmap of a 
specific size, you may want to set the Page Units (see Unit Options) and the grid and ruler 
units (see Grid & Ruler Options) to use this unit.
_______________
See also
Supported File Formats



Bitmap Export - Animated GIF

CorelXARA can export animated GIF files which contain several separate images rather than 
just one. Programs which support this type of file show each image one after the other with 
a set time delay between each. This means you can create animations using CorelXARA. 
Most World Wide Web browsers (Netscape Navigator Version 2 and Microsoft Internet 
Explorer 3) support animated GIFs, so using CorelXARA it is very easy to create animations 
for your WWW pages. Remember, as CorelXARA displays images at a very high quality and 
has a wide range of dithering and palette options, your animations will look great!

Creating Animated GIF Files
To create an animated GIF file you draw each frame and create a bitmap for each. When you
have all the bitmaps in the Bitmap Gallery, you can drag them around so the are in the 
correct order and then create the animated GIF file.

To Create the Bitmaps
1. Draw what you want to appear in the first frame.
2. Select the objects in the drawing.
3. From the Arrange menu, choose Create Bitmap Copy. This creates a bitmap of the 

objects and places it in the Bitmap Gallery, it also places the bitmap on the page in the 
document (do not delete this) (for more information on Create Bitmap Copy, see Create 
Bitmap Copy).

4. Change the drawing to how you want it in the next frame.
5. Use Create Bitmap Copy again to create the next frame.
6. Repeat steps 4 and 5 until you have built up the sequence of frames in the Bitmap 

Gallery.
7. Drag the frames in the Bitmap Gallery to place them in the right order.

To Create the Animated GIF File
1. In the Bitmap Gallery, select all the bitmaps you want in the animation. The easiest way 

to do this is to click on the first and SHIFT-click on the last (you can select or deselect 
individual bitmaps by CTRL-clicking).

2. In the Gallery, click the Save button to open the Export dialogue box.
3. When you have entered the filename and destination, click Save. This will open the 

Animated GIF Export dialogue box
4. The dialogue box contains all the normal GIF export options (see Bitmap Export - GIF) 

and also special options for the animation (described below). In the dialogue box, set the 
options, alter the width and height if you want (all the frames will be stretched to fit)

5. Click Export to create the file.

Animation Options
Delay
This sets the time delay between frames in the animation. The units are hundredths of a 
second, so if you want a delay of a second between each frame, enter a value of 100. 
Remember that many browsers display the frames quite slowly and may not be able to keep 
up with the value you set.
Restore
This option sets what happens after each frame has been displayed. Nothing means no 
action is taken, though many WWW browsers take this as meaning the same as the 
Background option. Leave As Is displays the frames one on top of another - this leaves 
many frames visible in a stack if some are transparent. Background restores the area 
covered by the graphic to the background colour of the GIF (except where the frame is 
transparent). Restore Previous restores the area covered by the frame to what it was 
before the frame was displayed.



Note that the way browsers interpret these values can vary, you may need to experiment to 
achieve the desired result.
Loop
This value defines the number of times the animation will repeat. If you enter a value of 
zero, the animation will loop continuously.

Tips
To ensure all your frames are the same size, draw a rectangle around the edge of all 

the frames and set its line colour and fill colour to 'no colour'. When you create a bitmap 
from the objects, ensure this rectangle is selected.

Remember that as your GIF file has several pictures in it, it may be larger than 
normal. To make the file smaller, use less frames or smaller frames.

The easiest way to preview your animated GIF is to drag-and-drop the file onto a 
WWW browser.

If you experience problems with the edges of objects in the frames being misaligned 
(you might see objects in slightly different positions between frames), set the page units to 
Pixels (see Unit Options) and turn on Grid Locking (see Snap to Grid). This will ensure all your
objects are aligned to individual pixel edges.

Remember some programs do not support animated GIFs. Netscape 2 and Internet 
Explorer 2 do support them.

If you delete any bitmaps from the Bitmap Gallery, remember that all the unused 
bitmaps will be deleted as well as the one you selected (all the bitmaps that do not appear 
on the page in the document).

Loading Animated GIF Files
If you import or open an animated GIF file, all the frames are imported and placed on the 
page on top of each other. Note that the frames will appear in the Bitmap Gallery in the 
animation sequence (the first bitmap is the highest in the gallery).



Bitmap Export - Compuserve GIF

The GIF export bitmap dialog box is opened by selecting GIF as the exported file format from
the Export dialog box. It allows the setting of the size/resolution of the exported bitmap, the 
area to be exported and the number of colours in the bitmap. In addition CorelXARA also 
allows GIF files to contain simple transparency and interlacing - two facilities of GIF files used
extensively on the World Wide Web. Remember you can also create animated GIF files using 
CorelXARA, see Bitmap Export - Animated GIF.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size
Type the required width or height into one of the fields. Note that the aspect ratio of the 
bitmap is fixed so only one dimension can be set - the other is calculated automatically.
Resolution information is not stored in GIF files, so the resolution field is dimmed.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

8 256 colours
4 16 colours
1 2 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

GIF Export Type - Interlacing
If interlacing is enabled the GIF file produced will be interlaced.

GIF Export Type - Transparency
If transparency is enabled the bitmap will be 'transparent' in all areas not covered by a 
selected object. If the selection has been chosen then this will be only the visible and 
selected objects. This makes it easy to remove the white background from exported pictures
and makes them ideal for publication on the World Wide Web. (see Creating World Wide Web
bitmaps).
If the Quality setting is high (i.e. anti-aliasing is turned on) the edges of the drawing will be 
anti-aliased with whatever is behind it (as normal). Normally the anti-aliasing will be to the 
paper colour of white.
When transparency is enabled, the selected items are used to determine what is going to be
transparent in the GIF, but all objects are rendered. This makes it simple to create bitmaps 
which anti-alias to the background they will eventually be on, by placing that background 
behind the drawing in CorelXARA. Then when the bitmap is exported ensure that the 
background is not selected but the drawing is and that the selection option is used. One 
easy way of doing this is to put the background in another layer and make this layer not 
selectable.
Note that if you create a transparent GIF file, one of the palette colours is used as the 
transparency. This means (for example) that a 2 colour GIF contains one colour and 



transparency.

Note that GIF transparency has a different meaning to CorelXARA transparency. This process 
does not take into account any CorelXARA transparency applied to objects in the document.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette 

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results, but remember to only 
use dithering when really necessary as it prevents the file compression working so well and 
so makes files larger.

You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences you have chosen.
_______________
See also
Bitmap Export



Bitmap Export - JPEG (JPG)

The JPEG export bitmap dialog box is opened by selecting JPEG as the exported file format 
from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported and the 'quality' of the final bitmap.
Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size and Resolution
The size of the exported bitmap can be set in two ways :

Resolution Type the resolution into the DPI field or select a value from the drop down 
menu. The Width and Height are calculated from this to ensure the aspect 
ratio of the area being exported is fixed.

Size Type the required width or height into one of the fields. Note that the aspect 
ratio of the drawing is fixed so only one dimension can be set - the other is 
calculated automatically.

Quality
This setting is specific to JPEG output. A low setting will result in a small file with a loss in 
quality whereas a high value will give only slight file size reduction, but high quality. Note 
that a setting of 100% will still compress the file.
As an example, a setting of 75% will give good compression without causing a noticeable 
loss in quality for most uses.

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Palette
JPEG files do not have palettes, these options are greyed.

Dithering
JPEG files cannot be dithered, these options are greyed.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences you have chosen.
_______________
See also
Bitmap Export



Bitmap Export - Macintosh PICT (PCT)

The PICT export bitmap dialog box is opened by selecting PICT as the exported file format 
from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported and the number of colours in the bitmap.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size
Type the required width or height into one of the fields. Note that the aspect ratio of the 
drawing is fixed so only one dimension can be set - the other is calculated automatically.
Resolution information is not stored in PICT files, so the resolution field is dimmed.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

24 Millions of colours
8 256 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results.
You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences chosen.
_______________
See also
Bitmap Export



Bitmap Export - Multi-page PCX (DCX)

The DCX export bitmap dialog box is opened by selecting DCX as the exported file format 
from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported and the number of colours in the bitmap.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size
Type the required width or height into one of the fields. Note that the aspect ratio of the 
drawing is fixed so only one dimension can be set - the other is calculated automatically.
Resolution information is not stored in DCX files, so the resolution field is dimmed.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

24 Millions of colours
8 256 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results.
You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences chosen.
_______________
See also
Bitmap Export



Bitmap Export - PaintBrush (PCX)

The PCX export bitmap dialog box is opened by selecting PCX as the exported file format 
from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported and the number of colours in the bitmap.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size
Type the required width or height into one of the fields. Note that the aspect ratio of the 
drawing is fixed so only one dimension can be set - the other is calculated automatically.
Resolution information is not stored in PCX files, so the resolution field is dimmed.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

24 Millions of colours
8 256 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results.
You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences chosen.
_______________
See also
Bitmap Export



Bitmap Export - Sun Raster (RAS)

The Sun Raster export bitmap dialog box is opened by selecting RAS as the exported file 
format from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported and the number of colours in the bitmap.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size
Type the required width or height into one of the fields. Note that the aspect ratio of the 
drawing is fixed so only one dimension can be set - the other is calculated automatically.
Resolution information is not stored in RAS files, so the resolution field is dimmed.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

24 Millions of colours
8 256 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results.
You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences chosen.
_______________
See also
Bitmap Export



Bitmap Export - TIFF (TIF)

The TIFF export bitmap dialog box is opened by selecting TIFF as the exported file format 
from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported, the number of colours in the bitmap and the bitmap 
compression.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size and Resolution
The size of the exported bitmap can be set in two ways :

Resolution Type the resolution into the DPI field or select a value from the drop down list. 
The Width and Height are calculated from this to ensure the aspect ratio of the
area being exported is fixed.

Size Type the required width or height into one of the fields. Note that the aspect 
ratio of the drawing is fixed so only one dimension can be set - the other is 
calculated automatically.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

24 Millions of colours
8 256 colours
4 16 colours
1 2 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Compression
TIFF files can be exported from CorelXARA in a compressed form. The compression types 
available are :

24bpp None, LZW.
8bpp None, LZW.
4bpp None, LZW.
1bpp None, LZW, Huffman, Group 3 Fax, Group 4 Fax, Packbits.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 



(Floyd Steinberg). In general, error diffusion will give the best results, but remember to only 
use dithering when really necessary as it prevents the file compression working so well and 
so makes files larger.
You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences you have set.
_______________
See also
Bitmap Export



Bitmap Export - TrueVision TARGA (TGA)

The TARGA export bitmap dialog box is opened by selecting TrueVision TARGA as the 
exported file format from the Export dialog box. It allows the setting of the size/resolution of 
the exported bitmap, the area to be exported and the number of colours in the bitmap.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size
Type the required width or height into one of the fields. Note that the aspect ratio of the 
drawing is fixed so only one dimension can be set - the other is calculated automatically.
Resolution information is not stored in TARGA files, so the resolution field is dimmed.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

24 Millions of colours
8 256 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results.
You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences chosen.
_______________
See also
Bitmap Export



Bitmap Export - Windows Bitmap (BMP)

The BMP export bitmap dialog box is opened by selecting BMP as the exported file format 
from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported and the number of colours in the bitmap.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size and Resolution
The size of the exported bitmap can be set in two ways :

Resolution Type the resolution into the DPI field or select a value from the drop down list. 
The Width and Height are calculated from this to ensure the aspect ratio of the
area being exported is fixed.

Size Type the required width or height into one of the fields. Note that the aspect 
ratio of the drawing is fixed so only one dimension can be set - the other is 
calculated automatically.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

32 Millions of colours (not currently widely supported)
24 Millions of colours
8 256 colours
4 16 colours
1 2 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Compression
16 colour (4bpp) and 256 colour (8bpp) BMP files can be exported from CorelXARA in a 
compressed form. There are two types of compression available :

RLE Run length encoding compression.
RGB No compression.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results.



You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences you have chosen.
_______________
See also
Bitmap Export



Bitmap Export - WordPerfect Group (WPG)

The WPG export bitmap dialog box is opened by selecting WPG as the exported file format 
from the Export dialog box. It allows the setting of the size/resolution of the exported 
bitmap, the area to be exported and the number of colours in the bitmap.

Note that when exporting a bitmap, the current CorelXARA Quality setting is used for the 
bitmap. E.g. if the Quality is set to a very low level the bitmap exported will be in outline 
only.

Bitmap Size
Type the required width or height into one of the fields. Note that the aspect ratio of the 
drawing is fixed so only one dimension can be set - the other is calculated automatically.
Resolution information is not stored in WPG files, so the resolution field is dimmed.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

8 256 colours
4 16 colours
1 2 colours

Area to Save
The bitmap can be created using one of three areas of the document :

The Spread The whole page, or both pages for a double page spread.
The Drawing The area covered by objects.
The Selection The area covered by the objects in the selection. Only available when 

objects are selected.

Palette
You can use these options to choose between the standard document palette and an 
optimised palette

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering. Choosing Ordered dithering uses a regular dithering pattern ( like 
CorelXARA 1.1). Choosing Error Diffused dithering uses a more complex dithering technique 
(Floyd Steinberg). In general, error diffusion will give the best results.
You cannot use ordered dithering if you are using an optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Export
Clicking the Export button will create the bitmap named in the Export dialog box using the 
preferences chosen.
_______________
See also
Bitmap Export



A Bitmap Fill allows you to fill shapes with a bitmap. The bitmap can be tiled (repeated) to 
fill the object(s).



 Bitmap Gallery (Utilities Menu)

 F11
The Bitmap Gallery shows all the bitmap objects that are currently being used in each of the 
loaded documents. It is used to view, insert, delete, and apply bitmaps as fills or 
transparency. It can also be used to choose bitmaps for use with other CorelXARA features 
such as the Tracer and Bitmaps effects controls. The gallery is divided into sections, one for 
each document currently open.

Insert Insert the bitmap into the selected document.
Fill Apply the bitmap as a bitmap fill to the selection.
Transp Apply the bitmap as a bitmap transparency to the 

selection.
Delete Delete the bitmap from the document.
Trace Open the Bitmap Tracer to trace the bitmap.
Effects Apply Bitmap Effects to the bitmap.
Options Bitmap Gallery options.
Save Save the bitmap.

Many operations using the Bitmap Gallery are made easier by the Bitmap Gallery pop-up 
menu.

Note
If a bitmap is deleted from a document it will remain in the Bitmap Gallery until the 
document is closed or saved; to remove it from the gallery, select it and click the Delete 
button.
_______________
See also
Selecting items in a gallery
Galleries



 Bitmap Gallery (Utilities Menu)
    F11

The Bitmap Gallery item on the Utilities menu and the Bitmap Gallery button open the 
Bitmap Gallery if it is closed and close it if it is open. The button remains pressed in if the 
gallery is open.



Bitmap Gallery - Delete Button
The Delete button in the Bitmap Gallery deletes the bitmaps, selected in the gallery, from 
the document. This operation cannot be undone, though Delete is generally unnecessary as 
unused bitmaps are automatically deleted when the document is closed or saved.
You can also delete a bitmap using the pop-up menu.



Bitmap Gallery - Effects Button
The Effects button in the Bitmap Gallery opens the Bitmap Effects dialog box ready to edit 
the bitmap selected in the gallery.
To apply effects to a bitmap quickly, right-click on it in the gallery to open the pop-up menu 
and choose Effects.



Bitmap Gallery - Fill Button

The Fill button in the Bitmap Gallery applies the bitmap selected in the gallery as a bitmap 
fill to the selected objects. If no objects are currently selected, the current fill attributes are 
set to use this bitmap as a fill. i.e. all objects drawn from then on will be filled with the 
bitmap.
You can also drag-and-drop the bitmap onto an object to apply it as a bitmap fill (CTRL-drag 
to apply inside) , double-click it to apply it to the selection (CTRL-double-clicking closes the 
gallery afterwards) or right-click on the bitmap in the gallery to open the pop-up menu and 
choose Apply As A Fill.
For details of editing the bitmap fill afterwards, see Editing a bitmap fill.



Bitmap Gallery - Insert Button
The Insert button in the Bitmap Gallery inserts the currently selected bitmap(s) into the 
selected document. Any bitmap in the gallery can be inserted into the selected document, 
even from other sections of the gallery. i.e. this button can be used to copy bitmaps between
documents.
You can also drag-and-drop the bitmap onto a blank part of the page to insert it or open the 
pop-up menu over the bitmap and choose Insert. Note that if you drop the bitmap onto an 
object it will be applied as a bitmap fill - drop it on a blank area of the page to insert it.



Bitmap Gallery - Options Button
The Options button in the Bitmap Gallery opens a menu containing the single option, Find. 
Choosing this option allows you to search the Bitmap Gallery using the Gallery Find dialog 
box.
_______________
See also
Searching a gallery



Bitmap Gallery - Pop-up Menu

Right-clicking on the Bitmap Gallery opens a pop-up menu which contains the following 
options :

Insert Identical to the Insert Button.
Apply as a Fill Identical to the Fill Button.
Apply as Transparency Identical to the Transparency Button.
Delete Identical to the Delete Button.
Save Identical to the Save Button.
Trace Identical to the Trace Button.
Effects Identical to the Effects Button.
(Un)Fold Section Folds up or unfolds the current section.
Previous Section Moves to the start of the previous section.
Next Section Moves to the start of the next section.

Right-clicking on a bitmap in the gallery will select it, so opening the pop-up menu over a 
bitmap allows you to operate on it directly.



Bitmap Gallery - Save Button
The Save button in the Bitmap Gallery opens the Export dialog box so you can save the 
selected bitmap in any of the supported bitmap export formats (see Supported file formats). 
Note that you will not be able to alter the size (resolution) or colour depth (number of 
colours) of the bitmap when you export it.
To save a bitmap more quickly, right-click on it to open the pop-up menu (this also selects 
the bitmap) and choose Save.



Bitmap Gallery - Trace Button
The Trace button in the Bitmap Gallery opens the Bitmap Tracer dialog box ready to trace 
the bitmap selected in the gallery. The tracing process converts a bitmap to a set of shapes.
To trace a bitmap quickly, right-click on it to open the pop-up menu (this also selects the 
bitmap) and select Trace.



Bitmap Gallery - Transparency Button

The Transparency button in the Bitmap Gallery applies the bitmap selected in the gallery as 
a bitmap transparency to the selection. If no objects are currently selected, the current 
transparency attribute is set. i.e. all objects drawn will have the bitmap applied as a bitmap 
transparency. For details of editing the bitmap transparency, see Editing bitmap 
transparency.
You can also apply a bitmap as transparency by opening the pop-up menu. over the bitmap 
(this also selects it) and choosing Apply as Transparency.



 Bitmap Tracer (Utilities Menu)
The Bitmap Tracer dialog box allows you to convert a bitmap image into a set of shapes. The
tracer would typically be used to trace two types of artwork, photographs and line art (e.g. a
logo).

For help with the tuning of the Bitmap Tracer parameters, see Bitmap Tracer 
Troubleshooting.

When opened, the tracer dialog box shows:
If you clicked the Trace button in the Bitmap Gallery, the bitmap you selected in the 

Bitmap Gallery,
The currently selected bitmap (if any),
The default bitmap if neither of the above.

The bitmap to be traced can be changed using the drop-down list.

It is recommended that the default settings are used for the first trace of an image and the 
values changed to achieve the desired result.

For more about the Tracer dialog box :
Bitmap Tracer buttons
Bitmap Tracer parameters

On-line Demonstration
    {button Bitmap Tracer,EF("XaraDemo.exe","Tracer.avi `Tracing Bitmaps'",1) }





Bitmap Tracer Troubleshooting

If you are having problems getting the desired results from the Bitmap Tracer, see Fine-
tuning the bitmap tracer.



Bitmap Tracer buttons

Insert
This button inserts the current tracer output into the current document. This button is 
dimmed if you have not yet traced the bitmap.

Close
This button closes the tracer dialog box.

Trace
This button starts the tracer. A trace can be stopped at any time by pressing ESC (Escape).

Reset Settings
This button restores the settings to those saved using the Save Settings button.

Save Settings
This button saves the current tracer settings. The saved settings will be used the next time 
the tracer is opened. The settings are saved between CorelXARA sessions.
The settings are saved separately for each colour 'mode'. i.e. the monochrome mode tracing
settings are separate from those saved for the True Colour mode and so on.

Defaults
This button restores the tracer settings to the 'factory default'.
_______________
See also
Bitmap Tracer parameters



Bitmap Tracer parameters

Trace Mode
This drop-down list lets you specify the maximum number of colours in the final object. The 
colour depths available are :

Monochrome  - 2 colours
Greyscale  - 256 shades of grey
256 colour  - 256 colours
Photographic  - 16 million (24 bit) colours

Selecting more colours than exist in the original bitmap wastes memory and is not 
recommended. The only time increasing the colours is useful is when tracing a heavily 
dithered 256 colour bitmap and you want near-photographic quality.
Each of these modes has its own set of parameters which are all saved using the Save 
Settings button.

Passes
The greater the number of passes, the longer the trace operation takes, the greater the 
resultant file size, but the final result is closer to the original bitmap.
With each pass the tracer attempts to more closely match any shading in the original 
bitmap. Obviously this increases the memory required for the final object. You may require 
an object with minimum shading and just broad areas of colour. Use one pass for such 
bitmaps.
If you require the shading to be represented accurately, use multiple passes.

Remove Noise
Noise is very common in bitmaps. It can occur because of random interference or possibly 
through techniques such as dithering.
When tracing bitmaps containing noise, you should set Remove Noise to a high setting. This 
control removes noise by ignoring very small areas of colour.

Minimum Area
Areas smaller than the size (in pixels) set in Minimum area are ignored by the tracer. An 
example of its use would be a photo containing large amounts of fine details (e.g. grass).

Initial Colour Tolerance
Colour tolerance is how great a colour change is required before the tracer considers two 
areas to be a different colour.
This setting is used for the first of multiple passes. It is similar to the broad brush strokes 
used to create the underlying colours on a conventional painting.
As a trace proceeds, the colour tolerance is reduced from the initial value to the final value, 
so the initial value must be the larger.
For a trace using only a single pass this value is ignored - see Final Colour Tolerance.

Final Colour Tolerance
Colour tolerance is how great a colour change is required before the tracer considers two 
areas to be a different colour.
This setting is used for the final pass. It is similar to merging the edges of colour transitions 
to simulate shading.
As a trace proceeds, the colour tolerance is reduced from the initial value to the final value, 
so the initial value must be the larger.
For a trace using only a single pass only this value is used - Initial Colour Tolerance is 



ignored.

Accuracy
This controls how accurately the tracer follows the outlines of the original bitmap. The more 
accurately it traces the outlines, the more control handles are required on each shape and 
hence more memory is required for the final object.
This setting does not affect the corners of shapes, only smooth curves.

Smoothing
This controls how accurately corners (sharp changes in direction) are traced. Increasing the 
smoothing takes longer to trace the image, but can reduce the final object size.
_______________
See also
Bitmap Tracer buttons



Bitmap Transparency is a type of transparency where the degree of transparency of the 
objects it is applied to is set by a bitmap. Usually, the lighter colours in the bitmap are the 
more transparent (You can alter the amount of transparency by selecting one of the 
Transparency handles and then dragging the Transparency slider). Bitmap transparency is 
particularly useful for semi-transparent patterning or creating effects such as feathering.
A bitmap must be greyscale to be used for bitmap transparency, but if a non-greyscale 
bitmap is applied it will automatically be converted to greyscale beforehand.



Bitmap is being used within a document

Cause
You have attempted to delete a bitmap in the Bitmap Gallery that is currently being used 
within a loaded document.

Recommended action
Choose Delete to delete the bitmap from the gallery.    The bitmap is replaced in the 

document by the default bitmap.
Choose Cancel to keep the bitmap in the gallery.



Bleach is one of the three types of transparency supported by CorelXARA; mix, stained 
glass and bleach. Bleach transparency has no clear analogy in the physical world. All other 
colours are bleached out leaving only the colours of the selected object. It is most effective 
when used over dark colours. It is most useful for highlights when the light source is not 
white.
Technically, the process is additive, progressing towards unsaturated colours.

0% bleach transparency Adds the selected object's colour to the colour of objects under 
it.
100% bleach transparency Completely transparent.



A Blend is a compound object made by progressively changing one object into another.

A blend object consists of two or more objects, between which are a number of intermediate 
steps in the change from one end object to the other. You can control the number of 
intermediate steps.
In CorelXARA the in-between steps are created as they are needed - they do not take up 
memory space in the document.
Blends can be used to create complex highlights, blurred edges on objects, repetitive 
patterns and many other effects.
In many ways a blend behaves like a group; it can be moved and copied like a group and 
you can use select-inside to select the end objects and edit them while they are inside the 
blend.



Blend Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a blend, it contains the following 
options:

Blend Tool
- - - - - - - - - -
Remove Blend
1 to 1 node mapping
Anti-alias blend steps
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Colour Editor



 
 Blend Tool

The Blend Tool is used to blend between objects by creating several intermediate shapes.
The Blend Tool can also be chosen using the Blend Pop-up Menu.

F7
Blend Tool Infobar Controls

Number of Steps
Remove

One to One
Anti-alias

Effect

Blend Tool Operations
Blending objects
Removing a blend
Creating advanced blends

On-line Demonstrations
    {button Simple Blending,EF("XaraDemo.exe","Blend.avi `Simple Blending'",1) }
    {button Advanced Blending,EF("XaraDemo.exe","BlendFun.avi `Advanced Blending'",1) }

Note
Objects used in blends can be edited without removing the blend first. See Selecting objects 
inside objects.
You can blend between any type of objects.



 Blend Tool - Anti-alias Button

The Anti-alias button on the Blend Tool Infobar sets whether the intermediate shapes in the 
currently selected blends are anti-aliased.
Anti-aliasing of intermediate objects is often unnecessary and slows down screen redraws.

An anti-alias setting of a blend can be altered without choosing the Blend Tool using Anti-
alias Blend Steps on the Blend Pop-up Menu.



 Blend Tool - Effect Field

The Effect field on the Blend Tool Infobar provides control of the way the colours in the 
currently selected blend(s) change through the blend.

Fade
With the Fade Effect, the colours fade simply from the colours of one object to the next.

Rainbow
With the Rainbow Effect, the colours in the blend change by following the shortest edge of 
the HSV colour wheel.
For example, a blend from a yellow shape to a cyan shape passes through green.

Alternate Rainbow
The Alternate Rainbow Effect acts in the same way as the Rainbow Effect except the colours 
follow the longest edge of the HSV colour wheel.
For example a blend from a yellow shape to a cyan shape passes through red, magenta and 
blue.



 Blend Tool - Number of Steps Field

The Number of Steps field on the Blend Tool Infobar sets the number of blend steps used in 
the currently selected blend(s). To change the number of steps, enter a new value and press 
RETURN.



 Blend Tool - One to One Button

The One-to-one setting on the Blend Tool Infobar only has an effect when both objects in the 
selected blend have the same number of point handles (if the objects are not shapes, the 
number of point handles they would have if there were converted must be the same).
When the one-to-one preference is not set, CorelXARA will add or removes points, as 
necessary, to blend one shape to another. When blending shapes with the same number of 
handles, this can produce unwanted effects. Selecting this button ensures that no points are 
added or removed during the blend.

    
          1-1 Mapping            No 1-1 Mapping (points added)

The blend mapping can be altered without choosing the Blend Tool using the 1-1 Node 
Mapping option on the Blend Pop-up Menu.



 Blend Tool - Remove Button

The Remove button on the Blend Tool Infobar removes any applied blends from the 
selection.

A blend can be be removed without choosing the Blend Tool using Remove Blend on the 
Blend Pop-up Menu.

Note
Objects used in blends can be edited without removing the blend first. See Selecting objects 
inside objects.



 Blend objects
Simple Blending

1. Choose the Blend Tool
2. Place the pointer over the first object.
3. Drag to and release over the second object.

Anti-aliasing
If anti-aliasing is enabled (see Blend Tool - Anti-alias Button) each individual step of the 
blend will be anti-aliased.
If the blend is a dense one, it may be useful to turn off the anti-aliasing as it will speed 
redraw but make little difference to the quality of the rendered object.

One to One Mapping
The intermediate objects produced when blending between objects with the same number of
points may not be the shape you want. The One to One Node Mapping Button on the Blend 
Tool Infobar provides less shape distortion in the intermediate objects when blending 
between objects with the same number of points.

Multi-stage Blending
1. Choose the Blend Tool.
2. Create a blend object as described above.
3. Drag from the blend to another object.

This will create a multi-stage blend between all three objects. Blending a blend object with 
another will create a multi-stage blend.

Blending Between Points
It is possible to specify the way the Blend Tool blends the shapes.

1. Select the objects with the Selector Tool (with edit handles enabled).
2. Choose the Blend Tool.
3. Drag from a specific point on the first shape to a specific point on the second. The 

mouse pointer shows a tick when it is over the second point.

Note that blending between different points produces different effects.

Blend Steps
1. Select the blend object.
2. Choose the Blend Tool.
3. Type the required number of blend steps into the edit field (see Blend Tool - Number of 

Steps Field) and press RETURN.

On-line Demonstration
    {button Simple Blending,EF("XaraDemo.exe","Blend.avi `Simple Blending'",1) }

Note
Blending objects in different layers moves the objects into the same layer.
If you blend between two bitmaps the blend will show the first bitmap for all steps except 
the last (see Morphing bitmaps).
_______________
See also
Creating advanced blends
Removing a blend





The Blur (Bitmap Effect) process is the the opposite of Sharpen. It makes the boundaries 
between colours in a bitmap less obvious. This is useful in reducing noise and patterning. 
The Bitmap Effects dialog box offers three settings for Blur; Low, Medium and High - the 
value can then be set more accurately using the slider in the dialog box.



The Bounding Box of an object is an imaginary box enclosing the whole object.



 Break Shapes (Arrange Menu)
Break Shapes splits any selected shapes previously joined with the Join Shapes option into 
their individual component shapes.

On-line Demonstration
    {button Joining and Breaking Lines and Shapes,EF("XaraDemo.exe","JoinBrk.avi `Joining 

and Breaking Lines and Shapes'",1) }



 Break lines and shapes apart
You sometimes want to break a line into two separate lines or break a shape (a closed 
object) to create an open object.

1. Select the line(s) or shape(s) (see Selecting and deselecting objects).
2. Choose the Shape Editor Tool.
3. Select the point handle(s) to be broken.
4. Click on the Break Button on the Infobar.



 Bring to Front (Arrange Menu)
    CTRL+F

Moves every object in the selection to the front of the layer it is on.

On-line Demonstration
    {button Moving Objects Backwards and Forwards within a 

Layer,EF("XaraDemo.exe","Arrange.avi `Moving Objects Backwards and Forwards within a 
Layer'",1) }



Butt Caps are a type of ending which can be applied to lines. There are three types of 
'cap' :

Butt Cap                      Round Cap                Square Cap

The line cap style is applied using the Line Gallery.



Button Palette Control Bar

The Button Palette is a special control bar in CorelXARA which contains a copy of every 
button available. When a new, blank bar is created you can ALT-drag buttons from the button
palette onto the new bar. The button palette cannot be deleted and buttons cannot be 
deleted from it.

See Control Bars dialog box for details on opening the button palette.
_______________
See also
Default Control Bars
Moving & copying buttons
Creating & deleting control bars



Buttons are not being drawn correctly

Problem
Buttons in CorelXARA are being drawn incorrectly,

Cause
This may be due to a problem with your video drivers. In some cases the video drivers for 
some S3 chip set based cards can conflict with Win32s. 

Recommended Action
Obtain a video driver update from your video card supplier.



The CMYK (Cyan, Magenta, Yellow and Key (black) ) colour model is used by commercial 
printers. CMY and K are the four inks used in full-colour printing. The Key colour is used to 
reinforce dark colours which would appear 'muddy' if printed using only C, M and Y. If the Key
is set to 100%, the colour will appear black irrespective of the settings of C, M and Y. CMYK 
colours are stored in 32-bit format. They are printed (and output in EPS) in CMYK format 
unless the document uses transparency when they are converted to RGB.



Cannot close file

Cause
If the file is on a floppy disk, the disk may have been removed from the drive.    
If the file is on a hard disk, the disk structure may be corrupt.

Recommended action
If the file is on a floppy disk, check the disk is correctly inserted in the drive.
If the file is on a hard disk, run your disk diagnostic utilities to check for a corrupted disk 
structure.



Cannot create file

Cause
CorelXARA tried unsuccessfully to create a new file.    This may be because:

The specified disk is full.
The specified drive is read-only. (For example, a CD-ROM drive.)
A file of that name already exists and is read-only.
You do not have write permission for the specified directory.

Recommended action
Check that the disk is not full - if it is, then choose another disk or delete some 

unwanted files from it.
Choose another name for the file, or another disk or directory.
Ask your system administrator to change your access permissions.



Cannot read or write your initialisation file

Cause
The initialisation file, CORELXRA.INI, has been moved, deleted, or corrupted.

Recommended action
CORELXRA.INI should be in your Windows directory.    If it has been moved to another 
directory,    close CorelXARA and copy CORELXRA.INI into the Windows directory. Then rerun 
CorelXARA.

If CORELXRA.INI has not been moved, then it may be corrupted.    Close CorelXARA and 
delete the CORELXRA.INI file. Then rerun CorelXARA.    This creates a new initialisation file 
with default settings.



Cascade (Window Menu)

Cascade shows all the open document views stacked on top of each other along a diagonal 
line.



Change the print method using the INI file

You should only attempt the following suggestion if you're an advanced user 
familiar with the concepts of manually editing configuration and initialisation 
files.

There are some hidden INI file settings which simplify the way in which CorelXARA prints 
(this only applies to Normal and PostScript printing).

1. Quit CorelXARA if it's running.
2. Start Notepad.
3. Open the file C:\Windows\CORELXRA.INI (replace C:\Windows with the path to your 

Windows/95/NT installation)
4. Find the line, "PrintMaskType=2".
5. Retype it as, "PrintMaskType=1" to simplify printing somewhat or 

"PrintWithMask=0" to simplify printing as much as possible.
6. Save the file.
7. Restart CorelXARA.

New document design rule:
With either form of simplified printing the transparent objects and other objects around them
will be printed using a single bitmap. This sometimes means that objects which you would 
prefer to be printed at the best possible resolution get printed at the transparency 
resolution.

Thus, there is a new design rule you should apply to your documents. Try to arrange them so
that highly-detailed objects (such as text or thin lines) are in front of any transparent 
objects. This will ensure that these objects are printed at the printer's resolution - not the 
transparency resolution. (See Output Options)

Tip: It's often a very good idea to keep highly detailed objects, such as text, in a layer at the
front of the document. That way you can't accidentally draw any transparency on top 
of them.

Tip: You can use Bring to Front to reorder objects within layers and you can reorder whole 
layers using drag and drop in the Layer Gallery. 

(To put printing back to the normal system type "PrintMaskType=2".)

Did this fix the problem?
      Yes! My document prints now. Close this troubleshooter.
      No. What else can I try?



 Change a named colour
The named colours shown on the Colour Line can be changed if required. If they are altered 
the changes will be reflected in all objects that use them. If the named colour you change 
was used in the creation of shade colours or linked colours these will also change.

To change a named colour
1. Open the Colour Editor.
2. Drag-and-drop the colour from the Colour Line or Colour Gallery onto the Colour Editor.
3. Alter the colour using the Colour Editor.

or
1. Open the Colour Editor.
2. Choose the named colour from the drop-down list.
3. Alter the colour using the Colour Editor.

or
1. Open the Colour Gallery.
2. Select the colour in the gallery.
3. Click the Edit button.

To change the named colour applied to a particular object
1. Open the Colour Editor.
2. Select the object using the named colour.
3. Drag the object's fill or line colour from the swatch on the left-hand end of the Colour 

Line onto the Colour Editor.

Note
Selecting an object and editing the colour shown in the Colour Editor will force the colour of 
the object to be a local colour and this is what will be edited. You must specifically choose a 
named colour before you can edit it.
You can use Undo to undo the colour changes.
_______________
See also
Creating a named colour
Deleting a named colour
Using shades



 Change the colour of guides
Depending on the colours used in your drawing, you may want to change the colour of guide
objects and guidelines so they are more clearly visible.

To change guide colour
1. Right-click on the guides layer in the Layer Gallery to open the pop-up menu.
2. Choose Properties to open the Layer Properties dialog box.
3. Open the Guides section.
4. Select a suitable colour from the drop-down list at the bottom of the dialog box.
5. Click OK.



 Change the default page size
CorelXARA defaults to a page size of US Letter.    If you wish to change this page size (to A4, 
for example), do the following :

1. Create a new, blank document.
2. From the Utilities Menu, choose Options.
3. In the dialogue box, click the Page tab.
4. From the Paper Size menu, choose the new paper size (e.g. A4).
5. Click OK to close the dialogue box.
6. From the File menu in the main CorelXARA window, choose Save Template. A dialogue box

will appear asking if you are sure you want to replace the template document, click the 
Save button to save your new paper size setting. For more information about the template
document, click the Help button.

All new documents will now appear with the chosen page size selected.

Tips
You can change any option permanently by saving out a new template document.
If you want to use a paper size not listed, select the Custom option from the menu 

and type the size into the fields below.



A Circular Fill consists of colour graduating in a radial fashion. Circular fills are applied 
using the Fill Tool.



Circular Transparency graduates from one transparency to another in a radial fashion. The
two transparency handles on either end of the transparency arrow represent the radius of 
the transparency. The outer handle can be used to change the outer transparency and alter 
the size of the circle, the inner one to move the circle and alter the centre transparency 
level.



 Clear Selection (Edit Menu)
    ESC (Escape)

Clear Selection deselects all selected objects. This can be useful to :

See the document without any handlers visible.
Reset the transformation centre.
Quickly clear the selected points on a line or shape so a new line or shape can be 

started (see Drawing a line with the Shape Editor Tool).



 Clipart Gallery (Utilities Menu)

 SHIFT+F10
The Clipart Gallery lets you easily incorporate clipart from a folder into your document. The 
folder is usually on the CorelXARA CD but you can change to a different drive if necessary. 
You can also add your own clipart to the gallery if you wish.

Import Import a file into the document
Open Open a new file.
Options Clipart Gallery Options
Add Clipart Add Clipart to the gallery
Remove Remove the selected sections from the gallery.

Many operations using the Clipart Gallery are made easier by the Clipart Gallery pop-up 
menu.
_______________
See also
Selecting items in a gallery
Galleries



 Clipart Gallery (Utilities Menu)
    SHIFT+F10

The Clipart Gallery item on the Utilities menu and the Clipart Gallery button on the control 
bars open the Clipart Gallery if it is closed and close it if it is open. The button remains 
pressed in if the gallery is open.



Clipart Gallery - Add Clipart Button

The Add Clipart button in the Clipart Gallery opens a modified version of the Open dialog box
that lets you choose a folder to add to the gallery or update an existing folder. This would 
usually be used to open the clipart folder on the CorelXARA CD, though any directory 
containing clipart can be added to the gallery. See Adding a folder to a gallery for more 
details.
_______________
See also
Using titles, descriptions and keywords



Clipart Gallery - Import Button

The Import button in the Clipart Gallery imports the selected image into the selected 
document. You can also import a clipart file by dragging it from the Clipart Gallery and 
dropping it on a document.



Clipart Gallery - Open Button

The Open button in the Clipart Gallery opens a new document and imports the selected 
picture into it. You can also open a clipart file by double-clicking on it in the gallery (CTRL-
double-click to close the gallery afterwards).



Clipart Gallery - Options Button

Clicking the Options button in the Clipart Gallery opens a menu containing the following 
options :

Add Clipart Add a clipart folder to the Clipart Gallery.
Find Search the Clipart Gallery.
Sort Sort the Clipart Gallery.
Properties Clipart Gallery Properties.



Clipart Gallery - Pop-up Menu

Right-clicking on the Clipart Gallery opens a pop-up menu which contains the following 
options :

Open Identical to the Open button.
Import Identical to the Import button.
Remove Section Identical to the Remove button.
(Un)Fold Section Folds up or unfolds the current section.
Previous Section Moves to the start of the previous section.
Next Section Moves to the start of the next section.

Note
When you right-click in the gallery to open the pop-up menu the picture under the mouse 
pointer will be selected, so using the pop-up menu is a quick way to select a picture and 
operate on it in one go.



Clipart Gallery - Remove Button

The Remove button in the Clipart Gallery removes the selected sections from the Clipart 
Gallery. You will be asked to confirm the operation. You can add the sections again using the 
Add Clipart button.



The Clipboard is a temporary store and is used like a physical clipboard. You can cut or 
copy part or all of your drawing onto the clipboard. You can then transfer the clipboard 
contents to another part of the document or even a completely different document or 
application.
The clipboard can only hold one item or set of items at a time. Placing something on it 
overwrites any existing contents. Objects remain on the clipboard until deleted or 
overwritten by CorelXARA or another application. The contents of the clipboard are lost when
Windows is exited.



 Clone (Edit Menu)
 CTRL+K

Clone creates a copy of the selection. and places it in the document in the same place as the
original. Unlike Duplicate, no offset is used. As the copy is placed on top of the original it is 
possible no change will be visible after the operation has been performed.

This command is useful for ...
1. Making a copy of an object before using Combine Shapes.
2. Making a copy of a (possibly transparent) object so it overlays the object underneath 

exactly.

Clone is also available from the Selection Pop-up Menu.

On-line Demonstration
    {button Duplicating and Cloning Objects,EF("XaraDemo.exe","DupClone.avi `Duplicating 

and Cloning Objects'",1) }

Note
You cannot clone objects selected using select inside. (See Selecting objects inside other 
objects.) This includes selected regions within text objects.
You can remember the key shortcut by thinking of Clone as 'Klone'!



 Close (File Menu)
Close closes the selected document and all views onto it. If you attempt to close a document
which has been altered but not saved CorelXARA will ask whether the document should be 
saved or not before closing it.

If you have multiple views open for a single document, one of the views can be closed using 
Close on the document control menu. Alternatively, double click on the application control 
button (the top-left corner of the document window).
_______________
See also
Exit



Close open documents?

Cause
This message is displayed when the 'Ask about closing document views' option is set in the 
General Options. When ever a new document is created or an existing document is loaded    
the message 'Would you like to keep the existing documents open?' is displayed with 
buttons labelled Keep and Close . The enables you to choose to use CorelXARA in the mode 
where only a single document is ever in memory at the one time.

Recommended action
If only the current document is required, and all others can be closed, then click Close. You 
will be warned about documents which have been modified and not saved in the usual way.

If all the existing documents should remain open then click Keep. This will do nothing to the 
existing documents open in CorelXARA. This acts the same as if the option is turned off.

If you do not require the warning any more then go to the General Options and turn the 
option off.,



 Close a gallery

Click on the icon in the top right-hand corner of the gallery.

Alternatively, when a gallery is open, its button on the control bars is pressed in - clicking 
the button closes the gallery.
_______________
See also
Galleries



 Colour Editor (Utilities Menu)
The Colour Editor is used to edit the colour of objects (local colours) and to create and 
change named colours. It allows you to edit colours using a range of colour models and even
allows you to create colours which are linked to other colours (their 'parent' colour) so that 
when the parent colour changes, all connected colours will also change - see Colour Editor    -
Advanced.
 CTRL+E (to open and close)

The Colour Editor can be reached in several ways :
Selecting Colour Editor from the Utilities menu.
Clicking the Edit Colour button on the Colour Line to edit the current fill colour.
Shift-Clicking the Edit Colour button on the Colour Line to edit the current line colour.
Selecting the Edit button in the Colour Gallery.
Selecting Colour Editor from the selection pop-up menu.
Drag-and-drop a colour from the Colour Line or Colour Gallery onto the Edit Colour 

button on the Colour Line.

Choose a Colour to Edit
The drop-down list shows the colour being edited. If the colour is a local colour,    the name 
field shows either Local Fill Colour or Local Line Colour (or Current Fill Colour or Current Line 
Colour if no objects are selected).
You can choose the colour to be edited by :

Choosing from the drop-down list. The first two items let you edit the current fill and 
line colours.

Selecting an object (or objects) to edit their local colour. See Selecting and 
deselecting objects.

Drag-and-drop a colour from the Colour Line or Colour Gallery onto the Editor. 

If an object with a named colour applied is selected and the Colour Editor opened, making 
changes in the Editor will result in the object's colour becoming a local colour. The changes 
will not affect the named colour originally used. For more information, see Colouring objects.

New Named Colour



Clicking this button opens the New Named Colour dialog box. The new colour is applied to 
the selected objects, so if you just wish to create a new colour and not use it, make sure 
there are no objects selected. If you click this button whilst holding down keys, you can skip 
past the dialog box and specify what you want to do more quickly :

SHIFT Create a copy of the current colour.
CTRL Create a shade of the current colour.
SHIFT+CTRL Use the current settings in the New Named Colour dialog box.

Show Menu

Clicking this button opens the Colour Editor Menu. You can also open the menu by right-
clicking on the Colour Editor.

Colour Swatches
In the top-right corner of the colour editing area are two colour swatches; one shows the 
edited colour and the other shows the colour as it was before you changed it. Either of the 
swatches can be drag-and-dropped onto objects to apply them as local colours. When you 
first open the Editor, both swatches are the same colour.

Shades
The definition of a shade sets how much lighter/darker the shade is than the parent and so is
edited differently from the normal colour models, see Editing Shade Colours.

Colour Model
When the Editor is opened, it will display a colour model. The model used can be either :

The model used when the colour was created.
The current model.

This setting is defined by the Automatic Colour Model Selection option in the View Options.
You can alter the Colour Model using the Colour Editor Menu.
The colour models available allow :

RGB Colour Model Editing
CMYK Colour Model Editing
HSV Colour Model Editing
Greyscale Colour Model Editing

Show Advanced Options

Clicking this button expands the Colour Editor to show additional options. See Colour Editor -
Advanced for more details.
_______________
See also
Undo
Importing colours & palettes
Using shades
Creating a named colour
Copying colour to another object



 Colour Editor - Advanced
When the Show Advanced Options button in the Colour Editor is clicked, the Editor expands 
to show additional options at the bottom of the dialog. The first section shows the exact 
values for the components of the colour (dependent on the colour model), the second shows
the colour model and the third displays the colour type.

Show Only Simple Options

Clicking this button closes the lower part of the Colour Editor, hiding the advanced options.

Component Values
These fields define the values for the components of the colour. The components shown 
depend on the colour model in use. For more details, refer to the relevant colour model in 
the section below. Note that when linked colours, tints and shades are being edited, some of 
these fields are dimmed and cannot be altered directly.
The values can be edited in one of two units, percentages (0% to 100%) or values (0 to 255).
Which is used is set by the Colour Units setting in the Unit Options. If you need to enter a 
value in the other format, you can force the units by typing (for example) "25%" (for a 
percentage) or "25d" (for 0 to 255 value).

3D
When editing normal colours and linked colours using the RGB and CMYK models, the Colour 
Editor can be set to show a projection of the colour space. This button enables this pseudo-
3D display. For more details, refer to the relevant colour type in the section below.

Colour Type
This drop-down list sets whether the named colour is a normal colour, a shade colour, a tint 
colour or a linked colour. For more details on editing a colour type, click on the type :

Colour Editor - Normal Colours
Colour Editor - Shade Colours



Colour Editor - Tint Colours
Colour Editor - Linked Colours



Colour Editor - CMYK Model

Normal colours and linked colours can be edited in several colour models. When editing a 
colour using the CMYK colour model, the Colour Editor can be used in two modes:

This mode displays the four component colours as bars (Cyan, Magenta, Yellow and Key 
(black)). To alter the level of each colour, drag the marker or type values into the fields 
below the bars.

This mode displays a slice through a colour cube. The small arrow button to the top of the 
cube changes the component on the diagonal axis of the cube, much like rotating it. The 
small colour strip on it indicates the diagonal component.
On the right-hand side of the cube slice is the Key bar, ranging from 0% Key (no black) to 
100% Key (black).
To edit the colour, drag the marker on the slice, or drag the slice using the handle on the 
diagonal and move the marker on the Key colour bar. 
When the marker on the cube slice is being dragged, the CTRL key can be held down to 
constrain its movement to horizontal and vertical.

The mode used is set using the 3D button. Deselect it for slider editing, select it for colour 
cube editing. Use the mode you find most intuitive.

Note
If you are editing a linked colour, some of the values will be constrained by white boundaries
(shown on the editing area) depending on the inheritance scheme in use.



Colour Editor - Greyscale Model

Normal colours and linked colours can be edited in several colour models. The greyscale 
model defines shades of grey between white (100%) and black (0%) by setting the amount 
of white (intensity). This colour model is the easiest to use when creating black-and-white 
illustrations.

The value can be altered by dragging the marker on the bar, or entering a value into the 
Intensity field.
3D editing is not available for this colour model.
The intensity can be edited in one of two units, percentages (0% to 100%) or values (0 to 
255). Which is used is set by the Colour Units setting in the Unit Options. If you need to 
enter a value in the other format, you can force the units by typing (for example) "25%" (for 
a percentage) or "25d" (for 0 to 255 value).
_______________
See also
Colour Editor



Colour Editor - HSV Model

Normal colours and linked colours can be edited in several colour models. The HSV (Hue, 
Saturation, Value) model is often found to be the most intuitive model.

To use this colour model, choose the Hue from the rainbow coloured strip along the bottom. 
This represents the edge of a circle, hence both ends are red. The Hue is an angle around 
the circle and can be entered in the Hue field.
The marker in the square panel represents the Saturation and Value components of the 
colour. These values can also be entered in fields under the colour strip.
The marker can be dragged and will be constrained to the horizontal and vertical axes if the 
CTRL key is held down during the drag.
3D editing is not available for this colour model.

Note
If you are editing a linked colour, some of the values will be constrained by white boundaries
(shown on the editing area) depending on the inheritance scheme in use. If the Hue has 
been inherited, the marker on the Hue line will be bound by a white circle and cannot be 
moved.
_______________
See also
Colour Editor



Colour Editor - Linked Colours

CorelXARA supports the editing of linked colours in exactly the same way as for normal 
colours (See Colour Editor - Normal Colours) except those components which have been 
inherited from the parent colour cannot be altered. Any changes to the parent colour will be 
reflected in the inherited components of its linked children. The marker defining the colour is
constrained according to the inheritance - see in the diagram above how the marker is 
constrained to only moving in the vertical (Value) axis and the Hue marker is fixed in place 
due to the inheritance from the parent of Hue and Saturation.
The fields can be edited in one of two units, percentages (0% to 100%) or values (0 to 255). 
Which is used is set by the Colour Units setting in the Unit Options. If you need to enter a 
value in the other format, you can force the units by typing (for example) "25%" (for a 
percentage) or "25d" (for 0 to 255 value).



Colour Editor - Normal Colours

CorelXARA supports the editing of normal colours in all four colour models :

RGB Colour Model Editing
CMYK Colour Model Editing
HSV Colour Model Editing
Greyscale Colour Model Editing



Colour Editor - RGB Model

Normal colours and linked colours can be edited in several colour models. When editing a 
colour using the RGB colour model, the Colour Editor can be used in two modes:

This mode displays the three primary colours as bars (Red, Green and Blue). To alter the 
level of each colour, drag the marker or type values into the fields below the bars.

This mode displays a slice through a colour cube. The small arrow button to the top of the 
cube changes the component on the diagonal axis of the cube, much like rotating it. The 
small colour strip on it indicates the diagonal component.
To edit the colour, drag the marker on the slice, or drag the slice using the handle on the 
diagonal. When the marker is being dragged, the CTRL key can be held down to constrain its
movement to horizontal or vertical.

The mode used is set using the 3D button. Deselect it for slider editing, select it for colour 
cube editing. Use the mode you find most intuitive.

Note
If you are editing a linked colour, some of the values will be constrained by white boundaries
(shown on the editing area) depending on the inheritance scheme in use.
The values can be edited in one of two units, percentages (0% to 100%) or values (0 to 255).
Which is used is set by the Colour Units setting in the Unit Options. If you need to enter a 
value in the other format, you can force the units by typing (for example) "25%" (for a 
percentage) or "25d" (for 0 to 255 value).





Colour Editor - Shade Colours

Shade colours are not edited using one of the four normal colour models, but using a display
showing all the shades available from the chosen parent colour. Drag the marker to set the 
new shade. The parent colour is marked in the display as a small cross (shown above in the 
top-left corner). When the parent colour is altered, the change is reflected in all shades 
created using it.

The two fields shown at the bottom of the Colour Editor when editing a shade colour allow 
you to set the exact position of the shade. When the shade is no different from its parent, 
the values shown are 0.0 and 0.0. Moving the shade to the left or bottom edges of the 
editing area moves one of the values towards -100% and moving the shade to the top or 
right edges gives 100%. The first field controls the X (relative saturation) direction, while the
other controls the Y (relative lightness/darkness) direction. 

Note
A colour model can be selected, but the only change will be the display of the colour 
components.
_______________
See also
Colour Editor
Using shades



Colour Editor - Tint Colours

Tint colours are not edited using a graphical colour model display as you only need to set 
the percentage of the tint. The display shows the full range of tints available, simply move 
the marker to select the required colour. Any change to the parent colour will be reflected in 
the tint. e.g. if a pink tint is created with Red as a parent and the Red then altered to 
Orange, the tint would become a light orange.

A colour model can be selected, but the only change will be the display of the colour 
components.



Colour Editor Menu
The Colour Editor menu, opened using the Menu button in the Colour Editor or right-clicking 
on it, contains the following options :

Rename Opens the Rename Colour dialog box.
Edit Parent Selects the parent (if any) of the current colour so it can be 
edited.
HSV Selects the HSV colour model.
RGB Selects the RGB colour model.
CMYK Selects the CMYK colour model.
Greyscale Selects the greyscale colour model.
Help Opens the CorelXARA documentation on the Colour Editor.



 Colour Gallery (Utilities Menu)

 F9
The Colour Gallery gives you full control over all the named colours in all the documents 
currently loaded. Local colours only exist on individual objects and are not shown in the 
Colour Gallery.
The Colour Line displays the named colours in a document in the same order as the Colour 
Gallery, so moving colours in the gallery also moves them on the Colour Line. The named 
colours on both can also be reordered either manually or using a specific sort - see 
Reordering gallery items. The list of named colours can also be searched (see Searching a 
gallery).
When a named colour is not currently used in a document, it has 'Not in use' shown next to 
it if the Full Information display option (see Altering gallery display format) has been chosen.
In the same way, shade colours have "Shade of XX" written next to them where XX is the 
name of the parent colour.

Apply Applying a named colour to objects
New Creating a new named colour
Delete Deleting a named colour
Options Colour Gallery options
Redefine Redefine a named colour from an object
Edit Change a named colour
Name Change the name of a colour

Many operations using the Colour Gallery are made easier by the Colour Gallery pop-up 
menu.
_______________
See also
Galleries
Selecting items in a gallery
Colouring objects
Importing colours & palettes



 Colour Gallery (Utilities Menu)
 F9

The Colour Gallery item on the Utilities menu and the Colour Gallery button on the control 
bars open the Colour Gallery if it is closed and close it if it is open. The button remains 
pressed in if the gallery is open.



Colour Gallery - Apply Button
The Apply button in the Colour Gallery applies the named colour selected in the gallery as a 
flat fill colour to the selection. Double clicking on a named colour in the gallery has the same
effect. CTRL+double-clicking on a colour in the gallery will apply the colour to the selection 
as a line colour.



Colour Gallery - Delete Button
The Delete button in the Colour Gallery deletes all the named colours currently selected in 
the gallery. If any of the selected colours are currently in use a warning will appear giving 
you the option to delete the entire set of selected colours, just delete the colours which are 
not being used or cancel the operation.
If you delete any colours which are in use in your document, any objects using those colours 
will not change in appearance, but the colours applied to them will become local colours.
Alternatively, you can right-click on the colour in the gallery to open the pop-up menu and 
choose Delete which you may find easier.



Colour Gallery - Edit Button
The Edit button in the Colour Gallery opens the Colour Editor allowing you to change the 
named colour which is currently selected in the gallery.
Alternatively, you can right-click on the colour in the gallery to open the pop-up menu and 
choose Edit.



Colour Gallery - Name Button
The Name button in the Colour Gallery opens the Rename Colour dialog box which allows 
you to change the name of the named colour selected in the gallery.
Alternatively, you can right-click on the colour in the gallery to open the pop-up menu and 
choose Rename.



Colour Gallery - New Button
The New button in the Colour Gallery opens the New Named Colour dialog box into which the
name of a new named colour can be entered. Selecting the Create button in this dialog box 
will then create a new colour with the name you give.
If a named colour is selected when the New button is pressed, the new named colour will be 
a copy of the selected named colour.
Alternatively, you can right-click on the gallery to open the pop-up menu and choose New.



Colour Gallery - Options Button
The Options button in the Colour Gallery opens a menu containing the following options :

Find Search the Colour Gallery
Sort Sort the Colour Gallery
Properties Alter the way the colours are displayed in the Colour Gallery.



Colour Gallery - Pop-up Menu

Right-clicking on the Colour Gallery opens the pop-up menu which contains the following 
options :

New Creates a new named colour, see New above.
Edit Opens the Colour Editor, see Edit above.
Delete Delete the selected colours, see Delete above.
Redefine Redefine the select named colour, see Redefine above.
Rename Renames the selected colour, see Name above.
(Un)Fold Section Folds up or unfolds the current section.
Previous Section Moves to the start of the previous section.
Next Section Moves to the start of the next section.

Note
When you right-click on a colour the colour is selected and the pop-up menu opens, so this is
a quick and easy way to select a colour and operate on it.



Colour Gallery - Redefine Button
When the Redefine button in the Colour Gallery is clicked, the definition of the named colour 
selected in the gallery is set to that of the fill colour of the currently selected object. This 
provides an easy way of redefining an existing named colour to look like a colour used in 
your document.
Alternatively, you can right-click on the colour in the gallery to open the pop-up menu and 
choose Redefine.



Colour Line

The Colour Line shows which of the named colours (if any) have been applied to the selected
object(s). It also provides a quick way of applying named colours and of opening the Colour 
Editor. Note that if the selection uses local colours no markers are displayed on the Colour 
Line.

Named Colours
The majority of the Colour Line is taken up by a list of all the named colours in the 
document. 
You can apply the named colours by dragging and dropping them from the Colour Line.
The fill and line colours are marked (see illustration for Current line and fill colour):

Diamonds show the colours if there objects selected,
Crosses show the current colour attributes if there are no objects selected,
Triangles show the two colours of a fill applied with the Fill Tool..

There are no marks if objects use local colours or multiple colours.
Line colour is marked on the right; fill colour on the left.

Current fill and line colours
The outer part of the colour swatch on the left-hand end of the Colour Line shows the line 
colour; the centre the fill colour. These are:

The colours of any selected objects,
Otherwise the current colour attributes.

These colours are also marked in the named colours section (see below).

Two way hatching indicates no colour. 
One way hatching indicates multiple colours. (For example if the selection contains items 
with different fill colours.)
For a graduated fill, the centre shows the two colours used in the fill.
You can drag and drop colours from the swatch to apply them to objects in the drawing.



Open Colour Editor button

Clicking on this button opens the Colour Editor. The Editor shows the current fill colour. 
(Shown in the colour swatch.)
SHIFT-clicking also opens the Colour Editor but showing the current line colour.

No Colour

Clicking this applies a no colour fill. SHIFT-clicking applies No colour to a line.
Note: this is not the same as 100% transparent. 'No colour' and transparency are very 
different. A shape with transparency applied remains a solid shape. A shape filled with 'no 
colour' is effectively hollow. See Zero Width Lines for more details.
_______________
See also
Colouring objects
Colour Gallery (reordering colours on the Colour Line)
Colour Line Enable/Disable 
View Options (for display options for the Named Colours)



Colour Line & Pasteboard colours are drawn incorrectly

Problem
Many colours on the Colour Line have been drawn incorrectly and the pasteboard around the
page in the document has been drawn in an incorrect colour.

Cause
It is likely you are suffering from a bug in the version 1.6 release of the S3 drivers supplied 
with Windows 3.1x.

Recommended Action
This problem can be fixed by :

Changing the BitmapBrushes= line in CORELXRA.INI (in your Windows system 
directory) to read "BitmapBrushes=1".
or

Obtaining a fixed version of the S3 video driver.



Colour Line (Window Menu)

Colour Line on the Bars submenu of the Window menu allows the Colour Line to be turned on
and off. When it is set, the Colour Line is enabled, otherwise it is not.
This setting is stored when you quit CorelXARA.



Colour Models define the way in which a colour is defined. In CorelXARA you can define 
colours using four models :

RGB (Red-Green-Blue). Most often used by video cards to define colours.
CMYK (Cyan-Magenta-Yellow-Key). Favoured by commercial printers. Cyan, Magenta, 

Yellow and Key (Black) are the colours of the inks used.
HSV (Hue-Saturation-Value). The "artists" method of defining colours. Hue is the pure 

pigment of the colour, Saturation is the amount of white mixed into the colour and Value is 
the amount of Black mixed into the colour. Hue is measured in degrees representing the 
angle around a colour wheel that sweeps from Red through Yellow, Green, Cyan, Blue, 
Magenta and back to Red again.

Grey scale defines colours as Black, White or shades of Grey.



Coloured Text Not Printing

If you find that your printouts are working fine except any coloured text is not printing you 
are probably suffering from a problem with your printer drivers. Your first step is to try and 
get an updated version of the drivers from the manufacturer. If this is not possible, do the 
following :

1. From the Utilities menu, choose Options.
2. Open the Output tab.
3. At the bottom of the window, select the Print All Text As Shapes option.

This will convert all text objects into groups of simple shapes before the document is sent to 
the printer and should resolve the problem.



 Colour objects
When colouring an object, you have two choices; You can use colours so they each only 
apply to individual objects (local colours), or you can use named colours so when the named 
colour is changed, all objects using the colour reflect the change. 

To change the fill colour of an object
Do one of the following:

Drag-and-drop a named colour onto the object from the Colour Line. or the Colour 
Gallery. The objects need not be selected. To apply the colour to an object inside another 
object, hold down CTRL    as the colour is dropped.

Select the object(s) and click on    a colour on the Colour Line.
Select the object(s), select the colour in the Colour Gallery and click the Apply button 

in the gallery.
Select the object(s) and double-click on the colour in the Colour Gallery.
Select the object(s), open the Colour Editor and select "current fill colour" from the 

drop-down list. Note editing in this way will force the object's colour to become a local 
colour.

Select the object(s), open the Colour Editor and change the colour. Note that editing 
in this way will force the object's colour to become a local colour.

Select the object and double click on the current fill colour panel on the Colour Line. 
Note that editing this way will force the object's colour to become a local colour.

To change the line colour of an object
Do one of the following:

Drag-and-drop a named colour from the Colour Line or Colour Gallery onto the edge 
of the object. The objects need not be selected. To apply the named colour to an object 
inside another object, hold down CTRL    as the colour is dropped.

Select the object(s) and SHIFT-click (or click the right-hand mouse button) on the 
named colour on the Colour Line.

Select the object(s) and double click the required named colour in the Colour Gallery 
with the right mouse button.

Select the object(s), open the Colour Editor and select "Local line colour" from the 
drop-down list. Note that editing this way will force the object's colour to become a local 
colour.

Select the object and double click on the current line colour panel on the Colour Line. 
Note that editing this way will force the object's colour to become a local colour.

The following shows how a dragged colour will be applied:

The colour will be applied as a (flat) fill colour.

The colour will be applied as a line colour.

    The colour will be used to set the current fill colour attribute. See Setting the current 
attributes.

Note
To remove the line or fill colour of a shape, apply No Colour (see Colour Line) to the object's 
fill or line.
You can also edit the colours of fills applied with the Fill Tool using drag-and-drop. See Editing
Fills.
Once you have applied a named colour to an object, changes to the named colour will be 



reflected in the object. See Changing a named colour.

On-line Demonstration
    {button Colouring Objects,EF("XaraDemo.exe","Colours.avi `Colouring Objects'",1) }

_______________
See also
Creating a named colour
Using shades
Copying colour to another object



Colours in bitmaps are stronger

You've noticed that some areas of your document print using much darker or stronger 
colours than others or that areas which should be white are appearing as light-grey.

Sadly, this is "normal" behaviour for many Windows printer drivers. They purposely make 
the colours "stronger" in bitmaps than in normal shapes.

This problem does not    occur on Postscript printer drivers or with EPS export. This can make
it difficult to produce meaningful proofs of colour artwork unless you have access to some 
kind of colour Postscript device.

Suggestion for Windows 95:
      Adjust your printer driver's colour correction facilities:

1. Click the Start button.
2. Click Settings and then click Printers.
3. Click on the icon for your printer, click the File menu and click Properties.
4. Click the Graphics tab in the Properties dialog box.
5. If your printer has colour correction facilities there will be a Color button at the 

bottom of this tab.
6. Click Color and try adjusting the options presented. It's difficult to be more precise 

than that because these options will vary from printer to printer! Try pressing the 
Help button and reading the printer manual for more information.

7. If you changed any options click OK and try to print again.

Suggestion for Windows 3.1 or NT:
      Print the whole document as a bitmap so that all    colours are made uniformly stronger. 

See Output Options.

If you're an advanced user:
      Edit the INI file to use alternative print methods that will print more of the document as 

bitmaps and thus lessen the visible differences.

Did one of those suggestions fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else can I try?



Combine Shapes (Arrange Menu)

The Combine Shapes submenu contains four options for 'combining' objects to produce new 
shapes. They are :

Add Shapes
Subtract Shapes
Intersect Shapes
Slice Shapes

The Combine Shapes operations are also available from the Selection Pop-up Menu.

Note
The Combine Shapes operations function equally well with objects other than shapes. With 
bitmaps, each bitmap is automatically converted to a simple shape filled with the original 
bitmap.



Compound Objects are objects in a document which contains other objects. The following 
are the compound object types :

Group Contains one or more objects of any type
Mould Contains one or more objects of any type
Blend Contains two or more objects of any type
Text Object Contains one or more Text Lines
Text Line Contains one or more characters



A Conical Fill fill consists of graduated colour swept around a central point to form a cone. 
It starts at the first colour, reaches the second half way around the circle and returns to the 
original colour at the start position. Conical fills are applied with the Fill Tool.



A Conical Transparency consists of graduated transparency swept around a central point 
to form a cone. It starts at the first transparency, reaches the second half way around the 
circle and returns to the original level at the start position. Transparency is applied with the 
Transparency Tool.



              
                                            Welcome to CorelXARA
                                        What's New in Version 1.2

                      
                    Tools                          How To...?          Demonstrations

                    
 Menus & Buttons      Galleries        Keyboard Short cuts

If you have trouble getting up and running with CorelXARA, see Troubleshooting.



Contone is short for "continuous tone". The term Contone is most commonly used in 
relation to bitmaps. A bitmap is a contone bitmap when all of the colours used in it are 
varying mixtures of two colours. For instance, a greyscale bitmap is a contone bitmap 
because all the colours in it are a mixture of black and white.
You can change the two colours of contone bitmap fills by selecting the fill handles and 
changing their colour in the usual ways. You can give a bitmap an old-fashioned sepia look 
by setting one contone colour to dark brown and the other to a yellow-creamy colour.



Control Bars are placed around the edges of the CorelXARA windows to make commonly 
used operations (in the form of buttons, sliders and edit boxes) more accessible. New Control
Bars can be created and the size of the buttons on different bars altered. Control Bars can be
free floating or docked (fixed) to the sides, top or bottom of the CorelXARA window. For more
details, see Default Control Bars.

        



Control Bars (Window Menu)

The Control Bars dialog box allows you to customise the control bars. It is also used to set 
the size of the buttons on docked and floating control bars and the button size used for 
galleries.

Close
This button closes the Control Bars dialog box.

New
This button opens a dialog box which will prompt for the name of a new control bar. Entering
a new name and clicking the OK button will create a new control bar with the given name. 
The new control bar will be opened, floating.

Delete
This button deletes the selected control bar. You will be asked to confirm deletion of the 
control bar. Note that you cannot delete the Infobar or the Button Palette.

Reset
This button resets the control bars to their 'factory' settings. It will remove all custom bars.
The list of control bars lets you choose which to display.

Button Size
The icons used for the buttons on the control bars and galleries    can be set to small icons or
larger icons. The bottom part of the dialog box describes what sizes the icons on control bars
at the top, left, right and bottom of the window are set to as well as the size of icons in 
floating control bars.
The setting for the size of buttons on floating bars is also applied to gallery buttons.

On-line Demonstration
    {button Creating Control Bars,EF("XaraDemo.exe","MakeBars.avi `Creating Control 

Bars'",1) }
_______________
See also
Default control bars
Creating & deleting control bars
Moving & resizing control bars



Moving & copying buttons



 Convert to Editable Shapes (Arrange Menu)

 CTRL+SHIFT+S
Convert to Editable Shapes takes an object and simplifies it so it is built from nothing more 
than lines and shapes.
This operation is also available from the Selection Pop-up Menu.

QuickShapes
Convert to Editable Shapes converts a QuickShape into a simple shape built up from straight
and curved line segments. This may be useful to add extra points to the shape or to change 
its shape in a way not possible with the QuickShape Tools. Once a QuickShape has been 
converted to editable shapes it can no longer be edited with the QuickShape, Ellipse or 
Rectangle Tools.

Text
When Convert to Editable Shapes is applied to a text object, each character in the text 
object is converted to a simple shape, all of these simple shapes are then placed in a group. 
When this operation has been carried out, the individual characters can be edited as if they 
were shapes, although as the object is now a group containing shapes not a text object, they
cannot be edited using the Text Tool. To edit individual characters inside the resulting group, 
you can Ungroup the group or use select inside; see Selecting objects inside other objects.

Bitmaps
Applying Convert to Editable Shapes to a bitmap creates a shape of the same size as original
bitmap and applies a bitmap fill to it using the original bitmap. The end-result is an object 
which looks identical to the original bitmap. This is useful as the edge the shape can be 
altered creating what looks like a non-rectangular bitmap. (see Masking a bitmap).

Groups
If Convert to Editable Shapes is applied to a group object, the result is as if it had been 
applied to each object within the group.

Moulds
When a mould is converted to simple shapes, the result is a group consisting entirely of 
simple lines and shapes.

Blends
When a blend is converted to simple shapes, the result is a group consisting of all the blend 
steps. If each step contains more than one object, each will also appear as a group of simple
lines and shapes.



 Copy (Edit Menu)
 CTRL+C

Copies the selection to the clipboard. Once the objects are on the clipboard they can be 
pasted back into the document any number of times, pasted into other documents or even 
into other applications. For more information, see Paste.
Cut is the same as Copy, but moves the objects to the clipboard removing them from the 
document.

Copy is also available from the Selection Pop-up Menu.



 Copy colour from one object to another
It is sometimes desirable to take the colour applied to one object and apply it to another 
object to ensure they have the same appearance. As well as using a named colour that can 
be shared by several objects, you can "copy" a local colour by the following method.

To apply an object's colour to another object
1. Select the object using the colour you wish to copy (see Selecting and deselecting 

objects).
2. Drag the "current colour" indicator patch (from the left end of the Colour Line) and drop 

it onto the object you wish to colour.

The current colour can also be dragged from the Colour Editor in a similar manner.

You can also copy colour using Paste Attributes.



CorelXARA EPS Export

This dialog box allows you to control various characteristics of the EPS you export from 
CorelXARA.    It appears after you have selected the name of the EPS file you wish to export 
to from the Export dialog box.

PostScript language level
This allows you to control what kind of PostScript is stored in the EPS file, in terms of Level 1 
or Level 2 compliance.    The default is 'Automatic' which outputs PostScript which will run on
Level 1 interpreters, but which will take advantage of Level 2 interpreters.    Set the Level 2 
option if you are sure your PostScript interpreter is Level 2 - this may result in faster printing,
especially if your document uses bitmaps and/or transparency heavily.    The Level 1 setting 
should be used if difficulties occur with printing PostScript, but should rarely, if ever, be 
needed, due to the auto-detection systems used by the 'Automatic' setting.    If in doubt, use 
the automatic setting.

Resolution
If your drawing contains bitmaps or transparency, CorelXARA stores bitmap data in the file 
when exporting as CorelXARA EPS.    You can control the resolution of this bitmap data.    It 
defaults to 200 pixels per inch.    If you find this is not right, you can override this with a 
manual setting.    Bitmap resolution is always measured in pixels per inch (or dots per inch if 
you prefer).    CorelXARA will not let you export bitmap data in an EPS file at more than 600 
pixels per inch, whatever method you choose.    This is because 600 dots per inch is very 
high resolution indeed and can produce very large EPS files - any higher resolution would be 
completely unnecessary. 300 DPI should be considered a practical maximum for exporting 
bitmap data to EPS.

Export text as shapes
When exporting text objects in EPS files, there is the usual PostScript problem of font 
matching to consider.    If you are using fonts in your document that you know or think your 
typesetter/printer does not have, then you can choose to export all text as shapes.    This 
means all text objects will be accurately printed when the EPS is printed.    However, because
the text is now sent as shapes and not using a proper PostScript font, you may find that 
small text does not print well, due to lack of hinting.    If this is the case, disable printing of 
text as shapes, and solve the problem using font mapping (see below).

Font mapping
When exporting EPS, CorelXARA uses a font mapping table to convert TrueType font names 
to PostScript font names.    The most common font names are built in to CorelXARA's font 
mapping table, but you may add your own, if you know the name of a font that your 
typesetter/printer has, and you know which of your TrueType fonts it resembles.    To edit 



CorelXARA's font mapping table, you must edit the .INI file.    To do this, run Windows 
Notepad (which is usually found in the Accessories group in Program Manager - or you may 
use another text editor if you prefer), and load the file CORELXRA.INI.    This file may be in 
the same directory as the CorelXARA program, but will usually be in the directory that 
Microsoft Windows is installed into, usually C:\WINDOWS.    If you cannot find the file, use 
Search on the File menu of File Manager, or use "Find files..." on the Windows 95 Start Menu.

Once you have loaded the CORELXRA.INI file, find the EPS font mapping section - it should 
look something like this:

[EPSFontMapping]
Times-New-Roman=Times-Roman
Times-New-Roman-Bold=Times-Bold
Times-New-Roman-Italic=Times-Italic
Times-New-Roman-BoldItalic=Times-BoldItalic
Courier-New=Courier
Courier-New-Bold=Courier-Bold
<... rest of table deleted for simplicity...>

Just search for the string "EPSFontMapping" in Notepad to find this section easily.

As you can probably tell, the font mapping is simple - the TrueType name is on the left, and 
the PostScript name is on the right, with an equals ('=') sign in between.    To add more font 
mappings, just add more lines like these to the section.    Bear in mind the following points:
TrueType names often contain spaces - replace these with dashes when specifying these in 
font mappings - for example, "Times New Roman" has been changed to "Times-New-Roman"
in the excerpt shown above.
You will need to map bold and italic variations explicitly, due to the way PostScript font 
names work. Again, as you can tell from the examples above, bold variations have "-Bold" 
added to the end, and italic versions have "-Italic" added to the end.    If the font is both bold 
and italic, it has "-BoldItalic" added to the end, and NOT "-Bold-Italic", "-ItalicBold", "-Italic-
Bold" or any other permutations.

Here are some examples:

Mapping the    TrueType font "ZapfDingbats BT" to the PostScript font "ZapfDingbats":

ZapfDingbats-BT=ZapfDingbats

Mapping the TrueType font "Avanti" to the PostScript font "AvantGarde":

Avanti=AvantGarde-Demi
Avanti-Italic=AvantGarde-DemiOblique
Avanti-Bold=AvantGard-Bold
Avanti-BoldItalic=AvantGard-BoldOblique

Mapping the TrueType font ZapfChancery to the PostScript version:

ZapfChancery=ZapfChancery-MediumItalic

Mapping the TrueType font Michael to the PostScript font Palatino:

Michael=Palatino-Roman
Michael-Bold=Palatino-Bold
Michael-Italic=Palatino-Italic



Michael-BoldItalic=Palatino-BoldItalic



CorelXARA Font Not Found

Cause
This message is displayed if the XARAFONT.FON font has been de-installed. This font is 
required by CorelXARA to run.

Recommended action

Windows 95
Please run the Windows Control Panel application to reinstall this font.    Double-click the 
'Fonts' icon in Control Panel to display the fonts installed on your computer.    Choose the 
File/Install New Font... menu option to display a dialog box that will allow you to enter the 
directory path to the font.    When CorelXARA is installed, the font is copied to the Fonts 
subdirectory of your Windows directory.    If the font has been deleted from there, a backup 
copy of it can be found in the CorelXARA directory, where the CorelXARA program is located.

Windows 3.1x
Please run the Windows Control Panel application to reinstall this font.    Double-click the 
'Fonts' icon in Control Panel to display a dialog box that allows you to install or de-install 
fonts.    Click the Add button to display a dialog box box that will allow you to enter the 
directory path to the font.    When CorelXARA is installed, the font is copied to the System 
subdirectory of your Windows directory.    If the font has been deleted from there, a backup 
copy of it can be found in the CorelXARA directory, where the CorelXARA program is located.

Alternatively, reinstalling CorelXARA will solve the problem.



CorelXARA Terminology

The following words have special meanings in CorelXARA and its documentation. Click on 
them to see their definition. The meanings of other terms are defined in the glossary 
accessible using the Glossary button at the top of this window.

Document
Spread
Line
Shape
Object
Attribute
Current Attribute



CorelXARA Troubleshooting

Printing Troubleshooter
Buttons are not being drawn correctly
Colour Line & Pasteboard colours are drawn incorrectly
CorelXARA gives GrowStub errors
CorelXARA is running slowly
On-line Demonstrations
Bitmap Tracer

De-installing Win32s

If you experience a problem which cannot be solved by any of the above, it is possible you 
are suffering from a fault in CorelXARA. Please refer to Technical Support for details of how to
report the problem.



CorelXARA gives GrowStub errors

Problem
As CorelXARA starts, there is a General Protection fault caused by "GROWSTUB in 
POINTER.DLL".

Cause
This problem is caused by a bug in GROWSTUB, which is part of the Microsoft Mouse driver 
version 9.01.

Recommended Action
Microsoft Mouse driver version 9.01b corrects this problem. Driver 9.01b is available via part 
number: 135-099-309 "Convert Mouse 2.0(dual) 9.01".
This driver does not introduce new functionality, therefore, you need only upgrade if you 
have run into this problem.

You can also avoid the problem by :
1. Open the file called "WIN.INI" which you will find in your Windows directory.
2. Find the line in the file beginning "load=".
3. Remove the section reading "POINTER.EXE" from this line.



CorelXARA is running slowly

Problem
If you find CorelXARA is running slowly on your machine (particularly on an 8Mb machine 
when the current document contains transparent objects) you may like to fine-tune the 
configuration to ensure it makes full use of your machine's resources. For 8Mb machines, we 
recommend at least 10Mb of virtual memory swap space - larger if possible.

Recommended Action
Alter the settings in the Tune up Options.



CorelXARA on-line help empty page
If you have reached this page, there is a fault with the On-line help system in CorelXARA. 
Please make a note of what you did to reach this help page and report this as a fault in 
CorelXARA to Corel Corp.
Please refer to Technical Support for more details.



Create Bitmap Copy (Arrange Menu)

The Create Bitmap Copy option creates a bitmap copy of the selected objects. When you 
select the option it opens the Create Bitmap dialogue box which allows you to set the 
options for the bitmap. Click the Create button to create the bitmap.
If you hold down SHIFT when you click the Create button in the dialogue box, the bitmap will 
be created on top of the selected objects. Note that this may mean it looks like nothing has 
changed after the bitmap has been created.

Bitmap Size and Resolution
These fields set the resolution (size) of the created bitmap. If you choose 96DPI, the bitmap 
will be the same resolution as it appears on screen. Either choose a resolution from the drop 
down menu or type a width or height into the fields.

Colour Depth
The number of colours in the exported bitmap can be set as follows :

24 Millions of colours
8 256 colours
4 16 colours
1 2 colours

Background
If you set the transparent option, any areas of the bitmap not covered by objects will be see-
through. The see-through areas are not done using normal CorelXARA transparency so you 
can apply transparency to the bitmap after you have created it.
Only objects with no fill colour will appear see-through, objects with transparency applied 
will not.

Palette
These options set whether the bitmap has the standard document palette or an optimised 
palette.

Dithering
You can select between three types of dithering with these options. Choosing none means 
there will be no dithering, ordered using an ordered (regular) dithering pattern and diffusion 
uses error-diffused dithering (a more complex dithering technique). In general, error 
diffusion will give the best results. You cannot use ordered dithering if you are using an 
optimised palette.
Note that you can set the dithering type for the screen display too, see View Options.

Tip
To create a bitmap copy quickly, right click on the selection and choose Create Bitmap Copy 
from the pop-up menu.



Create greyscale bitmap?

Cause
You have tried to apply contoning to a non-greyscale bitmap or you have attempted to apply
a non-greyscale bitmap as a bitmap transparency. Greyscale bitmaps must be used for the 
operations.

Recommended Action
Clicking Create will create a greyscale version of the bitmap and use that instead of the 
original. The new greyscale bitmap is added to the Bitmap Gallery with the same name as 
the original, but with "greyscale" appended to its name.
Clicking Cancel will cancel the operation.

If you do not wish to see this message, you can unset the Ask Before Making Greyscale 
Bitmaps option. See General Options.



 Create & delete control bars
To create a new control bar

1. Open the Control Bars dialog box using the Control Bars item on the Window menu.
2. Click the New button.
3. Enter the name for the new control bar.
4. Click OK.

This creates a new, floating control bar. You can now move or copy buttons on the new 
control bar. For more details, see Moving & resizing control bars and Moving & copying 
buttons.

To delete a control bar
1. Open the Control Bars dialog box using the Window menu.
2. Click on the name of the control bar in the dialog box.
3. Click the Delete button. CorelXARA asks you to confirm the deletion.

To restore the factory settings
1. Open the Control Bars dialog box using the Window menu.
2. Click the Reset button.

This is useful if you accidentally delete a control bar.

On-line Demonstration
    {button Creating Control Bars,EF("XaraDemo.exe","MakeBars.avi `Creating Control 

Bars'",1) }

Note
That you cannot delete the Button Palette control bar or the Infobar.
_______________
See also
Removing & restoring buttons



 Create World Wide Web Bitmaps
CorelXARA redraws pictures at an exceptional quality level and supports both transparency 
and interlacing in exported GIF files and is therefore ideal for creating bitmaps for 
publication on the World Wide Web. You can also create animated GIF files with CorelXARA, 
see Bitmap Export - Animated GIF.

            A GIF with transparency                                            A GIF file without transparency

The transparency used by World Wide Web browsers is extremely basic, but allows the 
removal of the background from pictures - this is particularly useful when the Web browser 
supports the use of bitmaps for backgrounds (as shown above). If Transparency is enabled 
when a GIF file is exported, any areas not covered by objects are left transparent in the file.

Note that transparency has a different meaning in GIF and CorelXARA terminologies. 
Transparency in GIF means that parts of the bitmap are completely 'see-through'. but any 
objects shown are completely solid. Transparency in CorelXARA means you can see through 
objects.

To create a WWW bitmap
1.      Create the image in CorelXARA as normal & select all objects in it.
2.      Set the Quality setting to high.
3.      Choose Export from the File menu.
4.      Choose GIF as the export format type (see CompuServe GIF Export).
5.      Choose the location to save the file, enter a filename & click Export.
6.      Enter the size, exported area & colour depth (256, 16 or 2 colour).
7.      Enable the GIF Interlacing setting.
8.      Enable the GIF Transparency setting.
9.      Choose the Diffusion dithering option if you want the image to look as good as 

possible, but remember the file may be larger.
10. Select whether you want to use the standard document palette or an optimised palette 

(see Tips).
11. Click Export to create the bitmap.

Bitmap Edges
If your final bitmap has see-through areas, it will look better if the edges of the objects in the
drawing are smoothed against the background colour. This is easily achieved if you place a 
copy of the background behind the objects when you export them (remember not to select 
the background). For example, import the background bitmap into CorelXARA and place it 
behind the drawing (ideally in a non-editable layer) and export as normal by selecting your 
drawing (not the background), it will export as before, but with its edges carefully anti-
aliased to the background. This will create a bitmap with very smooth edges.

Palettes
You can create completely non-dithered images for Netscape and Microsoft Internet Explorer 
by loading the WWW.PAL palette file included with this software and using the colours in it. 
This gives you access to a full range of colours which will be displayed without dithering in 
these two browsers (as long as you do not use blends, graduated transparency or graduated
fills). If you usually create WWW bitmaps, you might like to replace the default document 



with one using this set of colours, see Installing the WWW template document.
You may find it easier to use the Colour Gallery instead of the Colour Line to apply colours as
you can resize it to show all the colours in a small area.
Alternatively, always create use an optimised palette, these nearly always give exceptional 
results, but give slightly larger files.

Recommendations
For really good WWW bitmaps :

Always turn the Quality setting to its highest level.
Use error-diffused dithering (though remember this may increase the file size)
Use an optimised palette (this will also increase the file size)

Tips
If you create your bitmap using an optimised palette it will look far better in true 

colour (millions of colours) and high colour (thousands of colours) modes. You may also find 
that it looks better in 256 colour modes. You will nearly always get better results by using an
optimised palette, although you will usually find the file will be larger.

Remember CorelXARA includes a Pixel unit. If you turn on the grid and use pixels for 
the page units (see Units Options) and for the Grid and Ruler units (see Grid and Ruler 
Options) you can move objects by individual pixels and see all measurements measured in 
pixels.

To ensure you do not get any strange effects on the edges of your bitmap, align the 
outlines of objects with the edge of the bitmap you are creating. 

If your picture doesn't use many colours, try creating a 16 colour or 2 colour GIF, the 
file will be smaller.



 Create a named colour
Creating new named colours allows you to add your own custom colours (each individually 
named) to the Colour Line. You can create the new named colour using a colour you have 
already applied to an object, using an existing colour or from scratch. Named colours are 
also an ideal way to create drawings using many shades of different colours as you can link 
the colours so changing one changes all shades of that colour.

To create a named colour
1. Open the Colour Gallery.
2. Select the existing named colour in the gallery.
3. Click New.
4. If you would like the new colour to be a shade (see shade colour) of another named 
colour, select the shade option.
          If you would like the new colour to just be a copy of another colour, deselect the 
shade option.
5. Enter a name for the colour.
6. Click Create.

The new named colour is added to the Colour Line and displayed in the Colour Gallery.

To create a named colour from an object
1. Select an object which is filled with the required colour.
2. Open the Colour Editor.
3. Click the New Named Colour button to open the New Named Colour dialog box.
4. Deselect the shade option.
5. Enter a name for the new colour.
6. Click Create.

The new named colour is applied to the selected objects, added to the Colour Line and also 
shown in the Colour Gallery.

On-line Demonstration
    {button Defining Your Own Colours,EF("XaraDemo.exe","EditCol.avi `Defining Your Own 

Colours'",1) }
_______________
See also
Changing a named colour
Deleting a named colour
Using shades



Creating a new index

Cause
This message is displayed after attempting to create a new index for a folder.

Recommended action
Unless otherwise stated, the index and thumbnails will be placed in the XaraInfo 
subdirectory in the selected folder. This will require disk-space, and it is left up to you to 
delete this sub-directory if you require the space back. If this is OK, click Create, otherwise 
click Cancel.



 Create advanced blends
As mentioned in the multi-stage blending section of Blending objects, when you blend a 
blend object with another object, you create a new single multi-stage blend.    However, it 
can be useful to treat a blend object as an ordinary object before blending it.    You can do 
this by using groups. Here is an example :

1. Create a simple blend object by blending an ellipse to a rectangle (see Blending objects).
2. Ensure the ellipse and rectangle are widely spaced and contain different fill colours.
3. Select the blend (see Selecting & deselecting objects) and choose Group from the 

Arrange menu (or press CTRL+G). This creates a group that has just one object 
contained within it - the ellipse to rectangle blend.

4. Clone the group.
5. Move the clone group away from the original group (see Moving objects), but ensure 

both groups are visible on the page.
6. Choose the Blend Tool.
7. Blend from one group to the other.

You will see that each stage of the first blend is blended to each stage of the second blend, 
just as if they weren't blend objects at all.    Grouping the blend has effectively turned it into 
an ordinary object (as far as the Blend Tool is concerned).
You can use select inside (see Selecting objects inside other objects) to access either 
grouped blend object and change it as a blend (e.g. number of steps, etc).

On-line Demonstration
    {button Advanced Blending,EF("XaraDemo.exe","BlendFun.avi `Advanced Blending'",1) }



 Create fully justified text
CorelXARA does not support fully justified text blocks (frame text), but the effect can be 
achieved using the method described below.

To create a full-justified text block
1. Draw a horizontal line across the width of the text block.
2. Choose the Text Tool.
3. Click the Full Justification Button on the Infobar.
4. CTRL-click on the line to start the text at the start of the line.
5. Type the text, pressing RETURN when each line is filled to the required density.

The line can be rendered invisible by selecting the text object, choosing the Shape Editor 
Tool and right-clicking on the no colour (hatched) button on the Colour Line.



 Create guidelines
You can create guidelines in the guides layer using the Layer Gallery or simply by dragging 
out from the rulers.

Using the rulers
Do one of the following :

Drag from the ruler onto the editing window. For example to create a vertical 
guideline, drag from the left-hand ruler.

Double click on the ruler to create a guideline aligned at the click point. For example, 
to create a vertical guideline, double-click on the top ruler.

Using the Layer Gallery
1. Right click on the guides layer in the Layer Gallery to open the layer pop-up menu.
2. Choose Properties to open the Layer Properties dialog box.
3. Open the Guides tab.
4. Select Horizontal or Vertical.
5. Click New.
6. Type in the required position for the new guideline & click OK.

Note
After creating guidelines you can prevent them being accidentally moved. To do this turn off 
the Editable setting for the guides layer using the Layer Gallery.
_______________
See also
Show Rulers



 Create lighting effects
If you want to draw a picture of a shiny 3D object in most drawing programs you have to 
draw highlights as part of the object. The transparency system in CorelXARA makes this 
much easier. 

To add a lighting 'highlight' to a drawing
1. Create your drawing without worrying about highlights so that it looks matt and dull. 

Remember to include enough shading and shadows so that the object looks three-
dimensional.

2. Identify where a light source would bounce off the object into the viewers eye and draw 
a shape over that area. Set the colour of the object to white.

3. Use the Transparency Tool to make the object partly transparent and use the "Bleach" 
transparency type.

Bleach transparency is the key to this technique it allows the colours of the dull object 
underneath to be lightened. The most realistic highlights are achieved by using linear fills 
and circular fills in the highlight object or by drawing several highlight objects and blending 
them together (see Blending objects). You can alter the colour of the light source producing 
the highlights by altering the fill colour of the transparent highlight objects. White highlights 
objects look as if the light source is white. Slightly yellow highlights look as if the light source
is the sun. Orange highlights can make the object look as if it's being viewed at sunset.



 Create new text
To create text

1. Choose the Text Tool.
2. Position the pointer where the text is required and click - a red text cursor appears.
3. Set any attributes you would like to be applied to the text typed. e.g. fill colour, font, font
size.
4. Type the required text, pressing RETURN to create new lines if necessary.

See placing text around a curve for details of entering text directly onto a line or shape.

On-line Demonstration
    {button Entering Text,EF("XaraDemo.exe","Text.avi `Entering Text'",1) }

Note
To use a font for subsequent text typed, you can drag a font from the Font Gallery and drop 
it onto the text cursor.
_______________
See also
Editing text
Selecting text
Applying attributes to text
Text Tool Key Shortcuts
Entering special characters



 create parallel lines

To create parallel lines
1. Draw a line along the path between where you want the two lines. See Drawing a line.
2. Set it to the colour you want the two lines. See Colouring objects.
3. Set its line thickness so the line is wide enough to cover where the two parallel lines 

would be.
4. Clone the line.
5. Set the line colour of the clone to the background colour.
6. Reduce the line thickness of the clone.



Creating realistic shadows

To create a realistic shadow
1. Select your object(s) (on the left, above).
2. Clone them.
3. Apply Add Shapes to the clone to create a single shape covering the same area to form 
the shadow.
4. Set the fill colour of the new shape to black and move it behind the original objects, 
offset slightly - as shown in the centre above.
5. Making the back object transparent (see Applying transparency) allows you to see the 
background through it and creates a very realistic shadow.



Creating remote indexes

Cause
This message is displayed when the selected folder is read-only, but does not have an index.

Recommended action
If creating an index, and thumbnails, in the specified location is OK, click Create. If you do 
not want to create an index there, click Cancel.

Note that you can change the location which CorelXARA attempts to use for the remote 
indexes via the 'CORELXRA.INI' file which can be found in your Windows\System directory.

Exit CorelXARA, load the 'CORELXRA.INI' file into a text editor, such as Notepad, and add a 
directory path to the line that starts "RemoteIndexLocation=". (For example if your remote 
indexes were being written to your CorelXARA directory, you'd have the following line in your
ini file: "RemoteIndexLocation=C:\CorelXra".) Save the edited ini file, and re-run CorelXARA.



 Create the guides layer
It is only possible to have one guides layer. The guides layer is created automatically if you 
create a guideline using the rulers; see Creating guidelines. If you wish to create objects in 
the guides layer or move existing objects to the guides layer, you must create it manually.

To create the guides layer
1. Open the Layer Gallery.
2. Right-click on the Layer Gallery to open the pop-up menu.
3. Choose Create Guides Layer.

To place objects in the guides layer, click on the guides layer in the Layer Gallery (to make it 
the current layer) and create the objects as normal. For further details on creating guide 
objects, see Moving objects to the guides layer.



The Current Attributes are those attributes which get applied automatically to an object 
when it is created. For example, if the current line colour attribute were red, the next object 
drawn would have a red outline. if you intend to draw many objects that are to share the 
same attributes, then it is useful to make these shared attributes Current Attributes. In 
CorelXARA, Text objects have their own separate set of Current Attributes. See Setting the 
current attributes for more details.



The Current Fill Attribute is the current default setting for the fill attribute which is the 
type of fill that will be applied to newly created objects. To set the current fill attribute, apply
a fill with no objects selected.



The Current Layer is that currently selected (highlighted) in the Layer Gallery. It is the 
layer into which all newly created objects are inserted. The equivalent in CorelDRAW is the 
'active layer'.



Curve Edit Handles are handles used on curved line segments to alter the curve shape. 

The curve edit handles for selected point handles are only shown if there is one selected 
point handle. The two curve edit handles for the selected point are shown plus the nearest 
curve edit handles for adjacent points.



Custom Bitmap Effects allow you to alter the brightness of each pixel in a bitmap 
depending on the brightness of adjacent pixels using a method known as convolution. The 
matrix on the right of the Bitmap Effects dialog box controls the process. Type values into 
the matrix such that the sum of all the values is 1.
For example :

-2 -1 0
-1 1 1
0 1 2



 Cut (Edit Menu) 
 CTRL+X

Cuts the currently selected object(s) to the clipboard. This means the selected objects are 
removed from the document. Note that you can use    get the objects back in the same place
(or use CTRL-SHIFT-V to paste the objects back in the same place). Once the objects are on 
the clipboard they can be pasted back into the document any number of times, pasted into 
other documents or even into other applications. For more information, see Paste.
Copy is the same as Cut, but copies the objects to the clipboard leaving the selection in the 
document

Cut is also available from the Selection Pop-up Menu.



The Cyan colour component is used in the CMYK (Cyan, Magenta, Yellow, Key) colour model, 
which is commonly used by printers. By mixing various quantities of these four inks, a large 
range of colours can be generated.



Dashing is a term used by CorelDRAW to describe patterns applied to lines and shape 
outlines. In CorelXARA these options are available using the Line Gallery.



 De-installing Win32s
If it you need to reinstall Win32s, it will be necessary to remove it first. The following process
will remove all files installed by the Win32s installer. This process applies to Win32s 1.0, 1.1, 
1.15 and 1.2. This process will remove all of Win32s from your system.

To remove Win32s
1. Remove the following line from [386Enh] SYSTEM.INI in your Windows directory.

device=<WINDOWS>\<SYSTEM>\Win32s\w32s.386
Where <WINDOWS> and <SYSTEM> are the names of your Windows and System 
directories. This will normally be \Windows\System. (e.g. C:\Windows\System)

2. Find the following line in the [BOOT] section of SYSTEM.INI :
drivers=mmsystem.dll winmm16.dll

and change it to :
drivers=mmsystem.dll

3. Delete the following files from your Windows System directory (normally \Windows\
System) :
W32SYS.DLL
WIN32S16.DLL
WIN32S.INI

4. Delete all the files in the <WINDOWS>\<SYSTEM>\WIN32S subdirectory.
5. Delete the <WINDOWS>\<SYSTEM>\WIN32S directory.
6. Restart Windows.



 De-install a font
To de-install a font

1. Open the Font Gallery.
2. Find and select the required font(s) in the Installed section of the gallery (see Selecting 

items in a gallery).
3. Click the De-install button.

Note that you can only de-install fonts listed in Installed fonts.

A few programs will continue to show a de-installed font in their font list unless you quit and 
then reload them. This is beyond the control of CorelXARA.
_______________
See also
Installing a font



The Default Bitmap is always present in CorelXARA documents (in the Bitmap Gallery). 
This default bitmap is the Xara Ltd logo in greyscale and can be used like any other bitmap 
but cannot be deleted.



Default Control Bars

CorelXARA contains several default control bars in addition to the Toolbar and the tool-
specific Infobar. The Button Palette contains all the buttons available in CorelXARA. You can 
copy buttons from the Button Palette to existing or new control bars. You can also remove 
buttons from control bars (but not from the Button Palette.) Descriptions of the functions of 
the buttons can be found in the following pages :

Standard Control Bar
File Control Bar
Edit Control Bar
Arrange Control Bar
Window Control Bar
Gallery Control Bar
General Control Bar

Button Palette Control Bar
_______________
See also
Hidden buttons
Moving & copying buttons
Creating & deleting control bars
Moving & resizing control bars
Removing & restoring buttons



- A -
Alignment
Anti-Aliasing
Application Control Menu
ArtWorks
ATM
Attribute

- B -
Background Redraw
Bar
Bevelled Join
Bezier
Bitmap
Bitmap Fill
Bitmap Transparency
Bleach (Transparency Type)
Blend
Blur (Bitmap Effect)
Bounding Box
Butt Cap

- C -
Circular Fill
Circular Transparency
Clipboard
CMYK
Colour Model
Conical Fill
Conical Transparency
Contone
Control Bar
Current Attribute
Current Fill Attribute
Current Layer
Curve Edit Handle
Custom Bitmap Effect

- D -
Dash
Default Bitmap
Description
Dilation (Bitmap Effect)
Docked
Document
Document Control Menu

- E -
Edge Detection (Bitmap Effect)
Edit Handle
Elliptical Fill
Elliptical Transparency
em
Envelope Mould
EPS & EPSF

- F -
File Format
Fill Arrow



Fill Handle
Flat Fill
Flat Transparency
Floating
Folder
Font
Fractal Fill
Fractal Transparency
Full-screen Mode

- G -
Gallery
GIF
Grid
Guides Layer
Guide Object
Guideline

- H -
Handle
HSV
Hue

- I -
Infobar
Interlacing (GIF)
Inter-line Spacing
Isolate Points (Bitmap Effect)

- J -
JPEG

- K -
Kern
Key
Keyword

- L -
Laplacian (Bitmap Effect)
Layer
Line
Linear Fill
Linear Transparency
Linked Colours
Local Colour

- M -
Magnetic
Mitre Join
Mirroring
Mix (Transparency Type)

- N -
Named Colour
Normal Colour
Normal Mode

- O -
Object
Outlining

- P -
Page
Panning
Perspective Mould



PhotoCD
Point Handle
PostScript

- Q -
Quality
QuickShape

- R -
Redo
Redraw
Rendering
RGB
Robert's Cross (Bitmap Effect)
Rotate/Skew Mode
Round Cap
Round Join
Ruler

- S -
Saturation
Scale Mode
Scrollbar
Selection
Selection Handle
Select Inside
Selection Marker
Select Member
Select Under
Shade Colour
Shape
Sharpen (Bitmap Effect)
Slider
Snapping (Magnetic)
Spread
Square Cap
Stained Glass (Transparency Type)

- T -
Template Document
Temporary Directory
Text Cursor
Text Object
Tint Colour
Tool
Tracer
Tracking
Transformation Centre
Transparency
Transparency Arrow
Transparency Handle
TrueType

- U -
Undo

- V -
Value
Vector Format
View
Visual Selector



- Y -
Yellow

- Z -
Zoom



 Delete (Edit Menu)
 DEL (Delete)

Delete removes the selection from the document. Unlike Cut, Delete does not copy the 
selection to the clipboard, the clipboard is not affected in any way by Delete. A Delete 
operation can be reversed using Undo.

Delete is also available from the Selection Pop-up Menu.



 Delete a named colour
1. Select the named colour(s) in the Colour Gallery.
2. Click the Delete button in the gallery.

Note
If any of the named colours you selected are in use in the document you will be asked to 
confirm the deletion. If you choose to delete even the used colours, any objects previously 
using these colours will look the same, but will now have local colours applied.
_______________
See also
Creating a named colour
Changing a named colour



 Delete guidelines
Do one of the following :

Drag the guideline back onto the appropriate ruler.
Right-click on the guideline to open the guideline pop-up menu and choose Delete.

Note that guidelines cannot be deleted if the editable setting for the guides layer has been 
turned off in the Layer Gallery.



 Delete points on lines and shapes
1. Select the line(s) or shapes(s) (see Selecting & deselecting objects).
2. Choose the Shape Editor Tool.
3. Select the points (see Selecting points on lines and shapes).
4. Click the Delete Point(s) Button on the Infobar.



 Delete the guides layer
To Delete the guides layer

1. Open the Layer Gallery.
2. Click the guides layer to select it.
3. Click the Delete button.

If the guides layer contains objects you will be asked to confirm the deletion.



On-line Demonstrations

The following is a full list of categories of CorelXARA On-line demonstrations. Click on the 
button to run the demonstration. For more details on how to view and operate the on-line 
demonstrations, see Viewing the on-line demonstrations.

CorelXARA Basics
Colour
Manipulating Objects
Blending & Moulding
Text
Bitmaps
Lines & Shapes
Fills & Transparency
Control Bars



Demonstrations - Bitmap

    {button Bitmap Editing,EF("XaraDemo.exe","Bitmaps.avi `Bitmap Editing'",1) }
    {button Bitmap Fills,EF("XaraDemo.exe","BmapFill.avi `Bitmap Fills'",1) }
    {button Bitmap Tracer,EF("XaraDemo.exe","Tracer.avi `Tracing Bitmaps'",1) }



Demonstrations - Blending & Moulding

    {button Simple Blending,EF("XaraDemo.exe","Blend.avi `Simple Blending'",1) }
    {button Advanced Blending,EF("XaraDemo.exe","BlendFun.avi `Advanced Blending'",1) }

    {button Envelope Moulds,EF("XaraDemo.exe","Envelope.avi `Envelope Moulds'",1) }
    {button Perspective Moulds,EF("XaraDemo.exe","Perspect.avi `Perspective Moulds'",1) }



Demonstrations - Colour

    {button Colouring Objects,EF("XaraDemo.exe","Colours.avi `Colouring Objects'",1) }
    {button Defining Your Own Colours,EF("XaraDemo.exe","EditCol.avi `Defining Your Own 

Colours'",1) }



Demonstrations - Control Bars

    {button Moving and Copying Buttons,EF("XaraDemo.exe","Buttons.avi `Moving and 
Copying Buttons'",1) }

    {button Moving and Resizing Control Bars,EF("XaraDemo.exe","CtrlBars.avi `Moving and 
Resizing Control Bars'",1) }

    {button Creating Control Bars,EF("XaraDemo.exe","MakeBars.avi `Creating Control 
Bars'",1) }



Demonstrations - CorelXARA Basics

These demonstrations will explain the basics behind making use of CorelXARA. The first 
demonstration is a full-length movie displaying the wide range of features provided by 
CorelXARA.

                    {button CorelXARA Demonstration,EF("XaraDemo.exe","Intro.avi `CorelXARA 
Demonstration'",1) }

    {button Selection Handles,EF("XaraDemo.exe","SelHands.avi `Selection Handles'",1) }
    {button Selecting Objects,EF("XaraDemo.exe","Select.avi `Selecting Objects'",1) }
    {button Display Quality,EF("XaraDemo.exe","WYSIWYG.avi `Display Quality'",1) }
    {button Magnifying and Moving a Document,EF("XaraDemo.exe","ZoomPan.avi 

`Magnifying and Moving a Document'",1) }
    {button Moving Objects,EF("XaraDemo.exe","Moving.avi `Moving Objects'",1) }
    {button Full Screen Mode,EF("XaraDemo.exe","FullScrn.avi `Full Screen Mode'",1) }
    {button Layers,EF("XaraDemo.exe","Layers.avi `Layers'",1) }
    {button Selecting Objects In Objects,EF("XaraDemo.exe","SelInsid.avi `Selecting Objects 

In Objects'",1) }
    {button Selecting Objects Under Objects,EF("XaraDemo.exe","SelUnder.avi `Selecting 

Objects Under Objects'",1) }
    {button Magnetic Snapping,EF("XaraDemo.exe","Magnet.avi `Magnetic Snapping'",1) }



Demonstrations - Fills & Transparency

    {button Bitmap Fills,EF("XaraDemo.exe","BmapFill.avi `Bitmap Fills'",1) }
    {button Fractal Fills,EF("XaraDemo.exe","Fractals.avi `Fractal Fills'",1) }
    {button Linear Circular Elliptical and Conical Fills,EF("XaraDemo.exe","GradFill.avi `Linear

Circular Elliptical and Conical Fills'",1) }

    {button Simple Transparency Effects,EF("XaraDemo.exe","Transpar.avi `Simple 
Transparency Effects' ",1) }

    {button    Transparency Applications,EF("XaraDemo.exe","Transfun.avi    `Transparency 
Applications' ",1) }



Demonstrations - Lines & Shapes

    {button Drawing Lines and Shapes with the Shape Editor 
Tool,EF("XaraDemo.exe","CurvDraw.avi `Drawing Lines and Shapes with the Shape Editor 
Tool'",1) }

    {button Drawing Lines and Shapes with the Freehand 
Tool,EF("XaraDemo.exe","FreeDraw.avi `Drawing Lines and Shapes with the Freehand 
Tool'",1) }

    {button Drawing Lines and Shapes with the Pen Tool,EF("XaraDemo.exe","PenDraw.avi 
`Drawing Lines and Shapes with the Pen Tool'",1) }

    {button Editing Lines and Shapes with the Shape Editor 
Tool,EF("XaraDemo.exe","CurvEdit.avi `Editing Lines and Shapes with the Shape Editor 
Tool'",1) }

    {button Editing Lines and Shapes with the Freehand 
Tool,EF("XaraDemo.exe","FreeEdit.avi `Editing Lines and Shapes with the Freehand 
Tool'",1) }

    {button Editing Lines and Shapes with the Pen Tool,EF("XaraDemo.exe","PenEdit.avi 
`Editing Lines and Shapes with the Pen Tool'",1) }

    {button Editing Line Width Ends and Joins,EF("XaraDemo.exe","LineBits.avi `Editing Line 
Width Ends and Joins'",1) }

    {button Smoothing Lines and Shapes,EF("XaraDemo.exe","Smooth.avi `Smoothing Lines 
and Shapes'",1) }

    {button Joining and Breaking Lines and Shapes,EF("XaraDemo.exe","JoinBrk.avi `Joining 
and Breaking Lines and Shapes'",1) }

    {button Ellipses and Circles,EF("XaraDemo.exe","ellipses.avi `Ellipses and Circles'",1) }
    {button Rectangles and Squares,EF("XaraDemo.exe","oblong.avi `Rectangles and 

Squares'",1) }
    {button QuickShapes,EF("XaraDemo.exe","Regular.avi `QuickShapes'",1) }



Demonstrations - Manipulating Objects

    {button Aligning and Distributing Objects,EF("XaraDemo.exe","AlgnDist.avi `Aligning and
Distributing Objects'",1) }

    {button Moving Objects Backwards and Forwards within a 
Layer,EF("XaraDemo.exe","Arrange.avi `Moving Objects Backwards and Forwards within a 
Layer'",1) }

    {button Duplicating and Cloning Objects,EF("XaraDemo.exe","DupClone.avi `Duplicating 
and Cloning Objects'",1) }

    {button Grouping Objects,EF("XaraDemo.exe","Groups.avi `Grouping Objects'",1) }
    {button Adding Objects,EF("XaraDemo.exe","AddShape.avi `Adding Objects'",1) }
    {button Intersecting Objects,EF("XaraDemo.exe","IntShape.avi `Intersecting 

Objects'",1) }
    {button Slicing Objects,EF("XaraDemo.exe","Slice.avi `Slicing Objects'",1) }
    {button Subtracting Objects,EF("XaraDemo.exe","SubShape.avi `Subtracting Objects'",1)

}
    {button Converting Objects to Simple Editable Shapes,EF("XaraDemo.exe","mkshape.avi 

`Converting Objects to Simple Editable Shapes'",1) }



Demonstrations - Text

    {button Entering Text,EF("XaraDemo.exe","Text.avi `Entering Text'",1) }
    {button Editing Text,EF("XaraDemo.exe","EditText.avi `Editing Text'",1) }
    {button Advanced Text,EF("XaraDemo.exe","TextFun.avi `Advanced Text'",1) }



A Description can be stored with each CorelXARA document which is displayed when the 
file is added to the Clipart Gallery. See Document Info for further information.



Deselect All Points

This option on the Point Handle pop-up menu deselects all point handles which are currently 
selected.



 Deselect objects
To deselect a selected object

1. Choose the Selector Tool.
2. SHIFT-click on the selected object to swap it from being selected to not being selected.

    SHIFT-Click to swap the object under the mouse pointer between selected and not 
selected

To deselect all objects
Do one of the following :

Choose the Selector Tool and click on a blank area of the page.
Choose Clear Selection from the Edit menu,
Press ESC (Escape).



Dilation (Bitmap Effect) widens light areas and narrows dark areas of bitmaps. Its main use 
is emphasising edges after using Edge Detection or Isolate Points.



 Display and hide guides
CorelXARA uses two types of guide; guidelines and guide objects, both of which live within 
the guides layer. To display or hide the guides you must display or hide the guides layer.

To display or hide the guides layer
Do one of the following :

Choose Show Guides from the Window menu.
Open the Layer Gallery and click the left-hand option on the left of the guides layer to

swap it between visible and hidden. (see Layer Gallery - Editable and Visible Settings)

Both operations have exactly the same effect.



 Display and hide the rulers
1. Choose Bars from the Window menu.
2. Choose Rulers from the submenu to hide or display the rulers.



Dithering is a technique where patterns are applied to areas of colour in order to simulate a
wider colour range. It works very well in pictures which contain a large number of colours. 
CorelXARA uses two types of dithering, simple ordered dithering and the more complex error
diffused dithering. Remember that if you use dithering when you create a bitmap, it may not
compress as well, e.g. the GIF file will be larger.



A Docked control bar is one which is attached to one of the edges of the CorelXARA window 
and moves with the window. A docked control bar can be dragged away from the edge of the
window so it becomes a floating control bar.

                            A docked control bar



You can think of a Document as a conventional sheet of paper. Like a sheet of paper, you 
can draw lines and write text (and erase them later). You can save the document for later 
use by storing it on disk or printing it.
Unlike conventional paper, the computer provides you with many extra options. You can 
move objects around on the document just by grabbing them and sliding them around, even 
over other objects. You can copy objects and reuse them, either in the same document or in 
a different document.
CorelXARA documents are displayed as a page (or spread) with a wide margin around all four
sides shown in grey on screen. You can create objects on the page margin before moving 
them onto the page, or move objects onto the page margin for temporary storage.



The Document Control Menu contains options for manipulating documents (for example, 
closing, minimising & maximising)
To display the menu using the keyboard press ALT+HYPHEN.



 Document Info (File Menu)

Document Info opens the Document Information dialog box which displays information about
the current document. It also contains a comments field which you can use to add a title, 
description and keywords to the document.

Location
The folder where the file is located.

File Name
The name given to the document.

Created
The time and date when the document was created.

Last Saved
The time and date when the document was last saved.

Memory Used
The total memory used by the document.

Undo Size
The amount of memory used by undo information. See Undo.

Undo Steps
The number of undo steps stored.

Number of Bitmaps
The total number of bitmap in the current document.

Bitmap Size
The amount of memory used by bitmaps in the current document.

Number of Fractals



The total number of fractal fills and fractal transparencies in the document.

Fractal Size
The amount of memory used by fractals

Number of Objects
The total number of objects in the document.

Number of Selected Objects
The total number of objects in the Selection.

Document Fonts
This drop-down list contains a full list of all the fonts contained in the document. If the 
document uses a font not currently installed on your PC, an asterisk ( * ) will appear next to 
the font name.

Comments
The comments field allows details about the file to be added to the document. It can also be 
used for adding keywords and a title to a file which is then displayed in the Clipart Gallery. 
Note that the first line of this field is stored as the description of the file and will be displayed
in the Clipart Gallery if the file is added to it.
_______________
See also
Using titles, descriptions and keywords



Document file is invalid

Cause
The file you tried to open or import is corrupt or has the wrong format.

Recommended action
Recreate the document file from a backup or from the original creating program.



Document is unsaved

Cause
You have tried to close a document, or exit CorelXARA when a document has changes that 
have not been saved to disk.

Recommended action
Click the Save button if you want to save your work.    
Click the Don't Save button to discard the changes you have made to the document.
Click the Cancel button to cancel the close. This lets you continue running CorelXARA.



 Draw a light source
Bleach transparency is ideal for drawing bright light sources.

To create a light source
1. Draw a large rectangle covering the entire drawing and flat fill it with the required light 

source colour.
2. Select the rectangle.
3. Choose the Transparency Tool.
4. Apply a circular transparency to the rectangle.
5. Change the transparency type to Bleach.
6. Clone the rectangle (this improves the look of the effect) and group with the original. 

It is recommended that you cover the whole drawing with the rectangle containing the light 
source transparencies because you can then experiment with which area of the drawing is 
affected by the light source. 



 Draw a line
You can use the Pen, Shape Editor or Freehand Tools to draw lines.

The Shape Editor Tool is the most flexible and can also edit lines.
The Pen Tool is provided for users familiar with programs such as CorelDRAW & Adobe 
Illustrator.
The Freehand Tool lets you draw and edit lines by following freehand mouse movements.

What do you want to do?
Draw a line with the Shape Editor Tool
Draw a line with the Pen Tool
Draw a line with the Freehand Tool



 Draw a line with the Freehand Tool
To draw a line

1. Choose the Freehand Tool.
2. Place the mouse pointer at the start of the line.
3. Drag the mouse to draw a line.
4. Release the mouse button to complete the line.

Important: line drawing stops as soon as you release the mouse button.

As you are drawing the line you can do the following :
Draw straight lines sections
Erase part of the freehand line

When you have finished drawing the line you can smooth it. See Smoothing a freehand line.

On-line Demonstration
    {button Drawing Lines and Shapes with the Freehand 

Tool,EF("XaraDemo.exe","FreeDraw.avi `Drawing Lines and Shapes with the Freehand 
Tool'",1) }



 Draw a line with the Pen Tool
1. Choose the Pen Tool
2. Place the mouse pointer at the position of the first point and click.
3. Move the pointer to the next position along the line.
4. Do one of the following :

Drag to add a curved segment and shape it
Click to add a straight segment.

5. Repeat step 4 as necessary.
6. Complete the line with a SHIFT-click.

On-line Demonstration
    {button Drawing Lines and Shapes with the Pen Tool,EF("XaraDemo.exe","PenDraw.avi 

`Drawing Lines and Shapes with the Pen Tool'",1) }
_______________
See also
Extending a Line 
Drawing a shape



 Draw a line with the Shape Editor Tool
1. Ensure no lines or shapes are selected.
2. Choose the Shape Editor Tool
3. To draw a straight line, click the Straight lines button on the Infobar or press S.
        To draw a curved line, click the Curved lines button on the Infobar or press C.
4. Click where you want to start drawing. A point handle will appear in the document.
5. Click where you want the line to be drawn to. If the mouse button is held down, you can 

move the end point before it is drawn. Each subsequent click will add a new line 
segment.

          To swap between drawing straight and curved line segments, repeat step 3.
6. Complete the line by:

SHIFT-clicking away from the line
or clicking on the start point to close the line and create a shape filled with the 

current fill attribute.

Note: if an end point handle is selected, clicking adds a new line segment.

If CTRL is held down during a drag, the handle will be constrained to the angle set in the 
General Options.

On-line Demonstration
    {button Drawing Lines and Shapes with the Shape Editor 

Tool,EF("XaraDemo.exe","CurvDraw.avi `Drawing Lines and Shapes with the Shape Editor 
Tool'",1) }



 Draw a shape
As a shape is just a line where the end points touch, to create a new shape you just draw 
using any of the Shape Editor Tool, Pen Tool or Freehand Tool and make the start and end of 
the line coincide. The mouse pointer changes to show a '+' to indicate the shape will be 
closed. When a shape is created, it is filled with the current fill attributes.

Shape Editor Tool
1. Ensure the line is selected and the Shape Editor Tool has been chosen.
2. Do one of the following:

Drag one end of the line over the other and release.
Select one end point handle & click on the other.

Pen Tool
1. Ensure one point handle on the end of the line is selected & the Pen Tool has been 

chosen.
2. Click on the other end point handle.

Freehand Tool
1. Ensure the line is selected & the Freehand Tool has been chosen.
2. Place the pointer over one end of the line (the mouse pointer will show a '+').
3. Drag to the other end of the line & release.

A shape can be drawn with the Freehand Tool simply by drawing a line and finishing it at the 
start point.
_______________
See also
Drawing a line



 Draw concentric circles

Method 1
1. Choose the Ellipse Tool.
2. CTRL-drag to create a circle. (Remember that CTRL constrains the ellipse to a circle).
3. Choose Clone from the Edit menu. This creates a duplicate on top of the original.
4. Choose the Selector Tool.
5. SHIFT-drag one of the corner selection handles (in scale mode). This scales the top-most 

circle around its centre which is also the centre of the original circle.

Method 2
1. Turn on grid snapping. See Snap To Grid.
2. Choose the Ellipse Tool.
3. CTRL-SHIFT-drag to create a circle by its centre. The centre of the circle will be locked 

onto the grid.
4. CTRL-SHIFT-drag starting at the same point (ensuring the circle centre locks onto the 

grid in the same place).

Method 3
1. Turn on magnetic snapping. See Snap To Objects.
2. Choose the Ellipse Tool.
3. CTRL-drag twice to create two circles.
4. Choose the Selector Tool.
5. Drag one of the circles by its centre. The centre of the circle will now snap to other 

objects in the document. The magnetic snap indicator on the Status Line indicates when 
the centre of the second circle is over the centre of the first circle - releasing the mouse 
button at this point aligns the circles exactly.

All of these methods also work for creating "concentric" rectangles and ellipses and 
"concentric" QuickShapes. There are other methods not described here.



 Draw ellipses & circles
Ellipses and circles are drawn using the Ellipse Tool. It is also possible to use the QuickShape 
Tool, though it is generally easier to use the Ellipse Tool.

1. Choose the Ellipse Tool or QuickShape Tool.
2. QuickShape Tool: depress the Ellipse button on the Infobar.
3. Choose the method to be used to draw the ellipse:

By Radius - depress the Radius Creation Button on the Infobar.
By Diameter - depress the Diameter Creation Button on the Infobar.
By Bounds - depress the Bounds Creation Button on the Infobar.
(By Radius and By Diameter create circles.)

4. Drag on the page to create the ellipse

Holding down CTRL during a By Bounds drag creates a circle instead of an ellipse.
Holding down SHIFT during the drag will force creation around the centre of the ellipse. If 
Diameter creation is selected, this will force the use of Radius creation.
_______________
See also
Editing ellipses & circles



 Draw motion blur

To draw a motion blurred shape
1. Draw the shape to be blurred.
2. Clone the shape.
3. Apply a flat transparency of (for example) 85% to the clone.
4. Clone the transparent shape.
5. Move the new shape in the blur direction.
6. Alter the transparency of the second shape to be almost 100%.
7. Blend between the two transparent shapes.
8. Increase the number of blend steps as required.



 Draw polygons
1. Choose the QuickShape Tool.
2. Set the required number of sides in the Number of sides field on the Infobar.
3. Choose the method to be used to draw the polygon:

By Radius - depress the Radius Creation Button on the Infobar.
By Diameter - depress the Diameter Creation Button on the Infobar.
By Bounds - depress the Bounds Creation Button on the Infobar.

4. Drag on the page to create the polygon.
5. Use the curved corners and star buttons on the Infobar to apply these features to the new
polygon.

Holding down CTRL during a radius and diameter drag will constrain the shape to certain 
angles.
Holding down CTRL during a bounds drag will constrain the shape to being regular.
Holding down SHIFT during the drag will force creation around the centre of the polygon.
_______________
See also
Editing polygons
Drawing starred polygons



 Draw rectangles & squares
Rectangles and squares are drawn using the Rectangle Tool. It is also possible to use the 
QuickShape Tool, though it is generally easier to use the Rectangle Tool.

To draw a rectangle
1. Choose the Rectangle Tool or QuickShape Tool.
2. QuickShape Tool: depress the Polygon Button on the Infobar.
3. QuickShape Tool: set the Number of sides field on the Infobar to 4.
4. Choose the method to be used to draw the rectangle:

By Radius - depress the Radius Creation Button on the Infobar.
By Diameter - depress the Diameter Creation Button on the Infobar.
By Bounds - depress the Bounds Creation Button on the Infobar.

(By Radius and By Diameter create squares.)
5. Drag on the page to create the rectangle.

Holding down CTRL during a By Bounds drag creates a square instead of a rectangle.
Holding down SHIFT during the drag will force creation around the centre of the rectangle. If 
Diameter creation is selected, this will force the use of Radius creation.
_______________
See also
Editing ellipses & circles



 Draw starred polygons
1. Choose the QuickShape Tool.
2. Click on the Star Button on the Infobar.    Note that this will make all selected 

QuickShapes starred, so you may want to press ESCAPE to clear the selection. 
3. You can click the Curved Corners Button too, if you want the shape to have curved 

corners.
4. Choose the method to be used to draw the polygon:

By Radius - depress the Radius Creation Button on the Infobar.
By Diameter - depress the Diameter Creation Button on the Infobar.
By Bounds - depress the Bounds Creation Button on the Infobar.

5. Drag on the page to create the polygon.

Holding down CTRL during a radius and diameter drag will constrain the shape to certain 
angles.
Holding down CTRL during a bounds drag will constrain the shape to being regular.
Holding down SHIFT during the drag will force creation around the centre of the polygon.
_______________
See also
Editing starred polygons
Drawing polygons



 Draw straight lines with the Freehand Tool
To insert a straight section while drawing a freehand line with the Freehand Tool, press ALT 
during the drag, move the mouse pointer to the end of the straight section and release ALT. 
(The straight line is shown while the ALT key is pressed.) You can then continue drawing the 
freehand line.

The straight section can be constrained to the angle set in the General Options using CTRL.



 Duplicate (Edit Menu) 
 CTRL+D

Duplicate creates a copy of the selection. The copy is offset from the original by a distance 
and direction defined in the General Options. After the copy has been created, it is selected 
and the original deselected.

Duplicate is also available from the Selection Pop-up Menu.

On-line Demonstration
    {button Duplicating and Cloning Objects,EF("XaraDemo.exe","DupClone.avi `Duplicating 

and Cloning Objects'",1) }

Note
You cannot duplicate objects selected using Select inside. (See Selecting objects inside 
objects.) This includes selected regions within text objects.



EPS & EPSF are Encapsulated PostScript - a variant of the PostScript language. EPS is 
commonly used as a file format to transfer data between different programs. Not all 
CorelXARA commands can be implemented in EPS format and so some information is lost 
when you export as EPS. 
PostScript is a trademark Of Adobe Systems Inc. 



Edge Detection (Bitmap Effect) highlights sharp edges in bitmaps. You can detect edges 
with a specific orientation. e.g. vertical or 45 degrees. See Bitmap Effects for further details.



Edit Control Bar

Cut
Copy
Paste
Paste Attributes
Paste in Same Position
Delete
Select All
Clear Selection
Duplicate
Clone

_______________
See also
Default Control Bars



Edit Handles are used to edit objects. They appear on the object itself and are specific to 
the object type. Their function is different depending on which type of object they are on. 
Edit handles can be be used to edit the shape of lines, shapes and QuickShapes for example.
Edit handles can be displayed when the Selector Tool has been chosen allowing objects of 
different types to be edited using one Tool.

Edit handles appear on each selected object and allow editing operations specific to the 
object type. Edit handles appear most object types, including moulds, lines, shapes, 
QuickShapes and groups. Edit handles are very similar to the handles used by Macromedia 
Freehand and Microsoft Office. See Enabling edit handles.



Edit Menu

Undo
Redo

Cut
Copy
Paste
Paste Attributes
Delete
Select All
Clear Selection

Duplicate
Clone



 Edit a bitmap fill

Bitmap fills are controlled using a pair of fill arrows joined at one end with three associated 
fill handles. The arrows point from the centre of the bitmap to its top and right-hand edges 
and so control its position and the angles of the sides of the bitmap. The central fill handle 
controls the position of the bitmap.

To Move a Fill Handle
Select the object with the fill applied and simply drag the fill handle using the Fill Tool or 
Selector Tool (if Fill handles have been enabled - see Enabling fill handles & fill arrows).
If the CTRL key is held down whilst dragging a fill arrow, the angle of the arrow will be 
constrained to 45 degree intervals.

The mouse pointer when over a fill handle

If the SHIFT key is held down whilst dragging a fill arrow, the angle between the two fill 
arrows is locked during the drag, i.e. the bitmap is prevented from being stretched or 
skewed and can be scaled easily.

When in the Fill Tool, you can nudge the selected fill handle(s) using the cursor keys on the 
keyboard. CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, 
respectively).

To Alter Fill Colour
You can create a contone or duotone bitmap fill by applying colours to the fill handles. Click 
on a fill handle to select it and do one of the following :

Click on a colour on the Colour Line
Double click a colour in the Colour Gallery
Select a colour in the Colour Gallery and click Apply.

Note that if none of the fill handles are selected, this applies a flat fill.

To return a bitmap fill to its original colours, apply 'no colour' to both fill handles using the 
Colour Line.
To select all fill handles of a particular type (e.g. all centre (start) handles) within the 
selection, CTRL+SHIFT-click on one of the handles.
SHIFT-click can be used to select additional fill handles.

Fill Effect
The way in which the bitmap palette changes from the start to the end colours can be 
altered using the Fill Effect Field on the Fill Tool Infobar.

Resolution
The resolution (or size) of the bitmap fill can be altered accurately using the Bitmap Fill 
Resolution Field on the Fill Tool Infobar.

Bitmap Tiling
The tiling (repetition) of the bitmap in the fill can be altered using the Bitmap Tiling Field on 
the Fill Tool Infobar.
_______________



See also
Applying a bitmap fill



 Edit a circular fill

Circular fills are controlled using a single fill arrow with a fill handle on either end. Each end 
of the arrow has a colour associated with it and the fill graduates from the colour at the start
handle (in the centre ) to the end handle on the radius.

To Move a Fill Handle
Select the object with the fill applied and simply drag the fill handle using the Fill Tool or 
Selector Tool (if Fill handles have been enabled - see Enabling fill handles & fill arrows).
CTRL-dragging a fill handle constrains movement to 45 degree intervals.

The mouse pointer when over a fill handle.

When in the Fill Tool, you can nudge the selected fill handle(s) using the cursor keys on the 
keyboard. CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, 
respectively).

To Alter Fill Colour
Simply drag a colour from the Colour Line or the Colour Gallery onto the filled object - as the 
mouse pointer moves over the object, it changes shape to show where the colour will be 
applied :

Dropping the colour will apply it to the outside (end handle) of the circular fill
Dropping the colour will apply it to the centre (start handle) of the circular fill

The fill colours can also be altered by applying colour direct to the fill handles. Click on a fill 
handle to select it and do one of the following :

Click on a colour on the Colour Line
Double click a colour in the Colour Gallery
Select a colour in the Colour Gallery and click Apply.

Note that if there are no fill handles selected, applying colour in this way creates a flat fill of 
the chosen colour.
To select all fill handles of a particular type (e.g. all centre (start) handles) within the 
selection - CTRL+SHIFT-click on one of the handles.
SHIFT-click can be used to select additional fill handles.

Fill Effect
The way in which the colours change across the fill from the start to the end colours can be 
altered using the Fill Effect Field.
_______________
See also
Applying circular fills



 Edit a conical fill

Conical fills are controlled using a single semicircular fill arrow with a fill handle on either 
end. Each end of the arrow has a colour associated with it and the fill graduates radially from
the colour at the start handle to the end handle on the opposite side. There is a third fill 
handle in the centre of the fill controlling its position; this handle cannot be selected or have 
colour applied to it.
Note that although the fill arrows allow the size of the fill to be altered, they do not affect the
fill itself - only the rotation of the arrows alters the fill.

To Move a Fill Handle
Select the object with the fill applied and simply drag the fill handle using the Fill Tool or 
Selector Tool (if Fill handles have been enabled (see Enabling fill handles & fill arrows).
If the CTRL key is held down whilst dragging a fill arrow, the angle of the fill will be 
constrained to 45 degree intervals.

The mouse pointer when over a fill handle.

When in the Fill Tool, you can nudge the selected fill handle(s) using the cursor keys on the 
keyboard. CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, 
respectively).

To Alter Fill Colour
Simply drag a colour from the Colour Line or the Colour Gallery onto the filled object - as the 
mouse pointer moves over the object, the pointer changes to reflect how the colour will be 
applied :

Dropping the colour will apply it to the end handle of the conical fill
Dropping the colour will apply it to the start handle of the conical fill

The fill colours can also be altered by applying colour direct to the fill handles. Click on a fill 
handle to select it and do one of the following :

Click on a colour on the Colour Line
Double click a colour in the Colour Gallery
Select a colour in the Colour Gallery and click Apply.

Note that applying colour in this way with no fill handles selected will result in a flat fill of the
chosen colour being applied. Remember also that the colour cannot be applied to the central
handle.
To select all fill handles of a particular type (e.g. all centre (start) handles) within the 
selection - CTRL+SHIFT-click on one of the handles.
SHIFT-click can be used to select additional fill handles.

Fill Effect
The way in which the colours change across the fill from the start to the end colours can be 
altered using the Fill Effect Field.
_______________
See also



Applying conical fills



 Edit a fractal fill

Fractal fills are controlled using a pair of fill arrows joined at one end with three associated 
fill handles. The arrows point from the centre of the fractal to its top and right-hand edges 
and so control its position and the angles of the sides of the fractal. The central fill handle 
controls the position of the centre of the fractal. A fractal fill repeats a square of fractal 
texture to fill an object - it is very similar to a bitmap fill.

To Move a Fill Handle
Select the object with the fill applied and simply drag the fill handle using the Fill Tool or 
Selector Tool    (if fill handles have been enabled, see Enabling fill handles & fill arrows).
If the CTRL key is held down whilst dragging a fill arrow, the angle of the arrow will be 
constrained to 45 degree intervals.

The mouse pointer when over a fill handle.

If the SHIFT key is held down whilst dragging a fill arrow, the angle between the two fill 
arrows is locked during the drag. i.e. the fractal is prevented from being stretched or skewed
and can be scaled easily.

When in the Fill Tool, you can nudge the selected fill handle(s) using the cursor keys on the 
keyboard. CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, 
respectively).

To Alter Fill Colour
The colours in the fractal fill can be altered to graduate from one colour to a second. The 
colours are altered by applying colour direct to the fill handles. Click on a fill handle to select
it and do one of the following :

Click on a colour on the Colour Line
Double click a colour in the Colour Gallery
Select a colour in the Colour Gallery and click Apply.

Note that applying colour in this way with no fill handles selected will result in a flat fill of the
chosen colour being applied to the object.
To select all fill handles of a particular type (e.g. all centre (start) handles) within the 
selection CTRL+SHIFT-click on one of the handles.
SHIFT-click can be used to select additional fill handles.

Fill Effect
The way in which the fractal colours changes from the start to the end colours can be altered
using the Fill Effect Field on the Fill Tool Infobar.

Fractal Resolution
The resolution (or size) of the fractal fill can be altered accurately using the Fractal Fill 
Resolution Field on the Fill Tool Infobar.

Fractal Tiling
The tiling (repetition) of the bitmap in the fill can be altered using the Fractal Tiling Field on 
the Fill Tool Infobar.



Fractal Grain
The grain of the fractal can be altered using the Fractal Fill Grain Field on the Fill Tool Infobar.
_______________
See also
Applying a bitmap fill



 Edit a linear fill

Linear fills are controlled using a single fill arrow with a fill handle on either end. Each end of 
the arrow has a colour associated with it and the fill graduates from the colour at the start 
handle to the colour at the end handle across the object it is applied to.

To Move a Fill Handle
Select the object with the fill applied and simply drag the fill handle using the Fill Tool or 
Selector Tool (if Fill handles have been enabled - see Enabling fill handles & fill arrows).
CTRL-dragging a fill handle constrains movement to 45 degree intervals.

Fill handle can be dragged.

To Alter Fill Colour
Simply drag a colour from the Colour Line or the Colour Gallery onto the filled object. As the 
mouse pointer moves over the object, it changes shape to show where the colour will be 
applied :

Dropping the colour will apply it to the start of the fill
Dropping the colour will apply it to the end of the fill

Fill colours can also be altered by applying colour direct to the fill handles. Click on a fill 
handle to select it and do one of the following :

Click on a colour on the Colour Line
Double click a colour in the Colour Gallery
Select a colour in the Colour Gallery and click Apply.

Note that if there are no fill handles selected, applying colour in this way creates a flat fill of 
the chosen colour.
To select all fill handles of a particular type (e.g. all end handles) within the selection - 
CTRL+SHIFT-click on one of the handles.
SHIFT-click can be used to select additional fill handles.

Fill Effect
The way in which the colours change across the fill from the start to the end colours can be 
altered using the Fill Effect Field.
_______________
See also
Applying linear fills



 Edit a perspective mould
Perspective envelopes are controlled using four mould handles around the mould. Editing of 
the envelope is very similar to editing a shape with the Shape Editor Tool. Moulds can be 
edited using the Shape Editor Tool, the Mould Tool or the Selector Tool (if edit handles have 
been enabled - see Enabling edit handles).

To move a mould handle
1. Select the moulded object.
2. Drag the handle to its new position. If several handles are selected, they will all move 

simultaneously.

Click on a mould handle to select it. To select additional mould handles, SHIFT-click on them. 
SHIFT-click can also be used to deselect a selected mould handle.

Note
You can edit a mould without your changes being reflected until you have the required 
shape. Click the Detach Mould Button on the Infobar and make your changes. Deselect the 
button to remould the object.
The Mesh Button on the Infobar displays a mesh over all selected moulds which you may 
find helpful to visualise the mould shape.



 Edit an elliptical fill

Elliptical fills are controlled using a pair of fill arrows with a fill handle on the end of each and
one at the point at which they meet. The centre handle controls the position of the centre of 
the fill and its colour. The outer two handles control the width and height of the fill and the 
outer colour. Elliptical fills are very similar to circular fills, except that the second fill arrow to
give extra control over the shape of the fill.

To Move a Fill Handle
Select the object with the fill applied and simply drag the fill handle using the Fill Tool or 
Selector Tool (if Fill handles have been enabled - see Enabling fill handles & fill arrows).
CTRL-dragging a fill handle constrains movement to 45 degree intervals.

The mouse pointer when over a fill handle.

When in the Fill Tool, you can nudge the selected fill handle(s) using the cursor keys on the 
keyboard. CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, 
respectively).

To Alter Fill Colour
Simply drag a colour from the Colour Line or the Colour Gallery onto the filled object - as the 
mouse pointer moves over the object, it changes shape to show where the colour will be 
applied :

Dropping the colour will apply it to the outside (end handle) of the elliptical fill
Dropping the colour will apply it to the centre (start handle) of the elliptical fill

The fill colours can also be altered by applying colour direct to the fill handles. Click on a fill 
handle to select it and do one of the following :

Click on a colour on the Colour Line
Double click a colour in the Colour Gallery
Select a colour in the Colour Gallery and click Apply.

Note that if there are no fill handles selected, applying colour in this way creates a flat fill of 
the chosen colour.
To select all fill handles of a particular type (e.g. all centre [start] handles) within the 
selection - CTRL+SHIFT-click on one of the handles.
SHIFT-click can be used to select additional fill handles.

Fill Effect
The way in which the colours change across the fill from the start to the end colour can be 
altered using the Fill Effect Field.
_______________
See also
Applying elliptical fills





 Edit an envelope mould
Envelopes are controlled using four mould handles around the mould, each of which has two 
curve handles attached to it. Editing of the envelope is very similar to editing a shape with 
the Shape Editor Tool. Moulds can be edited using the Shape Editor Tool, the Mould Tool or 
the Selector Tool (if edit handles have been enabled - see Enabling edit handles).

To move a mould handle
1. Select the moulded object.
2. Drag the handle to its new position. If several handles are selected, they will all move 

simultaneously.

Click on a mould handle to select it. To select additional mould handles SHIFT-click on them. 
SHIFT-click can also be used to deselect a selected mould handle.

To move a mould curve handle
1. Select the moulded object.
2. Select a single mould handle - two curve handles will be displayed.
3. Drag the curve handles to alter the shape of the mould.

Note
You can edit a mould without your changes being reflected until you have the required 
shape. Click the Detach Mould Button on the Infobar and make your changes. Deselect the 
button to remould the object.
The Mesh Button on the Infobar displays a mesh over all selected moulds which you may 
find helpful to visualise the mould shape.



 Edit bitmap transparency
Bitmap transparency produces a pattern across the selected objects. You can alter the 'grain'
of the bitmap to produce a smooth or 'lumpy' transparency texture. You can alter the angle, 
direction and degree of transparency.

To alter the transparency type
1. Select the object.
2. Choose the Transparency Tool.
3. Choose    Mix, Stained Glass or Bleach from the Transparency Type Field on the 

Transparency Tool Infobar.

To alter the start or end transparency level
1. Select the object.
2. Choose the Transparency Tool.
3. Select the transparency handle(s).
4. Move the Transparency Level Slider on the Infobar.

To move a transparency handle (position and size of the bitmap)
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Drag the transparency handle to its new position.

Holding down CTRL during the drag constrains movements of the transparency arrow to 45 
degree intervals.
Holding down SHIFT during the drag locks the aspect ratio of the bitmap.

You can nudge the selected transparency handle(s) using the cursor keys on the keyboard. 
CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, respectively).

To change the transparency bitmap
1. Select the object.
2. Open the Bitmap Gallery or the Fill Gallery.
3. Select the new bitmap.
4. Click the Transp button.

To change the bitmap transparency tiling
1. Select the object.
2. Choose the Transparency Tool.
3. Choose one of the three tiling types from the Tiling Field on the Infobar.

_______________
See also
Editing Transparency



 Edit bitmaps
To alter bitmap palettes
It is possible to apply a contone effect to bitmaps.

The two colours used for the contoning are applied in the same way as fill and outline 
colours are applied. Drag a colour and drop it on the edge of the bitmap to change one 
colour, or drop it over the bitmap away from the edge to set the second colour. It is also 
possible to use right and left mouse button clicks on the Colour Line to achieve the same 
effect. Alternatively, open the Colour Editor and edit the line and fill colours of the bitmap 
directly.
If you attempt to apply contone colour to a bitmap which is not greyscale, it will be 
converted to greyscale first.

On-line Demonstration
    {button Bitmap Editing,EF("XaraDemo.exe","Bitmaps.avi `Bitmap Editing'",1) }

This effect is easily achieved by altering the white to a cream colour and the black to a dark 
brown.



 Edit circular transparency
A circular transparency applied to an object is a graduation of transparency from one level to
another in a radial fashion. The single transparency arrow used to control it has a handle on 
either end; the length of the arrow defines the radius of the transparency graduation and the
transparencies at either end defined by the levels applied to the handles.

To alter the transparency type
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Choose Mix, Stained Glass or Bleach from the Transparency Type Field on the 

Transparency Tool Infobar.

To alter the transparency level of a handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Select the transparency handle(s).
4. Move the Transparency Level Slider on the Infobar.

To move a transparency handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Drag the transparency handle to its new position.

You can nudge the selected transparency handle using the cursor keys on the keyboard. 
CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, respectively).
_______________
See also
Editing Transparency



 Edit conical transparency
A conical transparency applied to an object is a graduation of transparency from one level to
another swept out in a radial fashion. The single semicircular transparency arrow used to 
control it has a handle on each end with an additional handle in the centre; the handles on 
the ends of the arrow define the levels on either side of the conical transparency.

To alter the transparency type
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Choose Mix, Stained Glass or Bleach from the Transparency Type Field on the 

Transparency Tool Infobar.

To alter the transparency level of a handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Select the transparency handle(s).
4. Move the Transparency Level Slider on the Infobar.

To move a transparency handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Drag the transparency handle to its new position.

Holding down CTRL during the drag will constrain movements of the transparency arrow to 
45 degree intervals.

You can nudge the selected transparency handle(s) using the cursor keys on the keyboard. 
CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, respectively).
_______________
See also
Editing Transparency



 Edit curved lines and shapes

Point handle behaviour
The join of two curved line segments can be either smooth (shown above left) or sharp 
(shown above right). (A sharp join is sometimes called a cusp join.)
To change from smooth to sharp either:

1. Select the point handle.
2. Do one of the following :

Click the Sharp Point Button on the Shape Editor Tool Infobar 
Press Z on the keyboard.

You can also achieve the same result by double-clicking the point handle

To change from sharp to smooth either:

1. Select the point handle.
2. Do one of the following :

Click the Smooth Point Button on the Shape Editor Tool Infobar 
Press S on the keyboard.

You can also achieve the same result by double-clicking the point handle

To change curve shape
1. Select the line or shape.
2. Choose the Shape Editor Tool
3. Click on the point handle you wish to edit
4. Drag either of the two curve edit handles.

or
1. Select the line or shape.
2. Choose the Shape Editor Tool.
3. Move the mouse pointer over the line. (The pointer changes to an arrow.)
4. Drag to reform the line segment.

Drag to reform the line.

Selector Tool
When edit handles have been enabled in the Selector Tool it can be used to select and move 
point handles and curve handles. See Selecting points on lines and shapes.

Pop-up menu
If the pop-up menu is opened with the pointer over a point handle, it can be used to edit 
lines and shapes without the need to choose the Shape Editor Tool. See Point Handle Pop-up 
Menu.
_______________
See also
Moving points on shapes and lines





 Edit ellipses & circles
To move an ellipse

1.    Choose the QuickShape Tool or the Ellipse Tool.
2.    Drag the cross in the centre of the ellipse to move the ellipse to the required position.

Ellipses can also be moved using the Selector Tool - see Moving objects.

To rotate an ellipse
1.    Choose the Ellipse Tool.
2.    SHIFT-dragging a handle will allow the ellipse to be rotated and scaled simultaneously. 

To rotate the ellipse without altering its size, hold down CTRL while dragging.
or

1.    Choose the QuickShape Tool.
2.    Dragging a handle will allow the ellipse to be rotated and scaled simultaneously. To 

rotate the ellipse without altering its size, hold down CTRL while dragging.

Ellipses can also be rotated using the Selector Tool - see Rotating objects.

To stretch an ellipse
1.    Choose the Ellipse Tool.
2.    Drag a handle to stretch the ellipse relative to the opposite handle.

Ellipses can also be stretched using the Selector Tool - see Stretching objects.

To scale an ellipse
In the Ellipse Tool:
          CTRL+SHIFT-drag a handle.
In the QuickShape Tool:
        CTRL-drag a handle.

Ellipses can also be scaled using the Selector Tool - see Scaling objects.

To change an ellipse into a polygon
1. Select the ellipse.
2. Do one of the following :

Double-click on the centre of the ellipse.
Open the Pop-up Menu over the ellipse and choose Make Polygonal.



 Edit elliptical transparency
An elliptical transparency applied to an object is a graduation of transparency from one level
to another in a radial fashion. The pair of transparency arrows used to control it have a 
handle on one end and one at their joining point; the length of the arrows defines the radii of
the transparency graduation and the transparencies of the centre and outer edge are 
defined by the levels applied to the handles.

To alter the transparency type
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Choose Mix, Stained Glass or Bleach from the Transparency Type Field on the 

Transparency Tool Infobar.

To alter the transparency level of a handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Select the transparency handle(s).
4. Move the Transparency Level Slider on the Infobar.

To move a transparency handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Drag the transparency handle to its new position.

Holding down CTRL during the drag will constrain movements of the transparency arrow to 
45 degree intervals.

You can nudge the selected transparency handle(s) using the cursor keys on the keyboard. 
CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, respectively).
_______________
See also
Editing Transparency



 Edit fills
The Fill Tool and Selector Tool can be used to edit a linear fill, circular fill, conical fill, elliptical
fill, bitmap fill or fractal fill which has been applied to an object.

Editing linear fills
Editing circular fills
Editing elliptical fills
Editing conical fills
Editing bitmap fills
Editing fractal fills

_______________
See also
Applying fills



 Edit flat transparency
To alter the transparency level

1. Select the transparent object.
2. Choose the Transparency Tool.
3. Move the Transparency Level Slider on the Infobar.

To alter the transparency type
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Choose Mix, Stained Glass or Bleach from the Transparency Type Field on the 

Transparency Tool Infobar.
_______________
See also
Editing transparency



 Edit fractal transparency
Fractal transparency produces random, varying transparency levels across the selected 
objects. This is similar to a fractal fill except that the fractal values alter the level of 
transparency rather than the colour. You can alter the 'grain' of the fractal to produce a 
smooth or 'lumpy' transparency texture. You can alter the angle, direction and exact degree 
of transparency.

To alter the transparency type
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Choose Mix, Stained Glass or Bleach from the Transparency Type Field on the 

Transparency Tool Infobar.

To alter the transparency level of a handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Select the transparency handle(s).
4. Move the Transparency Level Slider on the Infobar.

To move a transparency handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Drag the transparency handle to its new position.

Holding down CTRL during the drag will constrain movements of the transparency arrow to 
45 degree intervals.
Holding down SHIFT during the drag will lock the aspect ratio of the fractal.

You can nudge the selected transparency handle(s) using the cursor keys on the keyboard. 
CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, respectively).

To change the fractal grain
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Ensure no transparency handles are selected by clicking away from the handles.
4. Drag the Grain Slider on the Infobar.

To change the fractal resolution
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Ensure no transparency handles are selected by clicking away from the object.
4. Alter the value in the Resolution Field on the Infobar.

To change the fractal transparency tiling
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Choose one of the three tiling types from the Tiling Field on the Infobar.

_______________
See also
Editing Transparency





 Edit linear transparency
A linear transparency applied to an object is a graduation of transparency from one level to 
another in a linear fashion. The single transparency arrow used to control it has a handle on 
either end; the direction of the arrow defines the direction of the transparency graduation 
and the transparencies at either end defined by the levels applied to the handles.

To alter the transparency type
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Choose Mix, Stained Glass or Bleach from the Transparency Type Field on the 

Transparency Tool Infobar.

To alter the transparency level at a handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Select the transparency handle(s).
4. Move the Transparency Level Slider on the Infobar.

To move a transparency handle
1. Select the transparent object.
2. Choose the Transparency Tool.
3. Drag the transparency handle to its new position.

You can nudge the selected transparency handle using the cursor keys on the keyboard. 
CTRL-nudge and SHIFT-nudge give larger nudges (five and ten times larger, respectively).
_______________
See also
Editing transparency



 Edit moulded text
Text which has been moulded cannot be edited directly in this version of CorelXARA, but 
described below is a simple process which allows you to easily remove the mould, edit the 
text and reapply the mould.

To edit moulded text
1. Select the moulded text object.
2. Choose the Mould Tool.
3. Click the Copy Mould button on the Infobar.
4. Click the Remove Mould button on the Infobar to remove the mould from the text.
5. Edit the text object as normal.
6. Choose the Mould Tool
7. Click the Paste Mould button on the Infobar.



 Edit polygons

To enable/disable curved corners on a QuickShape
1. Select the QuickShape.
2. Double click on a corner of the QuickShape.

or
1. Select the QuickShape.
2. Choose the QuickShape Tool.
3. Click the Curved Corners Button on the Infobar.

To change the number of sides of a QuickShape
1. Select the QuickShape.
2. Choose the QuickShape Tool.
3. Choose the number of sides from the drop-down list or enter a value & press RETURN. 

Any value from 3 to 99 is valid.
or

1. Open the Pop-up Menu over the QuickShape and choose a value from the Number of 
Sides submenu.

To resize or rotate a QuickShape
1. Click on the polygon or starred QuickShape to select it
2. Choose the QuickShape Tool
3. Drag on one of the outer handles.    The shape scales and rotates about its centre to 

keep the point you are dragging under the pointer.    To just scale the shape, hold down 
CTRL and drag towards or away from the centre.    To just rotate the shape, hold down 
CTRL and drag the handle radially.

To alter the corner-curvature of a QuickShape
1. Select the polygon or starred QuickShape.
2. Choose the QuickShape Tool
3. Drag on one of the curvature handles.    The QuickShape becomes more or less curved as

you drag the mouse between the two outer handles.

To warp the edges of a QuickShape
1. Select the polygon or starred QuickShape.
2. Choose the QuickShape Tool
3. Move the mouse pointer over a side of the QuickShape. (The pointer changes to an 

arrow.)
4. Drag to reform the sides of the object.

The sides of a QuickShape can be made straight again using the Restore Edges Button on 
the QuickShape Tool Infobar.

To enable/disable polygon stellation
1. Select the QuickShape.
2. Double-click on the edge of the polygon (not on a curved corner).

or
1. Select the QuickShape.
2. Choose the QuickShape Tool.



3. Click the Star Button on the Infobar.

To change a polygon into an ellipse
1. Select the polygon.
2. Do one of the following :

Double-click on the centre of the polygon.
Open the QuickShape Pop-up Menu over the polygon and choose Make Elliptical.

_______________
See also
Editing starred shapes
Drawing polygons



 Edit rectangles & squares

To change a rectangle into an ellipse
1. Select the rectangle.
2. Do one of the following :

Double-click on the centre of the rectangle.
Open the Pop-up Menu over the rectangle and choose Make Elliptical.

To move a rectangle
1. Choose the QuickShape Tool or the Rectangle Tool.
2. Dragging the cross in the centre of the rectangle moves the rectangle.

Rectangles can also be moved using the Selector Tool - see Moving objects.

To rotate a rectangle
1. Choose the Rectangle Tool.
2. SHIFT-dragging a handle will allow the rectangle to be rotated and scaled simultaneously.

To rotate the rectangle without altering its size, hold down CTRL while dragging.
or

1. Choose the QuickShape Tool.
2. Dragging a handle will allow the rectangle to be rotated and scaled simultaneously. To 

rotate the rectangle without altering its size, hold down CTRL while dragging.

Rectangles can also be rotated using the Selector Tool - see Rotating objects.

To resize a rectangle
In the Rectangle Tool:
      CTRL+SHIFT-drag a handle.
In the QuickShape Tool:
        CTRL-drag a handle.

Rectangles can also be scaled using the Selector Tool - see Scaling objects.

Note
To warp the edges of a rectangle, you must use the QuickShape Tool. See Editing polygons.
_______________
See also
Drawing rectangles & squares



 Edit starred polygons

To move the star handles
1. Select the polygon or starred QuickShape to select it
2. Choose the QuickShape Tool
3. Drag on one of the inner handles.    The star handle moves to stay under the mouse 

pointer. To just move the point in and out, hold down CTRL and drag towards or away 
from the centre. To just rotate the point, hold down CTRL and drag the handles radially.

(The star handles are shown as 'stellation radius & offset' in the diagram)

To enable curved corners on a QuickShape
1. Select the QuickShape.
2. Double click on a corner of the QuickShape.

or
1. Select the QuickShape.
2. Choose the QuickShape Tool.
3. Depress the Curved Corners Button on the Infobar to enable curved corners.

To disable curved corners on a QuickShape
1. Select the QuickShape.
2. Double click on a curved corner handle.

or
1. Select the QuickShape.
2. Choose the QuickShape Tool.
3. Pull out the Curved Corners Button on the Infobar.

To change the number of sides of a QuickShape
1. Select the QuickShape.
2. Choose the QuickShape Tool.
2. Choose the number of sides from the Number of Sides drop-down list on the Infobar or 

enter a value & press RETURN. Any value from 3 to 99 is valid.

To resize or rotate a QuickShape
1. Select the polygon or starred QuickShape.
2. Choose the QuickShape Tool
3. Drag on one of the outer handles.    The shape scales and rotates about its centre to 

keep the point you are dragging under the pointer.    To just scale the shape hold down 
CTRL and drag outward from the centre.    To just rotate the shape hold down CTRL and 
move the mouse around the circumference of the shape.

To alter the corner-curvature of a QuickShape
1. Select the polygon or starred QuickShape.
2. Choose the QuickShape Tool
3. Drag on one of the curvature handles.    The QuickShape becomes more or less curved as



you drag the mouse between the two outer handles.

To warp the edges of a QuickShape
1. Select the polygon or starred QuickShape to select it
2. Choose the QuickShape Tool
3. Move the mouse pointer over a side of the QuickShape. (The pointer changes to an 

arrow.)
4. Drag to reform the sides of the object.

The sides of a QuickShape can be made straight again using the Restore Edges Button on 
the QuickShape Tool Infobar.

To make a starred polygon a standard polygon
1. Select the QuickShape.
2. Double-click on the edge of the starred polygon.

or
1. Select the QuickShape.
2. Choose the QuickShape Tool.
3. Pull out the Star Button on the Infobar.

To change a polygon into an ellipse
1. Select the polygon.
2. Do one of the following :

Double-click on the centre of the polygon.
Open the QuickShape Pop-up Menu over the polygon and choose Make Elliptical.

_______________
See also
Drawing starred polygons
Drawing polygons



 Edit text
There are two editing modes used with the Text Tool. You can either edit text using the 
cursor or edit selected text regions.

Editing Text with the Text Cursor
1. Choose the Text Tool.
2. Click in the text object to insert the text cursor.
3. Edit the text as required (see Text Tool Key Shortcuts).

Editing Text Selections
When a region of text has been selected (see Selecting text) it is possible to :

Apply attributes to the selected region - see Applying attributes to text
Replace the selected region by typing new text.

Scaling & Stretching text
You can use either the Text Tool (see Font size or Aspect ratio) or the Selector Tool (see 
Scaling objects or Stretching objects).

On-line Demonstration
    {button Editing Text,EF("XaraDemo.exe","EditText.avi `Editing Text'",1) }

Note
Remember that whenever the text cursor is moved it takes on the attributes of the character
to its left.
_______________
See also
Creating new text
Placing text around a curve
Entering special characters



 Edit transparency
The Transparency Tool and Selector Tool can be used to edit a flat transparency, linear 
transparency, circular transparency, elliptical transparency, conical transparency, bitmap 
transparency or fractal transparency which has been applied to an object.

Editing Flat Transparency
Editing Linear Transparency
Editing Circular Transparency
Editing Elliptical Transparency
Editing Conical Transparency
Editing Bitmap Transparency
Editing Fractal Transparency
Removing Transparency

On-line Demonstration
    {button Simple Transparency Effects,EF("XaraDemo.exe","Transpar.avi `Simple 

Transparency Effects' ",1) }
    {button    Transparency Applications,EF("XaraDemo.exe","Transfun.avi    `Transparency 

Applications' ",1) }



 
 Ellipse Tool

The Ellipse Tool creates and edits elliptical and circular QuickShapes. It is a customised 
version of the QuickShape Tool.

SHIFT+F4
Ellipse Tool Infobar Controls

Bounds Creation
Diameter Creation
Radius Creation
Mode Indicator

Parameters

Ellipse Tool Operations
Drawing ellipses & circles
Editing ellipses & circles

On-line Demonstration
    {button Ellipses and Circles,EF("XaraDemo.exe","Ellipses.avi `Ellipses and Circles'",1) }

_______________
See also
Rectangle Tool
QuickShape Tool



 Ellipse Tool - Bounds Creation Button

The Bounds Creation button on the Ellipse Tool Infobar selects Bounds Creation mode. 
Dragging the mouse creates a new ellipse within the bounding box. This lets you create 
ellipses rather than circles. To create a circle, hold down CTRL while dragging.
_______________
See also
Drawing ellipses & circles



 Ellipse Tool - Diameter Creation Button
This button on the Ellipse Tool Infobar selects Diameter Creation. Drag the mouse to create a
new circle across its diameter.
_______________
See also
Drawing ellipses & circles



 Ellipse Tool - Mode Indicator
This indicator on the Ellipse Tool Infobar displays the 'mode' of the tool. It displays one of the
following :

New:
Changes made to the Infobar fields set the defaults for the tool. i.e. the settings that apply 
to all subsequent ellipses you draw.

Change:
The selection contains at least one elliptical QuickShape. Changes made to the Infobar fields
alter the selected ellipse(s).



 Ellipse Tool - Parameters Field

These fields on the Ellipse Tool Infobar allow the accurate editing of elliptical QuickShape 
parameters. From the drop-down list choose either

The width & height of the ellipse,
The coordinates of the centre of the ellipse.

Alter the values by typing into the edit fields and pressing RETURN or using the arrow 
buttons.
_______________
See also
Units in CorelXARA



 Ellipse Tool - Radius Creation Button

This button on the Ellipse Tool Infobar selects Radius Creation. Dragging the mouse creates a
circle from the centre outward.
_______________
See also
Drawing ellipses & circles



An Elliptical Fill consists of colour graduating in a radial fashion. It is very similar to the 
circular fill, but uses three fill handles to allow the fill to be stretched in two directions.



An Elliptical Transparency uses two transparency arrows, the transparency graduates 
from the centre out to the edges of the ellipse defined by the arrows. It is very similar to the 
circular transparency, but uses the extra transparency handle to allow the transparency to 
be stretched in two directions.



 Enable edit handles
Edit handles allow you to edit an object's shape with the Selector Tool.

To enable edit handles
1. Choose the Selector Tool.
2. Depress the Edit Handles button on the Selector Tool Infobar.



 Enable fill handles & fill arrows
Fill handles and fill arrows are used to edit fills in the Fill Tool. If they are enabled in the 
Selector Tool, fills can also be edited using the Selector Tool.

To enable fill handles & fill arrows
1. Choose the Selector Tool.
2. Depress the Fill Handles Button button on the Selector Tool Infobar.



 Enable selection handles
Selection handles are used in the Selector Tool and allow objects to be resized, scaled, 
rotated and skewed.

To enable selection handles
1. Choose the Selector Tool.
2. Depress the Selection Handles Button on the Infobar.

On-line Demonstration
    {button Selection Handles,EF("XaraDemo.exe","SelHands.avi `Selection Handles'",1) }



 Enable transparency
If your document contains transparency, the transparency can be enabled and disabled. This
does not affect the document, just the way it appears on screen. Transparency display is 
automatically enabled as soon as you create a transparent object or load a document 
containing transparency objects.

Transparency can be manually enabled and disabled using the transparency indicator on the
Status Line. For more details, see Status Line.



 Enter special characters
CorelXARA includes shortcuts for the following special characters. The characters are 
entered in the Text Tool by first pressing CTRL along with a modifier, releasing both keys and 
then pressing the letter to which the modifier should be applied.
So, for example, to enter an õ, you would hold down CTRL, type a ~ (usually SHIFT+#), 
release CTRL and then press o.

ÀÈÌÒÙàèìòù CTRL+ ` then a,A,e,E,i,I,o,O,u or U

ÁÉÍÓÚÝáéíóúý CTRL+ ' then a,A,e,E,i,I,o,O,u, U, y or Y

ÃÑÕãñõ CTRL+ ~ then a,A,n,N,o or O

ÂÊÎÔŠÛâêîôšû CTRL+ ^ then a,A,e,E,i,I,o,O,s, S, u or U

ÄËÏÖÜŸäëïöüÿ CTRL+ : then a,A,e,E,i,I,o,O,u, U, y or Y

¢ CTRL+/ then c

Øø CTRL+/ then O or o

ç Ç CTRL+ , then C (or c)

® CTRL+@ then R (or r)

© CTRL+@ then C (or c)

Åå CTRL+@ then A or a

Note
Some keyboards (e.g. Portugal, German) do dead keys already.    CorelXARA does not affect 
this.
Some keyboards require you to press CTRL to get an accent character (e.g. French é).    In 
this case the accent appears and CorelXARA does nothing.
If you wish to disable this system and you know how to edit INI files, change the line in the 
CORELXRA.INI file reading UseDeadKeys=1 to UseDeadKeys=0
If you are in a country with a keyboard that does not have one of the required keys (e.g. 
Portugal does not have a ^) you must enter the character using ALT+<character code> or 
use CharMap or similar.



An Envelope Mould is a shape used to mould objects. For instance a line of text could be 
moulded into a circle using a circular envelope.



    Erasing part of a freehand line
Whilst drawing a freehand line with the Freehand Tool, you can erase backwards along the 
line. Hold down SHIFT and move the mouse (without releasing the mouse button) backwards
along the line. Release SHIFT to continue drawing.



Exit (File Menu)

Ends a CorelXARA session. CorelXARA prompts you to save any unsaved documents. You can
also exit CorelXARA by doing one of the following:

Open the application control menu, (press ALT+SPACEBAR) and choose Close.
Double-click the application Control-menu box.



 Export (File Menu)

 CTRL+SHIFT+E
Selecting Export from the File menu allows you to export your document in a wide variety of 
file formats. Type in a file name, choose a directory, choose a file format and click OK.

Exporting Bitmaps
If a bitmap format is chosen, a second dialog box appears allowing you to alter settings 
controlling how the bitmap is exported. For more information, see Bitmap Export.

Exporting CorelXARA EPS
If CorelXARA EPS is chosen, a second dialog box appears letting you set specific options for 
the EPS file. See CorelXARA EPS Export for more information.

Note
PostScript does not support transparency and so any areas of a drawing containing 
transparency will be exported as bitmap data in EPS files.
The Export dialog will look slightly different under Windows 3.1, 3.11 and Windows NT.
_______________
See also
Supported File Formats



 Export a bitmap at a specific size
When exporting a picture as a bitmap, you might wish to specify a particular height or width 
in pixels (e.g. you might want to create a bitmap which is exactly 640x480 pixels) However, 
the Bitmap Export    dialog box uses the "dpi" field to determine how to scale the image, so it
can sometimes export the wrong size - for example, when asked for 150 pixels wide, it may 
give a final image only 139 pixels wide. To remedy this, select the entire image and scale it 
down so it more closely matches the destination size. Now, when you export it, the DPI 
setting is more accurate within the range of values you require, and thus the program can 
more closely match the desired pixel sizes.



 Extend a line 
Lines can be extended using the Pen, Shape Editor or Freehand Tools.

The Shape Editor Tool is the most flexible and can also edit lines.
The Pen Tool is provided for users familiar with programs such as CorelDRAW & Adobe 
Illustrator.
The Freehand Tool lets you extend the line by following freehand mouse movements.

What do you want to do?
Extend a Line with the Pen Tool
Extend a Line with the Freehand Tool
Extend a Line with the Shape Editor Tool



 Extend a line with the Freehand Tool
1. Select the line (see Selecting and deselecting objects).
2. Choose the Freehand Tool.
3. Move the mouse pointer over the end of the line - the pointer will change (see below).
4. Drag and move the mouse to create the new line section.

Dragging will extend an existing line



 Extend a line with the Pen Tool
1. Select the line (see Selecting and deselecting objects).
2. Click on the end point handle to extend from (the Shape Editor Tool or Selector Tool can 

be used for this).
3. Choose the Pen Tool.
4. Now click or drag as normal (see Drawing a Line with the Pen Tool) to add the new line 

section.



 Extend a line with the Shape Editor Tool
1. Select the line (see Selecting and deselecting objects).
2. Choose the Shape Editor Tool
3. Click on the point handle on the end of the line you wish to extend. (This can also be 

done with the Selector Tool if edit handles have been enabled - see Enabling edit 
handles.)

4. The Shape Editor Tool can now be used as normal to draw lines - the first segment of 
which will be connected to the existing line (see Drawing a line with the Shape Editor 
Tool).



Failed to find the CD

Cause
This message is displayed when the 'Find CD' button is clicked in the Add folder dialog box, 
and the CD cannot be found.

Recommended action
Insert the CD, and click 'Find CD' again.



Failed to make transparency mask for GIF

Cause
The GIF file that was being imported or opened has been loaded correctly but it specifies 
that it requires transparency. When the transparency mask was being created, a problem 
was encountered and the process halted. Therefore, the GIF file will be displayed without the
transparency mask. The reason for the failure is likely to be lack of memory.

Recommended action
Free up some memory by closing documents or quitting other applications and try loading 
the GIF file again.



 Feather a bitmap

To feather a bitmap
1.    Import the Bitmap.
2.    Draw a shape using the Freehand Tool around the edge to be feathered.
3.    Fill the shape black, set the line colour to white and give it a thick line width.
4.    Clone the shape, set its outline to a small line width and change its line colour to black.
7.    Use the Blend Tool to blend from the thick-outlined shape to the topmost shape.
8.    Increase the blend steps so you have a nice gradual fade (see Number of Steps Field).
9.    Draw a large white rectangle the same size as the original bitmap and position it 

between the bitmap and the blend. Make sure it is the only selected shape.
10. Export the selection as a bitmap (see Bitmap Export). The format is unimportant, but it 

must be in at least 256 colours.
11. Import the bitmap.
12. Delete the blend and the white rectangle.
13. Select the original bitmap.
14. Open the Bitmap Gallery and select the newly created bitmap.
15. Click the Transp button to apply the created bitmap as a bitmap transparency. If the 

bitmap is not a 256 colour greyscale bitmap CorelXARA will offer to convert it to a 
suitable form before it is applied.

16. Edit the bitmap transparency to align it with the bitmap (see Editing bitmap 
transparency).



File Control Bar

Close
Save As
Save All
Save Template
Import
Export
Document Info
Print
Print Setup

_______________
See also
Default Control Bars



File Format is the way in which information is arranged in a file. Different programs arrange
the information in different ways depending on their requirements. This means that files 
from one program cannot be read by another or, if it can be read, not all the information can
be displayed correctly. 
CorelXARA's native file format is called ".xar" format. ".xar" files can describe all of the 
advanced graphics produced by CorelXARA such as zero-memory blends and transparent 
objects. No other file format can fully describe the same graphics and, if drawings are saved 
in other formats, either some parts of the drawing are lost or changed or they are    no longer
editable when the file is reloaded into CorelXARA.
There are two major groups of graphic file formats; Bitmap (a rectangle of coloured dots) 
and Vector (a list of drawing instructions). CorelXARA can import and export many types of 
both Bitmap and Vector file formats.
Vector file formats can also be divided into two further subgroups: those that are designed to
be edited and those that are designed simply to be rendered (displayed). Postscript files 
(and their variant, EPS files) are usually intended to be rendered rather than edited.



File Menu

Open
Close
New

Save
Save As
Save All
Save Template

Import
Export

Document Info

Print Setup
Print

1,2,3,4 (recently loaded files list)

Exit



File already exists

Cause
You have tried to save or export to a file that already exists.

Recommended action
Click the Replace button to overwrite the existing file.
Click the Cancel button to abort the save or export. You can then repeat the operation using 
a different filename.



File is read-only

Cause
CorelXARA attempted to write to:

a file that is read-only, 
a read-only drive, such as a CD-ROM drive.

Recommended action
Use the Windows Explorer to check if the file is read-only.    If it is, then the file's read-only 
status can be changed. (Although there may be a reason why the file is read-only - if in 
doubt, then contact your system administrator.)
Alternatively, choose another file name or another disk drive.



File not found

Cause
The document file name you typed in does not exist.

Recommended action
Check that the name, drive and directory path are correct.
Check that the file exists.



File-sharing violation

Cause
Another process (or possibly, in the case of a file on a network, another user) has already 
claimed the file for writing.

Recommended action
Often if you wait a few seconds for the other user to finish, you can write to the file yourself. 
If this fails, contact your system administrator.



Fill Arrows are shown on filled objects and are used to edit the fills. The ends of the arrows 
can be clicked and dragged to move the fill. Some Fill Arrows have fill handles on the ends 
which allow colours to be applied to the fill.



 Fill Gallery (Utilities Menu)

 SHIFT+F11
The Fill Gallery contains bitmap textures suitable for use as bitmap fills and bitmap 
transparencies. These bitmaps are not loaded into memory - only when one is used is it 
loaded.
Fill bitmaps are normally loaded from the CorelXARA CD, but you can change to a different 
drive. You can also add textures to the gallery.

Import Import the fill as a bitmap.
Fill Apply the bitmap as a bitmap fill.
Transp Apply the bitmap as a bitmap transparency.
Add Fills Add more fills to the gallery.
Options Fill Gallery options.
Remove Remove the selected gallery sections.

Many operations using the Fill Gallery are made easier by the Fill Gallery Pop-up Menu.
_______________
See also
Galleries
Selecting items in a gallery



 Fill Gallery (Utilities Menu)
 SHIFT+F11

The Fill Gallery item on the Utilities menu and the Fill Gallery button open the Fill Gallery if it 
is closed and close it if it is open. The button remains pressed in if the gallery is open.



Fill Gallery - Add Fills Button

The Add Fills button in the Fill Gallery opens a modified Open dialog box that lets you choose
the directory containing the library. Usually you would read the directory directly from the 
CorelXARA CD, but you can copy the library onto a hard disk if required and use Add Fills to 
use the fill bitmaps. See Adding a folder to a gallery.



Fill Gallery - Fill Button

The Fill button in the Fill Gallery imports and applies the selected bitmap as a bitmap fill to 
the selection. If no objects are selected, the current fill attribute is set to a bitmap fill using 
the selected bitmap.
You can also drag-and-drop a fill bitmap onto an object to apply it as a fill or double-click it to
apply it to all the objects selected. CTRL-double-clicking closes the gallery afterwards.



Fill Gallery - Import Button

The Import button in the Fill Gallery imports the selected bitmap(s) into the selected 
document resulting in it appearing in the Bitmap Gallery.
You can also drag-and-drop the bitmap onto a blank part of the page to import it.



Fill Gallery - Options Button

Clicking the Options button in the Fill Gallery opens a menu containing the following 
options :

Add Fills
Find
Sort
Properties



Fill Gallery - Pop-up Menu

Right-clicking on the Fill Gallery opens the pop-up menu which contains the following options
:

Import Identical to the Import button.
Apply as a Fill Identical to the Fill button.
Apply as Transparency Identical to the Transparency button.
Remove Section Identical to the Remove button.
(Un)Fold Section Folds up or unfolds the current section.
Previous Section Moves to the start of the previous section.
Next Section Moves to the start of the next section.



Fill Gallery - Remove Button

The Remove button in the Fill Gallery removes the selected sections from the gallery. You will
be asked to confirm the operation.



Fill Gallery - Transparency Button

The Transparency button in the Fill Gallery imports and applies the selected bitmap as a 
bitmap transparency to the selection. If no objects are currently selected, the current 
transparency attribute is set to a bitmap transparency using this bitmap. i.e. all subsequent 
objects drawn will have the selected bitmap applied as a transparency.



Fill Handles are the squares on the ends of fill arrows. To change the colours in the fill 
select a handle and apply a colour to it.
To easily swap between the start and end handles, press TAB (this swaps the selected status 
of all handles). Note that this only works in the Fill Tool.
Fills can be edited using the Selector Tool if fill handles and fill arrows have been enabled in 
the Selector. See Enabling fill handles & fill arrows.
Pressing TAB whilst dragging a fill handle alters the way in which redraws are performed 
during the drag. The redraw type used can be set using the View Options.
You can alter the colours of a bitmap fill by applying colours to the fill handles. (This works 
best with greyscale bitmaps.)
If you CTRL+click on a fill handle, all handles of that type on the selection will be selected. 
e.g. all the end fill handles.
SHIFT+clicking on a fill handle will select it without deselecting any other handles (or 
deselect it if it is already selected).



 
 Fill Tool

The Fill Tool lets you fill the selected object(s) in a variety of graduated colour, fractal and 
bitmap fills.
Fills are controlled using fill arrows that control the position and direction of the fill. The 
colours of the fill are controlled using fill handles.

F5
Fill Tool Infobar Controls
Which fields appear on the Infobar depends on the current fill type.

Fill Type
Bitmap & Fractal Fill Tiling

Bitmap & Fractal Resolution
Bitmap
Bitmap Fill Colour
Fractal Fill Grain

Selected Fill Handle Colour
Fill Effect

Fill Tool Operations
Applying fills
Editing fills

On-line Demonstrations
    {button Bitmap Fills,EF("XaraDemo.exe","BmapFill.avi `Bitmap Fills'",1) }
    {button Fractal Fills,EF("XaraDemo.exe","Fractals.avi `Fractal Fills'",1) }
    {button Linear Circular Elliptical and Conical Fills,EF("XaraDemo.exe","GradFill.avi `Linear

Circular Elliptical and Conical Fills'",1) }
_______________
See also
Colour Line
Selector Tool
Transparency Tool



 Fill Tool - Bitmap & Fractal Fill Resolution Field

The Resolution field on the Fill Tool Infobar sets the resolution (the size) of the currently 
selected bitmap/fractal fill. You can change the resolution by:

Scaling the bitmap/fractal in the fill using the fill handles
Entering a new value in this field and pressing RETURN.

Note
This field only appears on the Infobar when the selection contains only bitmap/fractal filled 
objects, and there are no selected fill handles. Click away from the fill handles with the Fill 
Tool to deselect all the handles.
_______________
See also
Editing fills
Applying fills



 Fill Tool - Bitmap & Fractal Fill Tiling Field

The Tiling field on the Fill Tool Infobar sets the method used for 'tiling' fractal fills and bitmap
fills. There are three choices available :

Single Tile
This places a single copy of the fill bitmap inside the filled shape(s). The shape(s) may not 
be entirely covered by the fill bitmap. You can scale up the bitmap to fill the shape but the 
individual pixels of the bitmap may then be noticeable.

Repeating Tile
This repeats the fill bitmap to fill the shape(s).

Repeat Inverted
This is similar to Repeating Tile, but alternate tiles are reflected. This is very useful for 
bitmap textures which you need to tile without the joins being obvious. In the example 
below, the lighting over the texture makes it impossible for normal tiling to be effective.

Left to right: Single Tile, Repeating Tile and Repeat Inverted.

Note
This field only appears on the Fill Tool Infobar when the fills in the selection are all bitmap 
fills or all fractal fills.
_______________
See also
Fill Tool
Applying fills
Editing fills



 Fill Tool - Bitmap Field
The Bitmap field on the Fill Tool Infobar sets the bitmap used in bitmap filled object(s) in the 
selection.

Note
This field only appears on the Fill Tool Infobar when the current Fill Type is set to Bitmap.
_______________
See also
Applying fills
Editing fills



 Fill Tool - Bitmap Fill Colour Field
The Bitmap Fill Colour field on the Fill Tool Infobar displays the colour applied to the currently
selected fill handles.

Note
This field only appears on the Infobar when the selection contains one bitmap fill.
This field shows 'Many' if the currently selected fill handles have different colours applied.
_______________
See also
Applying fills
Editing fills



 Fill Tool - Fill Effect Field

The Fill Effect option on the Fill Tool Infobar defines the way in which the colours change from
one to another in a fill. There are three effects available:

Fade
Simply fades from the colours of one object to the next.

Rainbow
This is a more colourful fade following the shortest edge of the HSV colour wheel.
For example, a fade from yellow to cyan passes through green.

Alternate Rainbow
This acts in the same way as Rainbow except the colours follow the longest edge of the HSV 
colour wheel.
For example a fade from yellow to cyan passes through red, magenta and blue..
_______________
See also
Applying fills
Editing fills



 Fill Tool - Fill Type Field
The Fill Type field on the Fill Tool Infobar sets the type of fill applied to the selection.
The fill types available are :

Flat Fill
Conical Fill
Circular Fill
Linear Fill
Elliptical Fill
Bitmap Fill
Fractal Fill

The field shows 'Many' if the selection contains fills of different types.
The field shows 'None' if there are no selected objects.
The field shows 'Flat fill' if only flat filled objects are selected.
_______________
See also
Fill Tool
Applying fills
Editing fills



 Fill Tool - Fractal Fill Grain Field
The Grain field on the Fill Tool Infobar sets the 'grain' for the currently selected object with a 
fractal fill applied. Low values gives a smooth, cloud-like effect; higher values give a sharper,
more 'grainy' texture.

Note
This field only appears when the selection contains only fractal filled objects, and there are 
no selected fill handles. (when a fill handle is selected the handle type and colour will be 
displayed).
_______________
See also
Applying fills
Editing fills



 Fill Tool - Selected Fill Handle Colour Fields

These fields are on the Fill Tool Infobar. The left hand of the two shows the currently selected
fill handle(s). The right hand field shows the colour applied to the selected handle(s).

Note
This field is shown for all fill types if there is a fill handle selected.
_______________
See also
Applying fills
Editing fills



 Find clipart
To find clipart, use the Clipart Gallery. You can find pictures using the filename of the picture,
the title of the picture or using keywords (words related to the picture). For more details, see
Searching a gallery.



 Fine-tune the bitmap tracer
Problem:

Too many handles on each shape
If the bitmap uses dithering - increase the Remove Noise setting.
If the handles are evenly spaced along the lines - reduce the Accuracy setting.
If the handles are clustered around the corners - increase the Smoothing setting.

Too many shapes
Too many small shapes - increase the Minimum Area setting and possibly increase 

the Reduce Noise setting.
Too many shapes of a similar colour - increase the Final Tolerance setting.

Trace not accurate enough
... at the corners - decrease the Smoothing setting.
... in smooth areas (along lines) - increase the Accuracy setting.

Trace missing small areas
Reduce the Minimum Area setting.

Tracing is too slow
Try the following :
Decrease the Passes setting.
Reduce the Smoothing setting.
Reduce the bitmap size using Bitmap Effects.
Increase the Minimum Area setting.

Sharp edges look blurred
Try the following :
Use the 256 Colours mode if currently using True Colour.
Use the Monochrome mode if currently using Greyscale.
Reduce the Noise Removal setting.
Increase the Final Colour Tolerance setting.

Tracing accesses the disk frequently or runs out of memory
Reduce the bitmap size using Bitmap Effects
You have selected too many colours for the bitmap.

Tracer spends too long on the detail
Try the following :
Reduce the number of Passes.
Increase the Initial Colour Tolerance setting.
Decrease the Minimum Area setting.

_______________
See also
Bitmap Tracer



 Fit Text to Curve (Arrange Menu)
When the selection consists of a single line, shape or QuickShape and a text object, 
selecting Fit Text To Curve will fit the text along the edge of the object. The text can still be 
edited as normal after it has been fitted.

When a text object is selected which has been fitted to a curve, the Fit Text to Curve menu 
item will read Remove Text From Curve - selecting it will separate the two components 
leaving a text object and a line or shape (if a QuickShape was used it will have been 
converted to a shape).
_______________
See also
Text Tool
Placing text around a curve



A Flat Fill is a solid fill of a single colour. This type of colouring is applied using the Colour 
Line or the Colour Gallery. For more elaborate fills, use the Fill Tool.



Flat Transparency is a fixed level of transparency applied uniformly over a whole object(s).



Flipping an object is as if it was reflected in a mirror. This process is sometimes called 
'mirroring' or 'reflecting'.



 Flip objects

Objects can be flipped around the vertical and horizontal lines passing through the 
transformation centre.

1. Select the object(s) to be flipped (See Selecting & deselecting objects).
2. Do one of the following :

Press the Horizontal flip button on the Selector Tool Infobar.
Press the Vertical flip button on the Selector Tool Infobar.

Note
The transformation centre is only visible when selection handles are enabled and in 
Rotate/Skew mode. The flip will normally occur around the centre of the selection unless you
have moved the transformation centre.



A control bar is described as Floating when it has been dragged and dropped away from 
the edges of the CorelXARA window. A floating control bar has a thick edges so it can be 
resized, a title bar and a close button. A floating control bar moves independently of the 
CorelXARA window.

          A floating control bar



A Folder is a directory on disc which contains a number of graphics/font files and possibly a 
sub-directory containing an index and thumbnails for the items, depending what sort of files 
they are. Currently CorelXARA (.XAR) and Photo CD (.PCD) files do not require these external 
thumbnails, as they are built into the files themselves.



A Font is a collection of characters which are all designed in a particular style. Also known 
as a "typeface". Many different types of fonts are available; often the difference between 
them is very slight. A font often has several variants, the commonest being Bold and Italic.



 Font Gallery (Utilities Menu)

 SHIFT+F9
The Font Gallery allows you to select fonts visually from a list to use them in your drawings 
and also allows you to install and de-install TrueType and Adobe Type Manager (ATM) fonts.

The gallery usually shows all available fonts in three sections :
Installed fonts
Uninstalled fonts grouped by appearance and type (from the CorelXARA CD)
Uninstalled fonts (complete list of the CD fonts)

On the left-hand side of the font is an indicator which shows the format of the font :
Adobe Type Manager (ATM) Type 1
TrueType

Apply Apply the font to the selection.
Install Install the selected font(s).
De-install De-install the selected font(s).
Remove Remove the selected gallery section(s).
Add Fonts Add more fonts to the gallery.
Options Font Gallery options.

Many operations using the Font Gallery are made easier by the Font Gallery pop-up menu.
_______________
See also
Selecting items in a gallery
Galleries



 Font Gallery (Utilities Menu)
 SHIFT+F9

The Font Gallery item on the Utilities menu and the Font Gallery button open the Font 
Gallery if it is closed and close it if it is open. The button remains pressed in if the gallery is 
open.



Font Gallery - Add Fonts Button
The Add Fonts button in the Font Gallery opens a dialog box that lets you choose a folder of 
fonts to add to the gallery as a library. Only font folders on (or copied from) CorelXARA CD's 
can be added. See Add Folder dialog box.



Font Gallery - Apply Button
The Apply button in the Font Gallery applies the selected font to the currently selected text 
objects and regions.
A font can also be applied by dragging a font over a text object and dropping. Dropping onto
a selected region applies the font to that region otherwise the font is applied to the whole 
text story.
If you want to apply a font to a single character do one of the following :

Select the character then drag-and-drop the font onto the character (see Selecting 
text).

Start dragging the font then hold down CTRL. You can then drop the font onto the 
character without having to select it first.

If the selected font is currently not installed, it is installed when you apply it.
You can also apply fonts by double clicking them in the gallery, this will apply the font to the 
selection. CTRL-double-clicking will apply the font and close the gallery.



Font Gallery - De-install Button
The De-install button in the Font Gallery de-installs all selected fonts. Only those fonts shown
in the Installed Fonts section in the Font Gallery can be de-installed. See De-installing a Font 
for more details.



Font Gallery - Install Button
The Install button in the Font Gallery installs all selected fonts, see Installing a Font for more 
information.
There are different suggested limits of the number of installed fonts on Windows 3.1x, 
Windows 95 and Windows NT. Check your Windows User Guide.



Font Gallery - Options Button
Clicking the Options button in the Font Gallery opens a menu containing the following 
options :

Add Fonts
Find
Sort
Properties



Font Gallery - Pop-up Menu

Right-clicking on the Font Gallery opens a pop-up menu which contains the following options
:

Apply Identical to the Apply Button.
Install Identical to the Install button.
De-install Identical to the De-install Button.
Remove Section Identical to the Remove Button.
(Un)Fold Section Folds up or unfolds the current section.
Previous Section Moves to the start of the previous section.
Next Section Moves to the start of the next section.

Using the pop-up menu can be quicker as it allows you to open the menu and select a font at
the same time by right-clicking on the font.



Font Gallery - Remove Button
The Remove button in the Font Gallery removes the selected sections from the gallery. You 
will be asked to confirm the operation.



A Fractal Fill produces a patchy random fill for an object. It uses two colours and graduates 
between them. The two colours and the fill mapping can be used to alter the fill.



Fractal Transparency produces a patchy, random transparency for an object. The three 
transparency handles give control of the block of fractal texture used to control the 
transparency of the object. One handle moves the entire fractal and the other two scale, 
skew and rotate it.
The start handles control the start transparency for the fractal, the end handle controls the 
end transparency.



Problem creating fractal

Cause
Either (i) the program is short of free memory; or (ii) the "FractalDPI" setting in the 
CORELXRA.INI initialisation file is corrupt. This setting is the default resolution used for the 
creation of fractal fills.

Recommended action
Do one of the following :

Close some other applications to free some memory in your machine.
Close CorelXARA and edit the CORELXRA.INI file, found in your Windows directory, so 

the "FractalDPI" setting is 96.    Restart CorelXARA.
Close CorelXARA and delete the CORELXRA.INI file. Restart CorelXARA.



 
 Freehand Tool

The Freehand Tool allows you to draw freehand lines and shapes as you would with a pen on 
paper. You can edit freehand lines in the same way as those drawn with the Shape Editor 
Tool or Pen Tool. It can also be used to extend and redraw sections of existing lines and 
shapes.

F3
Freehand Tool Infobar Controls

Smoothing
Refit Indicator

Freehand Tool Operations
Drawing a line with the Freehand Tool
Drawing a shape with the Freehand Tool
Redrawing part of a line or shape
Extending a line
Joining lines
Smoothing a freehand line or shape

On-line Demonstrations
    {button Drawing Lines and Shapes with the Freehand 

Tool,EF("XaraDemo.exe","FreeDraw.avi `Drawing Lines and Shapes with the Freehand 
Tool'",1) }

    {button Editing Lines and Shapes with the Freehand 
Tool,EF("XaraDemo.exe","FreeEdit.avi `Editing Lines and Shapes with the Freehand 
Tool'",1) }
_______________
See also
Pen Tool
Shape Editor Tool



 Freehand Tool - Re-fit Indicator
The Refit indicator on the Freehand Tool Infobar shows 'Re-fit' when you can use the 
Smoothing slider to smooth the currently selected line.



 Freehand Tool - Smoothing Slider

The Smoothing slider on the Freehand Tool Infobar controls how closely a freehand line 
follows the original mouse movements. Setting the slider to 100% smoothing will smooth out
your mouse movements as much as possible, generating the smallest possible number of 
points on the resulting line. With the slider set to 0% almost no smoothing is performed, 
leaving you with a very accurate reproduction of your mouse movements and a great many 
control points.

After you have drawn a freehand line it is possible to modify the smoothing by dragging the 
slider, until you make further edits (for example by dragging a point handle). The Refit 
Indicator displays 'Refit' when you can still smooth the line.

If no freehand line is selected, the slider sets the default smoothing for lines drawn with the 
Freehand Tool.
_______________
See also
Smoothing a freehand line or shape



 Full Screen (Window Menu)    
 NumPad 8

CorelXARA works in two modes. Normal Mode and Full-screen Mode. They have their own 
settings for the display of the control bars and the Status Line and Colour Line. The current 
settings for each mode are remembered and apply whenever you change modes. This 
makes it possible to switch between two customised modes.
In Full Screen mode, move the pointer to the top of the screen to display the menu bar.

Full screen mode is also available from the View Pop-up Menu.

On-line Demonstration
    {button Full Screen Mode,EF("XaraDemo.exe","FullScrn.avi `Full Screen Mode'",1) }

Note
The key shortcut only works if NumLock is enabled on your keyboard.
If the scroll bars are turned off in a mode, the Push Tool can be used to slide the page.
When you switch modes all galleries are closed.



Full Screen Mode gives the maximum possible screen area for the editing window. No Title 
Bar, Menu Bar, Scrollbars or Status Line are displayed. Move the pointer to the top of the 
screen to display the Menu Bar.
8 on the numeric keypad lets you toggle between the two modes. (NumLock must be on.)
The alternative to Full-screen mode is Normal Mode.



Compuserve GIF bitmaps are widely used for pictures in World Wide Web pages. CorelXARA
can import and export in GIF format.



Gaddesden Place

Gaddesden Place - the home of Xara Ltd

Gaddesden Place was designed by James Wyatt and built between 1768 and 1773. It is 
reputed to be Wyatt's first country work and accurately represents his conformity at the 
start of his active career to the English Palladian tradition. The house is set in an elevated
position overlooking the Gade valley near Hemel Hempstead in Hertfordshire and enjoys 
one of the finest views in the Home Counties. The conservatory was added in 1891 and 
has recently been extensively restored. The quadrant links and north and south pavilions 
were demolished in 1955 and 1963 because of dry rot. Since becoming the headquarters 
of Computer Concepts & Xara Ltd, work has commenced on the rebuilding of the south 
wing, and the house and its grounds have been frequently used as film locations.



Galleries

Galleries contain lists of items and support drag-and-drop to let you do things such as 
loading clipart, change the order of layers and apply attributes. Some galleries also let you 
create new items and some have search facilities to find items in long lists.

Four of the galleries list items that are in documents :

Colour Gallery
Layer Gallery
Bitmap Gallery
Line Gallery

Two galleries list items stored on disc that you can use in a document if you want.

Fill Gallery
Clipart Gallery

The Font Gallery shows both items that are in documents and items that are on disc.

Font Gallery

The galleries have many common features; the title bar allows you to position the gallery on 
the screen. You can resize any gallery using the window border in the normal way. The close 
button closes the gallery completely. When you want to reopen a gallery use the appropriate
button on the control bar or a keyboard shortcut.
All galleries have a row of buttons under the title bar for working on selected items in the 
gallery and for setting gallery options. Note that you can make the buttons at the top of the 
galleries large or small using the Control Bars dialog box .
The main display area of all galleries is scrollable and contains one or more sections. Each 
section is shown by a grey "section bar" with a folder icon in it and the name of the section 
written in white. Sections can be folded so that only the section bar is showing or unfolded 
to see all the items within them. To fold or unfold a section double-click on its grey section 
bar or click on the folder icon.

Using Galleries
Selecting items in a gallery
Moving & resizing galleries
Reordering gallery items
Reordering gallery sections
Searching a gallery
Altering gallery display format
Closing a gallery
Adding a folder to a gallery
Adding files to a gallery
Updating a disc-based gallery



Galleries provide you with an easy way to select items from external libraries or where 
there is a wide range of possibilities. CorelXARA has seven galleries; for more information, 
see Galleries.



Gallery Control Bar

The Gallery Control Bar contains seven buttons which are used to open and close the seven 
CorelXARA galleries.

Colour Gallery
Layer Gallery
Bitmap Gallery
Line Gallery
Font Gallery
Clipart Gallery
Fill Gallery

_______________
See also
Default Control Bars



Gallery Find Dialog Box

Use this dialog box to search galleries to find and select items. It is particularly useful if a 
gallery contains many items, like the Clipart Gallery. The dialog is opened by clicking the 
Options button in a gallery and selecting Find from the menu.

Find items including text
Enter the text to search for in this edit-field.

Search Names and Keywords & Search full information
Click one of these radio-buttons to either restrict the search to the names (and filenames) 
and keywords of gallery items, or search all information available for each item. If you wish 
to find a piece of clipart from the clipart book, type the name shown by the picture into the 
edit field, and click Find First. There is no need to change the search type as both will search 
for the name of the file.
This table shows which information is searched for the two searching options.

Names & Keywords All Information
Colour Gallery colour name name, definition (e.g. RGB(255,255,255) ) & 'not in use'
Bitmap Gallery filename & title filename & title
Font Gallery typeface name & filename typeface name, filename & file size
Clipart Gallery title, keywords & filename title, keywords, filename, file size & full description (if 
present)
Fill Gallery title, keywords & filename title, keywords, filename, file size & full description (if 
present)

Find first
Click this button to start the search.    If the gallery does not contain any items that match 
the search text, a message box will be displayed.

Find next
Click this button to continue a search that has just found an item (or which starts at the 
currently selected item).    If the gallery does not contain any more items that match the 
search text, a message box will be displayed.
_______________
See also
Searching a gallery
Gallery Sort dialog box
Gallery Properties dialog box



Gallery Properties Dialog Box

The Gallery Properties dialog box is used to alter the way items are displayed in each of the 
Galleries. Note that not all the options shown are available for all galleries. The dialog box is 
opened by clicking the Options button in a gallery and selecting Properties from the menu.

Display as small icons
Choose this option to display the items smaller within a section, so that as many as possible 
are visible within the gallery.

Display as large icons
Choose this option to display items larger within a section, so each item can be more clearly 
seen.

Display full information
Choose this option to display items within a section with further information, such as a 
bitmap's file size.

Display as icons only
Some galleries, such as the font gallery, allow you to choose this option, which will cause the
gallery to display only the descriptive thumbnails of the items it contains.

Display as text only
Some galleries, such as the font gallery, allow you to choose this option, which will cause the
gallery to display only text descriptions of the items it contains.
_______________
See also
Gallery Find dialog box
Gallery Sort dialog box



Gallery Sort Dialog Box

The Gallery Sort dialog box allows you to sort the contents of the Clipart Gallery, Font 
Gallery, Fill Gallery or the Colour Gallery. To open the dialog box, open the relevant gallery, 
click Options and select Sort from the menu.

Primary and Secondary Keys
You can choose a sorting-order for items within the gallery from these two drop-down lists.    
Items can be sorted by name (alphabetically), by their size in memory, by their size on disk, 
by the file type, or by the length of their name (depending on the gallery).    If the Reversed 
check box is checked then the items are sorted in the reverse order.
For example, you may have a gallery of bitmaps that you would like sorted according to the 
type of bitmap, e.g. .BMP or .JPG, and within each category of bitmap, alphabetical order.    To
sort the items this way choose Sort By File Type from the Primary Key list and Sort by name 
from the Secondary key.

Apply sort to all the gallery sections
Select this option to apply the sort to all the items within all folders contained in the gallery.

Only apply the sort to sections containing selected items
Click this radio-button to apply the sort to only those sections which have an item selected 
within them.    See Selecting items in a gallery.
_______________
See also
Gallery Properties dialog box
Gallery Find dialog box



General Control Bar

Colour Editor
Bitmap Tracer
Bitmap Effects
Unit Options
Scaling Options
Page Options
Options

_______________
See also
Default Control Bars



 General Options
The general options for CorelXARA are accessed by selecting Options from the Utilities menu
and clicking on the General 'tab'.

Save Setting Now
This saves the current settings and overwrites the existing defaults.
This button is useful if Save Settings on Exit is not selected. Clicking Save Settings Now 
makes the current settings the defaults (they apply whenever you load CorelXARA).

Recent File List Size
The File menu contains a list of the most recently loaded files as a quick and easy way to 
reload them. The number of files shown in the File menu can be set (from 1 to 9) using 
this option.

Import With Layers
Many other packages have multiple layers. With this option selected, the layer 
information is preserved when EPS files are imported. If this option is not set, all objects 
imported from the EPS file will appear in one layer. The Import dialog box shows an 
Import Layers option, this can be used to enable or disable layer importing for a 
particular file (see Import).

Save Settings On Exit
With this option selected, the current settings are saved on exit and apply when you next
run CorelXARA. These settings include the control bar positions (for normal and Full 
Screen mode) and the current directories set in the file dialog boxes (Open, Import etc).

Current Layer Always Visible and Editable
With this option selected, selecting a layer in the Layer Gallery automatically makes it 
both visible and editable. If this option is not set, the current editable and visible status 
do not change when you select a layer.

Give New Objects Most Recent Attributes
With this option set, new objects take the attributes that were most recently applied. So, 
for example, if a shape is filled with a fractal fill, the next shape drawn will also be fractal
filled.

Ask Before Setting Attributes
With this option selected, CorelXARA asks before changing the current attribute.
This option is automatically unset when the Quiet option is selected in the warning dialog
box that appears confirming the setting of the current attributes. If this button has been 
pressed, the warnings can be re-enabled by setting this option.

Ask before making greyscale bitmaps
Only greyscale bitmaps can be used as bitmap transparency or successfully recoloured 
(contoning). CorelXARA can convert other types of bitmap to greyscale when required. 
This option controls whether you are prompted before bitmap conversion.

Ask before closing views
With this option selected, when you load a document, CorelXARA asks if you want to 
close the existing document. Many other programs let you have only a single document 
in memory and you may prefer to work in this way.
With this option unselected, loading a document keeps the existing document in 
memory.



Angle Constraint
When moving, rotating and skewing objects and moving handles, the CTRL key can be 
used to constrain the angle of movement. This angle is set using this option. The value 
can be selected from the drop-down list, or typed into the field (in degrees).

Nudge Size
When moving (nudging) objects and handles using the cursor keys, they move by a set 
amount. This option sets the nudge distance.

Duplication Distance
Duplicate creates a duplicate of the selection which is offset from the original object(s). 
The horizontal and vertical offset is set using this option.
Positive values set the offset to the right and above the selection, negative values down 
and to the left.



General failure to read or write a file

Cause
There may be a number of reasons why it is not possible to read or write the file. 

If the file is on a floppy disk, the disk may have been removed from the drive.    

If the file is on a hard disk, the disk structure may be corrupt.

Recommended action
If the file is on a floppy disk, check the disk is correctly inserted in the drive.

If the file is on a hard disk, run your disk diagnostic utilities to check for a corrupted disk 
structure.



 Get help with CorelXARA
If you experience a problem using CorelXARA, try :

Looking through the CorelXARA manual to see if you can find what you need.
Reading the text on the Status Line at the bottom of the main CorelXARA window. It 

always describes what actions are currently possible and what they will do, even during 
drags and so is ideal for learning to use the CorelXARA tools. It also gives details of what 
buttons and controls do as you move the pointer over them.

Choose Help Topics from the Help menu and search the on-line documentation.
ToolTips; Hold the mouse pointer over a button or control for a short while and a small

message    appears describing its function.



A Grid is a set of regularly spaced points to which objects and points can be snapped. By 
setting an appropriate grid spacing and turning grid snapping on, it is very easy to create 
drawings of very precise dimensions.
The grid can be shown or hidden whether or not grid snapping is turned on. 
At small zoom levels, grid points may become very close to each other. If they were all 
displayed, the screen would be covered by points and it would be difficult to see the 
drawing. To prevent this, CorelXARA leaves out some points if necessary. You can still snap to
these invisible points.
There are two types of grid in CorelXARA. Rectangular grids space points at 90 degrees to 
each other forming squares. Isometric grids space points at 60 degrees to each other 
forming isometric triangles.



 Grid & Ruler Options
The grid and ruler options for CorelXARA are accessed by selecting Options from the Utilities 
menu and clicking on the Grid & Ruler 'tab'. They control the way the grid and rulers appear. 
The grid and rulers share the same options because they are so similar.

Grid and Ruler Spacing
Major Spacing defines the distance between the major grid and ruler divisions. You can type 
a values into this fields using any unit (see Using units).
Number of Subdivisions sets how many subdivisions exist between each major division.

The units used for the grid and rulers is defined by the units you use for the Major Spacing. 
e.g. entering a major grid spacing of "2cm" will set the grid and ruler units to centimetres 
regardless of the page units specified in the Unit options.

Grid Type
CorelXARA    allows the use of a standard rectangular grid or an isometric grid.

Origin (0,0 point)
Normally the origin for the grid and rulers is at the bottom left-hand corner of the page. If 
you wish to move it to a different location, change the Origin value.
You can also move the origin by dragging on the rulers, see Moving the ruler zero point for 
more details.



 Group (Arrange Menu)
 CTRL+G

Combines the selection into a single grouped object.

Objects inside groups can be selected and edited without being first removed from the 
group. See Selecting objects inside objects

On-line Demonstration
    {button Grouping Objects,EF("XaraDemo.exe","Groups.avi `Grouping Objects'",1) }

_______________
See also
Ungroup



Guide Objects are objects placed or created in the guides layer. They can be any type of 
object including text and QuickShapes. Use guide objects to align or position objects on 
other layers. To make this easier you can make guide objects magnetic. Guide objects are 
non-printing and are always displayed as dotted outlines. For more information, see Using 
guides.



Guideline Pop-up Menu

If the pop-up Menu is opened with the mouse pointer over a guideline, it contains the 
following options :

Delete Removes the guideline.
Snap To Guides
- - - - - - - - - -
Properties
Guide Layer Properties



Guideline Properties Dialog Box

This dialogue box allows you to enter the exact position for the guideline. Type a value and 
click OK.
If you are creating a new guideline, clicking Cancel will stop a new guideline being created. If
you are altering the position of an existing guideline, it will leave the guideline where it was.

Note
The units used for the guideline position are the Page Units set for the document. You can 
change these in the Unit Options. Note however that the units used on the rulers (and grid) 
are set using the Grid and Ruler Options.
______________
See also
Units in CorelXARA



Guidelines are horizontal and vertical dotted lines displayed across the entire width or 
height of the window. You can use them to align or position objects. To make this easier you 
can make guidelines magnetic. Guidelines are non-printing and live in the guides layer.
For more information, see Using guides.



The Guides Layer is a special layer containing guide objects and guidelines which are used 
to align and position objects accurately. All objects on the guides layer are shown as dotted 
outlines and can be made magnetic to aid positioning. If a blend object is placed on the 
guides layer the intermediate objects are ignored. The guide layer is created automatically 
when you create a guideline and can be created manually using the Layer Gallery. The 
guides layer would normally be used to hold objects providing a framework to which objects 
in other layers are aligned. For more details, see Using guides.



Many people find HSV the easiest colour model to use. The HSV colour model uses Hue, 
Saturation and Value components to define colours. Hue is the pure pigment (defined as an 
angle round the colour circle) of the colour. Saturation is the amount of white added to the 
colour. The smaller the Saturation value, the greater the amount of added white. Value is the
amount of black added to the colour which can be viewed as the brightness of the colour. So
the Saturation and Value produce all the shades of the basic Hue value.



A Handle is a small square used to edit something. For example Fill Handles are used to edit
fills and Selection Handles to manipulate the currently selected objects.
Handles are usually dragged to perform editing function.

            Handles can be used to edit an object.



Help Menu

Help Topics
Using Help

Using the Tools
Using the Galleries
On-line Demonstrations

Technical Support

About CorelXARA



Contents (Help Menu)    F1
 F1

Help Topics on the Help menu opens the CorelXARA on-line documentation.



Hewlett Packard Printers

Some HP printer drivers (the driver versions are 6.1D, 7.0 and 7.1) default to using an old 
Windows printing method. CorelXARA and other applications do not support this method of 
printing and output with the standard settings will be wrong. The symptoms of these 
problems can appear as :

1.    Very long print times
2.    General Protection errors within an HP module during printing
3.    CorelXARA locking up when asked to print
4.    The printer spooler failing to respond after CorelXARA has started printing.
5.    When using the "Normal" output printing type from CorelXARA, vector images print 

incorrectly (as though the object is scaled by a very large value)

The problem can be solved by altering a value within an INI file.    The specific file for users of
version 6.1D drivers is called DeskJetC.ini (irrespective of whether you have a laser printer or
an InkJet printer). Version 7 drivers create an HP**.ini file (where ** is a number depending 
upon the type of printer in use).    The file is held within the Windows directory:

Version 6 drivers
1. Load Windows\DeskJetC.INI into an Editor (Notepad or WordPad for example).
2. Scroll down through the text until you find the entry "0jumbotechnology=0100".
3. Change this to read "0jumbotechnology=0000".
4. Save the file and restart Windows. Your printer should now produce satisfactory results 
from CorelXARA and other packages. (see note)

Version 7 drivers
1. Load Windows\HP**.INI (the ** will be a number depending on the printer in use) into an 
Editor (Notepad or WordPad for example).
2. Scroll down through the text until you find the entry "0jumbotechnology=0100".
3. Change this to read "0jumbotechnology=0000".
4. Save the file and restart Windows. Your printer should now produce satisfactory results 
from CorelXARA and other packages. (see note).

Note
Hewlett Packard indicate that this flag switches off the old windows print system, but 

that some applications may require the flag to be reset. This would require altering the 
above ini file in reverse. Please note that CorelDRAW 5 also requires the 
"0jumbotechnology=0000" setting.



Turn off error-diffused dithering in Windows 95

There is an unhappy interaction between the way CorelXARA prints and Windows 95's error-
diffused dithering.

1. Click on the Start button then click Settings.
2. Click Printers.
3. Click the printer that you're using then go to the File menu and click Properties.
4. Click the Graphics tab.
5. Ensure that the "Error diffused" switch isn't checked in the Dithering area. You'll 

have to choose a different dither mode to uncheck it.
6. If you made any changes click OK and try to print again.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



 
This documentation contains a large collection of pages to help you to use CorelXARA. 
Choose one of the categories below for more information on that subject.

Manipulating objects
Lines and shapes
Colour
Fills
Transparency
Bitmaps
Text
Moulds
Blends
Control bars and galleries
Miscellaneous



How to reach Corel worldwide

Worldwide Technical Support
Customer Service Worldwide is handled by Alexander and Lord, Dublin, on behalf of Corel 
Corporation. Customer service for any countries not listed below is handled on a toll-line at 
+(353)1 706 3912

Telephone Numbers for CorelXARA Technical Support
Austria 0660 5875 Italy 1678 74791
Belgium 0800 11930 Norway 800 11661
Denmark 800 18755 Spain 900 953538
France 0590 6512 Switzerland 155 8224
Germany 01 308 15074 Sweden 0207 91085
Holland 0602 22084 United Kingdom 0800 581028

Corel Corporation Customer Service in Australia 
49 B Bracken Road Micromatch Pty. Limited 1-800-658-
850
Sandyford Industrial Estate 7B Green Street
Sandyford, Dublin, Ireland Brookvale, NSW

2100, Australia

World Wide Support
Corel customers residing outside of North America    can contact Corel Technical Support 
representatives in Dublin, Ireland, or a local Authorised Support Partner. The Corel Support 
Representatives in Ireland handle calls in the following languages: German, French, Spanish, 
Italian, Dutch, and English. Calls are handled on toll lines. A charge will appear on your 
telephone bill,    but there is no charge for the technical support.

Warranty Support
Free technical support is available to you for 30 days from the day you place your first call to
technical support. If you require technical support beyond your warranty period, see    
Extended Technical Support Services listed above.

Access Numbers for Corel Technical Support
Dutch +(353) 1-708-2266 German +(353) 1-708-2344
English +(353) 1-708-2333 Italian +(353) 1-708-2377
French +(353) 1-708-2355 Spanish +(353) 1-708-2388

Australian Authorised Support Partner
Support 24 07-55-918-0043

_______________
See also
Electronic Support Options
How to use Automated Fax System



The Hue colour component is used in the HSV (Hue, Saturation, Value) colour model, which 
is an intuitive colour model most often used by artists.
Hue represents an angle in degrees around an imaginary colour wheel, where the colours 
appear in a "rainbow" fashion: Red (0), Yellow (60), Green (120), Cyan (180), Blue (240), 
Magenta (300) and back to Red (360)



 Import (File Menu)

 CTRL+SHIFT+I
Importing EPS
Choose the file you wish to load, choose the file format and click on OK. The file will then be 
loaded into the current document.
Alternatively, as CorelXARA supports drag and drop, files can be dropped onto the window to
load them into the current document.
If Import Layers is enabled any layer information in the file will be retained, otherwise, all 
objects in the file will be grouped as one object in a single layer. The default setting for this 
option is in the General Options. If the file format does not support layers, the setting is 
ignored.

Importing Colours
CorelXARA can load palette files created with CorelDRAW. See Importing colours & palettes.

Importing Bitmaps
CorelXARA can load bitmap files of several different formats directly into the current 
document. They can then be moved, rotated, scaled, sheared and have transparency 
applied to them within the document as well as used for bitmap fills and bitmap 
transparency.
Choose the relevant bitmap file type from the list or the Bitmaps item. Choose the bitmap 
file to load and click OK. The bitmap will appear in the top left corner of the current 
document (and in the Bitmap Gallery).

Note
The Import dialog will look slightly different under Windows 3.1 (& 3.11) and Windows NT.
_______________
See also
Importing CorelDRAW files
Importing transparent GIF files
Importing colours & palettes
Supported file formats





Importing CorelDRAW (CDR) files
CDR files from versions 3, 4, and 5 of CorelDRAW can be imported. All types of objects from 
CDR files are loaded.

Fills
All fill types apart from full colour pattern fills are supported. However, custom fills are 
imported as fills from the start colour to the end colour. Square fills are approximated to 
radial fills. Full colour pattern fills which are just a bitmap (no paths or other objects) are 
imported as bitmap fills.

Text
Text is imported with the font name, font size, bold, italic, underline, super/subscript and line
spacing attributes. Only the alignment and baseline shift options from the fit path to text 
roll-up are imported.
Text on a path can only be imported if the path it is fitted to still exists in the file. If you 
delete a path in CorelDRAW after fitting text to it, the text will be imported into CorelXARA as
normal text in the position it was before this operation. 

Special Effect
Mix, Colour limit and ColourAdd Lenses are supported. Other types of Lenses are not 
supported.
Some PowerClips may be imported incorrectly.
All other effects are supported.

Envelopes
Envelopes are approximated. You will be warned about this after the file has been imported if
there were any envelopes in the file.

Extrusions
Some extrusions cannot be imported correctly.

Colours
CorelDRAW has no concept of a named colour, so all objects have to be imported with local 
colours applied to them. The colours on the Colour Line are the default set for CorelDRAW. If 
you've edited these colours in your copy of CorelDRAW, you'll need to import your edited 
palette file into the document using the CorelDRAW Palette file filter as these colours are not
stored in CDR files. See Importing colours & palettes.

Lines
If lines are imported which have arrowheads, the object will appear as a group containing 
two objects, a line and a shape (the arrowhead). 

If Problems Occur
If any of these limitations cause problems, try saving the .CDR file from CorelDRAW as EPS 
and import that instead.
If a file is found to load incorrectly, please send the file to Corel Ltd with full details so we 
can fix the problem. See Technical Support for further details.



 Import transparent GIF files
CompuServe GIF files support 'masks' which are a very basic form of transparency. When a 
GIF with a mask is placed on a background (for example in a World Wide Web browser) 
some areas of the background will show through the bitmap. This method is often used to 
remove the background from pictures so the bitmap doesn't look rectangular.
If you import one of these files, the transparent mask is retained, you will be able to see 
through parts of the bitmap when it is in CorelXARA!

Tips
You can apply transparency to any bitmap, including this type of GIF file.
Remember you can create transparent GIF files with CorelXARA.



 Import colours & palettes
CorelXARA can import the following colour table and palette files.

CorelDRAW palette .CPL and .PAL
Microsoft palette .PAL
Adobe Colour Tables .ACT
Adobe Colour swatches .ACO
PaintShop Pro palettes .PAL

When imported, the colours contained in the file are recreated as named colours in 
CorelXARA and displayed in the Colour Gallery and on the Colour Line. As palette files do not
contain names, the names are made up using the components of each colour and the colour 
units (set in the Unit Options). This means pure red would appear as "R255G0B0" or 
"R100%G0%B0%" (depending on the colour unit setting).

For palette files that contain large numbers of colours, it may be easier to import the palette 
into a blank document and use the Colour Gallery to move the required named colours from 
the blank document into your selected document.    Using the Colour Gallery to apply a 
named colour from the blank document automatically copies that named colour into the 
selected document.

Tip
To import a palette into a document quickly, drag the palette file from Explorer or File

Manager and drop it on the document page. The new palette will be added to the Colour 
Line. To create a new blank document containing one of your palette files, drop the file onto 
CorelXARA away from the document page.
_______________
See also
Deleting a named colour



Incompatible processor

Cause
The processor in you computer is not suitable for running CorelXARA.    CorelXARA requires 
an i486 processor or better on Intel platforms.    If you have a Pentium processor, it may be 
an early version that exhibits the FDIV floating point division bug.

Recommended action
Contact your computer system vendor for an upgrade.    Intel have offered to replace 
defective Pentium processors free of charge.



Increase the pixel resolution

Objects which have transparent fills or bitmap fills are printed at the Transparency resolution
(see Output Options). When the Transparency resolution is quite low you can see the square 
pixels.

      Increase the transparency resolution.
1. Click the Utilities menu.
2. Click the Options item.
3. Click the Output tab.
4. Find the Transparency resolution area and click the "Manual" switch.
5. Type in a new transparency resolution (not higher than the resolution of the 

printer). A value between 150 and 300 is usually OK.
6. Click OK.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else can I try?



The Tool Infobar is a context sensitive control bar. It displays different information and 
controls dependent on the currently selected Tool. For example, when the Text Tool has been 
chosen the Infobar contains only text related controls.
The different functions available on the Infobar are described in the descriptions of the 
individual tools in the Tools section.
For information on hiding the Infobar, see Control Bars dialog box.



Input is invalid

Cause
You have entered data that is not of the correct format, or is incomplete.

Recommended action
The displayed error message explains what is wrong with what you have typed.    Please 
reenter the data and click OK.
_______________
See also
Units in CorelXARA



 Install a font
To install a font

1. Open the Font Gallery.
2. Find and select the required font(s) (see Selecting items in a gallery)
3. Click the Install button.

Alternatively, clicking the Apply button installs the font and applies it to the selected 
text/cursor (or sets the current attribute if nothing is selected).

Most programs show the installed font(s) in their font list immediately. You may find a few 
programs that you have to close and then reload before they show the new fonts. This is 
beyond the control of CorelXARA.
_______________
See also
De-installing a Font
Applying Attributes to Text



 Install the WWW template document
If you want to set CorelXARA up so every time you create a new document it uses the WWW 
browser palette and has the page units set to pixels, do the following :

1. Load www.xar.
2. From the File menu, choose Save Template.

Tip
If you want to return to the original settings, delete the file template.xar from inside 

the CorelXARA directory. When you next run CorelXARA, it will re-create the original file.



Inter-line Spacing is a term used by CorelDRAW to refer to what CorelXARA calls Line 
Spacing. See Text Tool - Line Spacing.



Interlacing can be used with CompuServe GIF files. This means that when the file is loaded 
into an application which supports it, the file will first appear as a low resolution image and 
the resolution increase as more of the file is loaded.
This technique is used commonly on the World Wide Web to improve the appearance of 
bitmap loading.



Internal error

Cause
A logical error in CorelXARA has been detected.

Recommended action
Please note the circumstances that led up to this message being displayed, and report the 
problem to Corel. See Technical Support. 

If you click the Continue button you will usually be able to save your work and restart the 
program. It is highly recommended that you save the file to a different filename. It is 
possible the file created will be corrupt due to the internal error and saving the document to 
the same filename will delete the old version and possibly remove any chance of data 
recovery.

After saving the file, exit CorelXARA and restart.



 Intersect Shapes (Arrange Menu)
Discard those areas of the selected objects not covered by the front object. The front object 
disappears.
The front object may be a group for more complex intersection. This operation is the 
opposite of Subtract shapes.
If the intersection results in more than one shape they will be grouped.

On-line Demonstration
    {button Intersecting Objects,EF("XaraDemo.exe","IntShape.avi `Intersecting 

Objects'",1) }



Invalid filename

Cause
You have entered an incorrect name for a file.    Often this is because the filename contains 
characters that are not permitted in filenames.

Recommended action
Different versions of Windows have different rules concerning what is valid in a filename.    
Generally filenames conforming to the MS-DOS convention will work on all versions of 
Windows.
MS-DOS filenames consist of: 

Up to 8 characters, 
Followed by a period (.), 
Followed by up to 3 characters (the extension).

Spaces, control characters, or punctuation marks are not permitted.

Windows NT and Windows 95 relax these rules, allowing filenames up to 256 characters long
that may contain spaces.    If your filename does contain spaces, you should surround it with 
double quotation marks, e.g. "this filename has spaces.xar"



Isolate Points (Bitmap Effect) highlights colour changes in bitmaps that apply to a single 
pixel. It can be used to create some interesting effects.



The JPEG format allows bitmaps to be stored in compressed form. Unlike most other 
compression techniques, the amount of compression is user selectable. JPEG works by 
discarding redundant information (it is 'lossy') although generally there is no noticeable 
reduction of image quality.
CorelXARA can import and export JPEG bitmaps.



 Join Shapes (Arrange Menu)
Join Shapes joins all the shapes and lines in the selection to form a single object. Because 
overlapping parts of the same shape are drawn with no fill colour (i.e. you can see through 
the overlapping parts), you can use this effect to create holes in shapes, by joining several 
shapes together.

The Join menu options will tie together a number of different shapes into one shape making 
all the parts that overlap see-through.

For example, joining an object with a smaller circle on top of it produces an object with a 
circular hole in it.

On-line Demonstration
    {button Joining and Breaking Lines and Shapes,EF("XaraDemo.exe","JoinBrk.avi `Joining 

and Breaking Lines and Shapes'",1) }
_______________
See also
Break Shapes



 Join lines
1. Choose the Selector Tool.
2. Click on the first line to select it.
3. SHIFT-click on the second line to select it.
4. (Using either the Selector Tool or the Shape Editor Tool) drag the end point handle of one

line over the end handle of the other line - the mouse pointer shows a '+' when the two 
handles are over each other.

5. Release the mouse button and the lines will be joined.
_______________
See also
Breaking lines and shapes apart
Adding points to a line or shape
Extending a line



Kerning allows you to alter the space between two characters in a line of text. Kerning is 
useful when two characters look unbalanced or too far apart. Small kerning changes 
between the two characters can improve their appearance. This is often necessary in very 
large headline or banner text where the "balance" of the characters is highly visible.
Kerning is measured in em's (the width of an "M" in the current font and font size).



The Key component is used in the CMYK (Cyan, Magenta, Yellow, Key) colour model, which is
commonly used by printers. By mixing various quantities of these four inks, a large range of 
colours can be generated. Key is black ink.



 Keyboard Shortcuts
CTRL+A Select all
CTRL+B Put object to back
CTRL+C Copy object to clipboard
CTRL+D Duplicate object with offset
CTRL+E Open/close the Colour Editor
CTRL+F Bring object to front
CTRL+K Clone object
CTRL+L Show Rulers
CTRL+N New document
CTRL+O Open document
CTRL+P Print document
CTRL+R Previous Zoom
CTRL+S Save document
CTRL+V Paste object from clipboard
CTRL+X Cut selection to clipboard
CTRL+Y Redo
CTRL+Z Undo
CTRL+SHIFT+D Move object to layer behind
CTRL+SHIFT+A Paste Attributes
CTRL+SHIFT+U Move object to layer in front
CTRL+SHIFT+B Move object backwards
CTRL+SHIFT+Z Zoom to Selection
CTRL+SHIFT+E Export
CTRL+SHIFT+F Move object forwards
CTRL+SHIFT+I Import
CTRL+SHIFT+L Open the Alignment dialog box
CTRL+SHIFT+O Open the Options dialog box
CTRL+SHIFT+P Zoom to Page
CTRL+SHIFT+S Convert to Editable Shapes
CTRL+SHIFT+T Display time taken to redraw the current document.
CTRL+SHIFT+V Paste object in original position
ALT+S Choose Selector Tool
ALT+X Choose Push Tool
ALT+Z Choose Zoom Tool
DELETE Delete the selection (unless Text Tool selected)
ESC Clear selection
SPACE Choose Selector Tool (unless Text Tool selected)
# Show Grid
< Undo
> Redo
F1 Help with CorelXARA
F2 Choose Selector Tool
F3 Choose Freehand Tool
F4 Choose Shape Editor Tool
F5 Choose Fill Tool
F6 Choose Transparency Tool
F7 Choose Blend Tool
F8 Choose Text Tool
F9 Open Colour Gallery
F10 Open Layer Gallery
F11 Open Bitmap Gallery
F12 Open Line Gallery
CTRL+F1 Display Information about CorelXARA



SHIFT+F2 Choose QuickShape Tool
SHIFT+F3 Choose Rectangle Tool
SHIFT+F4 Choose Ellipse Tool
SHIFT+F5 Choose Pen Tool
SHIFT+F6 Choose Mould Tool
SHIFT+F7 Choose Zoom Tool
SHIFT+F8 Choose Push Tool
SHIFT+F9 Open Font Gallery
SHIFT+F10 Open Clipart Gallery
SHIFT+F11 Open Fill Gallery
Numeric Keypad . Snap to grid
Numeric Keypad * Snap to objects
Number Keypad 8Select full screen
' , ' or '<' Undo
' . ' or '>' Redo
Cursor keys Move the selection in the Selector Tool or specific handles in other tools

(e.g. fill handles)
_______________
See also
Text Tool Key Shortcuts



All the CorelXARA clipart has Keywords associated with it. Keywords are associated words 
which help you to find documents more easily. As an example a document containing a 
picture of a puppy might contain the keywords "animal" and "dog".
For information on adding keywords to your own files, see Using titles, descriptions and 
keywords.



Laplacian (Bitmap Effect) highlights sharp colour changes in bitmaps.



Ensure LaserJet driver is in "Raster" mode

      Under Windows 3.1 set the driver to "Raster" mode instead of "HP-GL/2".
1. Click the File menu in CorelXARA and click Print Setup.
2. Click the Options button of the Setup dialog box.
3. Use the "Graphics Mode" list to choose "Raster" instead of "HP-GL/2".
4. If you changed any settings Click OK and try to print again.

      Under Windows 95 set the driver to "Raster" mode instead of "Vector".
1. Click the File menu in CorelXARA and click Print Setup.
2. Click the Properties button of the Setup dialog box.
3. Click the Graphics tab and check the "Raster graphics" switch instead of "Vector 

graphics".
4. If you changed any settings Click OK and try to print again.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



Ensure LaserJet driver properties are correct

Make sure the printer driver knows the correct amount of memory in the printer.

      Under Windows 3.1:
1. Run Control Panel and double-click Printers.
2. Make sure your printer is selected then click Setup.
3. Find the field labelled Memory (MB) and set its value correctly. (Refer to your 

printer's manual for details of how to find the correct values for both these fields.)
4. If you changed any settings Click OK and try to print again.

      Under Windows 95:
1. Click the File menu in CorelXARA and click Print Setup.
2. Click the Properties button of the Setup dialog box.
3. Click the Device options tab and alter the value of the Printer memory field to be 

correct for your printer.
4. Also set the Reserved memory field correctly. (Refer to your printer's manual for 

details of how to find the correct values for both these fields.)
5. If you changed any settings Click OK and try to print again.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



CorelXARA drawings can be drawn in Layers with different objects in each and with the 
layers laid on top of each other.
Layers behave exactly as the name suggests. They act like a series of transparent sheets 
laid on each other with opaque objects on one layer obscuring anything underneath them on
lower layers.
With layers it is possible to :

Permit editing of all layers or restrict it to only the current layer.
Show as many or as few layers as you wish.
Change the order of layers, front to back.
Name layers.
Create and delete layers.

The Layer Gallery is used to manage layers.
Layers can be used to act as overlays to show different levels of detail or to divide an 
illustration into layers for easy editing.
CorelXARA uses two types of layer: foreground and background. Background layers are 
identical to foreground layers except the do not print and are always behind the foreground 
layers.



 Layer Gallery (Utilities Menu)

 F10
The Layer Gallery gives you full control over the layers in a document. This includes the 
foreground and background layers and the guides layer.

The gallery shows two sections. The upper section lists all the foreground layers in the 
selected document, the lower section details the background layers which will not print. 
Note that the guides layer will never print. The current layer is the layer highlighted in the 
gallery and is the layer into which all newly created objects are placed.

Layers can be reordered simply by dragging them in the gallery. While the layer is dragged 
the mouse pointer will show an upward or a downward pointing arrow to indicate whether 
the layer will be placed above or below the layer under the mouse pointer.

             New  Create a new layer
             Copy  Copy an existing layer
             Properties  Layer properties
             Delete  Delete a layer
             All Visible  Display all layers
             All Editable  Unlock all layers

             Visible and Editable  Hide/lock individual layers
             Guides Layer  

Many operations using the Layer Gallery are made easier by the Layer Gallery Pop-up Menu.

On-line Demonstration
    {button Layers,EF("XaraDemo.exe","Layers.avi `Layers'",1) }

_______________
See also
Galleries
Selecting items in a gallery



 Layer Gallery (Utilities Menu)
 F10

The Layer Gallery item on the Utilities menu and the Layer Gallery button open the Layer 
Gallery if it is closed and close it if it is open. The button remains pressed in if the gallery is 
open.



Layer Gallery - All Editable

When the All Editable button in the Layer Gallery is selected all layers are unlocked and 
editable so objects in any layer can be edited. When this button is not selected the editable 
status of a layer is set by its own editable setting.



Layer Gallery - All Visible Button

When the All Visible button in the Layer Gallery is selected all layers in the document 
become visible. When this button is not selected, the visibility of a layer is set by its own 
visibility setting.
This button does not affect the guides layer.

Note
Objects in a non-visible layer cannot be seen or edited.



Layer Gallery - Copy Button
The Copy button in the Layer Gallery is used to copy a layer and its contents. Clicking it will 
open a dialog box from where the name for the copy can be entered.



Layer Gallery - Delete Button
The Delete button in the Layer Gallery will delete the current layer. If the layer contains 
objects you will be asked to confirm the deletion.



Layer Gallery - Guides Layer

Guidelines and guide objects live within the guides layer which can be locked to prevent 
editing of guides and also made visible or invisible as with any other layer. Remember that 
all objects in the guides layer are shown as dotted outlines. For more information on guides, 
see Using guides. Note that locking the guides layer against editing prevents you from 
moving or deleting all guidelines and guide objects.
You can quickly swap the visibility setting for the guides layer using Show Guides on the 
Window menu.



Layer Gallery - New Button
The New button in the Layer Gallery is used to create a new layer in a document. Clicking it 
opens a dialog box which prompts for a name for the layer.



Layer Gallery - Pop-up Menu

Right-clicking on a layer in the Layer Gallery opens a pop-up menu which allows you to 
operate on the layer. The menu contains the following options :

Copy Identical to the Copy Button.
Delete Identical to the Delete Button.
New Layer Identical to the New Button.
Create Guide Layer Creates the guides layer. For details more details on guides, see
Using guides.
Properties Opens the Layer Properties dialog box.



Layer Gallery - Visible and Editable Settings

        

Next to the layers listed in the Layer Gallery are two columns of switches. For each layer the 
left-hand switch indicates whether the layer is visible and the right-hand switch whether it is 
editable. The settings of these switches can be changed simply by clicking on them. The 
individual settings of both switches can be overridden by the All Visible and All Editable 
buttons (see below).
The current layer can also be forced to always be editable and visible (see General Options).

When a layer is visible, objects on it can be seen and edited. Making a layer invisible is a 
useful way of temporarily removing objects from a drawing which would otherwise make 
editing on other layers difficult.

When a layer is editable, objects on it can be selected and edited (making a layer non-
editable renders all selected objects on it deselected). If you try to click on an object on a 
non-editable layer the click will pass straight through it as if it was not there. Select All will 
only select object in visible, editable layers.

The visible and editable settings for a layer can also be set by selecting Properties from the 
Layer Gallery pop-up menu and using the Layer Properties dialog box.

If you shift-click on a Visible or Editable switch, all layers between that one and the last layer
you clicked on will have that switch turned on/off (depending on whether the one you shift-
clicked was off or on, respectively). This makes it much faster and easier to select/deselect a
range of layers.

Note
A non-visible layer cannot be seen or edited.



Layer Properties Dialog Box

The Layer Properties dialog box allows you to alter the properties of a layer and change the 
guides layer settings. The dialog box has two 'tabs'; Layer and Guides.

Layer
The Layer tab in the dialog box allows you to alter :

The name of the layer
Whether the layer is visible.
Whether objects in the layer can be edited.

These settings are duplicates of those shown in the Layer Gallery itself.

Guides
The Guides tab (shown above) allows you to create new guidelines and set the colour of all 
the guidelines and guide objects in the guides layer.

The Horizontal\Vertical settings sets whether horizontal or vertical guidelines are shown.
The New button allows you to create a new guideline.
The Delete button deletes the selected guideline(s).
The Properties button opens the Guideline Properties dialog box and allows you to set the 
exact position of the selected guideline.

At the bottom of the dialog box is a drop-down list from which you can select the colour used
to display the dotted outlines of all objects in the guides layer.

_______________
See also
Using guides





A Line can be straight, curved or contain a mixture of both straight and curved segments. A 
line must have a start and an end; thus it cannot be filled. You can apply a thickness, colour 
and transparency to a line as well as line ends and patterns. When the two ends of a line are
joined the line can be filled and is referred to as a shape.
If a line has a fill applied to it, the fill will only be visible when the ends of the line have been 
joined.



Line & Shape Pop-up Menu
If the pop-up menu is opened with the mouse pointer over a line or shape, it contains the 
following options :

Shape Editor Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Colour Editor



 Line Gallery (Utilities Menu)
 F12

The Line Gallery item on the Utilities menu and the Line Gallery button open the Line Gallery
if it is closed and close it if it is open. The button remains pressed in if the gallery is open.



Line Gallery - Dash Pattern

The Dash Pattern section of the Line Gallery allows you to apply different dash patterns to 
objects outlines.

To change the dash pattern :
Drag-and-drop the required pattern onto the object. Hold down CTRL to apply 'inside'.
Double click on the dash pattern to apply it to the selection.
Click the required dash pattern to select it and click Apply to apply it to the selection.



 Line Gallery (Utilities Menu)

 F12
The Line Gallery gives full control over the appearance of lines and shape outlines. It allows 
you to alter dash pattern, width, joins and ends.
The line attributes that can be set using the gallery are :

Line Width
Dash Pattern
Arrows
Join Type
Line Cap

On-line Demonstration
    {button Editing Line Width Ends and Joins,EF("XaraDemo.exe","LineBits.avi `Editing Line 

Width Ends and Joins'",1) }
_______________
See also
Selecting items in a gallery
Galleries
Zero Width Lines



Line Gallery - Arrows

The Arrowheads section of the Line Gallery allows you to apply arrowheads (and tails) to 
lines.

To apply an arrow head or tail to a line :
Drag-and-drop the arrow head or tail from the Line Gallery onto the line. Hold down 

CTRL to apply 'inside'
Select a line and double-click on the arrow head or tail in the line gallery.    This will 

apply the arrow head or tail to the appropriate end of the line, e.g. a rounded arrowhead will 
be applied to the start of the line while a feathered arrow tail will be applied to the end of 
the line.

Select a line and select an arrow head or tail in the line gallery. Click the Apply 
button.

To apply an arrow head or tail to the other end of a line, e.g. applying a feathered arrow tail 
to the start of a line, not the end, either drop the arrow head or tail onto the line where you 
would like it to appear, or use the second and third methods above while holding down 
CTRL.



Line Gallery - Join Type

This sets the style of corners on the line or shape.
Selecting a join type from the menu will set the join type of all currently selected lines and 
shapes. The join types available are :

Bevelled Join
Mitre Join
Round Join



Line Gallery - Line Cap

This sets the style of the ends of the line.
Selecting a line cap from this menu will set the end type of all currently selected lines and 
shapes. The line caps available are :

Butt Cap
Round Cap
Square Cap



Line Gallery - Line Width

You can change the line width using the drop-down list at the top of the gallery or using the 
Line Width section.
If there is a line selected, this field will change the width of the line(s). Otherwise it changes 
the line width current attribute so the line width is drawn for all newly created objects.

To alter the line width, enter a value into the field and press RETURN or select the required 
line width from the menu.
Alternatively you can change the line width as follows :

Drag-and-drop the required line width from the gallery onto the object.
Double click on the line width to apply it to the selection.
Click the required line width to select it and click Apply to apply it to the selection.



Line Width

The Line Width control allows you to edit the current line width attribute, or the line width of 
the selection.
Either choose a width from the drop-down list or type in the required width and press 
RETURN.
The line width settings are available from the Control Bars and the Line Gallery.
_______________
See also
Zero Width Lines
Units in CorelXARA



A Linear Fill is a smooth, linear graduation of colour.



A Linear Transparency is a smooth, linear graduation between two transparencies.



Linked Colours are a type of named colour and inherit components from another colour 
(called the parent colour). You define which components you want the linked colour to take 
from the parent named colour.
For example you could create a linked RGB colour that shared the Red and Green 
components of the parent named colour, but not the Blue. Any changes to the components 
of the parent named colour would be reflected in the linked colour.
If you wish to create a set of shades of the same colour which are all linked so their hue can 
be changed simultaneously, use shade colours.



 List the positions of guidelines
1. Open the Layer Gallery
2. Select the guides layer.
3. Open the layer pop-up menu
4. Choose Properties to open the Layer Properties dialog box.
5. Open the Guides tab - it shows the positions of all the guidelines.

To change the position of a guideline, select it and click the Properties button to open the 
Guideline Properties dialog box.



 Load & import files
To load a file

1. Click the Open button on the control bars.
2. Choose the location and filename of the file (see Open for details).
3. Click OK.

To import a file into an existing document
1. Drag the file from the Windows 3.1 File Manager, Windows 95 Explorer or equivalent and

drop it on the document.
or

1. Choose Import from the File menu.
2. Choose the location and filename of the file (see Import for details).
3. Click OK.

If the file is in the Clipart Gallery, you can use the buttons on the gallery and drag-and-drop 
to open or import the file.
For a list of types of file CorelXARA can load, see Supported File Formats.



CorelXARA has two types of colour; Local Colours and named colours. Local colours are 
used in only one place in a document. This is useful if you want to change the colour of an 
object without affecting other objects. Local colours are especially useful in simple 
documents that use relatively few colours. Local colours do not appear on the Colour Line 
nor the Colour gallery.



The Magenta colour component is used in the CMYK (Cyan, Magenta, Yellow, Key) colour 
model, which is commonly used by printers. By mixing various quantities of these four inks, 
a large range of colours can be generated.



Magnetic snapping makes one point or object snap towards another when one of them is 
moved. Magnetic snapping only takes place when it is enabled by Snap to Objects on the 
Window menu or by the Magnet button on the Standard Control bar. See Using magnetic 
snapping for more details.
You can specify separate snapping distances for point and lines. This makes it possible to 
snap two points together precisely.
The small magnet icon on the status line lights up and a magnet appears on the mouse 
pointer when the point or object being dragged has been snapped magnetically to a 
stationary object.
Guides can also be made magnetic using Snap to Guides on the Window menu.



Make more room for spooling

The Windows printing system needs space on your hard disc to store a temporary file when 
Spooling is turned on. It's likely that you haven't got enough space at the moment.

Try one or both of these suggestions:
      Make more space on your hard disc by deleting any unwanted files.
      If you are running Windows 95 empty the Recycle bin.

Did this fix the problem?
      Yes! My document prints now. Close this troubleshooter.
      No. What else could be wrong?

Tip
If you have more than one hard drive, try moving your virtual memory swap-file onto a 
different drive from that used for your temporary directory to prevent problems with the two 
clashing.



 Make guides magnetic
To make guides magnetic, select Snap To Guides from the Window menu. Enabling guide-
snapping will mean all guidelines and guide objects become magnetic so dragging handles 
and objects near the guide will lock it to the guide. The mouse pointer will show a magnet to
show that the object has snapped to the guide.



 Manipulate documents
Loading & importing files
Moving the page
Using scrollbars
Zooming
Using guides
Timing CorelXARA redraw
Using titles, descriptions and keywords
Exporting a bitmap at a specific size



 Manipulate objects
Selecting & deselecting objects

Rotating objects
Scaling objects
Moving objects
Skewing objects
Flipping objects

Colouring objects

Applying fills
Editing fills

Applying transparency
Editing transparency

Using guides
Using rulers
Aligning the centres of QuickShapes
Editing bitmaps



 Mask a bitmap

To mask a bitmap
1. Import the Bitmap into CorelXARA.
2. Choose the Freehand Tool.
3. Carefully draw around the area to be masked and form a shape.
4. Select the bitmap and the shape.
5. Choose Intersect Shapes from the Combine Shapes submenu on the Arrange menu.

To mask a bitmap 2
1. Select the bitmap
2. Choose Convert to Editable Shapes from the Arrange menu.
3. Edit the new shape as normal.

In both cases, the bitmap is converted to a simple editable shape with a bitmap fill applied. 
The object can then be edited like any other shape. For example using the Freehand Tool; 
see Redrawing part of a line or shape.

You can create masks using the QuickShape, Ellipse, Rectangle, Pen and Shape Editor Tools. 
Using a rectangle is an ideal way to crop a bitmap.



Maybe there's something wrong with the printer or the way it's set up?

Suggestions:
      Are you running Windows 95? If so, try using its Print troubleshooter.

1. Click the Start button on the task bar and choose Help from the menu.
2. Double-click "Troubleshooters" in the Help window.
3. Double-click "If you have trouble printing" in the Help window.

      Check that there's paper in the paper feed.
      Check that the printer isn't warning you of an error such as "out of ink".
      Check for paper jams.
      Check that the printer connectors are plugged in and the printer is turned on.
      Check that the printer is "on-line".

Did that fix the problem?
      Yes. My document prints now. Close this troubleshooter.
      No. Try to diagnose the problem.



Menu bar

CorelXARA provides the following menus on the menu bar :

File
Edit
Arrange
Utilities
Window
Help



Menus & Buttons

CorelXARA has a standard Windows menu bar containing all the options additional to the 
Tools. Additionally CorelXARA has a wide range of default control bars available which 
provide buttons to access these options more easily.

Menu bar
Default control bars

_______________
See also
Creating & deleting control bars



Mirroring is a term used by CorelDRAW to describe what CorelXARA refers to as flipping. 
See Flipping objects.



 
Zooming
Moving the page
Using guides
Drawing concentric circles
Drawing simple lighting effects
Drawing a light source
Drawing motion blur
Timing CorelXARA redraw



Mitre Join is one of the options available for line corners:

Use the Line Gallery to choose a join style.



Mix is one of the three types of transparency supported by CorelXARA; Mix, Stained Glass 
and Bleach. Mix is similar to spraying a thin coat of colour over underlying objects. 
Technically, the process is reflective.

0% transparency Solid colour
100% transparency Completely transparent



 Morph bitmaps
Using transparency and blending it is possible to create simple pseudo-morphing effects 
with CorelXARA.

To morph two bitmaps
1.      Import two bitmaps into a document.
2.      Create a rectangle with the Rectangle Tool and give it a bitmap fill with the first 

bitmap (see Applying a bitmap fill).
3.      Clone the square.
4.      Give the clone a bitmap fill using the second bitmap.
5.      Group both squares.
6.      Duplicate the group.
7.      Move the duplicate group away from the original group (see Moving objects).
8.      Ungroup the duplicate group.
9.      Select the top object (filled with the second bitmap).
10. Use the Transparency Tool to give it 100% transparency.
11. Select this transparent square and the square underneath, and group them.
12. Blend the two groups together.

The result is a pseudo-morphing effect from one bitmap to the other bitmap. If you only 
require one 'frame' from the sequence, apply Convert to Editable Shapes to the blend and 
remove the required section.



Applying a Mould to an object allows it to be warped. CorelXARA supports two types of 
mould; envelope moulds with up to four curved sides and perspective moulds with four 
straight sides. Perspective moulds can also be controlled using two vanishing points. For 
more information, see Applying a mould.



Mould Handles are used to control moulds. They are very similar to point handles. For 
more information, see Editing an envelope mould and Editing a perspective mould.



Mould Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a mould, it contains the following 
options:

Mould Tool
- - - - - - - - - -
Detach Mould
Rotate Mould
Copy Mould
- - - - - - - - - -
Default Envelope
Default Perspective
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Colour Editor



 Mould Tool    
The Mould Tool is used to apply Envelope and Perspective moulds to objects to warp, bend 
and reform them.
The Mould Tool can also be chosen using the Mould Pop-up Menu.

SHIFT+F6
Mould Tool Infobar Controls

Mesh
Remove
Copy Mould
Detach
Rotate Contents

Default Envelope
Circular Envelope
Elliptical Envelope
Concave Envelope
Banner Envelope
Paste Envelope

Default Perspective
Left Perspective
Right Perspective
Floor Perspective
Ceiling Perspective
Paste Perspective

Mould Tool Operations
Applying a mould
Editing an envelope mould
Editing a perspective mould

On-line Demonstrations
    {button Envelope Moulds,EF("XaraDemo.exe","Envelope.avi `Envelope Moulds'",1) }
    {button Perspective Moulds,EF("XaraDemo.exe","Perspect.avi `Perspective Moulds'",1) }

Note
Objects can be edited inside moulds without removing the mould first. See Selecting objects 
inside other objects.
You can apply a Perspective mould to a bitmap; you cannot apply an envelope mould.





 Mould Tool - Banner Envelope Button

The Banner Envelope button on the Mould Tool Infobar applies a banner envelope to the 
selection. You can edit the envelope as required. The selection always remains within the 
envelope whatever edits you make.



 Mould Tool - Ceiling Perspective Button

This button on the Mould Tool Infobar applies a ceiling facing perspective to the selection.



 Mould Tool - Circular Envelope Button
The Circular Envelope button on the Mould Tool Infobar applies a circular envelope to the 
selection. You can edit the envelope as required. The selection always remains within the 
envelope whatever edits you make.



 Mould Tool - Concave Envelope Button
The Concave Envelope button on the Mould Tool Infobar applies a concave envelope to the 
selection. You can edit the envelope as required. The selection always remains within the 
envelope whatever edits you make.



 Mould Tool - Copy Mould Button
The Copy Mould button on the Mould Tool Infobar copies the mould from the currently 
selected object (where possible) to the clipboard as a shape.
For example, if the selection contains an elliptical mould, this button places the ellipse on 
the clipboard.

A mould can also be copied using Copy Mould on the Mould Pop-up Menu.



 Mould Tool - Default Envelope Button
The Default Envelope button on the Mould Tool Infobar applies a default rectangular 
envelope to the selection. You can edit the envelope as required. The selection always 
remains within the envelope whatever edits you make.

The default envelope mould can also be applied using Default Envelope on the Mould Pop-up
Menu.



 Mould Tool - Default Perspective Button
The Default Perspective button on the Mould Tool Infobar applies the default, flat perspective
to the selection. You can then edit the shape of the mould as required.

The default perspective mould can also be applied using Default Perspective on the Mould 
Pop-up Menu.



 Mould Tool - Detach Mould
With a moulded object selected, press the Detach Mould button on the Mould Tool Infobar to 
'detach' the mould. You can then edit the mould without waiting for the moulded object 
being 'recalculated'. Click the Detach button again to update the display of the moulded 
object.
A detached mould will not be recalculated until the detach button is pulled out or the 
document is saved and reloaded.

A mould can also be detached using Detach Mould on the Mould Pop-up Menu.



 Mould Tool - Elliptical Envelope Button
The Elliptical Envelope button on the Mould Tool Infobar applies an elliptical    envelope to the
selection.    You can edit the envelope as required. The selection always remains within the 
envelope whatever edits you make.



 Mould Tool - Floor Perspective Button
This button applies a 'floor' facing perspective to the selection.
_______________
See also
Mould Tool



 Mould Tool - Left Perspective Button
The Left Perspective button on the Mould Tool Infobar applies a left facing perspective to the 
selection.



 Mould Tool - Mesh Button
The Mesh button on the Mould Tool Infobar is used to display a mesh over all selected 
moulds. The mesh lets you see the amount of distortion applied to the object. The mesh 
appears only on screen - it is never printed.



 Mould Tool - Paste Envelope Button
The Paste Envelope button on the Mould Tool Infobar takes a shape from the clipboard and 
pastes it as an envelope over the selection.    For this operation to succeed there must be a 
four-sided shape on the clipboard. An error will be reported if the shape is unsuitable to be 
pasted as an envelope. Once pasted, you can edit the envelope as required with this tool or 
with the Selector Tool.



 Mould Tool - Paste Perspective Button

This button on the Mould Tool Infobar applies a perspective to the selection using the 
contents of the clipboard as a perspective mould.
For this to work, the clipboard must contain a shape with four straight sides.



 Mould Tool - Remove Button
The Remove button on the Mould Tool Infobar removes the moulds from all moulded objects 
in the selection.



 Mould Tool - Right Perspective Button

This button on the Mould Tool Infobar applies a right facing perspective to the selection.



 Mould Tool - Rotate Contents
The Rotate Contents button on the Mould Tool Infobar 'rotates' the contents of the mould. 
This lets you align one edge of the moulded shape with any edge of the mould shape.

A mould can also be rotated using Rotate Mould on the Mould Pop-up Menu.



 Mouse Options
The mouse options for CorelXARA are accessed by selecting Options from the Utilities menu 
and opening the Mouse section of the dialog box.

Left Mouse Button Function
This sets the function of the left mouse button.

Normal Click
SHIFT-click
CTRL-click
ALT-click
Pop-up Menu
Enable/disable Full Screen Mode
Zoom In or Out

Right Mouse Button Function
This has the same range of options as for the left button.

Reset Defaults
This button returns the setting for left and right mouse buttons to their 'factory' defaults.

Magnetic Snap Radii
These two fields set the magnetic snap distances. These are the distances at which the 
mouse pointer will lock onto points and lines when magnetic snapping has been enabled 
with Snap To Objects.



 Move Backwards (Arrange Menu)
 CTRL+SHIFT+B

Moves every object in the selection backwards in the stack of objects in its layer.

On-line Demonstration
    {button Moving Objects Backwards and Forwards within a 

Layer,EF("XaraDemo.exe","Arrange.avi `Moving Objects Backwards and Forwards within a 
Layer'",1) }



 Move Forwards (Arrange Menu)
 CTRL+SHIFT+F

Moves every object in the selection forwards in the stack of objects in its layer.

On-line Demonstration
    {button Moving Objects Backwards and Forwards within a 

Layer,EF("XaraDemo.exe","Arrange.avi `Moving Objects Backwards and Forwards within a 
Layer'",1) }



 Move to Layer Behind (Arrange Menu)    
 CTRL+SHIFT+D

Moves all objects in the selection back one layer to the previous visible layer.

Note
The guides layer is ignored and skipped. 
_______________
See also
Move to Layer in Front
Moving objects to the guides layer



 Move to Layer in Front (Arrange Menu)
 CTRL+SHIFT+U

Moves all objects in the selection forwards one layer to the next visible layer.

Note
The guides layer is ignored and skipped. 
_______________
See also
Move to Layer Behind
Moving objects to the guides layer



 Move & copying buttons
To move a button

1. Hold down ALT.
2. Drag the button to a different position on the control bar or to a different control bar.

To copy a button
1. Hold down the ALT & CTRL keys.
2. Drag the button to the new position. A copy remains in the original location.

On-line Demonstration
    {button Creating Control Bars,EF("XaraDemo.exe","MakeBars.avi `Creating Control 

Bars'",1) }

Note
Buttons on the Infobar cannot be moved or copied.
There is a control bar called the Button Palette which contains a copy of every available 
button in CorelXARA. Buttons cannot be deleted from this bar.
_______________
See also
Creating & deleting control bars
Moving & resizing control bars
Removing & restoring buttons



 Move & resize control bars
All control bars can be anchored to the sides of the CorelXARA window or left free-floating. 
You can also change the size of a floating control bar.

To move a control bar
1. Place the mouse pointer over an area of the bar not occupied by buttons or fields.
2. Drag the bar to its new location.

As the bar is dragged it has either a thick or a thin outline. A thick outline means dropping 
the bar will leave it floating. A thin outline indicates that dropping the bar will become 
docked. If you want the bar to remain floating, hold down CTRL while dragging.

To resize a floating control bar
1. Move the mouse pointer over the edge of the control bar window. The mouse pointer 

changes to a double ended arrow.
2. Drag to resize the control bar.

_______________
See also
Moving & copying buttons
Creating & deleting control bars



 Move & resize galleries
To move a gallery

Do one of the following :
Drag the title bar of the gallery.
Drag the background of the gallery behind the buttons.

To resize a gallery
Drag the outer edge of the gallery as you would with any other resizeable window.



 Move a point on a line or shape
1. Select the line or shape (see Selecting & deselecting objects).
2. Choose the Shape Editor Tool (or Selector Tool, see note).
3. Do one of the following to move a single point:

Drag the point handle you wish to move. Hold down CTRL to constrain handle 
movement to multiples of the angle set in the General Options.

Alter the values in the centre Parameter Field on the Shape Editor Tool Infobar and 
press RETURN.

Use the arrow buttons on the coordinate Parameter Field on the Shape Editor Tool 
Infobar (the centre field).

Click on a point and use the cursor keys to move (nudge) it (Shape Editor Tool only). 
The nudge distance is set in the General Options.

Holding down CTRL and using the cursor keys nudges the selection by five times the 
distance.
Holding down SHIFT and using the cursor keys nudges the selection by ten times the 
distance.



 Move guidelines
Using the mouse

Drag the guideline to the required position.

Using the Pop-up Menu
1. Right-click on the guideline to open the guideline pop-up menu.
2. Choose Properties to open the Guideline Properties dialog box.
3. Type a new position into the field and click OK.

Using the Layer Gallery
1. Open the Layer Gallery.
2. Right-click on the guides layer to open the layer pop-up menu.
3. Choose Properties to open the Layer Properties dialog box.
4. Open the Guides tab.
5. Select Horizontal or Vertical.
6. Click Properties (this button is dimmed if you have more than one guideline selected) to
open the Guideline Properties dialog box.
7. Enter a new value for the position.

Note
If the Editable setting for the guides layer (set using the Layer Gallery) has been turned off, 
you will not be able to use the first two methods - the guides layer must be unlocked first.
The units used for guideline positioning are the page units defined in the Unit Options. Note 
however that the units used on the rulers (and grid) are set using the Grid and Ruler 
Options.



 Move objects
Objects can be moved using the mouse, accurately using the Infobar or in small steps using 
the keyboard.

What do you want to do?
Move objects by dragging
Move objects accurately

On-line Demonstration
    {button Moving Objects,EF("XaraDemo.exe","Moving.avi `Moving Objects'",1) }



 Move objects accurately
1. Select the object(s).
2. Do one of the following

Enter values in the Position Field on the Infobar and press RETURN.
Use the Position field arrow buttons on the Infobar to alter the values.
Press the cursor keys to 'nudge' the objects. The nudge distance is set in the General 

Options.

When you use the cursor keys, holding down CTRL nudges the selection by five times the 
distance and holding down SHIFT nudges it by ten times the distance.



 Move objects by dragging
1. Choose the Selector Tool.
2. Drag the object to the new position. If the object is part of the selection, the entire 

selection will move.

To constrain the move angle, hold the CTRL key down during the drag. Press CTRL after the 
mouse click    (otherwise the action will become a Select Inside operation).

Grid Locking
When an object is moved with grid locking enabled the leading edge(s) of the bounding box 
of the selection will lock onto the nearest grid points. The normal operation of this feature is 
the same as with CorelDRAW!.
It is possible to force the object to remain at the same relative position on the grid as it is 
moved. To do this hold down ALT during the drag. This style of grid locking is the same as 
that used in ArtWorks.

Note
To leave a copy of the original object, press NumPad '+' during the drag.
To move the object but not any fill applied to it, press NumPad '-' during the drag.



 Move objects to the guides layer
You can create objects in the guides layer exactly as on other layers. Simply select the 
guides layer in the Layer Gallery and create the object as normal.

You can also move or copy existing objects to the guides layer using Cut-Copy-Paste. Pasting
using CTRL+SHIFT+V (see Paste) pastes the object in the same position it was Cut/Copied 
from (if the object was Cut or Copied in CorelXARA).

When objects are created in the guides layer or moved to it, only a dotted outline is shown.

Note that Move To Layer in Front and Move to Layer Behind skip over the guides layer.



 Move points on shapes and lines
When editing a line or shape you can move point handles individually or several at a time. 
You can do this using the mouse, the controls on the Infobar or the keyboard.

What do you want to do ?
Move a point on a line or shape
Move several points on a line or shape
Set the length or angle of a straight line segment

Note
The Shape Editor Tool is the main line editing Tool in CorelXARA, but you can use the Selector
Tool for simple line editing operations if edit handles have been enabled - see Enabling edit 
handles.



 Move several points on a line or shape
1. Select the line or shape (see Selecting & deselecting objects).
2. Choose the Shape Editor Tool (or Selector Tool, see note).
3. Select the point handles to be moved (see Selecting points on lines and shapes).
4. Do one of the following :

Drag one of the selected handles. Hold down CTRL to constrain handle movement to 
multiples of the angle set in the General Options.

Use the cursor keys to move (nudge) the selected points (Shape Editor Tool only). The
nudge distance is set in the General Options.

Holding down CTRL and using the cursor keys nudges the selection by five times the 
distance.
Holding down SHIFT and using the cursor keys nudges the selection by ten times the 
distance.



 Move the page
To move the page

1. Choose    the Push Tool.
2. Move the pointer over the page and drag; the page will follow your movements.

On-line Demonstration
    {button Magnifying and Moving a Document,EF("XaraDemo.exe","ZoomPan.avi 

`Magnifying and Moving a Document'",1) }

Note
You can also move the page using the scrollbars. See Using scrollbars.



 Move the ruler zero point
It is often easier to measure objects if you align the 0,0 point of the rulers with the object. To
move the 0,0 point drag the square shown at the intersection of the two rulers. You can drag
vertically or horizontally along the rulers or over any part of the CorelXARA editing window.

This also moves the grid origin so the divisions on the ruler always align with the grid.

You can move the origin more accurately in the Grid & Ruler Options.

To reset the origin to the bottom left corner of the page, double click on the square at the 
intersection of the two rulers.



Name Layer Dialog Box

The Name Layer dialog box allows you to enter a name for the layer. Type the name and 
click OK.



CorelXARA has two types of colour: Local colours and Named Colours. Named colours are 
much like styles in a word-processor and can be used again and again in documents. The 
Colour Gallery gives control over the named colours in documents and the Colour Line is a 
list of all the currently defined named colours. All alterations made to named colour 
definitions are reflected in all objects using the named colour. Named colours can be copied 
between documents. CorelXARA allows four types of named colour, Linked Colours, Shade 
Colours, Normal Colours and    Tint Colours.



 New (File Menu)
 CTRL+N

New creates a new, blank document. The blank document is based on the CorelXARA 
template document. You can create your own template document (see Save Template) so 
that you can fix the appearance and options settings (see Options) in every new document.



New Named Colour Dialog Box

          

 
      Creating a new normal colour            Creating a new shade colour

Selecting the shade option sets whether you want the new colour to be a shade (on the 
right) of the colour you select in the drop-down list (see Using shades) or a normal colour (on
the left). If you do not select this option, the new named colour will be a stand-alone colour 
created as a copy of the colour you select in the list.
Once you have created the colour you can change it to any type of named colour you like.



 New View (Window Menu)
New View opens another view on the current document. Changes in one view are reflected in
all others.
The Quality setting can be different for different views.

New View is also available from the View Pop-up Menu.



No library index file available

Cause
Index file not found for this folder.

Recommended action
Choose the correct directory path where the index file can be found, or click the Create 
button to make a new index file for the folder.



No library index file available

Cause
No index file for a library is available.

Recommended action
Enter the correct directory path to where the index file can be found.



No result on combining shapes

Cause
Either
(a) you have attempted to combine some shapes (see Combine Shapes) that do not 
intersect, 
or (b) you have subtracted shapes so that no shape will result.

Recommended action
(a) Move the shapes so that they intersect.
(b) Change one of the shapes to be different from the other(s).

If you have tried to slice using a line, ensure both ends of the line lie outside the bounding 
box of the object(s) being sliced.



No suitable texture is available

Cause
You have tried to use an unsuitable bitmap for a fill, or there is no bitmap available at all.

Recommended action
Import a suitable bitmap.



Normal Colours are a type of named colour. Normal named colours are stand-alone and 
their colour is defined independently of all other colours. The other colour types (Shade 
Colours, Tint Colours and Linked Colours.)are linked to another colour definition in some way.



CorelXARA has two screen modes; Normal Mode and Full Screen Mode. In Normal mode all 
the usual screen furniture is displayed such as a Menu Bar and Scrollbars.
8 on the numeric keypad lets you toggle between the two modes. (NumLock must be on.)
For more details, see Full Screen Mode.



Objects in CorelXARA are the building blocks used to create drawings. Object is a general 
term used to describe the contents of the document.

Objects can be contained within other objects. For example, groups, moulds and blends all 
contain objects.



Objects are missing

Are you using Superprint printer drivers under Windows 95?

Suggestion:
      Turn off queuing in SuperQueue.

1. Run SuperQueue
2. Click the File menu and choose Queue setup.
3. Make sure your printer is selected in the list of printers.
4. Press the Unqueue button.
5. If you made any changes click OK.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



On-line Demonstrations (Help Menu)

This option displays the On-line Demonstrations page of the on-line documentation



Online Demonstrations

If you have trouble running the on-line demonstrations supplied with CorelXARA, refer to On-
line Demonstrations.



 Open (File Menu)

 CTRL+O
Opens an existing document or file in a supported format in a new window. CorelXARA keeps
track of the document you last worked on.

CorelXARA lets you have several documents open at the same time.    You may prefer to 
have only one document open at a time - if so, set the Ask Before Closing Views option in 
the General Options.

To open a document quickly without using the Open dialog box :
Choose the filename from the bottom of the File menu (see 1,2,3,4) if it has been 

loaded recently.
Drag the file from the Windows 95 Explorer (or the Windows 3.1 File Manager) to 

CorelXARA and drop it onto any part of the CorelXARA window except a document view 
(dropping onto a document will import the file into that document).

Double click the file from the Windows 95 Explorer (or the Windows 3.1 File Manager).

When you finish working on a document and you want to remove it from your screen, close it
by using Close.

File Name
The filename field specifies what type of file should be displayed in the list of files box below 
it. You can choose pre-defined types from the List of Files of Type drop-down list at the 
bottom of the dialog box. Normally for opening CorelXARA files this box will read " *. XAR ". If
it does not, you can choose "CorelXARA Documents" from the types list. The Open dialog box
can also open many other types of graphics file, to list all files choose All Files from the types
list. You can restrict the files displayed to a particular type by selecting the file type from the
types list. For a full list of the types of file CorelXARA can load, see Supported File Formats.

Drives
Choose the drive that contains the file you want to open.

Directories
Choose the directory that contains the file you want to open.

Network
Opens the Connect Network Drive dialog box so that you can make a connection to a 



network 
drive. For more information, click the Help button in the dialog box.

Note
The Open dialog box will look slightly different under Windows 3.1, 3.11. and Windows NT.
_______________
See also
Save As
New
Opening CorelDRAW files



Operation cancelled

Cause
You cancelled an operation, such as a file import.

Recommended action
Continue as usual - this message is for your information only.



A bitmap with an optimised palette is one where the colours in the bitmap have been 
chosen carefully to make the bitmap look as good as possible. If you display an optimised 
palette image in Netscape or Internet Explorer in a 256 colour mode, the browser will do the 
best it can to display the image correctly (it will usually be very good). However, if you 
display an optimised palette image in a high colour (thousands of colours) or a true colour 
(millions of colours) mode, the images will look nearly perfect. Note that an optimised 
palette image will be larger than a normal image.



 Options (Utilities Menu)
 CTRL+SHIFT+O

Options on the Utilities menu brings up the Options dialog box from where the CorelXARA 
options are set. There are two types of option :

Program options
Options for the current document

When options apply only to the current document, the section of the Options dialog box will 
show the document name (e.g. 'Scaling for map.xar'). The program options are saved when 
you finish using CorelXARA whereas the document options are saved with the document.

The options are divided into the following sections :

General Options
Grid & Ruler Options
Mouse Options
Output Options
Page Options
Print Options
Scaling Options
Tune up Options
Units Options
View Options

Default Document Options
If you wish to set the document options that are used every time a new document is 
created, do the following :

1. Open a New blank document.
2. Set the document options as appropriate.
3. Choose Save Template from the File menu.

This will create a new template document with the desired settings.



Out of memory

Cause
CorelXARA cannot perform the current task because your system does not have enough free 
memory.

Recommended action
Please remember that CorelXARA requires a computer with at least 8 megabytes of physical 
memory and a Windows swap file of at least 10 megabytes of virtual memory.    If your swap 
file is too small, then its size can increased using the Windows Control Panel program. (You 
will have to restart your computer after changing the size.) For further details, refer to your 
Windows User Guide.

If you are certain that your computer's memory is adequate then, if feasible, close some 
other programs you are running, particularly graphics applications which generally require a 
lot of memory to run.

CorelXARA requires more memory when editing or displaying documents that contain 
transparency effects.    If your document contains such effects, you might like to try turning 
transparency mode off - to do this, double-click the transparency indicator on the Status 
Line.

It is also possible to change your computer's screen mode to one with a lower resolution and
colour depth, e.g. if your computer normally displays 1024 x 768 pixels with a 24-bit colour 
depth (millions of colours), change to an 800 x 600 pixel mode with an 8-bit colour depth 
(256 colours).



Outlining is a term used by CorelDRAW and refers to changing the outline colour of an 
object. CorelXARA refers to 'changing the line colour' of an object. See Colouring objects.



 Output Options
The output options for CorelXARA are accessed by selecting Options from the Utilities menu 
and clicking on the Output 'tab'. These options control what is printed and how it is printed.

Print layers
Only foreground layers are printed - background layers are never printed.    You can 
choose to print what you see on screen (Visible foreground layers), or to print all 
foreground layers, regardless of whether they are visible or not (All foreground layers).

PostScript language level
There are two variants of PostScript - Level 1 & Level 2. All PostScript devices can 
interpret Level 1; more recent devices can also interpret Level 2, which contains speed 
and colour control enhancements.

We recommend selecting Automatic. This produces PostScript that uses the extra 
features of Level 2 but also runs on Level 1 devices.

Choose Level 2 if you know the destination PostScript device is Level 2. This may result 
in faster printing, especially if your document includes several bitmaps and/or 
transparency.

Choose Level 1 if Automatic gives problems. This should rarely, if ever, happen.

Print As
This controls the printing method. Some CorelXARA features, such as transparency, are 
not supported by current printers. This means CorelXARA has to send such features to 
the printer as a bitmap.

For most drawings you should choose Normal. (This option reads 'PostScript' if a 
PostScript printer is selected.) This uses the standard printing system except for areas 
that include bitmaps or transparency. Normal works well except for drawings that include
large areas of bitmaps or transparency. With such drawings printing can be slow.

If printing is slow, choose Bitmap or Anti-aliased Bitmap. This sends the entire drawing to
the printer as a bitmap. The resolution of the bitmap is controlled by the Resolution field 
on this dialog box. Generally Anti-aliased bitmap gives the best results except on 
drawings that include fine lines. (Fine lines do not print well when anti-aliased.)

The general rule is, try printing in Normal mode and, if you have problems, try again 
using Bitmap or Anti-aliased Bitmap. The best thing is experiment - you will soon know 
which print method best reproduces different types of drawings.

Transparency/Bitmap resolution
This is controls the resolution of bitmaps sent to the printer.

Automatic is suitable for most drawings. CorelXARA then automatically selects a 
resolution suitable for the current printer.

If necessary, type in a value to choose a specific resolution. (Resolution is measured in 
dots per inch [dpi]. The maximum value is 600dpi - this gives very high resolution but 
can produce very large print jobs that take a long time to run. Only rarely is a resolution 
greater than 150 dpi necessary.)



Fill Quality
This only has any effect when printing in 'Normal' mode (not PostScript, Bitmap, or Anti-
aliased bitmap modes).    It controls the number of steps (between 10 and 256) used 
when printing graduated fills.

Normal is suitable for most drawings.

Use Low if your drawing uses a lot of graduated fills and produces large print jobs (which 
take a long time to print). This reduces the number of steps and hence the size of the 
print job.

Use High if you think more steps are necessary. (This should be rare.)    Be careful: this 
setting can produce very large print jobs if you use graduated fills, and especially if you 
have lots of blends from one graduated filled shape to another.

Text Options
If you set the Print All Text as Shapes option, all text will be converted to simple shapes 
before the document is sent to the printer. This makes it possible to print text on the 
printer using fonts your PostScript printer does not have installed.



Overrun/truncated file.

Cause
CorelXARA has tried to read a file that is incomplete.    This usually means that it has been 
corrupted, possibly by cancelling an earlier export.

Recommended action
Run your system's disk diagnostics - it may be possible to recover the rest of the file.



The Page is the area onto which drawings are placed. The white area represents the paper 
with the grey area around the outside a 'pasteboard' for rough drawings or unwanted 
objects. This outer area is never printed. There can be one or two pages on each spread.



 Page Options
The page options for CorelXARA are accessed by selecting Options item from the Utilities 
menu and clicking on the Page 'tab'. You can also access them by selecting Page Options 
from the View Pop-up Menu.
These options control how the document appears on the screen.

Summary Line
This line displays the same information as in the normal Print dialog box - probably the 
most useful piece of information is how many pages will fit onto the piece of paper when 
printed.

Paper Size
The paper size setting sets the paper size used for the current document.

Centimetres Inches
A0 84.0x118.8 33.07x46.77
A1 59.4x84.0 23.39x33.07
A2 42.0x59.4 16.54x23.39
A3 29.7x42.0 11.69x16.54
A4 21.0x29.7 8.27x11.69
A5 14.85x21.0 5.85x8.27
A6 10.5x14.85 4.13x5.85
US Legal 35.56x21.59 14.0x8.5
US letter 27.94x21.59 11x8.5
Fanfold 30.48x20.95 12x8.25

To set a size not shown in the drop-down list, choose Custom and enter the required 
values in the Width and Height fields.
For details on setting the Page option for all new documents, see Changing the default 
page size.

Orientation
These two buttons allow you to control whether the paper is displayed so that its longest 
side is vertical ("portrait") or horizontal ("landscape"). When you come to print the 
drawing you will have to choose how to fit the drawing onto the paper and the Print 
Options contain controls which allow you to do this.

Outer Page Margin
This value sets the margin left around the page. This area is shown as grey in the CorelXARA
document window and is called the 'pasteboard'.

Double Page Spread
Your illustration may run across two facing pages in a multi-page publication. This is 
called a double page spread. Choose this option to make the current document a spread.

Bleed
Bleed-off allows your drawing to be printed over the edge of the page. This setting 
determines the bleed-off. Standard bleed-off distance is 0.3cm. If in doubt ask your 
printing company.
Note that bleed-off may require a larger paper size and increase costs.

Show Page Shadow



CorelXARA shows a shadow under the page in documents. Choose this option to show 
the shadow or deselect it to disable the shadow.



Panning is a term used by CorelDRAW to describe moving the page. See Moving the page.



Make sure the paper orientation matches the page

      Firstly, make sure that the printer driver's Paper orientation is correct:
1. Click CorelXARA's File menu and choose Print setup.
2. Click the Portrait button.
3. If you changed any settings click OK.

              Portrait page.

      Secondly, make sure the Page orientation is correct inside CorelXARA:
4. Click CorelXARA's Utilities menu and choose Options.
5. Choose the Print Options.
6. If the page you're trying to print is taller than it is wide, click the Upright button.
7. If the page you're trying to print is wider than it is tall, click the Sideways button.
8. If you changed any settings click OK.

            Upright printing

            Sideways printing

Tip: Turn on Print Borders to see on screen how much of the page will be printed.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



Use Best fit to ensure the drawing fits on the paper

      Make sure the CorelXARA page fits on the paper.
1. Click CorelXARA's Utilities menu and choose Options.
2. Choose the Print section.
3. Click Best fit.
4. If you changed any settings click OK.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



Make sure the paper size is correct

      Make sure the printer driver knows about your paper:
1. Click CorelXARA's File menu and choose Print setup
2. Make sure the field labelled Form or Paper size is the same as the size of the paper

in your printer. E.g. if you're printing on A4 paper make sure the field says "A4" and 
not "Letter" or "Legal".

3. If you changed any settings click OK.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



 Paste (Edit Menu)
 CTRL+V

Paste copies objects from the clipboard into the centre of the current view in the current 
layer. The objects may originally have come from the same document, they may have come 
from another document loaded in CorelXARA or they may even have come from another 
document in another application.
If the clipboard contains text, paste will place the text at the text cursor or overwrite the 
selected region (as appropriate).

The Paste menu item displays a brief description of what will be pasted. e.g. "Paste bitmap".

Paste is also available from the Selection Pop-up Menu.
You can paste only the attributes of the objects on the clipboard using Paste Attributes.

Pasting to the Original Position

You can paste the clipboard contents into the same X-Y position on the page as they were 
cut or copied from. This is useful for moving items between documents or moving between 
layers. (This applies only to objects cut or copied from CorelXARA.)
 CTRL+SHIFT+V

Pasting from Other Applications
Occasionally, when pasting into CorelXARA from another application, the data you are 
pasting can be transferred in several different formats. For example, text copied from 
Microsoft Word can be pasted as "unformatted text", or as a "Windows metafile picture". If 
this is the case, the Paste menu items will read Paste... and selecting it will open the Paste 
Special dialog box so you can choose how you want to transfer the data.



 Paste Attributes (Edit Menu)
 CTRL+SHIFT+A

Paste Attributes lets you copy attributes (such as the line pattern or fill colour) between 
objects. It is a quick way of applying multiple attributes. when you choose Paste Attributes, 
the attributes of the objects on the clipboard are applied to all the objects currently selected.

1. Select the objects with the required attributes.
2. Copy the selection to the clipboard (Copy on the Edit menu or CTRL+C).
3. Select the objects you wish to apply the attributes to.
4. Choose Paste Attributes from the Edit menu or press CTRL+ALT+V.

The objects remain on the clipboard until overwritten by, for example, a Cut or Copy 
operation. This makes it possible to repeat Paste Attributes many times.

Paste Attributes only applies attributes which are identical on all objects on the clipboard. So
for example if the clipboard contained objects with different fill colours, Paste Attributes 
would not affect the fill colour of the selected objects when chosen.



Paste Special Dialog Box

If when you Paste with data on the clipboard from another application and there is more 
than one format that the data could be transferred as, the Paste Special dialog box will 
appear giving you a chance to choose the specific format that you require CorelXARA to 
import. The highlighted format (always the top item in the list) is the one which is 
considered the "best" format to paste.

Choose the format which you prefer to paste, and then click the Paste button.

Alternatively, you may click Cancel to cancel the paste operation entirely.

Note
Once you have pasted into CorelXARA, the pasted data is remembered in order to make 
subsequent pastes faster (as importing some clipboard data formats can take some time). 
This means the Paste Special dialog box will not appear again until you copy new data to the
clipboard from another application.



The Pasteboard is the area around the page. The pasteboard can be used just like the page
area, but objects on it are never printed.



 
 Pen Tool

The Pen Tool is an alternative way of creating lines and shapes. We recommend using the 
Shape Editor Tool as it lets you create and edit lines using the same tool.
The Pen Tool operates in exactly the same way as equivalent tools in other programs such as
CorelDRAW or Adobe Illustrator. If you are familiar with such programs, you may prefer to 
use this tool to draw lines and shapes.

SHIFT+F5
Pen Tool Operations

Drawing a line
Drawing a shape
Extending a line

On-line Demonstrations
    {button Drawing Lines and Shapes with the Pen Tool,EF("XaraDemo.exe","PenDraw.avi 

`Drawing Lines and Shapes with the Pen Tool'",1) }
    {button Editing Lines and Shapes with the Pen Tool,EF("XaraDemo.exe","PenEdit.avi 

`Editing Lines and Shapes with the Pen Tool'",1) }
_______________
See also
Shape Editor Tool
Freehand Tool



An object in CorelXARA can be placed inside a Perspective Mould. This perspectivises the 
selection and ensures it is contained by the mould. The perspective can be edited using the 
four corners of the mould or by moving a vanishing point.



Photo CD is a Kodak proprietary process for storing photographs and transparencies in 
digital form on a CD. The CD can contain up to six copies of each image at different 
resolutions. For details on loading PhotoCD files, see PhotoCD Import.



PhotoCD Import Dialog Box

When you attempt to Open or Import a PhotoCD file you will be presented with this dialog 
box which allows you to choose which resolution you would like to load.

PhotoCD files contain up to six versions of the image at differing resolutions, these are 
defined by Kodak as :

Name Resolution Memory Required
Base/64 96x64 24Kb
Base/16 192x128 96Kb
Base/4 384x256 384Kb
Base 768x512 1.5Mb
Base*4 1536x1024 6Mb
Base*16 3072x2048 24Mb

Base/64 is used for small 'thumbnail' previews of the image. You cannot load Base/64 
images into CorelXARA.



 Place text around a curve
Existing text can be fitted to an existing curve, or alternatively, single or multi-line text can 
be typed directly onto a line or shape starting at any point.

To type text onto a curve
1. Select a line or shape.
2. Choose the Text Tool.
3. Click on the line or shape and type the text.

Remember that text will always follow the direction in which the curve was drawn. You can 
use the flip buttons in the Selector Tool to flip the line as necessary. See Flipping objects.
A kern will be placed on the curve so the text always starts at the point clicked. To explicitly 
start the text at the beginning of the line, CTRL-click.

To fit text to a curve
1. Choose the Selector Tool
2. Click on the line or shape to select it.
3. SHIFT-click on the text object to select it.
Select only one line/shape and one text object.
4. Choose Fit Text to Curve from the Arrange menu.

To remove text from a curve
1. Select the text object
2. Fit Text to Curve on the Arrange menu now reads Remove Text from Curve. Choose it.

To edit the curve under text
1. Select the text object on the curve.
2. Choose the Shape Editor Tool.

To make the curve invisible
1. Select the text object on the curve.
2. Choose the Shape Editor Tool.
3. SHIFT-click (or right-click) on the No Colour button on the Colour line.

To reverse the direction of the text on the curve
1. Open the text pop-up menu over the text object.
2. Choose Reverse Text on Curve

This can also be described as "moving the text onto the other side of the curve".

To move text along the curve
Insert a kern before the text. See Kerning.

When text has been fitted to a curve, applying full justification adjusts the spacing to exactly
fit the text on the line.
With other justifications, if text does not fit on the line it continues over the end at the same 
angle as the last character on the line.
Note that text around a curve can be edited and selected as normal. The text cursor follows 
the path of the curve.
_______________
See also
Text Tool
Creating New Text
Editing Text
Selecting Text
Applying Attributes to Text



Text Tool Key Shortcuts



Point Handles are the handles visible on the points of lines and shapes when the Shape 
Editor Tool or the Selector Tool (with Edit Handles enabled) is being used.



Point Handle Pop-up Menu

If the Pop-up Menu is opened with the mouse pointer over a point handle, it contains the 
following options :

Shape Editor Tool
- - - - - - - - - -
Change to lines
Change to curves
- - - - - - - - - -
Delete point(s)
Break at point(s)
- - - - - - - - - -
Select all points
Deselect all points



Pop-up Menus

Many commonly used CorelXARA functions can be found on the pop-up menu which appears
when you right-click on a document. Note that you can configure the mouse's right-button 
click to do other things if you prefer. See Mouse Options for more details. Pop-up menus are 
also available in other areas of CorelXARA, for example in the Galleries.

View Pop-up Menu
When you right-click where there are no objects (e.g. on the page or the page margin) the 
pop-up menu allows you to set up the document and the view onto it.

View Pop-up Menu

Selection Pop-up Menu
When you right-click on an object the pop-up menu offers options for that object and options
about objects in general. Note that right-clicking on an unselected object will select it before 
showing the pop-up menu.
 

Line & Shape Pop-up Menu
QuickShape Pop-up Menu
Blend Pop-up Menu
Mould Pop-up Menu
Text Pop-up Menu

Handle Pop-up Menu
When you right-click on a path handle the pop-up menu offers options for that handle.

Point Handle Pop-up Menu

Guidelines Pop-up Menu
When you right-click on a guideline the pop-up menu offers a range of guideline related 
options.

Guideline Pop-up Menu



PostScript is a file format commonly used for outputting to printers and typesetters. It has 
the advantage of being standardised and so any PostScript file should be readable by any 
PostScript device.    There are two variants: level 1 and level 2. Level 2 includes additional 
commands for colour handling and speed improvements.
PostScript is a trademark Of Adobe Systems Inc. 



 Previous Zoom
 CTRL+R

Previous Zoom is available from the Zoom drop-down list on the control bars and on the 
Push Tool and Zoom Tool Infobars. It restores the magnification level to its previous level. It 
can be used to toggle between two levels of magnification.



 Print (File Menu)    CTRL+P

 CTRL+P
This dialog box allows you to control the printing of a document.    It displays basic 
information on the printer and how the drawing will be printed.    If you want to change 
printer settings, press the Setup button.    If you want to change how CorelXARA will print 
your drawing, press the Options button.

Printer
This shows you which printer the printout will be sent to.    If you want to change this, click 
on the Setup button.

Print Objects
These options are available when any objects in the document are selected.    You can 
choose whether to print all the objects in the document, or to print only those objects that 
are selected (see Selecting & deselecting objects).    When you print selected objects, this 
means that the selected objects are printed, not that all the objects within the bounds of the
selection are printed.
Remember that objects in the background layers and the guides layer never print. See Layer
Gallery for more details.

Print Pages
If your document is a Double Page Spread (DPS) then you can control which page or pages 
are printed.    You can print the left page, the right page, or both pages.

Copies
Specifies how many copies of the drawing will be printed.    NB. some printers, such as Laser 
printers (or similar page printers) can support multiple copies of a page directly, whereas 
other printers, such as ink jet printers, cannot, and must be sent multiple copies of the 
drawing by CorelXARA.    This means that you may run out of disk space if you print many 
copies to a printer that does not support this option directly.

Collate Copies
This option is dimmed except when printing multiple copies of a double page spread as two 
separate pages.
With this option selected, pages are printed as left-right-left-right... etc.
With this option deselected, all the left-hand pages are printed, followed by all the right-
hand pages.



Printers that hold a page in memory (such as PostScript printers) take some time to process 
the image. The printer can then print multiple copies at its maximum speed. For such 
printers it is often faster to manually collate the pages after printing.

Print To File
If this is enabled, then the print job will not be sent to the printer, but will be diverted to a 
file instead.    When you initiate the print by clicking on the print button, CorelXARA will 
prompt you for the name of the file to redirect the print job to.    This option is most useful 
when used in conjunction with PostScript printers, as it enables you to produce a PostScript 
print file that can then be sent to a typesetter.

Summary Line
This is at the bottom of the print dialog box, and displays useful information about how the 
job will be printed.    It provides the following information:

What kind of layout will be used - Best Fit, Multiple Fit or Custom Fit (see Print 
Options).

The scaling to be used - 100% means print at normal size, 50% means print half size, 
200% means print at twice the normal size.

The orientation of the job - Upright or Sideways.    This is normally used to fit 
landscape pages onto portrait pages by rotating the drawing when printing (see the 
orientation buttons in the Print Options).    This effect can also be achieved by changing 
options in the Print Setup dialog box, but it is best to leave these settings alone, and use the 
controls provided in the Print Options instead.

How many pages, if any, will fit onto the paper with the current settings.    This takes 
account of the print margins of the printer (that is, which areas around the edge that the 
printer is physically unable to print to).    To change this, go to the Print Options.

Note
The Print dialog box will look slightly different if you are using Windows 3.1, 3.11 or Windows
NT.
Printing documents containing transparent objects will take longer than printing documents 
which do not use transparency.
_______________
See also
Print Borders
Output Options
Page Options
Print Setup
Changing the default page size.



 Print Options
The print options for CorelXARA are accessed by selecting Options from the Utilities menu 
and clicking on the Print 'tab'. The print options control how your document appears on 
paper.

All the options in this section apply to the selected document only.

Summary Line
This is at the bottom of the print dialog box, and displays useful information about how 
the job will be printed.    It provides the following information:

What kind of layout will be used - Best Fit, Multiple Fit or Custom Fit.
The scaling to be used - 100% means print at normal size, 50% means print half size, 

200% means print at twice the normal size.
The orientation of the job - Upright or Sideways.    This is normally used to fit 

landscape pages onto portrait pages by rotating the drawing when printing (see the 
orientation buttons in the Print Options).    This effect can also be achieved by changing 
options in the Print Setup dialog box, but it is best to leave these settings alone, and use the 
controls provided in the Print Options instead.

How many pages, if any, will fit onto the paper with the current settings.    This takes 
account of the print margins of the printer (that is, which areas around the edge that the 
printer is physically unable to print to).

If the summary line says 'Page only partially printable', this means that part of the page 
lies outside the Print Borders.

Paper Size
This field shows the currently selected paper size. (The paper size is defined using the 
Print Setup.)

Orientation
These options choose upright or sideways printing. Upright prints without rotating the 
document, whereas Sideways rotates the document through 90 degrees.
For example, to print an A4 landscape page on most printers requires sideways printing.
Note: This option is not the same as the one shown in the Print Setup or the Printer Properties dialog box. We strongly
recommend that you ensure that the printer is always set to Portrait printing and that you only use the Print Options 
orientation buttons to fit the drawing on the paper.
Tip: Turn on Print Borders before printing to check whether the drawing will fit on the paper.

Scale
The document can be scaled for printing. 100% is full size.
This can be used to print several copies of a document on a page. See Multiple Fit below.

Print Whole Spread
This option is only available when the current document is a double page spread. If this 
option is set, the spread is printed as one page.

Print Individual Pages
This option is only available when the current document is a double page spread. If this 
option is set, the two sections of the spread are printed as separate pages.

Best Fit
This option automatically chooses settings that print the page as best it can on the 



printer's paper.
It chooses the most appropriate orientation, depending on the shape of you page and the
shape of the paper in your printer.
The scale and margins are adjusted so that the page just fits within the paper's print 
borders.    You can see the scale it chooses in Scale field, and the margins it chooses in 
the Margin fields within the Custom fit section.
When this option is set, the Scale and Orientation fields are dimmed.

Custom fit
This option allows you set all aspects of the printing manually.
The Orientation buttons can be used to choose the orientation of the print out.
The scale can be altered using the Scale field.
The Top and Left margin fields can be changed.    These set where the top left-hand 
corner of the page appears on the printer's paper.
The Width and Height fields give you an alternative way of setting the print scale.    When
you change one of these settings, the other changes to ensure the page is always 
printed with a 100% aspect ratio.

Note that when you select Custom fit after selecting one of the other fit types, the values
generated by the previous fit type (such as scale and margins) will remain. For example, 
if you select Best fit and then select Custom fit, and you will see how the values remain 
as for Best Fit.

Multiple Fit
When the scaling is adjusted accordingly, it is possible to print multiple copies of the 
CorelXARA document on a page. To print multiple copies, choose this option, enter a 
value for the number of copies needed across the page (Rows), the number down the 
page (Columns) and the distance between each (Gutter).

_______________
See also
Print Borders
Print
Print Setup
Printing a drawing centrally



 Print Setup (File Menu)

This dialog box is primarily used to specify which printer you wish to print to. To change the 
printer, click on the drop-down list and choose the printer you require.    Assuming your 
printer is set up correctly, you may also choose what size of paper to print on.
You can change the orientation of the paper here, but it is preferable to use the Print Options
as the setting in the Print Setup dialog box usually defaults to Portrait.
You can usually change the resolution of the printer from this dialog box, either directly, or 
by pressing the More button.

Note
Your print setup dialog box may look significantly different to the one shown above if you are
running CorelXARA under Windows 3.1 (and 3.11) or Windows NT.
The process of installing printers is beyond the scope of this On-line documentation. If you 
require assistance, please consult your Windows User Guide.
_______________
See also
Print
Print Borders
Output Options
Page Options



Printing stops part-way down the page

Try these suggestions:
      Lower the transparency resolution.

1. Click CorelXARA's Utilities menu and choose Options.
2. Click the Output tab of the Options dialog box.
3. Find the Transparency resolution or Bitmap resolution area and click Manual.
4. Now type in a lower value into the Pixels per inch field. Any value between 90 and 

200 should be OK.
5. Click OK.

Or:
      Print the document as a bitmap.

1. Click CorelXARA's Utilities menu and choose Options.
2. Click the Output tab of the Options dialog box.
3. Find the Print as... area and click Bitmap.
4. If you changed any options click OK.

Did this fix the problem?
      Yes! My document prints now. Close this troubleshooter.
      No. What else could be wrong?



Print text as shapes

Print Text as Shapes on the Text Pop-up Menu converts text to simple shapes during the 
printing process. This is useful when a font has been used which is not present on the printer
on which the file will be printed. If a text object has Print Text as Shapes set it will be 
converted to shapes before it is sent to the printer, but can still be edited in a document as a
normal text object using the applied font.
If you want all text to print as shapes, you can set the Print All Text As Shapes option in the 
Output Options (see Output Options).



Print works but nothing happens

Are you printing to a network printer?

Suggestions:
      If the printer is a Postscript printer try using different printer driver. There are often 

several possible drivers for a given Postscript printer and it is possible that one of the 
alternatives will work better.

      If the printer is a Postscript printer and it supports a language other than Postscript try 
using that.

      Print your document as a bitmap.
      Print from a computer connected directly to the printer.

      When printing to a network printer, check to make sure the LPT port is actually 
connected to the network printer.

In Windows 3.1, this can be checked in Control Panel's Printers applet.
In Windows 95, just use the "Print Test Page" button which is on the General tab to make 

sure you are connected ok.

Did one of these suggestions work for you?
      Yes! My document prints now. Close this troubleshooter.
      No. It still doesn't print. What else could be wrong?



Print Troubleshooter

The CorelXARA printing troubleshooter will help you diagnose problems that may occur when
you print documents from CorelXARA and, where possible, it will offer solutions. Always 
make sure you're running the latest version of Windows and the latest versions of any 
printer drivers. 

Before using the troubleshooter, click here if you have a Hewlett Packard printer.

Do other applications print correctly?
      Yes. So, what's wrong with CorelXARA's printing?
      No. What could be wrong?



Printing a drawing centrally

To print a drawing in the middle of the page
Choose Multiple fit with Rows and Columns set to 1, and Gutter set to 0.
Choose the orientation that best matches the paper in your printer (choose Best fit, then 
choose Multiple fit again for an automatic way to do this).
The status line at the top of the dialog will tell you if the page is entirely printable.    If parts 
of the page lie outside the [link on]print borders[link off], it will say 'Page only partially 
printable'.    If the page is entirely printable, it will say '1 tile fits on the paper'.
If you need to get the entire page printed, increase the Gutter value until the status line says
'1 tile fits on the paper'.



Printing is very slow

CorelXARA uses bitmaps to produce its advanced transparency effects. Sending bitmaps to 
printers is often a time-consuming task. For this reason relatively simple documents which 
use transparency may take longer to print than you'd normally expect.

However, this is not all bad news. When several transparency effects are overlaid CorelXARA
accumulates them all into one bitmap and sends that to the printer.

So, as transparent effects in a document become more complex it won't become 
significantly slower to print.

Other programs that can do simple transparency effects produce exponentially more objects
as
you overlay transparencies. This means that their print times appear to be quite good for 
simple documents but they take a long time to print complex drawings

Suggestions to improve print times:
      Turn off spooling
      Reduce the pixel resolution



Problems Installing or De-installing an ATM Font

A problem occurred when trying to install or deinstall an ATM font.

Cause
You have tried to install a font that is already installed, or you have tried to de-install a font 
that is currently being used within a document, or by another program.    Alternatively, the 
font file itself is corrupt, or a problem was caused by Adobe Type Manager.

Recommended action
Installing a font - check that it is not installed already.
De-installing a font - make sure it is not being used in any loaded documents, or other 
applications, then try again. If this fails, use the ATM control panel to deinstall the font.



Problems creating a new index

Cause
This message is displayed if creating a new index file ran into problems. Possible problems 
include running out of disc-space, or writing to a floppy disk which has just been taken out of
the drive.

Recommended action
Ensure the disc is accessible and contains sufficient free space.



Problems creating a thumbnail

Cause
This message is displayed when a problem occurs generating thumbnails for a file. This is 
likely to be because the type of files is not supported by CorelXARA. It is also possible the file
is corrupt or has the wrong file extension.

Recommended action
Click OK to ignore this file, or Quiet to ignore all files with this problem. Stop will cause the 
index generation to cease.



Program installation incomplete or corrupted.

Cause
Some of the components of CorelXARA were not installed, have been moved, or have been 
deleted.    The program will not run correctly until the problem has been resolved.

Recommended action
Reinstall CorelXARA.



 
 Push Tool

The Push Tool lets you use the mouse to move a document within the window. The Infobar 
contains controls for zooming on the document.

ALT+X or SHIFT+F8
Push Tool Infobar Controls

Previous Zoom
Zoom to Drawing
Zoom to Selection
Zoom to Page
Zoom

Push Tool Operations
Moving the page

On-line Demonstration
    {button Magnifying and Moving a Document,EF("XaraDemo.exe","ZoomPan.avi 

`Magnifying and Moving a Document'",1) }
_______________
See also
Zoom Tool
Zooming
Using the Push Tool temporarily



 Put to Back (Arrange Menu)
 CTRL+B

Moves every object in the selection to the back of the layer it is on.

On-line Demonstration
    {button Moving Objects Backwards and Forwards within a 

Layer,EF("XaraDemo.exe","Arrange.avi `Moving Objects Backwards and Forwards within a 
Layer'",1) }



Document view Quality is the way in which documents are drawn on the screen. The 
Quality can range from the drawing being rendered in simple outline, to being edited in full 
colour, anti-aliased mode. This facility is useful for altering the speed at which a document is
redrawn as a lower quality setting will result in faster redraw times, but a higher setting will 
give far better results.
Sometimes it is useful to set the Quality to its lowest level for selecting some objects which 
would be obscured by other objects on higher settings.
CorelXARA also uses the Quality setting when exporting bitmaps.



Quality (Window Menu)

The Quality submenu on the Window Menu, the Quality slider on the control bars and the 
Quality buttons allow you to alter the way CorelXARA redraws documents. Low settings show
the document in simple 'outline' mode whilst high settings give a full-colour, anti-aliased 
view. There are also buttons available (not on the default control bars - see Moving & 
copying buttons) for each of the four main settings.
The Quality setting is also used when bitmaps are exported from CorelXARA. i.e. if the 
Quality setting is low, any bitmaps exported will show the document in outline.
The four main Quality levels are also available from the View Pop-up Menu.
Remember that if you want to improve the way your document looks on the screen, you can 
change the dithering pattern. For more details, see the dithering section in the View Options.

Anti-aliased

On this quality setting all edges are anti-aliased to reduce on-screen jaggies and graduated 
fills are shown with 256 steps.

Normal

On this setting all detail is shown, but anti-aliasing is not used.

Simple

On this setting, graduated fills are shown in flat colour, anti-aliasing is not used and lines are
all shown one pixel wide.

Outline

On this setting, no solid colours shown - only outlines even for bitmaps and objects with no 
outline colour). If the Quality slider is moved to a fraction above outline bitmaps are shown 
in full.



On-line Demonstration
    {button Display Quality,EF("XaraDemo.exe","WYSIWYG.avi `Display Quality'",1) }



QuickShapes are 'intelligent' shapes created using the QuickShape, Rectangle and Ellipse 
Tools. All QuickShapes can be edited in a very flexible manner. For instance, a circular 
QuickShape can be converted to a polygon QuickShape with one click using the QuickShape 
Tool.

If you wish to change a QuickShape so it can be edited as a shape built from straight and 
curved lines, you must use Convert to Editable Shapes.



QuickShape Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a QuickShape, it contains the 
following options :

QuickShape Tool
- - - - - - - - - -
Make Elliptical / Make Polygonal
- - - - - - - - - -
Make Stellated / Remove Stellation
Make Curved / Remove Curvature
- - - - - - - - - -
Number of Sides
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Colour Editor



 
 QuickShape Tool

The QuickShape Tool creates and edits QuickShapes.
The QuickShape Tool can also be chosen using the Line & Shape Pop-up Menu.

SHIFT+F2
QuickShape Tool Infobar Controls

Mode Indicator
Radius Creation
Diameter Creation
Bounds Creation
Ellipse
Polygon
Star
Curved Corners
Restore Edges
Number of Sides

Shape Parameters

QuickShape Tool Operations
Drawing rectangles & squares
Drawing polygons
Drawing starred polygons
Editing rectangles & squares
Editing polygons
Editing starred polygons

On-line Demonstrations
    {button Ellipses and Circles,EF("XaraDemo.exe","Ellipses.avi `Ellipses and Circles'",1) }
    {button Rectangles and Squares,EF("XaraDemo.exe","Oblong.avi `Rectangles and 

Squares'",1) }
    {button QuickShapes,EF("XaraDemo.exe","Regular.avi `QuickShapes'",1) }

_______________
See also
Ellipse Tool
Rectangle Tool



 QuickShape Tool - Bounds Creation Button
This button on the QuickShape Tool Infobar selects Bounds Creation. Dragging the mouse to 
create a new QuickShape draws the shape within the bounding box. This lets you create 
QuickShapes that have different height to width ratios.



 QuickShape Tool - Curved Corners Button

This button on the QuickShape Tool Infobar rounds the corners of polygon/starred 
QuickShapes. It has no effect on ellipses and circles.

Curved corners on QuickShapes can also be enabled and disabled using Make Curved and 
Remove Curvature on the QuickShape Pop-up Menu.



 QuickShape Tool - Diameter Creation Button
This button on the QuickShape Tool Infobar selects Diameter Creation. Dragging the mouse 
to create a new QuickShape draws the shape from side to side (across the diameter).



 QuickShape Tool - Ellipse Button
Pressing this button on the QuickShape Tool Infobar :

changes all currently selected QuickShapes to ellipses, 
or, if no QuickShapes are currently selected, sets the tool default so the next 

QuickShape you draw will be an ellipse.

You can also use the Ellipse Tool to draw ellipses - you may find this more convenient to use.

QuickShapes can also be swapped between ellipses and polygons using Make Polygonal and 
Make Elliptical on the QuickShape Pop-up Menu.
_______________
See also
Drawing ellipses
Editing ellipses



 QuickShape Tool - Mode Indicator
This indicator on the QuickShape Tool Infobar displays the 'mode' of the tool. It shows one of 
the following :

New:
Changes made to the Infobar fields set the defaults for the tool, i.e. the settings that apply 
to all subsequent QuickShapes you draw.

Change:
The selection contains at least one QuickShape. Changes made to the Infobar fields are 
reflected in the selected QuickShape(s).



 QuickShape Tool - Number of Sides Field

The Number of Sides field on the QuickShape Tool Infobar sets the number of sides for all the
QuickShapes in the selection (excluding ellipses). If no QuickShapes are currently selected, it
sets the default. The number of sides can be any value from 3 to 99.
To set the number of sides, do one of the following :

Type in a value and press RETURN,
Choose a value from the drop-down list.

The number of sides a QuickShape has can also be altered using the Number of Sides 
submenu on the QuickShape Pop-up Menu.
_______________
See also
Editing polygons
Drawing polygons



 QuickShape Tool - Polygon Button

Pressing the Polygon button on the QuickShape Tool Infobar :
changes all currently selected QuickShapes to polygons, 
or, if no QuickShapes are currently selected, sets the tool default so the next 

QuickShape you draw will be a polygon.

The Rectangle Tool can be used for drawing rectangles and squares. It draws QuickShapes, 
but does not require the setting of fields before the shape can be drawn.

QuickShapes can also be swapped between ellipses and polygons using Make Polygonal and 
Make Elliptical on the QuickShape Pop-up Menu.
_______________
See also
Drawing polygons
Editing polygons



 QuickShape Tool - Radius Creation Button
This button on the QuickShape Tool Infobar selects Radius Creation. Dragging the mouse to 
create a new QuickShape draws the shape from the centre outward.



 QuickShape Tool - Restore Edges Button

You can edit the edges of QuickShapes to make them curved (see Editing polygons). Click 
the Restore Edges button on the QuickShape Tool Infobar to straighten them again.
Note that this button affects only the sides of QuickShapes - it does not affect the corners. 
(Use the Rounded corners button to change the corners.)



 QuickShape Tool - Shape Parameters Field

The Parameter fields on the QuickShape Tool Infobar allow the accurate editing of 
QuickShape parameters. Choose the values to alter from the left hand field and alter the 
values by typing into the edit fields and pressing RETURN or use the arrow buttons.
_______________
See also
Editing ellipses
Editing polygons
Editing starred shapes
Units in CorelXARA



 QuickShape Tool - Star Button
Pressing the Star button on the QuickShape Tool Infobar :

changes all currently selected QuickShapes polygons to star-shaped polygons, 
or, if no QuickShapes are currently selected, sets the tool default so the next 

QuickShape polygon you draw will be star-shaped.

You can click this button only when the Polygon button has been clicked.

QuickShapes can be swapped between starred and non-starred using Make Stellated and 
Remove Stellation on the QuickShape Pop-up Menu.
_______________
See also
Drawing starred shapes
Editing starred shapes



RGB (Red, Green, Blue) is the natural model of computers. Colours would usually be defined 
using this model if they are to remain 'on-screen' - for example if the CorelXARA were being 
used to create bitmaps for use on the World Wide Web.



 Reorder gallery items
Items in galleries can often be reordered simply by dragging the items within the gallery. The
gallery contents can also be sorted from the Gallery Display Options dialog box accessible 
from the Options button.

Note
The items in the Line Gallery cannot be moved.
Moving layers in the Layer Gallery alters the stacking of layers.



 Reorder gallery sections
To move a gallery section, drag the title of the section in the gallery to its new position. The 
mouse pointer will show where the section will be positioned.

Note
You cannot reorder sections in the Line Gallery or the Layers Gallery



 
 Rectangle Tool

The Rectangle Tool creates and edits rectangular and square QuickShapes. It is a customised
version of the QuickShape Tool.

SHIFT+F3
Rectangle Tool Infobar Controls

Bounds Creation
Diameter Creation
Radius Creation

Mode Indicator

Parameters
Curved Corners

Rectangle Tool Operations
Drawing rectangles & squares
Editing rectangles & squares

On-line Demonstration
    {button Rectangles and Squares,EF("XaraDemo.exe","Oblong.avi `Rectangles and 

Squares'",1) }
_______________
See also
Ellipse Tool



 Rectangle Tool - Bounds Creation Button
This button on the Rectangle Tool Infobar selects Bounds Creation. Dragging the mouse 
creates a new rectangle within the bounding box. This lets you create rectangles rather than
squares. To create a square hold down CTRL while dragging.
_______________
See also
Drawing rectangles & squares



 Rectangle Tool - Curved Corners Button

This button on the Rectangle Tool Infobar applies rounded corners to the currently selected 
rectangle QuickShapes or, if no QuickShapes are selected, it sets the rounded corners 
setting - this default applies when you next draw a rectangle.
_______________
See also
Editing rectangles and squares



 Rectangle Tool - Diameter Creation Button
This button on the Rectangle Tool Infobar selects Diameter Creation. Drag the mouse to 
create a new square from corner-to-corner across its centre
_______________
See also
Drawing rectangles & squares



 Rectangle Tool - Mode Indicator
This indicator on the Rectangle Tool Infobar displays the 'mode' of the tool. It will display one
of the following :

New:
Changes made to the Infobar fields will set the defaults for the tool. i.e. the settings will be 
used for all subsequent rectangular QuickShapes drawn.

Change:
The selection contains at least one rectangular QuickShape. Changes made to the Infobar 
fields will be reflected in the selected rectangle(s).



 Rectangle Tool - Parameters Field
These fields on the Rectangle Tool Infobar allow the accurate editing of rectangular 
QuickShape parameters. Choose the values to alter from the left hand field and alter the 
values by typing into the edit fields and pressing RETURN or use the arrow buttons.
_______________
See also
Units in CorelXARA



 Rectangle Tool - Radius Creation Button
This button on the Rectangle Tool Infobar selects Radius Creation. Dragging the mouse 
creates a square from the centre outward.
_______________
See also
Drawing rectangles & squares



Redo allows you to redo an editing operation which has been Undone.



Redraw is the process of CorelXARA building up the on-screen image from the information 
stored about the drawing.



 Redraw part of a line or shape
Any section of an existing line or shape may be redrawn using the Freehand Tool.

1. Select the line with the Selector Tool
2. Choose the Freehand Tool.
3. Place the pointer over the start of the section of the line you wish to redraw. The pointer 

shows a '~'.
4. Drag the mouse to draw the replacement line section.
5. Release the mouse button when the redrawn section is complete. (Ensure the mouse 

pointer is over the line and the pointer shows a '~'.) If you get it wrong, just Undo and 
try again.

Note
QuickShapes can be redrawn using the Freehand Tool only if Convert to Editable Shapes has 
been applied first.
To redraw part of a character in a text object, convert the text to editable shapes and 
Ungroup first.



Reduce the pixel resolution

      Lower the transparency resolution.
1. Click CorelXARA's Utilities menu and choose Options.
2. Click the Output tab of the Options dialog box.
3. Find the Transparency resolution or Bitmap resolution area and click Manual.
4. Now type in a lower value into the Pixels per inch field. Any value between 90 and 

200 should be OK.
5. Click OK.

Did this fix the problem?
      Yes! My document prints now. Close this troubleshooter.
      No. What else could be wrong?



 Remove & restore buttons
To remove a button

1. ALT-drag the button and drop it away from all control bars.

To restore a    removed button
1. Choose Control Bars from the Window menu.
2. Scroll the list of control bars until you see the Button Palette listed.
3. Click the check box next to it to display the Button Palette.
4. ALT-drag the required button to a control bar.

_______________
See also
Creating & deleting control Bars
Moving & resizing control Bars
Moving & copying buttons



 Remove a blend
To remove a blend

1. Select the blend object.
2. Choose the Blend Tool.
3. Click on the Remove button on the Blend Tool Infobar.



Removing selected sections

Cause
This message is displayed after clicking Remove in one of the disc-based galleries (Clipart 
Gallery, Fill Gallery or Font Gallery).

Recommended action
If you would like to remove all the selected sections, click Remove. Otherwise click Cancel.



 Remove transparency
To remove transparency

1. Select the transparent object(s).
2. Choose the Transparency Tool.
3. Choose 'No Transparency' from the Transparency Shape Field on the Infobar.

_______________
See also
Applying Transparency



Rename Colour Dialog Box

The Rename Colour dialog box allows you to change the name of a named colour.

To open it, do one of the following :
Click the Name button in the Colour Gallery.
Select Rename from the Colour Editor menu.



Rendering is the process used by CorelXARA to draw the document on the screen.



Retain the clipboard contents after closing CorelXARA?

Cause
Some document objects have been placed on the Windows clipboard. On exit from 
CorelXARA, these objects may either be converted into a form suitable to be left on the 
clipboard, or can be discarded. Converting the objects may take some time and memory if 
there are a large number of objects.

Recommended action
Click the Keep button to keep the image of the objects in the clipboard after 

CorelXARA has closed. You can then paste them into another application.    
Click the Discard button to discard the contents of the clipboard.



Return the print method to its default by editing the INI file

You should only attempt the following suggestion if you're an advanced user 
familiar with the concepts of manually editing configuration and initialisation 
files.

1. Quit CorelXARA if it's running.
2. Start Notepad.
3. Open the file C:\Windows\CORELXRA.INI (replace C:\Windows with the path to your 

Windows/95/NT installation)
4. Find the line, "PrintMaskType=X".
5. Retype it as, "PrintMaskType=2".
6. Save the file.
7. Restart CorelXARA.

When CorelXARA is using PrintMaskType 2 only those objects which need transparency are 
printed using bitmaps. This can make print jobs larger but it guarantees that non-
transparent objects are printed at the best resolution the printer can manage.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. Return to previous page and try other suggestions



Reverse text on curve
 CTRL+SHIFT+R

Reverse Text on Curve on the Text Pop-up Menu flips text fitted to a curve so that the text is 
on the other side of the curve.

This is particularly useful when fitting text to a circle because it lets you fit the text to either 
the inside or the outside of the circle.



Robert's Cross (Bitmap Effect) lightens edges found in bitmaps.



 Rotate objects
Objects can be rotated about their centre or about a movable transformation centre by 
dragging with the mouse or, more accurately, using the controls on the Infobar :

What do you want to do?
Rotate objects by dragging
Rotate objects accurately



 Rotate objects accurately
1. Select the objects (see Selecting & deselecting objects).
2. Do one of the following :

Enter the required rotation in the Rotation Field on the Infobar and press RETURN.
Use the arrow buttons on the Rotation Field on the Infobar to rotate the selection in 

small increments.

The rotation will be centred around the transformation centre.



 Rotate objects by dragging

1. Select the object(s) (see Selecting & deselecting objects).
2. Ensure the selection handles are in rotate/skew mode (see Using selection handles).
3. Do one of the following

Drag the corner selection handles to rotate the selection around the transformation 
centre.

SHIFT-drag the corner selection handles to rotate the selection about its centre.

CTRL-drag to constrain the angle of rotation to that set in the General Options.
To leave a copy of the original non-rotated object, press and release NumPad '+' during the 
drag.
To rotate the object but not any fill applied to it, press and release NumPad '-' during the 
drag.

On-line Demonstration
    {button Selection Handles,EF("XaraDemo.exe","SelHands.avi `Selection Handles'",1) }



Round Caps are a type of ending which can be applied to lines. There are three types of 
'cap' :

Butt Cap                      Round Cap                Square Cap

The line cap style is applied using the Line Gallery.



Round Join is one of the options available for line corners:

Use the Line Gallery to choose a join style.



Rulers are shown at the left-hand side and top of the document window. They let you know 
which part of the page you are viewing, display the current mouse X,Y position and allow the
simple creation of guidelines. For more information, see Using rulers.



 Rulers (Window Menu)
CTRL+L

Rulers on the Bars submenu of the Window menu shows or hides the rulers. For more 
information, see Using rulers.



The Saturation colour component is used in the HSV (Hue, Saturation, Value) colour model, 
which is an intuitive colour model most often used by artists.
Saturation represents a mixture between the chosen Hue (colour) and white. A fully (100%) 
saturated red would be red, while a 50% saturated red would be pink. Any hue appears as 
pure white at 0% saturation.



 Save (File Menu)
 CTRL+S

Save saves the current document. The current document is saved to the same file that it 
was opened from or saved to. If the document is a new document that has not yet been 
saved, the Save As dialog box will appear asking what filename you would like to use and 
where you want to save the file.
_______________
See also
Save All
Save Template



 Save All (File Menu)
Save All is equivalent to selecting Save for each loaded document.
_______________
See also
Save Template



 Save As (File Menu)

The Save As dialog box allows you to save the current document in a named file.
The new file can simply be another file in the same folder or you can change the drive and 
folder so the document is saved in a completely different place. If you want to save the 
document not as a CorelXARA file but as a file that another program can load, use Export.

File Name
The filename field specifies what type of file should be displayed in the list of files box below 
it. You can choose pre-defined types from the List of Files of Type drop-down list at the 
bottom of the dialog box. Normally for saving CorelXARA files this box will read '* . XAR'. If it 
does not, you can choose "CorelXARA Documents" from the types list.

Save In
Choose the drive/folder where you wish to save the file.

Directories
Browse to the folder where you wish to save the file.

Note
The Save As dialog box will look slightly different if you are using Windows 3.1, 3.11 or 
Windows NT.
For more information on using Save As dialog boxes, refer to your Windows User Guide.
_______________
See also
Save
Save All



 Save Template (File Menu)
Save Template overwrites the template document with the current document. This change 
remains until a new document is saved over the document template.
When you save the template document it is saved in your CorelXARA directory as 
'template.xar'. If you wish to revert to the default template document, delete this file.
You need to use Save Template if you want to set the default document options. See 
Options.
CorelXARA includes an alternative template document. WWW.XAR contains the palette used 
by Internet Explorer and Netscape Navigator, if you use this template you can create WWW 
bitmaps with no dithering. See Installing the WWW template document.



Save new document template

Cause
You are about to overwrite the existing CorelXARA document template with a revised 
version.

Recommended action
Click the Save button to replace the existing document template.
Click the Cancel button to abort the save. The existing template document is 

unchanged.

When you save the template document it is saved in your CorelXARA directory as 
template.xar. If you wish to revert to the default template document, delete this file.



Selection Handles operate in two modes; Scale Mode and Rotate/Skew mode. The former 
allows the selection to be scaled; the latter allows it to be rotated and skewed.

 Selection handles
        in Scale mode



 Scaling Options
The scaling options for CorelXARA are accessed by selecting Options from the Utilities menu 
and clicking on the Scaling 'tab'. The scaling options control how (if at all) your document is 
scaled.

Use Scale Factor
This option allows a whole document to be drawn using a scale factor. For example a 
map could be drawn at a scale of 1cm to 1km where all measurements in the document 
are actually shown in kilometres rather than centimetres.
To remove scaling, deselect this option.

Drawing to Real World
These two fields are only available if the above option has been selected. Values should 
be entered here to set the scale factor of the document. e.g. 1cm to 1km.

_______________
See also
Units in CorelXARA



 Scale objects
Objects can be scaled either by dragging with the mouse or more accurately using the 
controls on the Selector Tool Infobar :

What do you want to do?
Scale objects by dragging
Scale objects accurately



 Scale objects accurately
1. Select the object(s) to be scaled (see Selecting & deselecting objects).
2. Do one of the following :

Enter the required scaling (%) in the Scaling Field on the Infobar and press RETURN.
Enter values in the Dimensions Field on the Infobar and press RETURN.
Scale the selection in small increments using the arrow buttons on the Infobar.

To lock or unlock the aspect ratio of the selection click the Aspect Ratio Lock button on the 
Infobar.
To force line thicknesses in the selection to increase/decrease with the scaling click the Scale
Line Width Button on the Infobar.

Note
Stretching an object containing a circular fill will change the fill to an elliptical fill, but an 
undo will not revert this change - the fill will remain elliptical.



 Scale objects by dragging

1. Select the objects to be scaled (see Selecting & deselecting objects).
2. Ensure selection handles are in Scale Mode (see Using selection handles).
3. Do one of the following

Drag a corner selection handle to scale away from the opposite corner.
SHIFT-drag a corner selection handle to scale around the centre.
Drag a side selection handle to stretch in one direction.
SHIFT-drag a side selection handle to stretch in both directions.

To lock or unlock the aspect ratio of the selection click the Aspect Ratio Lock button on the 
Infobar.
To force line thicknesses in the selection to increase/decrease with the scaling click the Scale
Line Width Button on the Infobar.
To leave a copy of the original non-scaled object, press and release NumPad '+' during the 
drag.
To scale the object but not any fill applied to it, press and release NumPad '-' during the 
drag.

On-line Demonstration
    {button Selection Handles,EF("XaraDemo.exe","SelHands.avi `Selection Handles'",1) }

Note
Stretching an object containing a circular fill will change the fill to an elliptical fill, but an 
undo will not revert this change - the fill will remain elliptical.



Scrollbar
Horizontal and vertical scrollbars let you use the mouse to move the document within the 
window.

Scrollbars are located at the right and bottom edges of the document window. To display or 
hide scrollbars, see Scrollbars on the Window menu.
Scrollbars contain markers, called scroll boxes, that indicate the vertical and horizontal 
location of the section of document currently in view. For more information on using 
scrollbars, see Moving the page.



Scrollbars (Window Menu)

Scrollbars on the Bars submenu of the Window menu allows the scrollbars around the 
CorelXARA window to be turned on and off. When it is set, the scrollbars are enabled, 
otherwise they are not.
Normal mode and full screen mode store this setting separately, so you could have the 
scrollbars enabled in normal mode, but not in full screen mode.
When the scrollbars are turned off, you can use the Push Tool to slide the page within the 
window.
Current settings are stored when you quit CorelXARA.
_______________
See also
Full screen



 Search a gallery
To search a gallery

1. Open the gallery.
2. Click the Options button.
3. Choose Find from the menu to open the Gallery Find dialog box.
4. Type in the text to search for.
5. Choose whether you wish to search just the names and keywords (title, filename & 

keywords) of gallery items or all the information stored for each item (title, filename, 
title, description and file size).

6. Click the Find First button to find the first match.
Click the Find Next button to continue searching.

Note
If you are searching for clipart from the clipart book, just enter the name shown by the 
picture into the field in the dialog box and click Find First. Clicking Find Next will find further 
matches.



 Select All (Edit Menu)
 CTRL+A

Select All selects (see selection) every object in all visible, editable layers in the current 
document. For details on using layers, see Layer Gallery.

Note
The CTRL+A key shortcut functions differently when the Text Tool has been chosen.



Select All Points
The Select all Points item on the Point Handle pop-up menu selects all the point handles on 
all the selected lines and shapes.



Select Inside can be used to select an object inside a group. This can be done in the 
Selector tool by CTRL-clicking or by Alt-CTRL-clicking on the object. Objects are said to be 
"inside" a group when they are members of the group. Normally, clicking on the object 
would select the group but a CTRL-click selects the object that you clicked on inside the 
group.
Select inside also works inside blends, moulds and text.
When any selected object is inside another one, the status line shows for example: "2 
shapes selected ("inside")"
Select-inside is just like select member, except it goes straight to the innermost object.    It is
a short-cut to select the object you actually click on, irrespective of whether it is part of a 
group, blend, or mould.
Some operations are unavailable when any selected object is inside another one.
For more details on this, see Selecting objects in objects.



Select Member
To select an object which is a member of a group. (This is a special form of Select inside.) 
This can be done in the Selector Tool by Alt-CTRL-clicking on the object. Objects are said to 
be "inside" when they are members of a group. Normally, clicking on the object selects the 
group but Alt-CTRL-click selects the object inside the group containing the clicked object. 
That object may itself be a group and then further Alt-CTRL-clicks can be used to select 
members of that group, etc. When the last selected object was not a group, it cannot have 
any members and so the next Alt-CTRL-click will select the outermost group again.
Select member also works inside blends, moulds and text.
When any selected object is inside another one the status line shows, for example:

"2 shapes selected ("inside")"
Some operations are unavailable when any selected object is inside another one.
For more details, see Selecting objects in objects.



Install the manufacturer's printer driver

Is your printer one of the following?

Hewlett Packard
DeskJet 500c
DeskJet 550
DeskJet 600
DeskJet 660c
DeskJet 880c
DeskJet 1200
LaserJet 4
LaserJet 5

Canon
BJ-200e
BJ-30
BJC-600
BJC-600e
BJC-70
BJC-4000. 

      If so, then reinstall the printer driver from the disc that came with the printer. Follow the
instructions in the printer's manual.

Did this fix the problem?
      Yes! My document prints now. Close this troubleshooter.
      No. Still no Print dialog box. What else could be wrong?



Select Under  allows you to select an object which is underneath another object. This can 
be done in the Selector Tool by Alt-clicking on the top object. Select under is most useful 
when one object is completely covered by another one. Clicking on the top object selects the
top object; Alt-clicking on the top object selects the object underneath.
If there are several objects covering each other, repeatedly using ALT-click selects the next 
object underneath the one that was last selected. When the last selected object is the one at
the back, the next ALT-click will start at the top again and select the top object.



 Select & deselect objects
In CorelXARA objects must usually be selected before attributes or operations are applied to 
them (applying attributes using drag-and-drop is the exception to this). Objects are selected 
and deselected using the Selector Tool.
When an object is selected a selection marker is shown on it and selection handles, edit 
handles, fill handles and fill arrows are displayed on and around the selection (if they have 
been enabled).

What do you want to do?
Select a single object
Select several objects
Select objects under other objects
Select objects in objects

Deselect objects

Select difficult objects

On-line Demonstration
    {button Selecting Objects,EF("XaraDemo.exe","Select.avi `Selecting Objects'",1) }

_______________
See also
Using the Selector Tool temporarily
Enabling selection handles
Enabling edit handles
Enabling fill handles & fill arrows



 Select a member of an object
CorelXARA has a special form of Select Inside which allows you to select a particular member
of a compound object as opposed to the normal select inside which will always selects the 
actual object you click on. With select member, a click selects the object inside the 
compound object which contains the clicked object. If that object is a compound object, 
another clicks will select a member in that object and so on. When the last selected object is
not a compound object the next click will select the outermost object again.

1. Choose the Selector Tool.
2. Place the mouse pointer over the member of the compound object.
3. Do one of the following :

CTRL+ALT-click to select the member object.
CTRL+ALT+SHIFT-click to swap the member object between selected and not 

selected.
If the required member object is deeper inside the object, repeat step 3.

 CTRL+ALT-click to select the next member of the selected object.

Example
The picture shows a group containing a rectangular QuickShape and a (2-line) text object. 
CTRL-ALT-clicking on the letter S will select the entire group. CTRL-ALT-clicking again will 
select the member of that group, the text object. CTRL-ALT-clicking again will select the 
member of that compound object, the upper line of text in the text object. CTRL-ALT-clicking 
again will select one level deeper; the single text character. A final CTRL-ALT-click reselects 
the entire group allowing you to cycle through all the objects under the mouse pointer.

Note
When any selected object is inside another one the status line shows, e.g. "2 shapes 
selected ("inside")"
Some operations are unavailable when any selected object is inside another one.



 Select a single object
1. Choose the Selector Tool.
2. Click on the object.

    Click to select the object under the mouse pointer



 Select difficult objects
If you are having trouble selecting an object, you may like to try the following :

Zoom in on the object so you are sure you are clicking in the correct place.
Lower the Quality setting to outline - this usually allows any object to be selected.
If the object is the back object in a blend with many steps, try using a high-zoom on 

the tiny section of the back object still visible.



 Select items in a gallery
Galleries allow you to perform operations on their contents (for example deleting named 
colours). Before these operations can be applied, the items in the gallery must be selected. 
Selected items are highlighted.

Selecting a Single Item
Click on the item

Selecting Several Items
1. Click on the first item
2. CTRL-click on each subsequent item

Selecting a Block of Items
1. Click on the first item in the block
2. SHIFT-click on the last item in the block. This selects all items between the first and last.



 Select objects in objects
CorelXARA lets you easily select objects that are contained within blends, moulds, text 
objects and groups; these objects can then be edited as if they were not contained. Select 
Inside is a shortcut to select the object you actually click on, irrespective of whether it is part
of a group, blend, text object or mould.
If you wish to select a compound object inside another object you must use Select Member. 
See Selecting a member of an object.

1. Choose the Selector Tool.
2. Place the mouse pointer over the contained object you want to select.
3. Do one of the following

CTRL-click to select the object.
CTRL+SHIFT-click to swap the object between selected and not selected.

CTRL-Click to select the object under the mouse pointer even if it is contained inside 
other objects

On-line Demonstration
    {button Selecting Objects In Objects,EF("XaraDemo.exe","SelInsid.avi `Selecting Objects 

In Objects'",1) }

Note
When an object has been selected inside another object, this information is displayed on the
Status Line. e.g. "1 QuickShape (inside) in Layer 1"
Some operations are unavailable when any selected object is inside another one.



 Select objects under other objects
1. Choose the Selector Tool.
2. Place the mouse pointer above the hidden object.
3. Do one of the following :

ALT-click to select the object underneath.
ALT-click again to deselect that object and to select the next object underneath.

The first ALT-click will select the object on top first if it is not selected already.    Subsequent 
ALT-clicks will go on to select the objects underneath. ALT-clicking with the bottom object 
selected will reselect the top-most object.

Click to select the object under the selected object. (ALT-click)

On-line Demonstration
    {button Selecting Objects Under Objects,EF("XaraDemo.exe","SelUnder.avi `Selecting 

Objects Under Objects'",1) }



 Select points on lines and shapes
You must select the line or shape before you can select points. See Selecting & deselecting 
objects.

To select a single point handle
1. Choose the Shape Editor Tool or the Selector Tool (see note).
2. Click on the point handle on the selected line or shape.

To swap the selection of a point handle
1. Choose the Shape Editor Tool or the Selector Tool (see note).
2. SHIFT-click on the point handle on the selected line or shape.
3. If selected the point is deselected, if not selected, the point is selected.

Use the Shape Editor Tool for the following operations :

To select several point handles:
Dragging creates a selection rectangle around the required point handles on the 

selected line or shape and selects them.
SHIFT-dragging around points toggles the selection of the point handles within the 

rectangle.

To deselect all point handles
CTRL-SHIFT-click on a selected point handle.

or
SHIFT-click away from the line or shape.

To select all point handles
CTRL-SHIFT-click on a deselected point handle.

To cycle which points are selected
Pressing the Tab key 'moves' the selection along the line or shape. (SHIFT-Tab 'moves' the 

selection in the opposite direction.)
The Home and End keys work in a similar way, but 'move' the selection to the beginning or 

end of the line.

Note
The Selector Tool can be used if edit handles are enabled, see Enabling edit handles.



 Select several objects
To select several objects

1. Choose the Selector Tool.
2. Do one of the following :

Drag from an empty part of the page to form a rectangle that envelopes all the 
required objects. When you release the mouse button all the objects entirely contained 
within the rectangle will be selected.

Click on the first object you wish to select & SHIFT-click on each subsequent object to 
swap it from not being selected to being selected.

    SHIFT-click to swap the object under the mouse pointer between selected and not 
selected.

To select all objects
From the Edit menu, choose Select All or if you are not using the Text Tool press CTRL+A.



 Select text
To apply attributes to a region of text it must first be selected. It is possible to select an 
entire text object, a line of text, a specific region of text or individual characters.

Selecting text with the Selector Tool
To select an entire text object
Click on the text object.

To select a line of text in a text object
1. Click on the text object to select it.
2. ALT+CTRL-click on the line to select it inside.

To select a character in a text object
1. Click on the text object to select it.
2. Either:

CTRL-click on the character ,
or ALT+CTRL-click on the character twice. The first click selects the line, the second 
click selects the character.

Selecting text with the Text Tool
To select an entire text object
Do one of the following :
Click in the text object & press CTRL+A to select all characters in the object.
Drag from the start of the text object to the end to select all characters in the object.

To select a line of text in a text object
Click in the text object
Press CTRL+L to select all characters in the current line

To select a character in a text object
Select a region of text covering a single character - see below.

To select a region in a text object
Do one of the following :
Click and drag over the characters.
Double click on a word to select all the characters in the word.
CTRL-click to select all characters in a line.
SHIFT-click either side of a selected region to extend it.
Move the text cursor to one end of the required region. Hold down SHIFT and use the 
cursor keys to select the required region.
Press CTRL+L to select all characters in the line containing the text cursor.
Press CTRL+A to select all characters in the text object.
Click in the text to insert the cursor at the start of the region and SHIFT-click at the end of 
the required region.

Note
When a region of text is selected, the Text Tool Infobar shows the attributes applied to the 
region.
A selected region of text remains selected even after a tool other than the Text Tool has been
chosen. This makes it simple to apply fills and transparency to selected text regions.
_______________
See also
Text Tool
Creating New Text



Editing Text
Applying Attributes to Text
Placing Text Around a Curve
Text Tool Key Shortcuts



The Selection is all the currently selected objects. Objects are selected with the Selector 
Tool. See Selecting & deselecting objects.



Selection Handles are displayed when the Selector Tool is the current tool and selection 
handles have been enabled (See Enabling Selection Handles). They are displayed around the
boundary of the selection and allow the selection as a whole to be scaled, rotated, skewed 
and stretched. They operate in two modes: Scale mode and Skew/Rotate mode. See 
CorelXARA Basics for an on-line demonstration of the use of selection handles.

                                    

    Selection Handles            Selection Handles
          in Scale Mode                in Rotate/Skew Mode



Selection Markers are small squares displayed on all selected objects.



Selection Pop-up Menu

The selection pop-up menu is displayed when the pop-up menu is opened with the mouse 
pointer over an object. The menu offers a set of standard options for manipulating the 
current selection and a set of options specific to the object under the mouse pointer.

Line & Shape Pop-up Menu
QuickShape Pop-up Menu
Blend Pop-up Menu
Mould Pop-up Menu
Text Pop-up Menu



 Selector Tool
The Selector Tool is the primary tool in CorelXARA. It is used for selecting, rotating, moving, 
skewing, stretching, flipping and scaling objects as well as other editing.
The Selector Tool can display three types of handle :

Selection Handles, which are used to rotate, scale and skew objects.
Edit Handles, which can be used to edit the shape of objects.
Fill Handles, which can be used to edit fills within objects.
F2 or SPACEBAR or ALT+S

Selector Tool Infobar Controls

Selection Handles
Edit Handles
Fill Handles
Rotate/Skew Mode or Scale Mode
Transformation Centre Grid
Position
Dimensions
Scaling

Aspect Ratio Lock
Rotation
Skew
Flip
Scale Line Widths

Selector Tool Operations
Using selection handles
Selecting & deselecting objects
Selecting objects under other objects
Selecting objects inside other objects
Moving objects
Rotating objects
Scaling objects
Flipping objects
Enabling selection handles
Enabling edit handles
Enabling fill handles & fill arrows
Stretching objects
Skewing objects
Editing fills
Using the Selector Tool temporarily
Moving points on shapes and lines
Selecting points on lines and shapes



Editing curved lines and shapes

On-line Demonstrations
    {button Selection Handles,EF("XaraDemo.exe","SelHands.avi `Selection Handles'",1) }
    {button Selecting Objects,EF("XaraDemo.exe","Select.avi `Selecting Objects'",1) }
    {button Selecting Objects In Objects,EF("XaraDemo.exe","SelInsid.avi `Selecting Objects 

In Objects'",1) }
    {button Selecting Objects Under Objects,EF("XaraDemo.exe","SelUnder.avi `Selecting 

Objects Under Objects'",1) }
    {button Moving Objects,EF("XaraDemo.exe","Moving.avi `Moving Objects'",1) }



 Selector Tool - Aspect Ratio Lock Button

The Aspect Ratio Lock button on the Selector Tool Infobar locks the height:width ratio of the 
selection. When the button is pressed in, the ratio is locked. When the button is pulled out, 
the height and width of the selection can be altered independently.
_______________
See also
Scaling objects
Stretching objects



 Selector Tool - Dimensions Field
The Dimensions Field on the Selector Tool Infobar shows the dimensions of the selection. Its 
values alter dynamically if you scale or stretch the selection.
You can also resize the selection by :

 Typing into the fields and pressing RETURN, 
Clicking the arrow buttons.

_______________
See also
Stretching objects
Scaling objects
Units in CorelXARA



 Selector Tool - Edit Handles Button
The Edit Handles Button on the Selector Tool Infobar enables and disables edit handles. With 
edit handles displayed you can use the Selector Tool to edit objects.

The Selector Tool offers the ability to do basic object editing but the more specialised Tools 
often offer more. For instance the QuickShape Tool can bend the edges of a QuickShape 
whereas the Selector Tool can only perform simple QuickShape editing.

Objects can be edited using the Shape Editor Tool, Text Tool, QuickShape Tool, Freehand Tool,
Pen Tool, Mould Tool, Ellipse Tool and Rectangle Tool.
_______________
See also
Enabling edit handles



 Selector Tool - Fill Handles Button
The Fill Handles Button on the Selector Tool Infobar enables and disables fill handles and fill 
arrows. 
When they are enabled you can use the Selector Tool to move fill handles on selected 
objects rather than being forced to choose the Fill Tool.
_______________
See also
Editing fills
Enabling fill handles and fill arrows



 Selector Tool - Flip Buttons

The Flip buttons on the Selector Tool Infobar flip the selection either vertically or horizontally.
Both horizontal and vertical flips reflect the selection about the transformation centre. This 
will usually pass through the centre of the object unless it has been moved.
_______________
See also
Flipping Objects



 Selector Tool - Position Field
The Position Field on the Selector Tool Infobar shows the coordinates of the bottom left 
corner of the bounding box of the selection relative to the bottom left corner of the spread. It
updates dynamically as you drag the selection.
You can also move the selection by :

Typing into the fields and pressing RETURN, 
Clicking the arrow buttons.

_______________
See also
Moving objects
Units in CorelXARA



 Selector Tool - Rotation Field
The Rotation Field on the Selector Tool Infobar lets you rotate the selection. To rotate the 
selection :

Type a value in degrees into the field and press RETURN.
Click the arrow buttons.

Positive angles rotate the selection anti clockwise; negative angles clockwise. The rotation is
centred around the transformation centre. This will usually be in the centre of the selection 
unless it has been moved.
_______________
See also
Rotating objects



 Selector Tool - Scale Line Width Button

The Scale Line Widths button on the Selector Tool Infobar selects whether scaling the 
selection also scales the line widths (thickness). With the button pressed in, the thickness of 
the lines changes in proportion as you scale the selection. With the button pulled out, line 
widths are unchanged by scaling. Line widths are not altered when rotating, skewing or 
stretching objects.
_______________
See also
Scaling Objects



 Selector Tool - Scaling Field

The Scaling Field on the Selector Tool Infobar is used to scale the selection. Entering a value 
into the field and pressing RETURN scales the currently selected objects.
The Aspect Ratio Lock button to the right of the Scaling Field locks the ratio of the horizontal 
and vertical scaling values. This lets you scale objects without distorting them. To scale just 
the width or height of the selection, turn aspect ratio off.
The scaling is centred around the transformation centre. This will usually be in the centre of 
the selection unless it has been moved.
_______________
See also
Scaling objects
Stretching objects



 Selector Tool - Selection Handles Button
The Selection Handles Button on the Selector Tool Infobar enables and disables selection 
handles. With selection handles displayed, you can rotate, scale, stretch and skew the 
selection by dragging the handles.
_______________
See also
Using selection handles
Rotating objects
Scaling objects
Stretching objects
Skewing objects
Enabling selection handles



 Selector Tool - Skew Field
The Skew Field on the Selector Tool Infobar is used to skew the selection. To skew the 
selection :

Type a skew angle and press RETURN.
Click the arrow buttons to skew the selection.

Positive values skew the selection above the transformation centre to the right. Negative 
values skew the selection above the transformation centre to the right. The skew takes place
along a horizontal line through the transformation centre. This will usually mean a horizontal
line through the centre of the selection unless you have moved the transformation centre.
_______________
See also
Skewing Objects



 Selector Tool - Rotate/Skew Mode Button
The Rotate/Skew Mode Button on the Selector Tool Infobar controls the operation of the 
selection handles around the selection. When the button is pressed in, the selection handles 
are in Rotate/Skew mode and when the button is pulled out selection handles are in scale 
mode.
If selection handles are not enabled, pressing this button enables them and places them in 
Rotate/Skew mode.
Clicking on a selected object with the Selector Tool chosen will swap the selection mode 
between Rotate/Skew mode and Scale mode - this is usually easier than using the 
Rotate/Skew mode button.
_______________
See also
Rotating objects
Scaling objects
Stretching objects
Skewing objects
Using selection handles



 Selector Tool - Transformation Centre Grid
The Transformation Centre Grid on the Selector Tool Infobar is used to move the 
transformation centre. Clicking on one of the nine buttons moves the transformation centre 
to the equivalent position on the selection. For example, pressing the central button moves 
the transformation centre to the centre of the selection.
The same effect can be achieved by CTRL-dragging the transformation centre. This 
constrains the transformation centre to one of the corners, the centre of the edges or the 
centre of the selection, whichever is closer to the mouse.
_______________
See also
Rotating objects
Skewing objects
Flipping objects



Set current graphic attribute?

Cause
You have attempted to apply an attribute with no objects selected. Applying attributes with 
no objects selected defines the attributes that will be used for all newly created objects 
(except text objects, see note).

Recommended Action
If you wish to set the current attribute, click Set.
If you want to cancel the operation, click Cancel.
If you    do not wish to see this warning in future, click Quiet. This sets the Ask Before Setting 
Current Attribute option. See General Options.

Note
Setting the current attribute with the Text Tool chosen sets the current text attributes; those 
used for all newly created text objects.
______________
See also
Setting the current attributes



Set current text attribute?

Cause
You have attempted to apply a text attribute with no objects selected. Applying attributes 
with the Text Tool chosen and no objects selected defines the attributes that will be used for 
all newly created text objects.

Recommended Action
If you wish to set the current attribute, click Set.
If you want to cancel the operation, click Cancel.
If you    do not wish to see this warning in future, click Quiet. This sets the Ask Before Setting 
Current Attribute option. See General Options.
______________
See also
Setting the current attributes



Setting a Current Attribute

Cause
This message is displayed when you apply an attribute, such as a fill or a line-width, when 
no suitable object is selected.    For example, trying to apply a fill to a blank page, or trying 
to apply a bold-text attribute to an ellipse. This action changes the current attributes.

Recommended action
Click the Set button to make the attribute current, i.e. the default for all objects 

subsequently created.    For example, if a line-width of 8 pt is made the current attribute, all 
the lines you later draw initially have a width of 8 pts.    Of course, you can still alter a line's 
attributes to be something different.

Click the Quiet button to set the attribute current, and also suppress future prompts 
when setting a new current attribute.    This button is useful when setting a number of 
current attributes in quick succession.

Clicking the Cancel button prevents the current attribute being set.
______________
See also
Setting the current attributes



 Set the current attributes
The current attributes are those attributes which get applied automatically to an object 
when it is created. If you intend to draw many objects that are to share the same attributes, 
then it is useful to make these shared attributes 'Current'. For example if you want to draw a
number of shapes with a red fill colour, and a 4pt line width. Then select red as your current 
fill colour, and '4pt' as your current line width. All shapes subsequently drawn will have these
attributes applied.

When mixing Text with Graphics in a document you frequently want to keep the attributes 
applied to Text objects different to those which are applied to other graphics objects. For 
example all text in your document might be black, whilst all other objects might be blue. For 
this reason CorelXARA has two separate sets of Current
Attributes.

Current Text Attributes                      Applied automatically to a new Text object.
Current Graphic Attributes      Applied automatically when any other type of object is 
created.

To prepare to set a Current Text Attribute, select the Text Tool
To prepare to set a Current Graphic Attribute, select any tool other than the Text Tool.

There are a variety of ways to set the current attributes :

Applying an Attribute With no Selected Objects
1. Deselect all objects (see Clear Selection)
2. Apply the attribute as you would normally to selected objects.

Drag-and-Drop
For attributes which can be applied using drag n' drop (e.g. colours, line widths & bitmap 
fills). Drag the attribute onto an empty part of the page.

Making the Last Applied Attribute a Current Attribute
In the General Options you can set the 'Give new objects most recent attributes' preference. 
Every time an attribute is applied to an object that attribute will become a Current Attribute. 
If you apply an attribute to a Text object then the attribute will become a Current Text 
Attribute. If you apply the attribute to a non text object then the attribute will become a 
Current Graphic Attribute.

Setting an Object's Attributes as Current Attributes
1. Copy the object to the clipboard
2. Deselect all objects
3. Use Paste Attributes to set the current attributes to those used by the objects on the 
clipboard.



 Set the length and angle of a straight line segment
1. Select the line.
2. Choose the Shape Editor Tool.
2. Select the point handle on one end of the segment.
3. Enter the angle and length into the fields on the Infobar.



Shade Colours are a type of named colour which are lighter or darker shades of a parent 
colour. The colours are linked so when the parent colour is altered the shades alter too. This 
allows you to create a range of shades where changing one parent colour alters the hue of 
all of them. Creating pictures using a set of shades gives great editing flexibility. For best 
results with shades, always make sure the parent colour is a 'pure' colour (saturation and 
value should be near 100%). For more information, see Using shades.



A Shape is a solid (or closed) object. The difference between a line and a shape is that a 
shape has no start or end. Because a shape is a closed object it can be filled with a colour. A 
thickness can be applied to the outline of the shape.
CorelXARA sometimes uses 'Shape' as shorthand for 'Line or Shape'.
In PostScript terminology, a shape is a closed path.
Shapes can have two main attributes applied; a fill and a line colour. The line colour is the 
colour used for the outline of the shape and the fill can be a simple colour or a more 
complex fill (e.g. conical, bitmap or fractal).



 
 Shape Editor Tool

Unlike other drawing programs, CorelXARA combines the main shape or curve editing 
functions and line or shape creation facilities in this one tool. The Shape Editor Tool can be 
used to alter curves or straight lines, insert or delete points, smooth complex curves, cut 
lines, reshape curves and create new lines or shapes. It is often easier to use than the Pen 
Tool. and provides more accuracy than the Freehand Tool for drawing lines and shapes.
The Shape Editor Tool can also be chosen using the Line & Shape Pop-up Menu.

F4
Shape Editor Tool Infobar Controls

Mode Indicator
Curved Lines
Straight Lines
Smooth Point
Sharp Point
Break
Delete Point(s)

Parameters

Smoothing

Shape Editor Tool Operations
Drawing a line
Drawing a shape
Extending a Line
Moving points on shapes and lines
Selecting points on lines and shapes
Deleting points on lines and shapes
Editing curved lines and shapes
Adding points to a line or shape
Smoothing a line or shape
Joining lines
Breaking a line or shape apart

On-line Demonstrations
    {button Drawing Lines and Shapes with the Shape Editor 

Tool,EF("XaraDemo.exe","CurvDraw.avi `Drawing Lines and Shapes with the Shape Editor 
Tool'",1) }

    {button Editing Lines and Shapes with the Shape Editor 
Tool,EF("XaraDemo.exe","CurvEdit.avi `Editing Lines and Shapes with the Shape Editor 
Tool'",1) }

    {button Smoothing Lines and Shapes,EF("XaraDemo.exe","Smooth.avi `Smoothing Lines 



and Shapes'",1) }
_______________
See also
Freehand Tool
Pen Tool



 Shape Editor Tool - Break Button

The Break button on the Shape Editor Tool Infobar 'breaks' the selected line(s) or shape(s) at
each of the selected point handles.
Breaking a shape will form a line and breaking a line will form two lines.
_______________
See also
Breaking a line or shape apart



 Shape Editor Tool - Curved Lines Button
The Curved Lines button is on the Shape Editor Tool Infobar. If no point handles are selected, 
it sets the default line type to curved lines. The next line segment you draw will be curved.
If a number of point handles are selected (see Selecting points on lines and shapes), this 
button will change all the connecting line segments to curves. Only those line segments with
both point handles selected change - any line segment with only one point handle selected 
does not change.

C
Note
The keyboard shortcut only works when the Shape Editor Tool is the current tool.
_______________
See also
Drawing a line
Drawing a shape
Editing curved lines and shapes



 Shape Editor Tool - Delete Point(s) Button

The Delete Points button on the Shape Editor Tool Infobar deletes all selected point handles.
If only one point handle is left after the delete operation, the entire line or shape will be 
deleted.

DEL (Delete)
Note
The keyboard shortcut only works when the Shape Editor Tool is the current tool - normally 
Delete deletes all the objects selected.
_______________
See also
Deleting points on lines and shapes



 Shape Editor Tool - Mode Indicator
This indicator on the Shape Editor Tool Infobar shows the current state of the tool. It shows:

New:
No point handles are selected, click to start a new line or shape.

Add:
An end point handle is selected. 

Click away from the line to extend the line, 
Click on the line to add a new point handle,
Click on the other end point handle to close the shape.

Change:
An intermediate point handle or several point handles are selected. Click away from the line 
to start a new line or click on the line to add a new point handle.



 Shape Editor Tool - Parameter Fields

The parameter fields on the Shape Editor Tool Infobar display information about the currently
selected point handle, the fields are blank if more than one point handle is selected.

Left Hand Field
This field displays :

The co-ordinate of the previous curve edit handle, if the previous segment is a curved
line.

The length and angle of the previous segment, if it is a straight line.

Centre Field
This field displays the coordinates of the selected point handle.

Right Hand Field
This field displays :

The co-ordinate of the next curve handle, if the previous segment is a curved line.
The length and angle to the horizontal of the next segment, if it is a straight line.

One point handle is 'previous' to another if it is nearer the start of the line.
_______________
See also
Units in CorelXARA



 Shape Editor Tool - Sharp Point Button
The Sharp Points button on the Shape Editor Tool Infobar changes all the selected point 
handles into sharp (cusp) corner points with independently controllable curve edit handles - 
i.e. they are not smooth points.
If no point handles are selected it sets sharp points as the default.

Z
Note
The keyboard shortcut only works when the Shape Editor Tool is the current tool.



 Shape Editor Tool - Smooth Point Button
The Smooth Point button on the Shape Editor Tool Infobar changes all the selected point 
handles into smooth points - i.e. they are not corner (cusp) points.
If no point handles are selected it sets smooth points as the default.

S
Note
The keyboard shortcut only works when the Shape Editor Tool is the current tool.
_______________
See also
Editing curved lines and shapes



 Shape Editor Tool - Smoothing Slider
The Smoothing slider on the Shape Editor Tool Infobar smoothes (simplifies) the currently 
selected line(s) by removing points (see Selecting points on lines and shapes) and altering 
the shape of the remaining line to match the original shape as closely as possible.
It is similar to the auto-reduce feature found in CorelDRAW!.

Note
The smoothing slider is dimmed when no point handles are selected.
_______________
See also
Smoothing a line or shape



 Shape Editor Tool - Straight Lines Button
The Straight Lines button is on the Shape Editor Tool Infobar. If no point handles are 
selected, it sets the default line type to straight lines. The next line segment you draw will 
be straight.
If a number of point handles are selected (see Selecting points on pines and shapes), this 
button will change all the connecting curved line segments to straight lines. Only those line 
segments with both point handles selected change - any line segment with only one point 
handle selected does not change.

L
Note
The keyboard shortcut only works when the Shape Editor Tool is the current tool.
_______________
See also
Drawing a line
Drawing a shape
Editing curved lines and shapes



Shape not suitable for moulding

Cause
When pasting a shape from the clipboard as a mould, the first item on the clipboard which is 
or can become a shape is used. In this case the shape found is unsuitable for use as a 
mould. If you are pasting as a perspective mould, the shape is restricted to a four sided 
polygon. If you are pasting as an envelope mould the shape must be made up of four sides, 
be they curves or lines. If the shape fails the test for suitability you will get this error. Finally, 
twisted shapes of four sides such as a bow tie shape where two edges intersect cannot be 
used as a perspective mould. Twists are allowed however in envelope moulds.

Recommended Action
Paste the contents of the clipboard (CTRL+V ) into another document and have a look at the 
shape, it may be possible to edit this shape to make it suitable for use as a mould by using 
the Shape Editor Tool. Having edited the shape copy it back to the clipboard and try pasting 
again.



Sharpen exaggerates the boundary between colours in bitmaps. It is useful for bringing out 
detail. It is not useful for :

Gentle transitions between shades of the same colour.
'Noisy' bitmaps. Applying sharpening to such a bitmap is likely to emphasise the 

noise.
The Bitmap Effects dialog box contains three levels of Sharpening; Low, Medium and High. 
One of these can be selected, and the slider used to set the level more accurately.



 Show Grid (Window Menu)
    #

Show Grid sets whether or not the grid is displayed. A tick next to the option denotes that 
the grid is shown.

Show Grid is also available from the View Pop-up Menu.
_______________
See also
Snap To Grid



 Show Guides (Window Menu)
Show Guides displays or hides the guides layer which contains all guidelines and guide 
objects. Show Guides is a short-cut for changing the visibility setting of the guides layer in 
the Layer Gallery.

For more information on guides, see Using guides.

Note
Selecting this option only affects the guides in the current document.
_______________
See also
Snap to Guides



 Show Print Borders (Window Menu)
Most printers have a non-printing margin (the print border) around the edge of the paper. 
With Show Print Borders selected two rectangles are displayed on screen. The yellow 
rectangle represents the extremes of the paper (This corresponds to the paper size defined 
in the Print Setup dialog box) and the red rectangle represents the area which can be 
printed. The dark grey area around the outside is the area that will not be printed.
If no printer has been set up, no print borders are shown.

Note that the print borders are not necessarily central on the paper (especially for ink jet 
printers).
_______________
See also
Print



 Show hidden buttons

If buttons on a control bar are hidden because the window has been scaled and obscured 
them or you are using a small graphics mode, there are three options available :

Set the buttons to 'small' using the Control Bars option on the Window menu.
Make the bar float by dragging it away from the window edges. See Moving & resizing

control bars
Drag some of the buttons to a new bar. See Moving & copying buttons.



Selection handles operate in two modes; Scale mode and Rotate/Skew Mode. The former 
allows the selection to be scaled, the latter allows it to be rotated and skewed.

      Selection handles
 in Skew/Rotate mode



 Skew objects
Objects can be skewed along their edges, along a line parallel to their edges passing 
through the centre of the selected objects or along a line parallel to their edges passing 
through the transformation centre, either using the mouse or, accurately, using the Infobar.

What do you want to do ?
Skew objects by dragging
Skew objects accurately



 Skew objects accurately
1. Choose the Selector Tool.
2. Select the objects to be skewed.
3. Move the transformation centre onto the required horizontal skew axis.
4. Do one of the following :

Enter the required skew in the Skew Field on the Infobar and press RETURN.
Use the Skew field arrow buttons on the Infobar.



 Skew objects by dragging

1. Select the objects to be skewed (see Selecting & deselecting objects).
2. Ensure the selection handles are in Rotate/Skew mode (see Using selection handles).
3. Do one of the following :

Drag the side selection handles to skew the object with opposite side used as a base 
line.

SHIFT-drag the side selection handles to skew the selection about its centre.

The skew angle (see General Options) can be constrained by pressing CTRL during the drag.

Note
To leave a copy of the original non-skewed object, press NumPad '+' during the drag.
To skew the object but not any fill applied to it, press NumPad '-' during the drag.



 Slice (cut) Shapes (Arrange Menu)
This operation operates much like a pastry or cookie cutter. The object at the front of the 
selection is used as the cutter to slice through the other objects.
If the front object is a line, you can slice objects in two.
If the slice operation results in more than one shape, they will be grouped.

On-line Demonstration
    {button Slicing Objects,EF("XaraDemo.exe","Slice.avi `Slicing Objects'",1) }

Note
If you need to slice a line, it is easier to add a point to the line and use the    Break Button on 
the Shape Editor Tool Infobar. See Adding points into a line or shape and Breaking lines and 
shapes apart.
If a line is used to cut an object, the end points of the line must both lie outside the 
bounding box of the object.



Sliders allow values to be set by sliding a small button along a groove. They are sometimes 
referred to as 'trackbars'.



 Smooth a freehand line
The slider on the Freehand Tool Infobar controls how accurately the final line follows your 
original mouse movements. At 0%, the final line closely follows your original movements. 
This creates a line with many point handles. Higher percentages insert fewer point handles 
and produce a less accurate but smoother line.
You can smooth a freehand line at any time until you draw another freehand line. The 
Infobar shows 'Refit' when smoothing is possible. 
You can always smooth a line or shape using the Smoothing Slider on the Shape Editor Tool 
Infobar, see Smoothing lines and shapes.



 Smooth lines and shapes
Lines imported from tracers or freehand lines often have far more points than necessary. 
Smoothing removes these unnecessary points.

1. Use the Selector Tool to select the line(s) or shape(s)
2. Choose the Shape Editor Tool.
3. Select the points on the region of the line to be smoothed (or simplified). See Selecting 

Points on Lines and Shapes
4. Move the smoothing slider on the Shape Editor Tool Infobar.

Note
Smoothing only alters selected points. Unselected points are never altered. If there are 
areas of the line you do not want changed, make sure the points in these areas are 
unselected.



 Snap To Grid (Window Menu)
 Number Keypad    .

Snap to Grid sets whether or not objects drawn will automatically lock onto the grid in the 
document.
If the option is selected, items will lock onto the grid.

Snap to Grid is also available from the View Pop-up Menu.

Note
The key shortcut only works if NumLock is enabled on your keyboard.
_______________
See also
Show Grid



 Snap To Objects (Window Menu)
 Number Keypad    * 

Selecting Snap to Objects enables magnetic snapping. For more information, see Using 
magnetic snapping.

Snap to Objects is also available from the View Pop-up Menu.

On-line Demonstration
    {button Magnetic Snapping,EF("XaraDemo.exe","Magnet.avi `Magnetic Snapping'",1) }

Note
The key shortcut only works if NumLock is enabled on your keyboard.
The key shortcut can be used during a drag.



 Snap to Guides (Window Menu)
Selecting Snap to Guides will make all objects in the guides layer magnetic. This includes all 
guidelines and guide objects. With the option set, dragging objects near guides will result in 
them snapping onto the guide - the mouse pointer shows a magnet when this happens.

Note
Snap To Guides is also available on the Guideline Pop-up Menu.
_______________
See also
Show Guides
Using guides



Snapping cause an object or point to be pulled to a certain place while it's being dragged. 
CorelXARA has three forms of snapping, Grid snapping, Guide snapping and Magnetic 
snapping. Snapping is useful for precisely aligning    points or objects with each other. See 
Snap To Objects.



Some fonts have been substituted

Cause
A document has been opened or imported which contains fonts you do not have installed on 
your system.

Recommended Action
Open the Document Info dialog box and use the drop-down list of fonts to look for fonts 
listed with a ' * ' next to them, these are the fonts that have been substituted. You must 
install each of these fonts (see Installing a font).
If you do not have the fonts used, you can apply a different font to the text objects (see 
Applying attributes to text) or leave them as they are.



Set print method to Normal

Did you change the print method by editing the INI file?
      Yes. Return the print method to the default setting.

      Set the print method to Normal:
1. Click on the Utilities menu and choose Options.
2. Click on the Output tab.
3. Ensure that the leftmost switch in the print method area (labelled either Normal or 

Postscript) is checked.
4. If you changed any options click OK.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else can I try?



Some of the selected named colours are in use in your 
document

Cause
You have attempted to delete named colours from the document which are being used.

Recommended Action
Clicking Delete Unused will delete all the colours you have selected apart from those 
currently in use.
If you click Delete All, all the colours you have selected will be deleted, including the ones 
being used. The objects which are using these colours will have local colours applied to 
them. The document will not look any different.



Some parts of the document could not be exported

Cause
The export format does not support certain of CorelXARA's unique features. (For example, 
CorelDRAW format does not support CorelXARA transparency or fractal fills.)

Recommended action
This may be an acceptable limitation if    you must export in a non-CorelXARA format.    If this 
limitation is not acceptable, then export in CorelXARA's native format or create a bitmap of 
the document.
_______________
See also
Export



Some parts of the document could not be imported

Cause
Parts of an imported file cannot be converted to CorelXARA document format, e.g. an Adobe 
Illustrator complex graduated fill.

Recommended action
If you are familiar with the look of the original document, you can probably reconstruct the 
missing parts using the tools provided in CorelXARA.    You can then save the document as a 
CorelXARA document file.



 Create special effects
Drawing motion blur
Creating advanced blends
Creating fully justified text
Drawing concentric circles
Creating parallel lines

Creating lighting effects
Drawing a light source

Morphing bitmaps
Feathering a bitmap
Masking a bitmap



A Spread is the name given to a number of pages that are joined together. The two pages in
the middle of a magazine are often referred to as the 'centre-spread'. CorelXARA supports 
two types of spread, single-page-spreads and double-page-spreads (DPS). A single page 
spread is just one page on its own. A double-page-spread is two pages side by side. The line 
where two pages join on a double page spread is often used to fold the paper that the 
document is finally printed out on.



Spread too large

Cause
The values that have been entered into the page width, height and margins fields in the 
Page Options to modify the current page size mean that the height and/or width of the 
pasteboard is beyond what CorelXARA will cope with, which is about 275cm or about 9ft. The
pasteboard is the grey area en compassing the page or pages of the spread and the margins
around the outside.
The height of the pasteboard is always the total of the page height and twice the size of the 
margin, as there is a margin above and below the page. 
If only a single spread is selected then the width of the pasteboard will be the total of the 
page width plus two margins.    However, if the double page spread option is selected, then 
the pasteboard width will be the total of two page widths and two margins.

Recommended action
Reduce the size of the width, height and margin fields so that the pasteboard size becomes 
less than the maximum.
_______________
See also
Scaling Options



Square Caps are a type of ending which can be applied to lines. There are three types of 
'cap' :

Butt Cap                      Round Cap                Square Cap

The line cap style is applied using the Line Gallery.



Stained Glass is one of the three types of transparency supported by CorelXARA; mix, 
stained glass and bleach. The effect is similar to viewing underlying objects through 
coloured glass. It is useful for the simulation of glass. Technically, the process is subtractive, 
progressing towards saturated colour. This process always makes the underlying colours 
darker.

100% transparency Completely transparent
0% transparency Perfect colour filter using the fill colour(s)



Standard Control Bar

New
Open
Save
Delete
Undo
Redo

Zoom
Previous Zoom
Zoom to Drawing
Line Width
Quality
Snap To Objects

_______________
See also
Default Control Bars



Status Line

The Status Line help text is context sensitive. It continually displays to the user the current 
state of the application. This includes a description of what operations can be performed at 
any one time and progress information for longer processes. It also displays a simple 
description of the objects currently selected.
The Status Line is an ideal companion to learning how to use CorelXARA.

Mouse Position

The current position of the mouse pointer in the document relative to the bottom left-hand 
corner.

Magnetic Snap Indicator

This indicator only functions when Snap To Objects has been selected.
When the handle currently being dragged snaps onto an object this indicator shows a red 
magnet (in addition to a magnet appearing on the mouse pointer). Otherwise the indicator is
dimmed.

Transparency Indicator

This indicator shows a glass when transparency is enabled for the selected document. It is 
dimmed otherwise. When a document containing transparent objects is loaded or a 
transparent object created in a document, the transparency is enabled automatically if 
Automatic Transparency is set in the View Options.
Double clicking on the transparency indicator swaps the document between redrawing with 
transparency and ignoring it.
_______________
See also
Status Line Enable/Disable



Status Line (Window Menu)

Status Line on the Bars submenu of the Window menu allows the Status Line to be turned on
and off. When it is set, the Status Line is enabled, otherwise it is not.
Normal mode and full screen mode store this setting separately, so you could have the 
Status Line enabled in normal mode, but not in full screen mode.
Current settings are stored when you quit CorelXARA.



 Stretch objects
You can stretch objects by either scaling or skewing them.

What do you want to do?
Scale objects
Skew objects



 Subtract Shapes (Arrange Menu)
Discard those areas of the selected objects covered by the front object. The front object 
disappears.
The front object may be a group for more complex cut-outs. This operation is the 'opposite' 
of Intersect shapes.
If the subtract results in more than one shape, they will be grouped.

On-line Demonstration
    {button Subtracting Objects,EF("XaraDemo.exe","SubShape.avi `Subtracting Objects'",1)

}



Supported File Formats

The following is a list of the file types which can be imported into CorelXARA.

Bitmap Import Formats
.301 Brook Trout
.BM X Windows (2 colour)
.BMP Windows Bitmap
.CAL CALS (2 colour)
.CUT Halo CUT (256 colour)
.DCX DCX
.GIF CompuServe Graphics Interchange Format (see GIF)
.GX2 Storyboard
.ICA IOCA (2 colour)
.ICO Microsoft Windows Icon (16 colour)
.IFF Amiga IFF
.IMX Sun Raster
.IMG IMG (16 colour)
.JPG JPEG
.i KOFAX
.LV LaserView (2 colour)
.MAC MacPaint (2 colour)
.MSP Microsoft Paint (2 colour)
.PCD PhotoCD
.PCTPICT
.PCX PCX Paintbrush
.PSD Photoshop
.RAS Sun Raster
.TGA TrueVision TARGA
.TIF TIFF
.WPG Word Perfect Group (256 colour)
.XBM X Windows (2 colour)
.XPM X Windows (256 colour)

EPS Import Formats
.AI Illustrator EPS (88, 3, 4 & 5)
.EPSIllustrator EPS (88, 3, 4 & 5)
.EPSCorelDRAW! 3, 4 & 5 EPS
.EPSFreeHand 3.0 EPS
.EPSArtWorks EPS

Other Import Formats
.XAR CorelXARA
.AFF Acorn Draw
.CDR CorelDRAW (3,4 & 5)
.CDT CorelDRAW Template
.DRW Acorn Draw
.WMF Windows Meta File

Palette Import Formats
.CPL CorelDRAW Palette (see Importing colours & palettes)
.PAL CorelDRAW Palette (see Importing colours & palettes)
.PAL Microsoft Palette
.PAL PaintShop Pro Palette
.ACT Adobe Colour Table
.ACO Adobe Colour Swatch

The following is a list of the file types which can be exported from CorelXARA.

Bitmap Export Formats
.BMP Windows Bitmap (see BMP Export)
.DCX DCX (see DCX Export)
.PCX PCX (see PCX Export)
.GIF CompuServe Graphics Interchange Format (see GIF Export)



.JPG JPEG (see JPEG Export)

.PCTPICT (see PICT export)

.RAS Sun Raster (see Sun Raster Export)

.TGA TrueVision TARGA (see TrueVision TARGA Export)

.TIF TIFF (see TIFF Export)

.WPG Word Perfect Group (256 colour) (see WPG Export)

EPS Export Formats
.AI Illustrator EPS (88)
.EPSIllustrator EPS (88)
.EPSArtWorks EPS
.EPSCorelXARA EPS

Other Export Formats
.XAR CorelXARA
.WMF Windows Meta File

_______________
See also
Open
Import
Save As
Export



Technical Support

Corel is committed to providing customers with high quality, real-time technical support.    
We recognise that support needs vary from user to user, and offer a wide range of choices 
when you need answers to technical queries and problems which may arise from the use of 
this application.

If you have a question about CorelXARA features and functions,    look in the User's Manual or
consult the online documentation. You might also like to try the Online Demonstrations.

If you cannot find the answer in these locations, you can speak to a Technical Support 
Representative located in North America or in Europe.
If you have problems after hours or on weekends or holidays, you can contact IVAN - our 
Interactive Voice Answering Network or the Automated FaxBack System.
We also offer Electronic Support Services from our Bulletin Board, Internet World Wide Web 
site (http://www.corel.com), and our FTP site.
Xara Ltd, the developers of CorelXARA, also have a World Wide Web site at 
http://www.xara.com/ which may help.

How to reach Corel in North America
How to reach Corel worldwide
Electronic support options
How to use Automated FaxBack System
Extended Technical Support



Technical Support - Automated Fax System

Technical Support maintains an Automated FaxBack System of numbered documents that 
contain up-to-date information about common issues, tips, and tricks This service is 
available 24 hours a day, 365 days a year. 

Calling the Automated FaxBack System
Dial 613-728-0826, extension 3080.    You will then be prompted for a document number and 
your own fax number.    The document you request is automatically sent to you. To fax a 
catalogue of documents to yourself, call the Automated FaxBack System number and 
request document #2000.



Technical Support - Electronic Options

BBS
Technical Support operates a BBS service that allows you to download program files that 
have been modified between releases.    A    Technical Support representative may request 
that you upload troublesome files to the BBS.

Calling the BBS
Dial 613-728-4752 or (613) 761-7798. Both lines are set for 8 bit word, 1 stop bit, no parity.   
The supported speeds on these Hayes 288 modems are 2400-28,800 baud.

Microsoft Network (MSN)
Technical Support operates a forum on the Microsoft Network.    Periodic updates or patches 
are made available in the Corel Forum.    You will also find utilities and interesting information
that forum members have made available.    Interact with other users and Corel technicians 
to obtain product and support information for CorelXARA.
For quick access to forums in the MSN, use Go Words.    In the MSN Central, go to the Edit 
Menu and choose Go To.    Choose Other Location, then type COREL.    Then click OK or press 
ENTER to go directly to the Corel Forum.

To Access the Corel Forum in the MSN
In the MSN Central, go to the Edit Menu. Click on GoTo. Choose Other Location. Type Corel. 
Click on OK.

Internet Services

WorldWide Web Site (WWW)
For late breaking technical news and information on all Corel products, visit our WWW home 
page at http://www.corel.com. From the home page, you can access Corels Technical 
Knowledge base, as well as corporate, marketing, and product information.
Additionally, Xara Ltd, developers of CorelXARA, have a site on the Internet at 
http://www.xara.com/.

FTP
You can download updates, patches and utilities by accessing our anonymous FTP site at 
ftp.corel.com.



Technical Support - Extended

For details on support options available to you after your warranty support expires, please 
contact Corel Technical Support at    1-613-728-9861



Technical Support in North America

Technical Support
Corel is committed to providing customers with high quality real-time technical support. We 
recognise that support needs vary from user to user, and offer a wide range of choices when
you need answers to technical queries and problems which may arise from the use of this 
application. This document will introduce you to the variety of support services we provide.

Warranty Technical Support Services
1-613-728-9861 (North America Only)
Free technical support is available to you for 30 days from the day you place your first call to
technical support.    CorelXARA support personnel are available to respond to your call from 
Monday to Friday, 8:30 a.m. to 4:30 p.m. Eastern Standard Time. During and after your 
warranty support period, you can also use the basic services listed below.

Extended Technical Support services
To request an up-to-date listing of Corel's Authorised Support Partners world-wide, and a 
copy of Corel's Extended Technical Support Policy, please contact Corel Technical Support at 
1-613-728-9861.

Basic Services
Corel offers the following technical support options, most of which are available 365 days of 
the year, 24 hours a day.    These services are useful if you prefer not to pay for support or 
encounter problems during off-hours.

IVAN (Interactive Voice Answering Network)
Ivan contains answers to commonly asked questions and is available 24 hours a day, 365 
days a year. IVAN is regularly updated with the latest information, tips, and tricks. You can 
request that IVAN's solutions be faxed to you.

Calling IVAN 
Dial 613-728-6398. There is no charge for this service other than the cost of the telephone 
call.

Automated FaxBack System
Technical Support maintains an automated FaxBack system of numbered documents that 
contain up-to-date information about common issues, tips, and tricks. This service is 
available 24 hours a day, 365 days a year.

Calling the Automated FaxBack System
Dial 613-728-0826, extension 3080. You will be asked for a document number and your fax 
number. The document you request is automatically sent to you. To fax a catalogue of 
documents to yourself, call the automated FaxBack System and request document 2000.

Before You Call
Before calling Technical Support, please have the following information available.    It will 
assist the Technical Support Representative in helping you with your problem quickly and 
efficiently:

A brief description of the problem including the exact text of any error messages received, 
and the steps to recreate it.

Type of computer, monitor, pointing device (e.g., mouse, tablet), printer and video 
card (display adapter) in use.

The versions of Microsoft Windows and the CorelXARA product in use.    Choose the 



About Windows 95 command from the Help menu in Explorer to find which version of 
Windows you are running.

A list of any programs loaded into RAM (e.g., TSRs).    Check the Startup folder in the 
Programs menu to determine if you are running any other programs.

Customer Service in North America

Customer Service Representatives answer questions about specifications and pricing,    sell 
Corel products,    and issue replacement disks.    There is no charge for calling Customer 
Service.
General customer service and product information can    be accessed through the MSN and 
WorldWide Web at http://www.corel.com .

Internet United States and Canada 1-800-772-6735
custserv@Corel.com
Customer Service
Corel Corporation
c/o UCA&L
P.O. Box 3595
Salinas
California 93912 - 3595



The Template Document is the blank document that appears when you open a new 
document. The template document can be altered using Save As Template.



CorelXARA locates a Temporary directory using the 'TEMP' environment variable. If this 
variable is not set to a proper directory, various features of the program, such as the remote 
index building in the library galleries, will not work.



The Text Cursor is displayed when the Text Tool is selected. The cursor shows you where 
characters will appear if you start typing or where editing will take place if the cursor is 
inside an existing text object. To move the cursor click the mouse where you want the 
cursor.
Note that no cursor is displayed if there is a selected text region.



A Text Object is one or more lines of text which can be moved and copied like any other 
object. The Text Tool allows you to edit the contents of text objects by typing new 
characters, changing the font, font size, etc. Many normal attributes can be applied to text 
from the other tools such as line width, fill type and colour and even transparency.
Text objects can be fitted to a curve and they remain editable in the Text Tool.



Text Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a text object, it contains the 
following options :

Text Tool
- - - - - - - - - -
Left Justification
Centre Justification
Right Justification
Full Justification
- - - - - - - - - -
Reverse text on curve
- - - - - - - - - -
Print text as shapes
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate (see note)
Clone (see note)
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Colour Editor

Note: Duplicate and Clone may be dimmed when you have a selected region. CorelXARA 
cannot duplicate or clone objects that are within other objects (in this case, a text story).
_______________
See also
Pop-up Menus



 
 Text Tool

The Text Tool allows you to create text objects consisting of one or many lines of text which 
can be placed around a curve if necessary and alter existing text objects. With the Text Tool 
selected, the Infobar shows the range of text attributes.

F8
If there is a selected region of text, any change to a text attribute applies to that 

region.
Otherwise, the change applies at the text cursor. Start typing and the text appears 

with the changed attribute.

If there is a selected region of text, the Infobar shows the attributes that apply to the region. 
If multiple values for one attribute have been applied, the field is blank, e.g. if the selected 
region includes both 10pt and 12pt text, the Font Size field is blank. When the cursor is 
visible, the Infobar shows the attributes that will apply when you type a character.
The Text Tool can also be chosen using the Text Pop-up Menu.

Text Tool Infobar Controls

Font
Font Size
Aspect Ratio
Bold
Italic
Left Justification
Centre Justification
Right Justification
Full Justification
Superscript and Subscript
Line Spacing & Tracking
Baseline Shift & Kerning

Text Tool Operations
Creating new text
Editing text
Selecting text
Applying attributes to text
Placing text around a curve
Creating fully justified text
Editing moulded text
Entering special characters
Text Tool key shortcuts



On-line Demonstrations
    {button Entering Text,EF("XaraDemo.exe","Text.avi `Entering Text'",1) }
    {button Editing Text,EF("XaraDemo.exe","EditText.avi `Editing Text'",1) }
    {button Advanced Text,EF("XaraDemo.exe","TextFun.avi `Advanced Text'",1) }

_______________
See also
Installing a font



 Text Tool - Aspect Ratio Field
This field on the Text Tool Infobar shows the aspect ratio of text.
100% is a 1:1 aspect ratio. An aspect ratio of 80% gives narrow (condensed) text whereas a 
ratio of 120% gives wide text. (Values below 80% and above 130% can make the text look 
distorted.)
Refer to Applying attributes to text for details of how changes to this field affect text.



 Text Tool - Baseline Shift & Kerning

These two fields on the Text Tool Infobar are used to move characters either vertically 
(baseline shift) or horizontally (kerning). 

Baseline Shift
Changing the baseline shift of text moves it vertically.
The baseline shift is displayed in the default text units (usually points (pt) ).

Kerning
Kerning lets you alter the horizontal space between two adjacent characters by inserting a 
'kern' character in the text. This kern is a variable width space in the text which can be 
deleted like any other character if it is no longer required. Kerns can be used to simulate tab 
characters (particularly when the text has been fitted to a curve).
Place the text cursor between the two characters to insert or edit a kern.
Positive values increase the width of the kern, negative values decrease its width.
Kern size is measured in thousandths of em's.

Refer to Applying attributes to text for details of how changes to this field affect text.
CTRL+ '+'Increase tracking (if the text cursor is present)
CTRL+ '-' Decrease tracking (if the text cursor is present)

_______________
See also
Units in CorelXARA



 Text Tool - Bold Button

When this button on the Text Tool Infobar is depressed, the Bold attribute is applied to the 
text.
Refer to Applying attributes to text for details of how changes to this field affect text.

CTRL+B
Note
The keyboard shortcut only works when the Text Tool is the current tool.



 Text Tool - Centre Justification Button

This button on the Text Tool Infobar sets the justification of text. When it is depressed, the 
text is centrally aligned around the point where you started typing.
Refer to Applying attributes to text for details of how changes to this field affect text.

Centre justification can also be applied using the Text Pop-up Menu.

Note
You can centre justify text fitted to a curve.



 Text Tool - Font Field
This field on the Text Tool Infobar shows the current text font (typeface). Choose from the 
drop-down list to change the font. Note that you can also apply fonts using the Font Gallery. 
Refer to Applying Attributes to Text for details of how changes to this field affect text.

On the left-hand side of the font is an indicator which shows the format of the font :
Adobe Type Manager (ATM) Type 1
TrueType

If a font is listed with a ' * ' displayed next to it, this means the font required for the current 
document cannot be found. This may be due to it not being installed on your system or the 
font file being corrupt. It may be possible to solve this problem by reinstalling the font. See 
Installing a font. For a full list of fonts used in a document, see Document Info.



 Text Tool - Font Size Field
This field on the Text Tool Infobar shows the current point size of text. To change the font size
:

Type in a value and press RETURN.
Choose a size from the drop-down list.

Refer to Applying attributes to text for details of how changes to this field affect text.
_______________
See also
Units in CorelXARA



 Text Tool - Full Justification Button

This button on the Text Tool Infobar sets the justification of text that has been fitted to a 
curve. When it is depressed, text is justified fully between the ends of the line that the text 
has been fitted to. Full justification works by increasing or decreasing the spacing until the 
text fills the line.

Full justification can also be applied using the Text Pop-up Menu.

If you apply Full justification to text not fitted to a curve, the text is left justified. 

Refer to Applying attributes to text for details of how changes to this field affect text.
_______________
See also
Creating fully justified text



 Text Tool - Italic Button
When this button on the Text Tool Infobar is depressed, the Italic (slanted) attribute is 
applied to the text..
Refer to Applying attributes to text for details of how changes to this field affect text.

CTRL+I
Note
The keyboard shortcut only works when the Text Tool is the current tool.



 Text Tool - Left Justification Button
This button on the Text Tool Infobar sets the justification of text. When it is depressed, the 
text is justified so that its left-hand edge is aligned with the point where you started typing.
Refer to Applying attributes to text for details of how changes to this field affect text.

Left justification can also be applied using the Text Pop-up Menu.

Note
You can left justify text fitted to a curve.



 Text Tool - Line Spacing & Tracking
Line Spacing
Changing the Line Spacing value on the Text Tool Infobar changes space between a line and 
that above it.. This attribute always affects entire lines of text, i.e. any changes made to the 
line spacing of a selected region affects all the text lines covered by the selection.
Line Spacing is displayed as a percentage of the character size. "100%" spaces the lines as 
closely as possible without lines coming into contact; "200%" is double-spaced text. Enter a 
value as a percentage of the size of the largest character in the line.

You can also enter absolute values using any unit, e.g. you can enter "4pt" or "2cm".

Tracking
Changing the Tracking value on the Text Tool Infobar changes the inter-character spacing.
Tracking is measured in thousandths of em's.

Refer to Applying attributes to text for details of how changes to this field affect text.
CTRL+ '+' Increase tracking (if a region is 

selected)
CTRL+ '+' Decrease tracking (if a region is 

selected)
_______________
See also
Units in CorelXARA



 Text Tool - Right Justification Button
This button on the Text Tool Infobar sets the justification of text. When it is depressed, the 
text is justified to the right of the point where you started typing.
Refer to Applying attributes to text for details of how changes to this field affect text.

Right justification can also be applied using the Text Pop-up Menu.

Note
You can right justify text fitted to a curve.



 Text Tool - Superscript & Subscript Buttons

These buttons on the Text Tool Infobar set the superscript and subscript attribute to text., 
this results in text which is about half size. Subscript is the lower button and places the text 
at the bottom of the text line, whereas Superscript (the top button) places the small text at 
the top of the text line.

Refer to Applying attributes to text for details of how changes to this field affect text.



Text Tool key shortcuts
Cursor keys Move the text cursor one character at a time up, down, left or 

right.
Home Move the text cursor to the start of the line.
End Move the text cursor to the end of the line.
CTRL+right-cursor Move the text cursor right one word.
CTRL+left-cursor Move the text cursor left one word.
CTRL+HOME Move the text cursor to the start of the first line in a text object.
CTRL+END Move the text cursor to the end of the last line in a text object.
CTRL+A Selects all characters in a text object.
CTRL+B Apply the Bold attribute (see Bold).
CTRL+I Apply the Italic attribute (see Italic).
CTRL+C Copy the selected region of text to the clipboard.
CTRL+L Selects all characters in the line containing the text 

cursor.
CTRL+V Paste text at the text cursor position (If the clipboard 

contains text)
CTRL+W Swap the case of the character to the right of the text 

cursor.
CTRL+equals/plus key Increase kerning/tracking.
CTRL+underline/minus key Decrease kerning/tracking.
RETURN Start a new line of text.
DELETE Delete the character to the right of the text cursor. If the 

cursor is on the end of a text line, join this line to the line below.
BACKSPACE Delete the character to the left of the text cursor. If the cursor is

at the start of a text line, join this line to the line above.
SHIFT+cursor keys Selects all text between the original position of the text cursor 

and its new position.
SHIFT+HOME Select all text between the cursor position and the beginning of 

the line.
SHIFT+END Select all text between the cursor position and the end of the 

line.

For details of how to enter special characters with the Text Tool, see Entering special 
characters.



Text to search for is invalid

Cause
You have not entered any text to search for.

Recommended action
Repenter the text you wish to search for.



The Adobe Type Manager is Not Running

The Adobe Type Manager is not running, or is turned off.

Cause
The Adobe Type Manager is not running, or is turned off. ATM currently does not work on 
Windows NT.

Recommended action
If you are running Windows 3.1, 3.11 or Windows 95 and ATM is not installed, you need to 
install it to use ATM fonts.
If you are running NT, you won't be able to use ATM fonts. Change to either Windows 3.x or 
Windows 95.
If ATM is installed, but is not turned on, enable ATM using the ATM control panel.



The CorelXARA Workplace

The CorelXARA Environment consists of:
Control Bars
Infobar
The Colour Line
The Status Line
Scrollbars
Page
Pasteboard
Rulers
Toolbar



The appropriate type of object is not selected

Cause
In CorelXARA, operations are often performed on objects that are selected.    You have tried 
to perform an operation when no object is selected, or the wrong kind of object is selected.

Recommended action
Select the object you wish to perform the operation on, then try the operation again.
_______________
See also
Selecting & deselecting objects



This operation will remove a perspective fill

Cause
Displayed when converting an object to editable shapes will discard the object's perspective 
moulded fill.

Recommended action
Click the OK button to discard the perspective mounded fill.
Click the Cancel button to keep the perspective mounded fill and therefore not 

convert the object to editable shapes.



 Time CorelXARA redraw
CorelXARA lets you time the redraw of a document. This is useful for comparing the redraw 
speed of    CorelXARA with other drawing packages.

To time CorelXARA redraw
1. Open the document.
2. Zoom in and move the document until it is at the required size and position.
3. Press CTRL+SHIFT+T.

This redraws the document and afterwards a dialog box appears showing the time taken for 
the redraw.

To make a fair comparison between CorelXARA and other packages
1. Turn off anti-aliasing by setting the Quality slider to Normal (other packages do not 

generally anti-alias drawings).
2. Turn off background redraw in the View Options.
3. If transparency is enabled, disable it by double-clicking on the transparency indicator on 

the Status Line as documents with transparency take slightly longer to redraw.



Tint Colours are a type of named colour. They are based on another named colour (called 
the parent colour) but with the addition of white, so any changes made to the parent colour 
will be reflected in the tint. They have two main uses:

As a quick way to define new named colours. e.g. Pink could be defined as 50% Red.
To extend the range of colours available for printing inks. For example, a 75% black 

tint gives dark grey, a 25% black tint light grey. This gives three colours using just one ink.
To create highlights of the parent colour.

A tint can be based on any other named colour, including another tint. 



A Title can be stored with each CorelXARA document which is displayed when the file is 
added to the Clipart Gallery. See Using titles, descriptions and keywords for further 
information.



A Tool in CorelXARA is much like a tool in normal life. It is used for a specific job. CorelXARA 
is divided into well-defined tools each of which has a specific purpose.

For more information on the CorelXARA Tools, see The Tools.



The Toolbar is a special control bar containing buttons for all the Tools available in 
CorelXARA.



Tools

Tools are the main method of drawing objects and editing your documents. Each tool 
customises the Infobar to show information and controls relevant to that Tool.
The currently chosen tool defines which actions can be performed on the document. The 
following are the buttons used to choose Tools; they are displayed on the Toolbar.

          Selector Tool  
          Freehand Tool  
          Shape Editor Tool  
          Pen Tool  
          Rectangle Tool  
          Ellipse Tool  
          QuickShape Tool  
          Blend Tool  
          Fill Tool  

     Transparency Tool  
          Mould Tool  
          Text Tool  
          Push Tool  

     Zoom Tool  

To remove a Tool button from the Toolbar, ALT-drag it and drop it away from the control 
bars. If you like you can copy or move Tool buttons to other control bars. See Moving & 
copying buttons and Removing & restoring buttons.



The Bitmap Tracer produces a set of shapes that look like a bitmap. It examines a bitmap 
and tries to determine the shapes that best approximate the areas of colour in the bitmap.
The bitmap tracer has options to control the minimum size of the shapes, how many 
different colour levels it should try to find, etc.



Tracking uniformly changes the spacing between all the characters in a region. (Note the 
difference between this and Kerning which adjusts the spacing between a pair of 
characters.) Tracking is often used to expand text to exactly fit an area of a document.
Tracking is measured in em's (the width of an "M" in the current font and font size).



Transformation Centre
The transformation centre is the point/axis around which objects are skewed, flipped and 
rotated using the Selector Tool. The transformation centre is only visible when the Selector 
Tool is in Rotate/Skew mode.

To move the transformation centre do one of the following :
Click on a square on the Transformation Centre Grid on the Infobar to move the 

transformation centre to a specific position on the selection.
Drag the transformation centre to a new position. If you hold down CTRL whilst 

dragging the centre, it will be constrained to the nine points shown on the Transformation 
Centre Grid on the Selector Tool Infobar.



Transparent objects allow you to see some amount of the objects behind them. There are 
three types of transparency in CorelXARA; Mix, Stained glass and Bleach. Transparency is 
measured in percentages. 0% means that the transparent object affects all of what can be 
seen underneath it. 100% means that the transparent object does not affect your view of 
what's underneath it at all. By combining transparency types and shapes with different fill 
colours and types you can create a wide range of effects and shading. Note that documents 
using transparent objects takes longer to redraw on-screen and to print.



Transparency Arrows let you control graduated transparency. The direction and length of 
the arrow directly control the direction and extent of the graduated transparency. The arrow 
has handles at either end which can be selected. The transparency set by the slider in the 
Transparency Tool Infobar is applied to the selected handles.



Transparency Handles are the handles at the ends of the Transparency arrow. 
Drag the handles to change the direction and size of the graduated transparency. 
Select a handle and drag the slider on the Transparency Tool Infobar to change the amount 
of transparency applied.
To easily swap between the start and end handles, press TAB.



 
 Transparency Tool

The Transparency Tool lets you apply graduated, fractal and bitmap transparency to objects. 
It works in a similar way to the Fill Tool.

F6
Transparency Tool Infobar Controls
Note that the Infobar shows only those controls relevant to the current Transparency Shape.

Transparency Shape
Bitmap & Fractal Transparency Resolution
Fractal Transparency Grain

Transparency Level
Bitmap & Fractal Transparency Tiling
Transparency Type

Transparency Tool Operations
Applying transparency
Editing transparency
Removing transparency
Enabling transparency
Using transparent lines

On-line Demonstrations
    {button Simple Transparency Effects,EF("XaraDemo.exe","Transpar.avi `Simple 

Transparency Effects' ",1) }
    {button    Transparency Applications,EF("XaraDemo.exe","Transfun.avi    `Transparency 

Applications' ",1) }

Note
Using transparent objects in drawings will result in slower redraw and printing.



 Transparency Tool - Bitmap & Fractal Transparency 
Resolution Field

This field is displayed on the Transparency Tool Infobar when the selection contains only 
bitmap/fractal transparencies and no transparency handles are selected.

Altering the value in the field changes the resolution of the bitmap/fractal fills in the 
selection by changing their size.



 Transparency Tool - Bitmap & Fractal Transparency Tiling 
Field

This field appears on the Transparency Tool Infobar when the selection contains only 
bitmap/fractal transparencies.

There are three options available which set sets the way in which the fractal/bitmap is tiled 
(repeated) to fill the shape.

Repeat Inverted
Fill the shape with multiple copies of the image - alternate images are reflected.

Repeating Tile
Fill the shape with multiple copies of the image.

Single Tile
Fill the shape with one single image. 



 Transparency Tool - Fractal Transparency Grain Slider

This field only appears on the Transparency Tool Infobar when the selection contains only 
fractal transparencies and no transparency handles are selected.

Moving the slider changes the grain of the fractal fill(s). A low value gives a smooth, cloud-
like pattern, a higher value gives a sharper, more 'grainy' texture.



 Transparency Tool - Transparency Shape Field

Transparency Shape field is always present on the Transparency Tool Infobar. It sets the 
transparency shape of the currently selected objects.
The options available are :

No Transparency
Linear transparency
Circular transparency
Elliptical transparency
Conical transparency
Bitmap transparency
Fractal transparency

_______________
See also
Applying transparency
Editing transparency



 Transparency Tool - Transparency Level Slider

This pair of controls is displayed on the Transparency Tool Infobar when the selection 
contains only flat/linear/circular/elliptical/conical fills.

The left hand field of the pair describes the selected handle(s).
The right hand field shows the amount of transparency applied to the selected handles. Drag
the slider to alter the transparency of the selected handle.



 Transparency Tool - Transparency Type Field
This field is always present on the Transparency Tool Infobar.

This field sets the transparency type of the transparency (if any) of the selection.
The options available are :

Mix
Stained Glass
Bleach



Tried everything

You've tried the suggestions on other troubleshooter pages but:
They don't apply
They don't help
They're not satisfactory

Here are a few final suggestions:
      Have you tried changing the print method?

If you're using Normal printing try changing to Bitmap printing and vice-versa. (See 
Output Options for more information.)

      Have you tried reducing the transparency resolution?
If your document contains lots of transparent objects, a high transparency resolution 
setting may produce too much data for the printer to handle. Generally, the transparency
resolution only needs to be about half the resolution of your printer. It rarely needs to be 
higher than 300dpi. It should never    be higher than the printer's resolution. (See Output 
Options for more information.)

      Have you tried reducing the fill quality?
Higher fill quality settings send more data to the printer. It's possible that your document
will still look good if the quality of the fills is reduced. (See Output Options for more 
information.)

      Windows 95 has a Print troubleshooter of its own which may help you to track down 
your problem. If you're running Windows 95 and you haven't already tried the Print 
troubleshooter:

1. Click the Start button on the task bar and choose Help from the menu.
2. Double-click "Troubleshooters" in the Help window.
3. Double-click "If you're having trouble printing" in the Help window.

Remember that we recommend you only run the final release version of Windows 95 - not a 
pre-release copy. If you haven't already done so please upgrade to the final release version.

      If you're an advanced user there are hidden INI file settings you can try.

Did this fix the problem?
      Yes! My document prints now. Close this troubleshooter.
      No. What else can I try?



TrueType is a type of font format. There are two main formats in use: TrueType and Adobe 
Type Manager (ATM). CorelXARA supports both types.



 Tune up Options
The tune up options for CorelXARA are accessed by selecting Options from the Utilities menu
and clicking on the Tune up 'tab'. The tune up options allow various settings to be changed 
which affect everyday CorelXARA use.

Redraw
CorelXARA uses memory to build up the image on your screen (and also when you export 
bitmaps and print), the amount necessary for fastest redraw is shown at the top of this 
section. Normally you will select the Automatic option which will allocate as much memory 
as possible taking into account how much memory your PC has (if there is not enough 
available to reach the figure required, CorelXARA will reduce the memory required by 
redrawing the document in strips). Selecting Automatic will always give the best 
performance from CorelXARA.
If for some reason you wish to set the amount of memory used by CorelXARA manually you 
can do this using the Use Limited Memory option. You might wish to do this if you wanted to 
reduce CorelXARA's memory requirements to an absolute minimum (to be able to run other 
programs simultaneously or prevent disc access). Values can be entered in megabytes, 
kilobytes or bytes. e.g. "1M" (1Megabyte), "200K" (200 Kilobytes), "4000" (4000 bytes).

Cache
When displaying items in some galleries, CorelXARA reads the information off disk into a 
cache to alleviate the need to load images as the gallery is scrolled. This option sets the 
number of items to be cached at any one time. If your machine has spare memory, you 
might like to increase this value. Values can be entered from 1 to 99.

Undo Size
This applies only to the selected document. The amount of undo (see Undo) information 
stored can be unlimited, or a value can be set for the maximum amount of space to be taken
up by it. When the undo buffer becomes full, the oldest information is always discarded first.
Values can be entered in megabytes, kilobytes or bytes. e.g. "1M" (1Megabyte), "200K" (200
Kilobytes), "4000" (4000 bytes).



Turn off "Print all foreground layers"

Make sure that CorelXARA is only printing the layers visible on screen:
1. Click CorelXARA's Utilities menu and choose Options.
2. Choose the Output section.
3. Click the Visible foreground layers switch.
4. If you changed any settings click OK and try to print again.

Did this fix the problem?
      Yes! My document prints correctly now. Close this troubleshooter.
      No. What else could be wrong?



Turn off spooling

The Windows printing system uses a temporary file on your hard disc to queue up printing 
commands and send them to the printer in the background. If you turn off spooling the 
temporary file is no longer needed (so you won't need lots of space on your hard disc to 
store it) but all applications, including CorelXARA, will take longer to print.

 On Windows 95
1. Select your printer in the Printers window.
2. Choose    the Properties option from the File menu.
3. Open the Details section.
4. Click the Spool Settings button at the bottom of the dialog box.
5. Ensure the Print Directly to the Printer option is checked.
6. If you changed any settings, click OK.

 On Windows 3.1
1. Run Control Panel.
2. Double-click the Printers icon.
3. Ensure that the Use Print Manager option at the bottom of the dialog box is 

unchecked.
4. If you changed any settings, click OK.

 On Windows NT
1. Run Control Panel.
2. Double-click the Printers icon.
3. Make sure that your printer's window is the active window.
4. Click the Printer menu and then choose Properties.
5. Click Details.
6. Ensure that Print directly to ports is checked.
7. If you changed any settings, click OK.

Did this fix the problem?
      Yes! My document prints now. Close this troubleshooter.
      No. What else could be wrong?



Unable to find any files to add to index

Cause
This message is displayed after attempting to generate an index for a directory with no 
recognised files that can be used in the relevant gallery.

Recommended action
Check the path is correct. Files are currently chosen by their extensions, if these are 
incorrect this may explain the problem.
This error will be given if you attempt to add a folder containing no bitmaps to the fill gallery
even if it contains vector format files (e.g. .XAR files).



Unable to find folder

Cause
Cannot find the required folder / directory for the gallery.

Recommended action
If the folder is on the CD, and the CD is not in the CD drive, insert the CD and click Retry. If 
this is not possible, or the folder has been deleted, click Add to locate a new folder. Cancel 
will open a, possibly empty, gallery.



Unable to find index

Cause
This message is displayed when an index is unavailable.

Recommended action
If the index is on the CD, and the CD is not currently in the CD drive, insert the CD and click 
Retry. If this is not possible, or the folder has been deleted, click Continue and the relevant 
folder will be removed from the gallery. Clicking Quiet will remove all the affected folders 
with no further warnings.



Unable to update index

Cause
This message is displayed when you try and update a read-only index.

Recommended action
If the index is on a CD, it is not possible to update it - the entire folder must first be copied to
a writable drive.
If the index is on a read-only network mount, copy the folder to a different drive or contact 
your system administrator.



To Undo your most recent changes to a document. Undo allows you to get rid of changes 
which you've applied mistakenly to your document, which went wrong or which you simply 
don't like the look of. Undo is a very powerful tool when combined with Redo because it 
gives you the freedom to experiment with a drawing, secure in the knowledge that you can 
always undo any changes or if you eventually decide you do actually like the changes, to 
redo them again.



Undo & Redo (Edit Menu)

Undo

 CTRL+Z or '<'
Any changes you make to a CorelXARA document can be undone. The number of steps you 
can undo depends on the memory that was available to record them (see Tune up Options). 
The recorded undo information is not saved with the document and so, if you save a 
document and later reload it you will no longer be able to undo changes you made before 
the Save.

Redo

 CTRL+Y or '>'
At any time when you have Undone some changes you can choose to redo them again. This 
is very useful because it gives you the ability to change your mind about an edit as many 
times as you like. One point to note is that however far you go back through undo steps, as 
soon as you edit the document yourself you will no longer be able to redo any of those 
steps.

Undo and Redo always show a brief description of what will be undone or redone. e.g. "Undo 
Delete".

Note
The < and > key shortcuts do not work when the Text Tool has been chosen.



 Ungroup (Arrange Menu)
 CTRL+U

Ungroup separates all selected groups into their constituent objects.

Objects inside groups can be selected and edited without being first removed from the 
group. See Selecting objects inside other objects

On-line Demonstration
    {button Grouping Objects,EF("XaraDemo.exe","Groups.avi `Grouping Objects'",1) }

_______________
See also
Group



 Unit Options
The unit options for CorelXARA are accessed by selecting Options from the Utilities menu 
and clicking on the Units 'tab'. This section allows the control of the use of units in 
CorelXARA and the definition of new, custom units.
The standard units are Pixels, Millimetres, Centimetres, Metres, Kilometres, Millipoints, 
Points, Picas, Inches, Feet, Yards and Miles. You can also define your own.

Page Units
The Page Units are the units used for most measurements in CorelXARA. For example the
Status Line uses the units defined here as do many of the fields on the Selector Tool 
Infobar.
Note that the units used for the grid and rulers are set using the Grid and Ruler Options.

Font Units
The units set in this field are used by CorelXARA for text measurements.

Colour Units
The colour units are used by the Colour Editor when you are editing colours. You can 
choose to use percentages or values from 0 to 255. These units are also used to make up
the names for colours imported from colour table files. e.g. colours can be named like 
R126G0B0 or R85%G0%B0%.

Unit Definition
To delete a unit, select it from the Unit Name drop-down list and click the Delete button. 
The standard units cannot be deleted.
To create a new unit, click the New Unit button and fill in each of the following fields.

Unit Name
This is the full name used for the new unit, e.g. Nautical miles.

Abbreviation
This is the abbreviation used for the unit, e.g. n.m., US$.

Prefix
If this option is set, the abbreviation is shown before the numeric measurement. e.g. 
£14.

Suffix
If this option is set, the abbreviation is shown after the numeric measurement. e.g. 
12n.m.

Is Equivalent To
These three fields are used to define the size of the new unit in terms of one of the 
existing units. For example, for nautical miles    you would fill the fields to read "1 
nautical mile is equivalent to 1852 metres".

To delete a unit, select it from the Unit Name drop-down list and click Delete. The standard 
units cannot be deleted. Also, units that are being used in the document cannot be deleted. 
These might be being specified in the grid spacing, the document scaling or in the default 
font or page units.
_______________
See also
Units in CorelXARA





 Update a disc-based gallery
To update a disc-based gallery

1. Open the gallery.
2. Select the sections you want to update.
3. Click the Add button to open the Add Folder dialog box.
4. Click the Update button.



Using Help (Help Menu)

Using Help on the Help menu opens Windows Help with an explanation on how to make use 
of it. This information can then be used to use the CorelXARA Help system, available from 
Contents on the Help menu.



 Use bitmaps
Editing bitmaps
Creating World Wide Web Bitmaps
Feathering a bitmap
Masking a bitmap
Fine-tuning the bitmap tracer
Importing Transparent GIF Files
Applying a bitmap fill
Editing a bitmap fill
Exporting a bitmap at a specific size



 Use blends
Blending objects
Creating advanced blends
Removing a blend
Morphing bitmaps



 Use colour
Colouring objects

Creating a named colour
Changing a named colour
Deleting a named colour

Importing colours & palettes
Copying colour from one object to another

Applying fills
Editing fills

Drawing simple lighting effects



 Use control bars & galleries
Closing a gallery
Selecting items in a gallery
Moving & resizing galleries
Reordering gallery items
Reordering gallery sections
Searching a gallery
Altering gallery display format

Moving & copying buttons
Creating & delete control bars
Moving & resize control bars
Show hidden buttons



 Use fills
Applying linear fills
Applying circular fills
Applying elliptical fills
Applying conical fills
Applying bitmap fills
Applying fractal fills

Editing linear fills
Editing circular fills
Editing elliptical fills
Editing conical fills
Editing bitmap fills
Editing fractal fills

Colouring objects



 Use guides
Guides are guidelines and guide objects on the guides layer. Use guides to align or position 
objects on other layers. For example, drawing a series of lines radiating from a single 
vanishing point lets you easily draw perspective drawings. To make alignment easier, you 
can make guides magnetic (see Snap to Guides).
Guidelines and guide objects are non-printing.
Guides are displayed with a coloured, dotted outline. You can change the colour used to 
display guides.

Guides
Creating the guides layer
Deleting the guides layer
Displaying and hiding guides
Changing the colour of guides
Making guides magnetic
Moving objects to the guides layer

Guidelines
Creating guidelines
Moving guidelines
Deleting guidelines
Listing the positions of guidelines

Note
You can use objects in layers other than the guides layer as guide objects by enabling 
magnetic snapping, see Snap to Objects.



 Use lines and shapes
Drawing a line
Drawing a shape
Redrawing part of a line or shape
Joining lines
Extending a line 
Editing curved lines and shapes
Smoothing lines and shapes

Moving points on shapes and lines
Selecting points on lines and shapes
Deleting points on lines and shapes
Adding points into a line or shape
Breaking lines and shapes apart

Drawing ellipses & circles
Drawing rectangles & squares
Drawing polygons
Drawing starred polygons

Editing ellipses & circles
Editing rectangles & squares
Editing polygons
Editing starred polygons

Using guides
Aligning the centres of QuickShapes
Drawing concentric circles



Use magnetic snapping

Magnetic snapping is a very powerful way of accurately aligning objects, lines and points on 
lines to any other object so they exactly touch.    So, for example, if you want several lines to
start at exactly the same point, or want a line to exactly join the edge of a circle, then using 
snap to objects is the answer.    You can even use this to align the centres of objects.

When you pick an object up, with the magnetic snapping turned on, it will move the object 
so the nearest 'point of interest' is exactly under the mouse pointer position.    When the 
object is being dragged and the magnet snapping has been enabled, the point under the 
mouse pointer will snap to the nearest outline or any other 'point of interest' on any visible 
shape. The 'point of interest' is defined as the outline or any handle on the outline, and other
positions such as the centre of objects.

For example, you can exactly align the corner of a square to the centre of a circle by picking 
up the corner of square (or very nearby) and dragging this near the centre of the object.    
When the object has snapped, the mouse pointer will show a magnet and the magnet 
indicator on the Status Line will light up.

The Magnetic snapping distance stays the same on screen no matter what zoom factor is 
used to view the drawing. So, if two potential guide objects are very close together and you 
have difficulty controlling which of them things snap to, zoom in on the two guide objects so 
that you can see the separation between them more clearly. You can then consistently snap 
to either object. Changing the magnetic snapping distances is described in Mouse Options.

Magnetic Snapping is enabled using Snap to Objects on the Window menu.
_______________
See also
Using guides



 Use moulds
Applying a mould

Editing an envelope mould
Editing a perspective mould



 Use rulers
As you create or scale objects you can use the rulers to check their size. If you need to size 
or scale objects more accurately, you can use the Selector Tool.

The units and number of divisions on the rulers are the same as those for the on-screen grid.
These are set in the Grid & Ruler Options. The right-hand end of the top ruler shows the 
units currently in use.
_______________
See also
Displaying and hiding the rulers
Moving the ruler zero point



 Use scrollbars
Scrollbars allow you to move the page around in the CorelXARA document window.

The Scrollbars in CorelXARA are proportional. For example if the current zoom on your 
document means you are looking at half the workspace, the scroll bar will take up half of the
bar. This makes it easier to see, at a glance, at what scale the document is being viewed.

The scrollbars are also interactive meaning that the page scrolls as you move them, rather 
than waiting until you release the mouse button.

Clicking the right mouse button on scrollbars moves in the opposite direction from normal. 
For example, right-clicking above the scroll box scrolls down. This makes it simple to move 
backwards and forwards using the scrollbars without having to move the mouse.



 Use selection handles
Selection handles allow basic manipulation of the selected objects. They are enabled using 
the Selection Handles Button on the Selector Tool Infobar (see Enabling selection handles). 
They operate in two modes, Scale Mode and Rotate/Skew Mode. The former allows the 
selection to be scaled and stretched and the latter allows it to be rotated and skewed.

To swap selection handle mode
Click the Rotate/Skew Mode Button button on the Selector Tool Infobar.

or
Click on one of the objects in the selection.

On-line Demonstration
    {button Selection Handles,EF("XaraDemo.exe","SelHands.avi `Selection Handles'",1) }



 Use shades
It is very easy to create a range of different shade colours using CorelXARA.

To create a shade
1. Click the New Named Colour button in the Colour Editor to open the New Named Colour 

dialog box.
2. Select the Shade option.
3. Select the parent for the shade from the drop-down list.
4. Enter a name for the colour.
5. Click Create.

Changing a shade
You can edit a shade or any named colour by dragging it from the colour line to the Colour 
Editor.    You will notice the name change in the editor to reflect the name of the colour 
you're editing.    If you're editing a shade you can only alter the Saturation and Value - the 
Hue is fixed by the parent colour.

When editing any named colour, all objects in the drawing that use this colour will change. 
In this respect it is like editing a style in a word processor.

To edit the parent colour of a shade you can either select the parent from the Colour Editor's 
drop down name list, drag it onto the Editor from the Colour Line or more easily right click on
the editor and select 'Edit parent'.    When editing the parent you will notice that all shades 
created using it will change at the same time. The parent colour is shown in the Colour 
Editor as a small white cross.

For more information, see Colour Editor - Shade Colours.

Note
It is recommended that the parent colour is a bright, pure colour. i.e. that the marker in the 
colour editor is in the top left-hand corner. This means all shades will be selected as lighter 
or darker variations of the parent's pure colour.    This ensures that if you change the 
lightness or darkness of the parent, all the linked shades will change by the correct relative 
amount.



 Use text
Creating new text
Editing Text
Selecting text
Applying attributes to text
Placing text around a curve
Creating fully justified text
Editing moulded text
Entering special characters

Installing a font
De-installing a font

Text Tool key shortcuts



Using the Galleries (Help Menu)

This option opens the on-line documentation on the Galleries page.



 Use the Push Tool temporarily
The Push Tool can be used temporarily - alleviating the need to manually choose the 
previous tool afterwards.

To use the Push Tool temporarily
1. Press and hold down ALT+X to swap to the Push Tool.
2. Use the Push Tool as required. See Moving the page.
3. Release ALT+X to return to the previous tool.

or
1. Press and release ALT+X to swap to the Push Tool.
2. Use the Push Tool as required.
3. Press and release ALT+X again to return to the previous tool.



 Use the Selector Tool temporarily
The Selector Tool can be used temporarily - alleviating the need to manually choose the 
previous tool afterwards.

To use the Selector Tool temporarily
1. Press and hold down ALT+S (or F2) to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Release ALT+S (or F2) to return to the previous tool.

or
1. Press and release ALT+S (or F2) to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Press and release ALT+S (or F2) again to return to the previous tool.

or (except from the Text Tool)
1. Press and hold down the Space Bar to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Release the Space Bar to return to the previous tool.

or (except from the Text Tool)
1. Press and release the Space Bar to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Press and release the Space Bar again to return to the previous tool.



Using the Tools (Help Menu)

This option opens the on-line documentation on the Tools page.



 Use the Zoom Tool temporarily
The Zoom Tool can be used temporarily - alleviating the need to manually choose the 
previous tool afterwards.

To use the Zoom Tool temporarily
1. Press and hold down ALT+Z to swap to the Zoom Tool.
2. Use the Zoom Tool as required. See Zooming.
3. Release ALT+Z to return to the previous tool.

or
1. Press and release ALT+Z to swap to the Zoom Tool.
2. Use the Zoom Tool as required.
3. Press and release ALT+Z again to return to the previous tool.



 Use the keyboard
Both the CorelXARA manual and the On-line documentation follow conventions for showing 
keyboard Shortcuts.

Keys are shown in upper case. e.g. CTRL is the Control key.

Combinations of keys are shown like this: CTRL+A. This means :

1. Press and hold down the CTRL (Control) key.
2. Press and release the A key.
3. Release the CTRL key.

The Constrain Key
The CTRL (Control) key has a special function in CorelXARA. It constrains the action of the 
current operation in some way.
For example, normally you can rotate an object through any angle. Hold down CTRL and the 
rotation is constrained to preset angles (defined in General Options).
Similarly constraining the creation of an ellipse creates a circle.

The ALT keys
Most keyboards have two ALT keys. The right-hand ALT key is interpreted by Windows as 
CTRL+ALT. CorelXARA cannot alter this behaviour. As a result CorelXARA operations involving
the ALT key only function using the left-hand ALT key.
_______________
See also
Mouse Use
Keyboard Short-cuts



 Use the mouse
Click
Press and release the mouse button. This is usually the left mouse button, but this is 
configurable. See Mouse Options.

Double Click
Click twice in quick succession.

Drag
Hold down the mouse button whilst moving the mouse.

Drag-and-drop
Move the mouse over an item, drag the item to the required position and release the mouse 
button to drop it.

CTRL-Click
Hold down the CTRL key during the click.

SHIFT-Click
Hold down the SHIFT key during the click.

ALT-Click
Hold down the ALT key during the click.

Note
CTRL, SHIFT & ALT can be held down in any combination during an operation.
_______________
See also
Keyboard Use



 Use titles, descriptions and keywords
Using the Document Info dialog box it is possible to add a title, description and keywords to 
a document. If the file is then added to the Clipart Gallery this information will be used 
during searches and for displaying the document in the gallery.

The information is entered into the Comments field of the Document Info dialog box. The 
first line of the Comment field is taken as a description of the file, unless it starts 'KEY:' or 
'TITLE:' in which case the item is assumed not to have a description.

If a line starts with 'TITLE:' the rest of the line is taken as the title for the drawing.
If a line starts with 'KEY:' the rest of the lines is taken as a list of keywords separated by 
commas or vertical bars ('|').

For example, a picture of a dog might contain the following information in the Comments 
section of the Document info dialog box (<ENTER> is where the user would have pressed 
<ENTER>):

A large great dane<ENTER>
KEY:Dog,Large,Animal,Mammal<ENTER>
TITLE:Great dane

Note
Comments will only be added to the indexes when creating or updating them, and only .XAR 
files will be checked for these comments.



 Use transparency
Applying flat transparency
Applying linear transparency
Applying circular transparency
Applying elliptical transparency
Applying conical transparency
Applying bitmap transparency
Applying fractal transparency

Editing flat transparency
Editing linear transparency
Editing circular transparency
Editing elliptical transparency
Editing conical transparency
Editing bitmap transparency
Editing fractal transparency

Removing transparency
Enabling & disabling transparency
Using transparent lines



 Use transparent lines
If you apply flat transparency to an object with an outline (or simply a line) the transparency 
will also affect the outline. If you remove the transparency from the object, the outline will 
also lose its transparency.

To apply transparency to the outline only
1. Select the object.
2. Choose the Transparency Tool.
3. Set the required transparency level for the line.
4. Remove the fill from the object by clicking on the No Colour button on the Colour Line.
5. Clone the object.
6. Reapply the original fill to the cloned object.
7. Remove the outline from the cloned object by right-clicking on the No Colour button on 

the Colour Line.
8. Choose No Transparency from the Transparency Tool Infobar to remove the transparency 

from the cloned object.

Note
Lines and outlines are only transparency when flat transparency has been applied to the 
object. The other transparency types (linear, conical etc) do not affect lines or outlines of 
objects.



 Use units in CorelXARA
CorelXARA has a high level of support for units of measurement. Units are used widely 
throughout the program and it is even possible to define additional custom units as required 
(see Unit Options).
If you set the Page Units (in the Unit Options) to Pixels (for example) all measurements will 
be shown in pixels. You could also change the grid and ruler units (see Grid and Ruler 
Options) to use pixels.
Whenever a field is visible showing a measurement in units a value can be entered using 
any unit. For example it is possible to enter "2pt" or "4cm" or even "10mi" into the Font Size 
field on the Text Tool Infobar.
The default CorelXARA units are :

"pix" Pixels (1/96 inch)
"mm" Millimetres
"cm" Centimetres
"m" Metres
"in" Inches
"ft" Feet
"yd" Yards
"pt" Points            (1,000 mp or 1/72 inch)
"pi" Picas              (12,000 mp 1/6 inch)
"mp" Millipoints (1/72,000 inch)
"mi" Miles
"km" Kilometres

CorelXARA also supports the use of scale factors. For example CorelXARA could be used to 
draw a map at a scale of 25,000 to 1 with the units appearing on the Status Line and control 
bars in Kilometres. See Scaling Options.



Utilities Menu

Colour Gallery
Layer Gallery
Bitmap Gallery
Font Gallery
Clipart Gallery
Fill Gallery
Line Gallery

Colour Editor

Bitmap Tracer
Bitmap Effects

Options



The Value colour component is used in the HSV (Hue, Saturation, Value) colour model, 
which is an intuitive colour model most often used by artists.
Value (sometimes called Brightness) represents how dark or light the colour is. A value of 0%
makes any colour completely black, while a value of 100% is as bright as the colour can be 
made.



Vector Format files describe a picture as a list of drawing instructions. This has two 
advantages over Bitmap formats:
1. The instructions can be scaled to work at any size.
2. The list can be edited to add, remove or alter any part of the drawing very easily.



A View is a window showing a document in a particular way. The different ways in which a 
View can show a document are: 

Area of document in the view, 
Zoom factor, 
Quality setting, 
Grid visible, 
Print border visible.

You can have more than one View open onto a document. For instance, you could have two 
Views onto different areas of the same document, two views showing the same document at 
different zoom factors or at different Quality settings.



 View Options
The view options for CorelXARA are accessed by selecting Options from the Utilities menu 
and clicking on the View 'tab'. They control a large array of options concerned with the way 
you use CorelXARA.

Show Progress Hourglass
When CorelXARA is performing long operations, it can display an hourglass pointer. 
Selecting this option will enable the display of this hourglass pointer.

Show Progress Bar
When CorelXARA is performing long operations, it can display a progress bar on the 
Status Line. Selecting this option will enable the display of this bar. The bar shows how 
far the operation has progressed.

Interactive Fill Dragging
When this option is set fill and transparency editing is 'interactive' - the fill updates as 
the mouse moves and the handles are only displayed when the mouse is not moving. If 
the option is not set fills and transparencies are edited by moving the handles alone and 
the changes are only visible when the mouse button is released. 
This setting can be temporarily swapped by pressing TAB during fill editing.

Dithering
The dithering method used to display your document on the screen can be changed with 
these options. Choosing none means there will be no dithering. Choosing Ordered 
dithering uses a regular dithering pattern ( like CorelXARA 1.1). Choosing Error Diffused 
dithering uses a more complex dithering technique (Floyd Steinberg). In general, error 
diffusion will give the best results, but is slower to redraw than the others. Choosing no 
dithering gives the fastest redraw times.

Colour Line Size
This option allows the display of colours on the Colour Line to be altered.
When the full set of named colours no longer fits on the screen, scrollbars appear on the 
Colour Line.

Edit Local Colours In
This option sets the colour model used when editing local colours using the Colour Editor.
It can be set to any of the available colour models or to Automatic Colour Model which 
will use the appropriate model.

Automatic Scroll to Selected Colour
When this option is set, the Colour Line and Colour Gallery will automatically scroll as 
necessary to ensure the fill colours of the currently selected object(s) are in view where 
possible.
If this option is not set, the Colour Line and Colour Gallery will not scroll. The colours of 
the selection may not always be visible on the Colour Line or in the Colour Gallery.

The following options only apply to the current document. They will not affect any
other documents currently loaded.

Proportional Scrollbars
When this option is set, the scrollbars around the document window are shown 
proportional to the visible portion of the document rather than being of a fixed size as is 
usual with Windows. Scrollbars can be disabled completely using the Scrollbars option on
the Window menu.



Background Redraw
When this option is set, redraw is slowed down, but the drawing can be edited while 
redraw takes place. For maximum redraw speed, disable this option.

Show Transparency
When this option is set, transparency is enabled. When it is not set, all transparency 
information in objects is ignored during redraw.



View Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a blank area of the document or 
an unselected handle, it contains the following :

New View
Full Screen
- - - - - - - - - -
Quality
Show Grid
Show Guides
- - - - - - - - - -
Snap To Grid
Snap to Guides
Snap To Objects
- - - - - - - - - -
Page Options



 View the on-line demonstrations
CorelXARA includes a large number of on-line multimedia demonstrations. To run the demos,
refer to On-line Demonstrations.

Starting playing
The demonstration starts automatically as soon as you click the demonstration button.

Pausing playing
Click the Pause (bottom left-hand) button. Click again to restart.

Rewinding/Advancing the demonstration
Drag the slider at the bottom of the window.

Resizing the window
You cannot drag the edges of the window to resize. (This would distort the image in the 
window and give poor quality results.) Instead, click the Menu button (to the right of the 
Pause button) and choose from the View options.

Closing the window
If you let the demonstration run to the end and stop, the demo window will close down 
automatically after a few seconds.    If you rewind the demo the window will only close when 
you close it manually.

Full screen/Normal mode
For maximum image size you can run the demonstration in full screen mode. CTRL+click on 
the Pause button to enter full screen mode. Press any key to return to Normal mode.

The Demonstration menu
To display this do one of the following :

click on the Menu button (to the right of the Pause button)
 right-click anywhere on the window.

View Lets you select from several pre-defined window sizes.
Volume Lets you alter the volume from external speakers connected to your computer.
Speed Usually demonstrations are run at normal speed. You may want to slow down 
a demonstration to view the actions more carefully.
Copy Copies the current demonstration to the clipboard as an AVI movie clip.
Config Lets advanced users set the default options.
Command For advanced users only.

Windows 3.1 and 3.11 users
CorelXARA multimedia demonstrations require Microsoft Video for Windows to be installed.    
This is supplied with CorelXARA.    Windows NT and Windows 95 users do not need Microsoft 
Video for Windows.



CorelXARA refers to Visual Selectors as colour models. Colour models are selected using 
the Colour Gallery.



Warning - about to lose Undo information

Cause
You have changed the maximum size of the undo information buffer.    This will discard 
existing Undo information.

Recommended action
To discard the existing Undo information click the Resize button. 
To make the Undo information buffer larger and hence preserve the existing Undo 

information, click Don't Resize and enter a higher value.



        

What's New - Click Here to see what's new in Version 1.2 !

Welcome to CorelXARA 1.2
CorelXARA is an advanced graphic illustration package for Windows computers. You will find 
producing illustrations quick and easy. You just choose the drawing tools you want from an 
on-screen toolbar and draw. Relevant information about the current tool is also displayed on-
screen. You can customise the bars to show as many or as few functions as you wish.
Every change you make is recorded by CorelXARA. So, if you make a mistake or change your
mind, you can step backwards undoing previous operations. You can experiment knowing 
you can always return to an earlier stage. Using CorelXARA could not be easier.
CorelXARA also provides many advanced features such as graduated fills, transparency, 
multi-stage blends, enveloping and perspective.

To watch a demonstration movie of CorelXARA in action, click this button :

    {button CorelXARA Demonstration,EF("XaraDemo.exe","Intro.avi `CorelXARA 
Demonstration'",1) }

CorelXARA Terminology
The CorelXARA Workplace
Mouse Use
Keyboard Use
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What printer are you using?

      HP LaserJet (or compatible)
      Some other printer



What's New?

CorelXARA version 1.2 extends bitmap handling options. These new options are especially 
useful for creating graphics intended for publishing on the World Wide Web (WWW). Also 
included are some additional functions requested by users.

Improved Palette Import Facilities
Extra Flexibility of Colour Editing
Measurement using Pixels
World Wide Web Browser Palette Support
Higher Quality Bitmap Export
Improved GIF Import
Extended GIF Export Options
Animated GIF Import and Export
Improved Screen Display Quality
Convert to Bitmap menu option

Improved Palette Import Facilities
Colour palettes are files containing a series of colour definitions. Importing a colour palette is
a quick way of adding colours into a document and so easily extending the range of pre-
defined colours. 
The original version of CorelXARA imported CorelDRAW (.cpl & .pal) palette files. 
CorelXARA 1.2 can also import:

Windows palettes (.pal files). These are produced by a variety of programs.
Adobe Colour Tables (.act files). These are used by Photoshop in paletted images. 

Saved using Colour table on the Mode menu in Photoshop (select Indexed colour on the 
Mode menu first).

Adobe Colour Swatches (.aco files). These are used by Photoshop to store collections 
of colours for external use. Colours can be defined in RGB, CMYK or HSV - the other formats 
define RGB colours.

Paint Shop Pro Palettes (.pal files). These are created using Save Palette on the 
Colours menu in Paint Shop Pro.

To import a palette, drag-and-drop the file icon onto the Colour Line. This imports the colours
into the current document. Colours in palette files are unnamed so CorelXARA allocates 
names based on colour composition. For example, "R100%G50%B0%" is an RGB colour 
comprising 100% red, 50% green and 0% blue. (If you have selected Decimal as the way to 
specify RGB colours, the colour name would be "R255G127.5B0". For details on specifying 
RGB colours in decimal, see Unit Options.)

See Importing colours and palettes

Extra Flexibility of Colour Editing
Many users like to specify RGB (Red-Green-Blue) colours as 0-255 rather than 0-100%. You 
can now do this with CorelXARA.. The default is 0-100%.

See Unit Options for details of the new colour units.

Measurement using Pixels
For graphics that will be displayed on a computer screen (such as WWW graphics), it’s often 
easiest to enter and display measurements in screen pixels (96pixels=1 inch). CorelXARA 



1.2 lets you do this using a new measurement unit of pixels (abbreviation 'pix'). You can 
always enter dimensions in pixels by typing pix after the dimension (120pix).

See Units in CorelXARA

World Wide Web Browser Palette Support
Supplied with CorelXARA 1.2 is a new template document (WWW.xar) and a palette file 
(WWW.PAL) that include colours identical to those used by both Netscape Navigator and 
Microsoft Internet Explorer. Netscape and Explorer display these colours without dithering 
which gives the best results on screen. (Intermediate colours in blends and fills will not 
match palette colours and so will be dithered.) The template document also includes other 
features useful for creating WWW graphics such as a grid spacing in pixels. Using WWW.xar 
makes it easier to create top-quality graphics for use on the WWW.

See Creating World Wide Web bitmaps

Higher Quality Bitmap Export
Two new options are provided when you export bitmaps: Dithering (none, ordered dithering 
or error diffused dithering) and Palette (standard or optimised). These options provide you 
with a range of options for improving the appearance of exported bitmaps. 
When exporting GIF images for the WWW, our general recommendations are to use Diffusion
dithering and an Optimised palette. If the web pages are likely to be viewed in a 256-colour 
mode only, you may get better results with Diffusion dithering and a Standard palette. Note 
that if you want to create the smallest files possible, you may want to turn off dithering.

See Bitmap Export.

Improved GIF Import
In Version 1.1 of CorelXARA, transparent GIFs were imported as normal and the mask added 
using CorelXARA transparency. CorelXARA 1.2 uses its own masking system, so you can now 
apply transparency to imported transparent GIF files.

See Importing transparent GIF files.

Extended GIF Export Options
The original version of CorelXARA could export GIFs as 16-colour (4-bit) without GIF 
transparency or 256-colour (8-bit) with transparency. CorelXARA 1.2 can also export GIFs as 
2-colour (1-bit) with optional transparency and 16-colour (4-bit) with optional transparency. 
The greater the number of colours used, the larger the file size. This is important when 
creating graphics for the WWW as small files take less time to download.
Transparency in a GIF bitmap means you can see through parts of the image to the 
background. If you export just a selection, then only the selected objects appear - all other 
areas are transparent. Note that GIF supports only a simple on-off transparency mask and 
not the more advanced graduated transparency that CorelXARA offers. Therefore semi-
transparent objects are not possible in GIF files. GIF transparency is really suitable only for 
masking around the outside of objects.

See Bitmap Export - Compuserve GIF.

Animated GIF Import and Export
CorelXARA 1.2 allows you to convert groups of objects to bitmaps. You can then use the 
Bitmap Gallery to export these bitmaps as frames in an animated GIF file. This makes 
CorelXARA an ideal tool for generating animations for publication on the World Wide Web. 



You can also import animated GIF files and edit them.

See Bitmap Export - Animated GIF

Improved Screen Display Quality
CorelXARA provides options for altering the dithering used on the screen. This is most useful 
in 256 colour screen modes because it gives the illusion of many more colours on the 
screen. It has no advantage for deep-colour screen modes (more than 256 colours). The 
disadvantage is that dithering slows down screen redraw times. (It takes longer to display 
objects on the screen.)
Options provided by CorelXARA are:

· No dithering. This is gives the fastest screen redraw times but poorest display quality. 
No dither is only really useful to see how exported 8-bit bitmaps will look with no 
dither.

· Ordered. This is the normal setting. It gives good results and is as fast as No dithering
· Error diffused gives the best results but, because more processing is required, slowest 

redraw. The actual redraw time depends on the hardware in your computer. We 
recommend this option unless the redraw time is too slow. 

See the new settings in the View Options.

Create Bitmap Copy Menu Option
This new item on the Arrange menu will create a bitmap from the selected objects. When 
you select the menu item, the Create Bitmap dialogue box appears giving you the option to 
specify the size and number of colours of the bitmap, the type of dithering used and whether
the bitmap is transparent.

See Create Bitmap Copy

Other Changes
To avoid conflicts with some foreign language keyboards, the following key shortcuts have 
changed :

CTRL+SHIFT+A Paste attributes (was CTRL+ALT+V)
CTRL+SHIFT+D Move object to layer behind (D for Down) (was CTRL+ALT+B)
CTRL+SHIFT+U Move object to layer in front (U for Up) (was CTRL+ALT+F)
CTRL+SHIFT+Z Zoom to selection (was CTRL+SHIFT+D)

Some changes have been made which affect the way objects with thick lines snap to the 
grid and to other objects. The original version of CorelXARA snapped to the outside of lines. 
CorelXARA 1.2 snaps to the centre of lines.



What's wrong with the printout?

      Some objects are missing from the printout.
      There are horizontal white lines across some objects.
      Some objects have stepped or jagged edges.
      The printout doesn't fit on the paper the way it's shown on screen.
      Objects which should be the same colour are darker in some places than others.
      Objects which aren't shown on screen are on the printout.
      None of these.



What's wrong?
      The Print dialog box won't open.
      Nothing is printed - not even blank paper appears.
      Printing partly works but stops before the page is complete.
      A complete page is printed but it looks different on paper than it does on screen.
      Printing is very slow.
     Coloured text is not appearing on the paper



Where to go next

You have found a problem which is not covered by this troubleshooter.

      Contact our Technical Support service.
      Close this troubleshooter.



Window Control Bar

Zoom to Page
Zoom to Drawing
Zoom to Selection
New View
Full Screen Mode
Show Grid
Snap To Grid
Print Borders
Show Rulers
Snap to Guides
Show Guides

 High Quality
 Normal Quality
 Simple Quality
 Outline Quality

_______________
See also
Default Control Bars



Window Menu

New View
Arrange Views
Cascade
Arrange Icons

Control Bars
Bars

Full Screen

Quality
Show Grid
Show Guides
Show Print Borders

Snap To Grid
Snap to Guides
Snap To Objects



Wrong version of Win32s

Cause
CorelXARA has detected that you are using an old version of Win32s, the Win32 extender for
Windows 3.1 and Windows for Workgroups. Win32s allows 32 bit applications to run under 
Windows 3.1. Without the correct version installed, CorelXARA is unable to run.

Recommended action
Reinstall Win32s.



The Yellow colour component is used in the CMYK (Cyan, Magenta, Yellow, Key) colour 
model, which is commonly used by printers. By mixing various quantities of these four inks, 
a large range of colours can be generated.



Your Initialisation file is out of date

Cause
The initialisation file, CORELXRA.INI, was created by an older version of CorelXARA.

Recommended action
Clicking Default recreates your initialisation file so that it contains the standard settings. You 
lose the previous settings, such as the window position and the list of recently used files, as 
well as the settings set in the Options.
If you want to keep your existing settings, then click Current.    Any settings which apply to 
the new version of CorelXARA are merged into your existing initialisation file.



Zero width lines
If you require a zero width line, do not use the line width controls (Line Gallery or the Line 
Width field on the control bar) to accomplish this. Instead set the line colour to 'no colour' 
with a right hand mouse click on the 'no colour' square on the Colour Line with the object 
selected.

Zero width lines are printed with a width of one device pixel. So, for example on a laser 
printer they will only just be visible, but on an image setter (which has a much higher 
resolution) will be too thin to see. They are device dependent and should not be used. 

CorelXARA converts zero width lines in imported files to 0.25 point.
_______________
See also
Colouring objects



Zoom
This drop-down list allows you to choose a a pre-defined zoom, or type in a user defined 
zoom value. It also contains options for zooming to the page, drawing and selection and 
returning to the previous zoom.

25,601%
16,000%
8,000%
4,000%
2,000%
1,000%
500%
200%
100%
75%
50%
25%
10%
Page
Drawing
Selection
Previous

The Zoom drop-down list is available on the control bars and the Zoom Tool and Push Tool 
Infobars.



 
 Zoom Tool

The Zoom Tool allows you to alter the magnification of the current document view. It only 
affects the view on screen - the document itself does not change.

ALT+Z or SHIFT+F7
Zoom Tool Infobar Controls

Previous Zoom
Zoom to Drawing
Zoom to Selection
Zoom to Page

Zoom

Zoom Tool Operations
Zooming

On-line Demonstration
    {button Magnifying and Moving a Document,EF("XaraDemo.exe","ZoomPan.avi 

`Magnifying and Moving a Document'",1) }
_______________
See also
Push Tool
Using the Zoom Tool temporarily



 Zoom to Drawing
Zoom to Drawing is also available from the Zoom drop-down list on the control bars and on 
the Push Tool and Zoom Tool Infobars. It zooms the current view to bring the whole of the 
drawing into view. Invisible layers are ignored.



 Zoom to Page
 CTRL+SHIFT+P

Zoom to Page is also available from the Zoom drop-down list on the control bars and on the 
Push Tool and Zoom Tool Infobars. It zooms the current view to bring the whole page (or 
pages if a double page spread) into view.



 Zoom to Selection
 CTRL+SHIFT+Z

Zoom to Selection is also available from the Zoom drop-down list on the control bars and on 
the Push Tool and Zoom Tool Infobars. It zooms the current view to bring all the selected 
objects into view.



The Zoom level of a View lets you see a document in close up or at a distance. You can think
of the zoom level being like a magnifying glass whose strength you can vary. When you look 
at your document with a zoom level of anything other than 100%, you are looking at it 
through a magnifying glass. But note that changing the Zoom level only changes your view 
onto the document - it does not change the size of the document or anything in it.



 Zoom
To return to the previous zoom
Do one of the following :

Choose Previous from the Zoom control on the control bars.
Click the Previous Zoom button on the control bars

To view the whole drawing
Do one of the following :

Choose Drawing from the Zoom control on the control bars.
Click the Zoom to Drawing button on the control bars.

To view all selected objects
Do one of the following :

Choose Selection from the Zoom control on the control bars.
Click the Zoom to Selection button on the control bars

To view the entire page
Do one of the following :

Choose Page from the Zoom control on the control bars.
Click the Zoom to Page button on the control bars.

To set the magnification
Choose the magnification from the Zoom control on the control bars.

To zoom in and out
1. Choose the Zoom Tool.
2. Do one of the following :

Click to zoom in on the document.
SHIFT-click to zoom out from the document.

The Status Line displays the zoom that will occur.

To view a specific area of a document
1. Choose the Zoom Tool.
2. Drag a rectangle around the area.

On-line Demonstration
    {button Magnifying and Moving a Document,EF("XaraDemo.exe","ZoomPan.avi 

`Magnifying and Moving a Document'",1) }



Em's are used to measure tracking and kerning.
One 'em' is the width of the character 'M' in the current font and font size. Hence, it is a 
relative measurement - changing the font or size, changes the absolute value.




